
 

Operation Manual



 

Original Manual: Synkron
Revision and Quality Control: C. Bachmann, H. Bischoff, S. Pfeifer, C. Schomburg

The information in this document is subject to change without notice and does not rep-
resent a commitment on the part of Steinberg Media Technologies GmbH. The soft-
ware described by this document is subject to a License Agreement and may not be 
copied to other media except as specifically allowed in the License Agreement. No part 
of this publication may be copied, reproduced or otherwise transmitted or recorded, for 
any purpose, without prior written permission by Steinberg Media Technologies GmbH.

All product and company names are ™ or ® trademarks of their respective owners. 
Windows XP is a trademark of Microsoft Corporation. The Mac logo is a trademark used 
under license. Macintosh and Power Macintosh are registered trademarks.

© Steinberg Media Technologies GmbH, 2005. 
All rights reserved.



 

Table of Contents



 

CUBASE SE

 

4 Table of Contents

 

9 About this manual

 

10 Welcome!

 

13 VST Connections: 
Setting up input and 

 

output busses

 

14 About this chapter
14 Setting up busses
18 Using the busses

 

21 Playback and the 

 

Transport panel

 

22 Background
26 Operations
29 Options and Settings

 

33 Recording

 

34 Background
35 Basic recording methods
40 Audio recording specifics
50 MIDI Recording Specifics
62 Options and Settings

 

67 The Project window

 

68 Background
70 Window Overview
81 Operations
113 Options

 

119 Folder tracks

 

120 About folder tracks
121 Handling folder tracks
123 Working with folder parts

 

127 Using markers

 

128 About markers
128 The Marker window

132 Using the Marker track
136 Marker key commands

 

137 Fades, crossfades 

 

and envelopes

 

138 Creating fades
142 The Fade dialogs
145 Creating crossfades
147 The Crossfade dialog
150 Auto Fades and Crossfades

 

153 The mixer

 

154 About this chapter
155 Overview
157 Configuring the mixer
160 The audio channel strips
161 The MIDI channel strips
162 The common panel
163 The output channels
164 Basic mixing procedures
168 Audio specific procedures
180 MIDI specific procedures
181 Utilities

 

187 Audio effects

 

188 About this chapter
188 Overview
190 Insert effects
195 Send effects
204 Making settings for the ef-

fects
206 Installing and managing ef-

fect plug-ins

 

213 VST Instruments

 

214 Introduction
214 Activating and using 

VST Instruments



 

CUBASE SE

 

Table of Contents 5

 

221 Automation

 

222 Background
225 Automation track operations
231 Using Write/Read 

automation
235 Working with automation 

curves
240 Tips and common methods
241 Options and Settings

 

243 Remote controlling 

 

the mixer

 

244 About this chapter
244 Setting Up
246 Operations
248 Remote control device spe-

cifics
250 The Generic Remote device

 

255 Audio processing and 

 

functions

 

256 Background
257 Audio processing
274 Freeze Edits

 

275 The Sample Editor

 

276 Background
276 Opening the Sample Editor
277 Window overview
282 Operations
290 Options and settings

 

293 The Audio Part Editor

 

294 Background
294 Opening the 

Audio Part Editor
295 Window overview
298 Operations

301 Common methods
303 Options and Settings

 

305 Working with hitpoints 

 

and slices

 

306 Background
307 Using hitpoints
311 Editing hitpoints
317 About Q-points
318 Using the Audio Tempo 

Definition tool
322 Creating slices
323 Other hitpoint functions

 

327 The Pool

 

328 Background
330 Window Overview
333 Operations
350 Options and Settings

 

351 MIDI realtime para-

 

meters and effects

 

352 Introduction
353 The Inspector – General 

handling
354 Basic track settings
357 Track parameters
362 MIDI effects
367 Managing plug-ins
368 Merge MIDI in Loop

 

371 MIDI processing and 

 

quantizing

 

372 Introduction
373 Quantizing
384 Other MIDI menu functions
390 Dissolve Part



 

CUBASE SE

 

6 Table of Contents

 

393 The MIDI editors

 

394 About editing MIDI
395 Opening a MIDI editor
398 The Key Editor – Overview
404 Key Editor operations
427 The Drum Editor – Overview
430 Drum Editor operations
433 Working with drum maps
441 Using drum name lists
442 The List Editor – Overview
443 List Editor operations
450 The Score Editor – Overview
453 Score Editor operations
468 Common MIDI editor options 

and settings

 

471 Working with the 

 

Tempo track

 

472 Background
473 The Tempo Track Editor – 

overview
476 Operations
481 Options and settings
482 The Beat Calculator
484 Merge Tempo From Tapping

 

485 Export Audio 

 

Mixdown

 

486 Introduction
487 Mixing down to an audio file
489 File format specifics

 

497 Synchronization

 

498 Background
500 Window Overview
502 Options

 

503 VST System Link

 

504 Introduction
505 Preparations
511 Activating VST System Link
518 Application examples

 

521 Video

 

522 Background
523 Operations
528 Options

 

529 ReWire

 

530 Introduction
531 Launching and quitting
532 Activating ReWire channels
533 Using the transport and 

tempo controls
534 How the ReWire channels 

are handled in Cubase SE
535 Routing MIDI via ReWire2
536 Considerations and 

limitations

 

537 File handling

 

538 File Operations
555 Options and Settings

 

557 Customizing

 

558 Background
559 Customizing the Transport 

panel
561 Customizing the toolbars
563 Appearance
563 Applying track and event 

colors
566 Where are the settings 

stored?



 

CUBASE SE

 

Table of Contents 7

 

569 Key commands

 

570 Background
571 Setting up Key Commands
579 Setting up tool modifier keys

 

581 Index



 

CUBASE SE

 

8 Table of Contents



 

1

 

About this manual



 

CUBASE SE
1 – 10 About this manual

 

Welcome!

 

This is the Operation Manual for Steinberg’s Cubase SE 3. Here you 
will find detailed information about virtually all features and functions 
in the program. 

 

How to use the manuals and the Help

 

When it comes to manuals, different users look for information in differ-
ent ways, depending on their previous knowledge and personal prefer-
ences. You may be looking for a complete description of a procedure, 
you may just be trying to find a certain function in the program, you may 
have found a function in the program and want it explained – or you may 
simply want to learn it all!

Therefore, there are several ways to enter the documentation and get 
help:

 

•

 

Use the Table of Contents to browse the manual or the Help and find 
the section you need to know more about.

 

You can click directly on a chapter or section to go there.

 

•

 

Use the Index to look up specific features and functions.

 

Again, you can click directly on the page number for an index entry to go to there. 
The help also allows you to perform a free search of any term.

 

•

 

In the program you will find Help buttons in most dialogs – click to get 
information about that specific dialog.

 

Similarly, you can press [F1] to get information about the current window.

 

•

 

If you want information about a specific menu item, use the Menu 
Reference section in the Help.

 

All main menu items in Cubase SE are listed and explained there.

 

•

 

Finally, you could read the manuals from start to end if you like.

 

See below for a description of all parts of the Cubase SE documentation package.
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Other documents

 

Apart from the Operation Manual and the help, the following documents 
are included with Cubase SE:

 

Getting Started

 

In this book (also available in Adobe Acrobat pdf format) you will find:

 

• Requirements, installation and setting up your system.
• Basic concepts and terminology.
• Basic methods – e.g. how to set values, use tools and menus.
• A list of all default key commands.
• A number of tutorials, helping you get started with working in Cubase SE.

 

Audio Effects and VST Instruments

 

In this pdf document you will find:

 

• Descriptions of the included VST audio effect plug-ins.
• Descriptions of the included VST Instruments.

 

These descriptions can also be found in the help.

 

MIDI Devices and Features

 

In this pdf document you will find:

 

• Information on how to set up and manage MIDI devices in Cubase SE.
• Descriptions of the included MIDI effect plug-ins.
• Information on how to edit MIDI System Exclusive messages.
• Information on how to use the Logical Presets, the Input Transformer and the 

Transformer effect.

 

All pdf documents can be opened from the Help menu in the program, 
from the folder /Contents/Documentation/ within the program folder or 

 

the folder /Library/Documentation/Cubase SE 3 under Mac OS X.
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About this chapter

 

As described in the Getting Started book, Cubase SE uses a system 
of input and output busses to transfer audio between the program and 
the audio hardware.

 

• Input busses let you route audio from the inputs on your audio hardware into 
the program. This means that when you record audio, you will always do this 
through one or several input busses.

• Output busses let you route audio from the program to the outputs on your 
audio hardware. When you play back audio, you will always do this through 
one or several output busses.

 

As you can see, the input and output busses are vital when you work 
with Cubase SE. That’s the reason why you find this chapter in the be-
ginning of the Operation Manual – once you understand the bus system 
and set up the busses properly, it will be easy to go on with recording, 
playing back and mixing.

 

Setting up busses

 

Strategies

 

You can create any number of busses in Cubase SE in mono or stereo. 

 

• The bus configuration is saved with the projects – therefore it’s a good 
idea to add and set up the busses you need and save these in a template 
project (see page 541).

 

When you start working on new projects, you start from this template. That way you 
get your standard bus configuration without having to make new bus settings for each 
new project. If you need to work with different bus configurations in different projects, 
you could either create several different templates or store your configurations as pre-
sets (see page 17). The templates can of course also contain other settings that you 
regularly use – sample rate, record format, a basic track layout, etc.
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You can add the following busses:

 

Input busses

 

• Most likely you need at least one stereo input bus assigned to an analog input 
pair. This would let you record stereo material. If you want to be able to record 
in stereo from other analog input pairs as well, you could add stereo input 
busses for these too.

• Although you can record mono tracks from one side of a stereo input, it may be 
a good idea to add a dedicated mono input bus. This could be assigned to an 
analog input to which you have connected a dedicated microphone pre-amp 
for example. Again, you could have several different mono busses.

• You probably want a dedicated stereo input bus assigned to the digital stereo 
input, for digital transfers.

 

Output busses

 

• You probably want one or several stereo output busses for monitoring and 
listening to stereo mixes.

• For digital transfers, you need a stereo bus assigned to the digital stereo 
output as well.
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The VST Connections window

 

You add and set up busses in the VST Connections window, opened 
from the Devices menu.

There are two tabs in the window: the Input and Output tab for viewing 
input busses or output busses, respectively. 

For the time being we shall focus on how to set up input and output 
busses.

Depending on which tab you have selected, Input or Output, the win-
dow lists the current input or output busses, with the following columns:

 

Column Description

 

Bus Name Lists the busses. You can select busses and rename them by clicking 
on them in this column.

Speakers Indicates the speaker configuration (mono, stereo) of each bus.

Audio Device This shows the currently selected Master ASIO driver.

Device Port When you have “opened” a bus (by clicking its + button in the Bus 
Name column) this column shows which physical input/output on your 
audio hardware is used by the bus.
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Adding a bus

 

1.

 

Click the Inputs or Outputs tab depending on which you want to add.

 

2.

 

Click the Add Bus button.

 

A dialog appears.

 

3.

 

Select the desired (channel) configuration.

 

The pop-up menu contains Mono and Stereo options.

 

•

 

Alternatively you can right-click (Win) or [Ctrl]-click (Mac) in the VST 
Connections window and add a bus in the desired format directly 
from the context menu that appears.

 

The new bus appears with the ports visible.

 

4.

 

Click in the Device Port column to select an input/output port for a 
channel in the bus.

 

The pop-up menu that appears lists the ports with the names you have given them in 
the Device Setup dialog. Repeat this for all channels in the bus.

 

Other bus operations

 

•

 

To change the port assignment for a bus you proceed as when you 
added it – make sure the channels are visible (by clicking the + button 
next to the bus, or by clicking the “+ All” button at the top of the win-
dow) and click in the Device Port column to select ports.

 

•

 

To remove a bus you don’t need, select it in the list, right-click (Win) 
or [Ctrl]-click (Mac) and select “Remove Bus” from the pop-up menu.

 

•

 

You can store and recall bus presets with the pop-up menu at the top 
of the window.

 

To store the current configuration as a preset, click the store (+) button and enter a name 
for the preset. You can then select the stored configuration directly from the Presets 
pop-up menu at any time. To remove a stored preset, select it and click the (-) button.
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Using the busses

 

This section describes briefly how to use the input and output busses 
you have created. This is described in more detail in the chapters “Re-
cording” and “The mixer”.

 

Routing

 

When you play back an audio track (or any other audio channel in the 
mixer – VST Instrument channels, ReWire channels, etc.), you route it 
to an output bus. In the same way, when you record on an audio track 
you select from which input bus the audio should be sent.

 

•

 

You can select input and output busses in the Inspector, using the 
“In” and “Out” pop-up menus.

For channel types other than audio tracks (VST Instrument channels, 
FX channels, etc.), only the “Out” pop-up menu is available. To access 
the “Out” pop-up menu for such a channel in the Inspector, select one 
of its automation subtracks in the Track list.

When selecting an input bus for a track you can only select busses that 
correspond to the track’s channel configuration. Here are the details:

 

• Mono tracks can be routed to mono busses or individual channels within a 
stereo bus (input or output). 

• Stereo tracks can be routed to stereo busses.
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Viewing the busses in the mixer

 

Only the output busses are visible in the mixer! You cannot make any 
specific mixer settings for the input busses.

 

Output channels

 

The output channels are shown to the right in the mixer. Here you can 
do the following:

 

• Adjust the total output level for the busses with the faders.
• Add effects or EQ.

 

These will affect the whole bus. Examples of effects you may want to add here include 
compressors or limiters. See page 193.
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Background

 

This chapter describes the various methods available for controlling 
Playback and Transport functions in Cubase SE.

The Transport panel

Below you can find a brief description of each Transport panel item.

• You can customize the look of the Transport panel, hiding unneeded 
controls and moving controls as desired – see page 559.
The pictures below show the Transport panel with all controls visible and in their default 
position. The Transport panel is divided into sections, from left to right.

Activates Auto 
Quantize

Record mode pop-upCycle Record 
mode pop-up

CPU load and Disk 
Cache meters

Preroll setting and 
on/off switch

Postroll setting and 
on/off switch

Left locator: record start point, punch 
in point and beginning of Cycle

Right locator: 
punch out point and end of Cycle

Primary Time Display and format pop-up

Position slider Record

Play

Fast forward
Rewind Stop

Go to next marker or project end

Nudge position 
right/left

Go to previous 
marker or project 
start

Secondary Time Display 
and format pop-up

Exchange time formats

Cycle on/off
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• The main Transport functions (Cycle/Stop/Play/Record) can also be 
shown on the toolbar.

In addition, various play options are available on the Transport menu.

Hiding and showing

The Transport panel is shown by default when you launch a new 
project. To hide or show it, select the “Transport Panel” item from the 
Transport menu (or use a key command – by default [F2]).

About Preroll and Postroll

These items are described in the chapter “Recording” – see page 62.

Tempo track on/off 

Synchronization on/off The tempo and time signature display

Metronome click on/off Show Markers 
(opens Marker window)

Jump to Marker

Precount on/off

MIDI In (left meter)/
MIDI Out activity

Level Control (Output bus 1)

Audio activity (Output bus 1)Audio input activity (Input bus 1)
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Customizing the Transport panel

You can customize the appearance of the Transport panel by right-
clicking (Win) or [Ctrl]-clicking (Mac) anywhere on the panel and 
making selections on the pop-up menu that appears.

• On the upper half of the pop-up menu you can hide or show elements on the 
panel by activating or deactivating the corresponding menu items.

• Selecting the Show All item displays all sections of the Transport panel.
• Selecting Default shows all sections in their default positions on the panel.
• The items in the lower half of the pop-up menu are preset configurations for 

the Transport panel. You will find all your own stored presets here, for quick 
selection.

• Selecting Setup brings up a dialog where you can set show/hide status for 
the separate sections, configure where the sections should be placed on the 
panel and store different Transport panel layouts as presets for instant recall.

For more about customizing the Transport panel, see page 559.
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The numeric keypad

In the default Key Command settings, the numeric keypad on the 
computer keyboard is assigned various Transport panel operations:

Numeric Key Function

[Enter] Play

[+] Fast Forward

[–] Rewind

[*] Record

[÷] (Win) or [/] (Mac) Cycle On/Off

[,] Return to Zero

[0] Stop

[1] Go to Left Locator

[2] Go to Right Locator

[3 - 9] Go to marker 3 to 9
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Operations

Setting the project cursor position

There are several ways to move the project cursor position:

• By using Fast Forward and Rewind.
• By dragging the project cursor in the lower part of the ruler. 
• By clicking in the ruler.

Double clicking in the ruler moves the cursor and starts/stops playback. 

• If the option “Locate when Clicked in Empty Space” is activated in the Prefer-
ences dialog (Transport page) you can click anywhere in an empty section of 
the Project window to move the cursor position.

• By changing the value in any of the position displays.
• By using the position slider above the transport buttons.

The range of the slider relates to the Length setting in the Project Setup dialog. Hence, 
moving the slider all the way to the right will take you to the end of the project. 

• By using markers (see page 128).
• By using playback options (see page 30).
• By using functions on the Transport menu.

The following functions are available:

• If Snap is activated when dragging the project cursor, the Snap value is 
taken into account. This is helpful for finding exact positions quickly.

Function Description

Locate Selection / 
Locate Selection End

Moves the project cursor to the beginning or end of the cur-
rent selection. For this to be available, you must have selected 
one or more events or parts, or made a selection range.

Locate Next/Previous 
Marker

This moves the project cursor to the closest marker to the 
right or left (see page 128).

Locate Next/Previous 
Event

This moves the project cursor forwards or backwards respec-
tively, to the closest beginning or end of any event on the se-
lected track(s).



CUBASE SE
Playback and the Transport panel 3 – 27

• There are also numerous key commands available for moving the project 
cursor (in the Transport category in the Key Commands dialog). 
For example, you can assign key commands to the “Step Bar” and “Step Back Bar” 
functions, allowing you to move the project cursor in steps of one bar, backwards and 
forwards.

About the Transport panel display formats

Primary time display (left) and secondary time display (right).

The time unit shown in the ruler can be independent from the time unit 
shown in the main time display on the Transport panel. This means that 
you can display timecode in the transport position display and bars and 
beats in the ruler, for example. In addition, there is a secondary time dis-
play to the right of the primary time display which is also independent, 
giving you three different time units shown at the same time. 

The following rules apply:

• If you change the time format from the primary time display on the 
Transport panel, this will apply to the ruler as well.
This is the same as changing the display format in the Project Setup. Therefore, to have 
different display formats in the ruler and the main time display you should change the for-
mat in the ruler.

• The primary time display format is set on the pop-up menu to the right 
in the main position display.

• The setting here also determines the time format displayed for the left 
and right locators.

• The secondary time display is completely independent, and the display 
format is set on the pop-up menu to the right.

• You can swap time formats between the primary and secondary time 
displays by clicking the double arrow symbol between them.
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The left and right locators

The left and right locators are a pair of position markers used for 
specifying punch-in and punch-out positions during recording, and as 
boundaries for cycle playback and recording. 

• When cycle mode is activated on the Transport panel, the area between 
the left and right locator will be repeated (cycled) on playback. 
However, if the right locator is positioned before the left, this will work as a “jump” or 
“skip mode” – when the project cursor reaches the right locator it will immediately 
jump to the left locator position and continue playback from there.

There are several ways to set locator positions:

• To set the left locator, press [Ctrl]/[Command] and click at the desired 
position in the ruler.
Similarly, pressing [Alt]/[Option] and clicking in the ruler sets the right locator. You can 
also drag the locator “handles” directly in the ruler.

The locators are indicated by the “flags” in the ruler. The area between the locators 
is highlighted in the ruler and in the Project window (see page 563). Note that if the 
right locator is before the left locator the area will be red in the ruler to indicate this.

• Click and drag in the upper half of the ruler to “draw” a locator range.
If you click on an existing locator range, you can drag to move it.

• Pressing [Ctrl]/[Command] and pressing [1] or [2] on the numeric 
keypad sets the left or right locator to the project cursor position.
Similarly, you can press [1] or [2] on the numeric keypad (without [Ctrl]/[Command]) to 
set the project cursor position to the left or right locator position. Note that these are 
default key commands – you can change these if you like.

• By creating cycle markers you can store any number of left and right 
locator positions, which can be recalled by simply double clicking on 
the corresponding marker (see page 132).

• The “Locators to Selection” item on the Transport menu (default key 
command [P]) sets the locators to encompass the current selection.
This is available if you have selected one or several events or made a selection range.
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• You can also adjust the locators numerically in the Transport panel.
Clicking the L/R buttons in the locator section on the Transport panel will move the 
project cursor to the respective locator. If you press [Alt]/[Option] and click the L or R 
button, the corresponding locator will be set to the current project cursor position.

Options and Settings

The “Return to Start Position on Stop” preference

This setting is found on the Transport page in the Preferences dialog 
(found on the File menu under Windows, on the Cubase SE menu un-
der Mac OS X).

• If “Return to Start Position on Stop” is activated when you stop play-
back, the project cursor will automatically return to the position where 
recording or playback last started.

• If “Return to Start Position on Stop” is deactivated, the project cursor 
will remain at the position where you stop playback.
Pressing Stop again will return the project cursor to the position where recording or 
playback last started.

About track disable/enable

For audio tracks, the track context menu contains an item named “Dis-
able Track”. This shuts down all disk activity for the track, as opposed to 
using Mute, which merely turns down the output volume for a track. For 
example, if you often record “alternative takes” you can easily build up a 
large number of takes on different tracks. Even though these tracks are 
muted, they are actually still “playing back” from the hard disk during 
playback. This puts an unnecessary load on your disk system, so using 
“Disable Track” is recommended for such situations.

• Select “Disable Track” for tracks that you want to keep in the project 
for later use (but don’t want to play back now).
Select “Enable Track” from the track context menu to re-enable disabled tracks.
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Playback functions

Apart from the standard transport controls on the Transport panel, you 
can also find a number of functions that can be used to control play-
back on the Transport menu. The items have the following functionality:

The functions listed above (except “Play until Next Marker”) are only avail-
able if you have selected one or more events or made a selection range.

About Chase

Chase is basically a function that makes sure your MIDI instruments 
sound as they should when you locate to a new position and start 
playback. This is accomplished by having the program transmitting a 
number of MIDI messages to your instruments each time you move to 
a new position in the project, making sure all MIDI devices are set up 
correctly with regard to program change, controller messages (such 
as MIDI Volume) etc.

For example, let’s say you have a MIDI track with a program change 
event inserted at the beginning. This event makes a synth switch to a 
piano sound.

In the beginning of the first chorus you have another program change 
event which makes the same synth switch to a string sound.

Option Description

Play from Selection 
Start/End

Activates playback from the beginning or end of the current se-
lection.

Play until Selection 
Start/ End

Activates playback two seconds before the start or end of the 
current selection and stops at the selection start or end, re-
spectively.

Play until Next Marker This activates playback from the project cursor and stops at the 
next marker.

Play Selection Range This activates playback from the start of the current selection 
and stops at the selection end.

Loop Selection This activates playback from the start of the current selection 
and keeps starting over again when reaching the selection end.
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You now play back the song. It begins with the piano sound and then 
switches to the string sound. In the middle of the chorus you stop and 
rewind to some point between the beginning and the second program 
change. The synth will now still play the string sound although in this 
section it really should be a piano!

The Chase function takes care of that. If program change events are set 
to be chased, Cubase SE will track the music back to the beginning, 
find the first program change and send this out, so that the synth is set 
to the right sound.

The same thing can apply to other event types as well. The Chase 
Events settings in the Preferences dialog–MIDI page determine which 
event types will be chased when you locate to a new position and start 
playback.

• Event types for which the checkbox is activated here will be chased.
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Background

This chapter describes the various recording methods that you can 
use in Cubase SE. As it is possible to record both audio and MIDI 
tracks in Cubase SE, both these recording methods are covered in 
this chapter.

Before you start

This chapter assumes that you are reasonably familiar with certain ba-
sic recording concepts, and that the following initial preparations have 
been made:

• You have properly set up, connected and calibrated your audio hard-
ware. 
This is described in the Getting Started book.

• You have opened a project and set the project setup parameters to 
your specifications.
Project setup parameters determine the record format, sample rate, project length etc. 
that affect the audio recordings you make during the course of the project. See page 81.

• If you plan to record MIDI, your MIDI equipment should be set up and 
connected correctly.
See the Getting Started book.
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Basic recording methods

This section describes the general methods used for recording. How-
ever, there are additional preparations and procedures that are specific 
to audio and MIDI recording respectively. Make sure to read these sec-
tions before you start recording (see page 40 and page 50).

Record enabling a track

Cubase SE can record on a single track or on several tracks (audio 
and/or MIDI) simultaneously. To make a track ready for recording, click 
the Record Enable button for the track in the Track list, in the Inspector 
or in the mixer. When activated, the button(s) turn red, indicating record 
ready mode.

Record Enable in the Inspector, Track list and mixer.

• If the option “Enable Record on Selected Track” is activated in the Pref-
erences dialog (Editing page), tracks are automatically record enabled 
when you select them in the Track list.

• The exact number of audio tracks you can record simultaneously depends 
on your computer CPU and hard disk performance.



CUBASE SE
4 – 36 Recording

Manually activating recording

You activate recording by clicking the Record button on the Transport 
panel or toolbar, or by using the corresponding key command (by de-
fault [*] on the numeric keypad).

Recording can be activated from Stop mode (from the current cursor 
position or from the left locator) or during playback:

• If you activate recording from Stop mode, and the option “Start Record at Left 
Locator” is activated on the Transport menu, recording will start from the left 
locator.
The preroll setting or the metronome count-in will be applied (see page 62).

• If you activate recording from Stop mode, and “Start Record at Left Locator” 
is deactivated, recording will start from the current project cursor position.

• If you activate recording during playback, Cubase SE will immediately enter 
Record mode and start recording at the current project cursor position.
This is known as “manual punch in”.

Activating recording in Sync mode

If you are synchronizing the Cubase SE transport to external equipment 
(Sync is activated on the Transport panel) and you activate recording, 
the program will go into “record ready” mode (the record button on the 
Transport panel will light up). Recording then starts when a valid time-
code signal is received (or when you manually click the Play button). 
See page 498 for more information about synchronization.
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Automatically activating recording

Cubase SE can automatically switch from playback to recording at a 
given position. This is known as “automatic punch in”. A typical use for 
this would be if you need to replace a section of a recording, and want 
to listen to what is already recorded, up to the recording start position.

1. Set the left locator to the position where you want recording to start.

2. Activate the Punch In button on the Transport panel.

Punch In activated.

3. Activate playback from some position before the left locator.
When the project cursor reaches the left locator, recording is automatically activated.

Stopping recording

Again, this can be done automatically or manually:

• If you click the Stop button on the Transport panel (or use the corre-
sponding key command, by default [0] on the numeric keypad), record-
ing is deactivated and Cubase SE goes to Stop mode.

• If you click the Record button or use the key command for recording, 
by default [*], recording is deactivated but playback continues.
This is known as “manual punch out”.

• If the Punch Out button is activated on the Transport panel, recording 
will be deactivated when the project cursor reaches the right locator.
This is known as “automatic punch out”. By combining this with automatic punch in, 
you can set up a specific section to record – again very useful if you want to replace a 
certain part of a recording. See also page 62.

Punch In and Out activated.
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Cycle recording

Cubase SE can record and play back in a cycle – a loop. You specify 
where the cycle starts and ends by setting the left and right locators. 
When the cycle is active, the selected section is seamlessly repeated 
until you hit Stop or deactivate cycle mode.

• To activate cycle mode, click the cycle button on the Transport panel.
If you now start playback, the section between the left and right locator is repeated in-
definitely until you stop.

Cycle activated

• To record in cycle mode, you can start recording from the left locator, 
from before the locators or from within the cycle, from Stop mode or 
during playback.
As soon as the project cursor reaches the right locator, it will jump back to the left 
locator and continue recording a new lap.

• The results of cycle recording depend on the selected cycle record 
mode and are different for audio (see page 48) and MIDI (see page 56).

Audio pre-record

This feature allows you to capture up to 10 minutes of any incoming 
audio you play in Stop mode or during playback, “after the fact”. This 
is possible because Cubase SE can capture audio input in buffer 
memory, even when not recording. 

Proceed as follows:

1. Pull down the File menu and open the Preferences dialog.

2. In the list to the left, select “Record” to open the Record page.

3. Specify a time (up to 600 seconds) in the Audio Pre-Record Seconds 
field.
This activates the buffering of audio input, making Pre-Record possible.
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4. Make sure an audio track is record enabled and receives audio from 
the signal source.

5. When you have played some audio material you want to capture (either 
in Stop mode or during playback), click the Record button.

6. After a few seconds stop the recording (unless you wish to continue 
recording).
An audio event is created, starting at where the cursor position was when you acti-
vated recording. This means that if you were in stop mode, and the cursor was at the 
beginning of the project, you may have to move the event to the right in the next step. 
If you were playing along to a project you should leave the event where it is.

7. Select the Arrow tool and place the cursor on the bottom left edge of 
the event so that a double arrow appears, then click and drag to the left. 
Now the event is extended and the audio you played before activating record is in-
serted – this means that if you played along during playback, the captured notes will 
end up exactly where you played them in relation to the project.

The recording was activated at the start of bar 9. This is indicated by a blue line in 
the audio event.
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Audio recording specifics

Selecting a recording file format

The format of recorded files is set in the Project Setup dialog on the 
Project menu. There are three settings: sample rate, record format (bit 
depth) and record file type. While the sample rate is set once and for 
all when you start working on a new project, the bit depth and file type 
can be changed at any time.

Record file type

The Record File Type setting determines which type of files will be 
created when you record:

Record format (bit depth)

The available options are 16 bit and 24 bit. The following applies:

• Normally, select the record format according to the bit depth delivered by 
your audio hardware.
For example, if your audio hardware has 20 bit A/D converters (inputs), you may want 
to record at 24 bit resolution, to capture the full bit depth. On the other hand, if your 
hardware has 16 bit inputs, it’s pointless to record with a higher bit depth – this will 
only make the audio files larger, with no difference in audio quality.

• The higher the bit depth, the larger the files and the more strain is put on the 
disk system.
If this is an issue, you may want to lower the record format setting.

File type Description

Wave File Wave files have the extension “.wav” and are the most common file for-
mat on the PC platform.

AIFF File Audio Interchange File Format, a standard defined by Apple Computer 
Inc. AIFF files have the extension “.aif” and are used on most computer 
platforms. AIFF files can contain embedded text strings (see below).
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Setting up the track

Creating a track and selecting the channel configuration

Audio tracks can be configured as mono or stereo tracks. This allows 
you to record or import a stereo file and treat it as one entity, with no 
need to split it up into mono files etc. The signal path for an audio 
track maintains its channel configuration all the way from the input 
bus, via EQ, level and other mixer settings to the output bus.

You specify the channel configuration for a track when you create it:

1. Select Add Audio Track from the Track list context menu or the 
Project menu (or double click in an empty area of the Track list when 
an audio track is selected – when a MIDI track is selected, double 
clicking in the Track list creates a new MIDI track).
A dialog appears with a channel configuration pop-up menu.

2. Select the desired format from the pop-up menu.
You can choose between mono and stereo.

3. Click OK.
A track appears, set to the specified channel configuration. In the mixer, a corresponding 
channel strip appears. Note that you cannot change the channel configuration for a track.

Selecting an input bus for a track

Here we assume that you have added and set up the required input 
busses (see page 14). Before you record you need to specify from 
which input bus the track should record. You do this in the Inspector:

• Select an input bus on the “in” pop-up menu in the top section.
As described on page 71, the Inspector shows the settings for the selected track. You 
show or hide the Inspector using the Inspector icon on the Project window toolbar.

Click here to select an 
input bus for the track.

Click here to show/hide the Inspector.
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Setting input levels

When recording digital sound, it’s important to set the input levels 
correctly – loud enough to ensure low noise and high audio quality, 
but not so loud that clipping (digital distortion) occurs.

Clipping typically occurs in the audio hardware, when a too loud ana-
log signal is converted to digital in the hardware’s A/D converters. 

Proceed as follows:

In Cubase SE, you check the input level at the channel strip for the 
track on which you are recording:

1. Locate the channel strip for the track you’re about to record on.

2. Activate monitoring for the channel by clicking the speaker button next 
to the fader.
When monitoring is activated, the meter shows the level of the incoming audio signal.

3. Play the audio source that you want to record and check the level 
meter for the channel.

4. Adjust the output level of your audio source so that the meters go rea-
sonably high without reaching 0.0 dB.
Check the numerical peak level indicator below the meter in the bus channel strip. To 
reset the peak level indicator, click on it.

• You must adjust the output level of the audio source – you cannot use 
the faders in Cubase SE to adjust the input level!

• An alternative way of checking the input levels would be to use the control 
panel for your audio hardware (if it’s equipped with input level meters). It 
may also be possible to adjust the input level in the control panel.
See the documentation of the audio hardware for details.
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Monitoring

In this context, “monitoring” means listening to the input signal during 
recording. There are three fundamentally different ways to do this: via 
Cubase SE, externally (by listening to the signal before it reaches Cu-
base SE) or by using ASIO Direct Monitoring (which is a combination 
of both of the other methods – see below).

Monitoring via Cubase SE

If you monitor via Cubase SE, the input signal is mixed in with the audio 
playback. The advantage of this is that you can adjust the monitoring 
level and panning in the mixer, and add effects and EQ to the monitor 
signal just as during playback.

The disadvantage of monitoring via Cubase SE is that the monitored 
signal will be delayed according to the latency value (which depends on 
your audio hardware and drivers). Therefore, monitoring via Cubase SE 
requires an audio hardware configuration with a low latency value (see 
the Getting Started book). You can check the latency of your hardware 
in the Device Setup dialog (VST Audiobay page).

• If you are using plug-in effects with large inherent delays, the automatic 
delay compensation function in Cubase SE will increase the latency.
If this is a problem you can use the Constrain Delay Compensation function while 
recording - see page 217.

When monitoring via Cubase SE, you can select one of four modes in 
the Preferences dialog (VST page):
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• Manual.
This option allows you to turn input monitoring on or off by clicking the Monitor button 
in the Inspector, the Track list or in the mixer.

• While Record Enabled.
With this option you will hear the audio source connected to the channel input when-
ever the track is record enabled.

• While Record Running.
This option switches to input monitoring only during recording.

• Tapemachine Style.
This option emulates standard tapemachine behavior: input monitoring in Stop mode 
and during recording, but not during playback.

External monitoring

External monitoring (listening to the input signal before it goes into 
Cubase SE) requires some sort of external mixer for mixing the audio 
playback with the input signal. This can be a stand-alone physical 
mixer or a mixer application for your audio hardware, if this has a mode 
in which the input audio is sent back out again (usually called “Thru”, 
“Direct Thru” or similar).

When using external monitoring, you cannot control the level of the 
monitor signal from within Cubase SE, or add VST effects or EQ to 
the monitor signal. The latency value of the audio hardware configura-
tion does not affect the monitor signal in this mode.

• If you want to use external monitoring, you need to make sure that mon-
itoring via Cubase SE isn’t activated as well.
Select the “Manual” monitoring mode in the Preferences dialog (VST page) and simply 
don’t activate the Monitor buttons.
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ASIO Direct Monitoring

If your audio hardware is ASIO 2.0 compatible, it may support ASIO 
Direct Monitoring. In this mode, the actual monitoring is done in the 
audio hardware, by sending the input signal back out again. However, 
monitoring is controlled from Cubase SE. This means that the audio 
hardware’s direct monitoring feature can be turned on or off automat-
ically by Cubase SE, just as when using internal monitoring.

• To activate ASIO Direct Monitoring, open the Device Setup dialog on 
the Devices menu and check the Direct Monitoring checkbox on the 
VST Audiobay page.
If the checkbox is greyed out, your audio hardware (or its driver) doesn’t support ASIO 
Direct Monitoring. Consult the audio hardware manufacturer for details.

• When ASIO Direct Monitoring is activated, you can select a monitor-
ing mode in the Preferences dialog (VST page), as when monitoring 
via Cubase SE (see page 43).

• Depending on the audio hardware, it may also be possible to adjust 
monitoring level and panning from the mixer.
Consult the documentation of the audio hardware if in doubt.

• VST effects and EQ cannot be applied to the monitor signal in this 
mode, since the monitor signal doesn’t pass through Cubase SE.

• Depending on the audio hardware, there may be special restrictions 
as to which audio outputs can be used for direct monitoring.
For details on the routing of the audio hardware, see its documentation.

• The latency value of the audio hardware configuration does not affect 
the monitor signal when using ASIO Direct Monitoring.
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Recording

Recording is done using any of the general recording methods (see 
page 35). After you finish recording, an audio file has been created in 
the Audio folder within the project folder. In the Pool, an audio clip is 
created for the audio file, and an audio event that plays the whole clip 
appears on the recording track. Finally, a waveform image is calculated 
for the audio event. If the recording was very long, this may take a while.

• If the option “Create Audio Images During Record” is activated in the Pref-
erences dialog (Record page), the waveform image will be calculated and 
displayed during the actual recording process.
This real-time calculation uses some processing power – if your processor is slow or 
you are working on a CPU-intensive project you should consider turning this option off.

Undoing recording

If you decide that you don’t like what you just recorded, you can delete 
it by selecting Undo from the Edit menu. The following will happen:

• The event(s) you just created will be removed from the Project window.
• The audio clip(s) in the Pool will be moved to the Trash folder.
• The recorded audio file(s) will not be removed from the hard disk.

However, since their corresponding clips are moved to the Trash folder, you can delete 
the files by opening the Pool and selecting “Empty Trash” from the Pool menu.

Recording overlapping events

The basic rule for audio tracks is that each track can play back a single 
audio event at a time. This means that if two or more events are overlap-
ping, only one of them will be heard at any given time.

What happens when you record overlapping events (record in an area 
where there’s already events on the track) depends on the Linear 
Record Mode setting on the Transport panel:
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• In “Normal” or “Merge” mode, recording where something has already 
been recorded creates a new audio event that overlaps the previous 
one(s).
When you record audio there is no difference between “Normal” and “Merge” mode – 
the difference only applies to MIDI recording (see page 54).

• In “Replace” mode, existing events (or portions of events) that are 
overlapped by the new recording will be removed.
This means that if you record a section in the middle of a longer existing recording, that 
original event will be cut into two events with a gap for the new event.

Which event will be heard?

If two or more events are overlapping, you will only hear the events (or 
portions of events) that are actually visible. Overlapped (hidden) events 
or sections are not played back.

• The functions “Move to Front” and “Move to Back” on the Edit menu 
(see page 98) are useful for managing overlapping events, as is the 
“To Front” function (see below).
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Recording audio in cycle mode

If you are recording audio in cycle mode, the result depends on the 
following factor:

• The Cycle Record Mode setting on the Transport panel.

Cycle Record Modes on the Transport panel

There are three different modes on the Transport panel, but the differ-
ences between two of the modes only apply to MIDI recording. For 
audio cycle recording, the following applies:

• If “Keep Last” is selected, the last complete “take” (the last completely 
recorded lap) is kept as an audio event.

Recording audio in cycle mode

The following will happen when you record audio in cycle mode:

• One continuous audio file is created during the entire recording process. 
• For each recorded lap of the cycle, one audio event is created.

The events will have the name of the audio file plus the text “Take *”, where “*” indicates 
the number of the take.

• The last take (the last recorded lap) will be on top (and will thus be the one 
you hear when you activate playback).
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To select another take for playback, proceed a follows:

1. Right-click (Win) or [Ctrl]-click (Mac) the event and select “To Front” 
from the pop-up menu that appears.
A submenu appears, listing all the other (obscured) events.

2. Select the desired take.
The corresponding event is brought to front.

This method allows you to quickly combine the best parts of each 
take, in the following way:

1. Use the Scissors tool to split the events in several sections, one for 
each part of the take.
For example, if you recorded four lines of vocals (in each take), you can split the events 
so that each line gets a separate event.

The events after splitting. Note that since the original take events overlap each 
other, clicking with the Scissors tool will split all takes at the same position.

2. For each section of the take, use the “To Front” function to bring the 
best take to the front.
This way, you can quickly combine the best sections of each take, using the first vocal 
line from one take, the second line from another take and so on.

You can also compile a “perfect” take in the Audio Part Editor, as 
described on page 301.
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MIDI Recording Specifics

Activating MIDI Thru

As described in the Getting Started book, the normal way to work 
with MIDI is to have MIDI Thru activated in Cubase SE, and Local Off 
selected in your MIDI Instrument(s). In this mode, everything you play 
during recording will be “echoed” back out again on the MIDI output 
and channel selected for the recording track.

1. Make sure the option “MIDI Thru Active” is activated in the Preferences 
dialog (MIDI page).

2. Record enable the track(s) on which you want to record.
Now, incoming MIDI is “echoed” back out again, for all record enabled MIDI tracks. 

• If you just want to use the Thru function for a MIDI track without record-
ing, activate the monitor button for the track instead.
This is useful e.g. if you want to try out different sounds or play a VST instrument in real 
time without recording your playing.

Setting MIDI channel, input and output

Setting the MIDI channel in the instrument

Most MIDI synthesizers can play several sounds at the same time, each 
on a different MIDI channel. This is the key to playing back several 
sounds (bass, piano etc.) from the same instrument. Some devices 
(such as General MIDI compatible sound modules) always receive on 
all 16 MIDI channels. If you have such an instrument, there’s no specific 
setting you need to make in the instrument. On other instruments you 
will have to use the front panel controls to set up a number of “Parts”, 
“Timbres” or similar so that they receive on one MIDI channel each. See 
the manual that came with your instrument for more information.

Record Enable button. Monitor button.
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Naming MIDI ports in Cubase SE

MIDI inputs and outputs can often be shown with unnecessarily long 
and complicated names. If you wish, you can rename your MIDI ports 
to more descriptive names:

1. Open the Device Setup dialog from the Devices menu.

2. Select the Windows MIDI or DirectMusic (Win) or MIDI System (Mac) 
device in the Device list.
The available MIDI inputs and outputs are listed. Under Windows, which device to 
choose depends on your system.

3. To change the name of a MIDI port, click in the Device column and 
type in a new name.
After closing the dialog, the new names will appear on the MIDI “in:” and “out:” pop-ups.

Setting the MIDI input in the Inspector

You select MIDI inputs for tracks in the Inspector – the area to the left 
of the Track list in the Project window:

1. If the Inspector is hidden, click the Show Inspector button on the tool-
bar.

2. Select the track(s) by clicking in the Track list.
To select multiple tracks, press [Shift] or [Ctrl]/[Command] and click. The Inspector 
shows the settings for the first selected track (for details, see page 71).
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3. Click the track headline in the Inspector to make sure the topmost 
section is shown.

4. Pull down the “in” pop-up menu and select an input.
The available MIDI inputs are shown. The items on the menu depend on the type of 
MIDI interface you are using etc. 

• If you select the “All MIDI Inputs” option, the track will receive MIDI 
data from all available MIDI inputs.

• If you hold down [Alt]/[Option] and select a MIDI input, this is selected 
for all MIDI tracks.

• If you hold down [Shift] and select a MIDI input, this is selected for all 
selected MIDI tracks.

• If you hold down [Ctrl]/[Command] and select a MIDI input, this is se-
lected for all MIDI tracks within the same folder track (see page 75).
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Setting the MIDI channel and output

The MIDI channel and output settings determine where the recorded 
MIDI is routed during playback, but are also relevant for MIDI Thru in 
Cubase SE. Channel and output can be selected in the Track list or in 
the Inspector. The procedure below describes how to make the set-
tings in the Inspector, but it can be done in largely the same manner in 
the Track list as well.

1. To select the track(s) and show the settings in the Inspector, proceed 
as when selecting a MIDI input (see above).

2. Pull down the “out:” pop-up menu and select an output.
The available MIDI outputs are shown. The items on the menu depend on what type of 
MIDI interface you are using etc.

• If you hold down [Alt]/[Option] and select a MIDI output, this is selected for all 
MIDI tracks.

• If you hold down [Shift] and select a MIDI output, this is selected for all se-
lected MIDI tracks.

• If you hold down [Ctrl]/[Command] and select a MIDI output, this is selected 
for all MIDI tracks within the same folder track (see page 75).

3. Use the “chn” pop-up menu to select a MIDI channel for the track.

• If you set the track to MIDI channel “Any”, each MIDI event on the 
track will be sent out on the channel stored in the event itself.
In other words, the MIDI material will be played back on the channel(s) used by the 
MIDI input device (the MIDI instrument you play during recording).
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Selecting a sound

You can select sounds from within Cubase SE, by instructing the pro-
gram to send Program Change and Bank Select messages to your 
MIDI device. This is done using the “prg” and “bnk” value fields in the 
Inspector or Track list.

Program Change messages give access to 128 different program lo-
cations. If your MIDI instruments have more than 128 programs, Bank 
Select messages (set in the “bnk” value field) allow you to select dif-
ferent banks, each containing 128 programs.

• Bank Select messages are recognized differently by different MIDI instru-
ments. Also, the structure and numbering of banks and programs may 
vary. Consult the documentation of your MIDI instruments for details.

• Note that it is also possible to select sounds by name. For descriptions 
of how to set this up, see the “MIDI Devices” chapter in the separate pdf 
document “MIDI Devices and Features”.

Recording

Recording MIDI is done according to the basic recording methods 
(see page 35). When you finish recording, a part containing MIDI 
events is created in the Project window.

About overlap and the Rec Mode setting

MIDI tracks are different from audio tracks when it comes to overlap-
ping parts:

• All events in overlapping parts are always played back.
If you record several parts at the same locations (or move parts so that they overlap), 
you will hear the events in all parts on playback, even though some of the parts are ob-
scured in the Project window.
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When recording overlapping parts, the result depends on the Rec 
Mode setting on the Transport panel:

• If Rec Mode is set to “Normal”, overdub recording works as with audio tracks, 
i.e. if you record again where something has already been recorded, you get a 
new part that overlaps the previous one(s).

• If Rec Mode is set to “Merge”, the overdubbed events are added to the exist-
ing part.

• If Rec Mode is set to “Replace”, the new recording replaces any existing 
events in the area on that track.

About punch in and out on MIDI tracks

Performing and setting up manual and automatic punch in/out record-
ing for MIDI tracks is done in exactly the same way as for audio tracks. 
There is one thing to note, however: 

• Punching in and out on recordings with Pitch Bend or controller data 
(modulation wheel, sustain pedal, volume etc.) may lead to strange ef-
fects (apparently hanging notes, constant vibrato etc.).
If this happens, you may need to use the Reset item on the MIDI menu (see page 58).

About the Auto Quantize function

If Auto Quantize is activated on the Transport panel (the “Auto Q” but-
ton), the notes you record are automatically quantized according to 
the current Quantize settings. For more information about quantizing, 
see page 373.
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Recording MIDI in cycle mode

When you record MIDI in cycle mode, the result depends on which 
Cycle Record mode is selected on the Transport panel:

Cycle Rec mode: Mix (MIDI)

For each completed lap, everything you record is added to what was 
previously recorded, in the same part. This is useful for building up 
rhythm patterns, for example. Record a hi-hat part on the first lap, the 
bass drum part on the second lap etc. 

Cycle Rec mode: Overwrite (MIDI)

As soon as you play a MIDI note (or send any MIDI message) all MIDI 
you have recorded on previous laps is overwritten – from that point on 
in the part. An example:

1. You start recording in an eight bar cycle.

2. The first take wasn’t good enough – you start directly with a new take 
on the next cycle lap and overwrite the first take.

3. After recording the second take you let the recording roll on and listen, 
without playing anything. 
You find that the take was good up until bar seven, for example.

4. On the next lap, you wait until bar seven and start playing.
This way you will overwrite the last two bars only.

5. Make sure you stop playing before the next lap begins – otherwise 
you will overwrite the entire take.

Cycle Rec mode: Keep Last

Each completed lap replaces the previously recorded lap. Note:

• The cycle lap must be completed – if you deactivate recording or 
press Stop before the cursor reaches the right locator, the previous 
take will be kept.

• If you don’t play or input any MIDI during a lap, nothing happens (the 
previous take will be kept).
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Recording different types of MIDI messages

You can decide exactly which event types should be recorded by using 
the MIDI filters – see page 61.

Notes

With MIDI, when you press and release a key on your synth or other 
MIDI keyboard, a Note On (key down) and a Note Off (key up) message 
are sent out. The MIDI note message also contains the information 
which MIDI channel was used. Normally, this information is overridden 
by the MIDI channel setting for the track, but if you set the track to MIDI 
channel “Any”, the notes will be played back on their original channels.

Continuous messages

Pitch bend, aftertouch and controllers (like modulation wheel, sustain 
pedal, volume etc.) are considered as MIDI continuous events (as op-
posed to the momentary key down and key up messages). If you move 
the Pitch bend wheel on your synthesizer while recording, this move-
ment is recorded together with the key (Note On and Note Off mes-
sages), just as you’d expect. But the continuous messages can also 
be recorded after the notes have been recorded (or even before). 
They can also be recorded on their own tracks, separately from the 
notes to which they belong. 

Say for instance that you record one or several bass parts on track 2. 
If you now set another track, like track 55, to the same output and 
MIDI channel as track 2 you can make a separate recording of just 
pitch bends for the bass parts. This means that you activate recording 
as usual and only move the pitch bend wheel during the take. As long 
as the two tracks are set to the same output and MIDI channel it will 
appear to the MIDI instrument as if the two recordings were made at 
the same time.
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Program Change messages

Normally, when you switch from one program to another on your key-
board (or whatever you use to record), a number corresponding to 
that program is sent out via MIDI as a Program Change message. 
These can be recorded on the fly with the music, recorded afterwards 
on a separate track, or manually entered in the Key or List Editors. 

System Exclusive messages

System Exclusive (SysEx) is a special type of MIDI message used to 
send data that only makes sense to a unit of a certain make and type. 
Every major MIDI manufacturer has its own SysEx identity code and 
these are part of practically all SysEx messages. SysEx can be used 
to transmit a list of the numbers that make up the settings of one or 
more sounds in a synth. For more about viewing and editing SysEx 
messages, see the chapter “Working with System Exclusive mes-
sages” in the separate pdf document “MIDI Devices and Features”.

The Reset function

The Reset function on the MIDI menu sends out note-off messages 
and resets controllers on all MIDI channels. This is sometimes neces-
sary if you experience hanging notes, constant vibrato, etc.

• Cubase SE can also automatically perform a MIDI reset during play-
back (after each part) and/or on stop.
You turn these functions on or off in the Preferences dialog (MIDI page).
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Retrospective Record

This feature allows you to capture any MIDI notes you play in Stop 
mode or during playback and turn them into a MIDI part “after the 
fact”. This is possible due to the fact that Cubase SE can capture 
MIDI input in buffer memory, even when not recording.

Proceed as follows:

1. Enable the Retrospective Record function in the Preferences dialog 
(Record page).
This activates the buffering of MIDI input, making Retrospective Record possible.

2. Make sure a MIDI track is record enabled.

3. When you have played some MIDI material you want to capture (either 
in Stop mode or during playback), select Retrospective Record from 
the Transport menu (or use the key command, by default [Shift]-[Pad*]).

The contents of the MIDI buffer (i.e. what you just played) is turned into 
a MIDI part on the record enabled track. The part will appear where the 
project cursor was when you started playing – this means that if you 
played along during playback, the captured notes will end up exactly 
where you played them in relation to the project.

• The Retrospective Record Buffer Size setting in the Preferences dialog 
(Record page) determines how much data can be captured.
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MIDI Preferences

The following options and settings in the Preferences dialog affect 
MIDI recording and playback:

MIDI page

• Length Adjustment
Adjusts the length of notes so that there always is a short time between the end of one 
note and the start of another (of the same pitch and on the same MIDI channel). You 
set the time in ticks. By default there are 120 ticks per 1/16 note, but you can adjust 
this with the MIDI Display Resolution setting on the same page.

Record page

• Snap MIDI Parts to Bars
When this is activated, recorded MIDI parts will automatically be lengthened to start 
and end at whole bar positions. If you are working in a Bars+Beats-based context, this 
can make editing (moving, duplicating, repeating, etc.) easier.

• Solo Record in MIDI Editors
If this is activated and you open a part for editing in a MIDI editor, its track is automat-
ically record enabled. Furthermore, Record Enable is deactivated for all other MIDI 
tracks until you close the editor again.
This makes it easier to record MIDI data when you’re editing a part – you will always be 
sure the recorded data ends up in the edited part and not on any other track.

• MIDI Record Catch Range in ms
When you record starting at the left locator, this setting helps you make sure the very 
start of the recording is included. A very annoying scenario is when you have recorded 
a perfect MIDI take, only to find out that the very first note wasn’t included – because 
you started playing a little bit too early! If you raise the Record Catch Range, Cubase 
SE will catch the events played just before the recording start point, eliminating this 
problem. 
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Filtering MIDI

The MIDI–MIDI Filter page in the Preferences dialog allows you to 
prevent certain MIDI messages from being recorded and/or “thruput” 
(echoed by the MIDI Thru function).

The dialog is divided into four sections:

Section Description

Record Activating any of these options prevents that type of MIDI message from 
being recorded. It will, however, be thruput, and if already recorded, it 
will play back normally.

Thru Activating any of these options prevents that type of MIDI message from 
being thruput. It will, however, be recorded and played back normally.

Channels If you activate a channel button, no MIDI messages on that MIDI channel 
will be recorded or thruput. Already recorded messages will, however, 
be played back normally.

Controller Allows you to prevent certain MIDI controller types from being recorded 
or thruput.
To filter out a controller type, select it from the list at the top of the 
Controller section and click “Add”. It will appear on the list below.
To remove a controller type from the list (allow it to be recorded and 
thruput), select it in the lower list and click “Remove”.
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Options and Settings

Recording-related Preferences

A couple of settings in the Preferences dialog (Transport page) are 
relevant for recording. Set these according to your preferred method 
of work:

Deactivate Punch In on Stop

If this is activated, punch in on the Transport panel is automatically 
deactivated whenever you enter Stop mode.

Stop after Automatic Punch Out

If this is activated, playback will automatically stop after automatic 
punch out (when the project cursor reaches the right locator and 
punch out is activated on the Transport panel). If the postroll value on 
the Transport panel is set to a value other than zero, playback will con-
tinue for the set time before stopping (see below).

About Preroll and Postroll

The preroll and postroll value fields (below the left/right locator fields) 
on the Transport panel have the following functionality:

• By setting a preroll value, you instruct Cubase SE to “roll back” a short sec-
tion whenever playback is activated.
This applies whenever you start playback, but is perhaps most relevant when recording 
from the left locator (punch in activated on the Transport panel) as described below.

• By setting a postroll value, you instruct Cubase SE to play back a short sec-
tion after automatic punch out, before stopping.
This is only relevant when punch out is activated on the Transport panel and “Stop 
after Automatic Punchout” is activated in the Preferences dialog (Transport page).

• To turn pre- or postroll on or off, click the corresponding button on the Trans-
port panel (next to the pre/postroll value) or use the “Use Preroll” and “Use 
Postroll” options on the Transport menu.

Preroll value field and on/off switch.

Postroll value field and on/off switch.
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An example:

1. Set the locators to where you want to start and end recording.

2. Activate punch in and punch out on the Transport panel.

3. Activate the option “Stop after Automatic Punchout” in the Preferences 
dialog (Transport page).

4. Set suitable preroll and postroll times by clicking in the corresponding 
fields on the Transport panel and typing in time values.

5. Activate pre- and postroll by clicking the buttons next to the preroll 
and postroll times so that they light up.

6. Activate recording.
The project cursor “rolls back” by the time specified in the preroll field and playback 
starts. When the cursor reaches the left locator, recording is automatically activated. 
When the cursor reaches the right locator, recording is deactivated, but playback con-
tinues for the time set in the postroll field before stopping.

Using the metronome

The metronome will output a click that can be used as a timing refer-
ence. The two parameters that govern the timing of the metronome 
are tempo and time signature, and these are edited in the Tempo 
Track window (see page 476).

You can use the metronome for a click during recording and/or play-
back or for a precount (count-in) that will be heard when you start re-
cording from Stop mode. Click and precount are activated separately:

• To activate the metronome, click the Click button on the Transport panel.
You can also select “Metronome On” from the Transport menu or use the correspond-
ing key command (by default [C]).

• To activate the precount, click the Precount button on the Transport panel.
You can also select “Precount On” from the Transport menu or set up a key command 
for this.

Click on/off Precount on/off
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Metronome settings

You make settings for the metronome in the Metronome Setup dialog, 
opened from the Transport menu.

The metronome can use either an audio click played back via the audio 
hardware, send MIDI data to a connected device which will play back 
the click or do both. 

The following metronome settings can be made in the dialog:

Metronome Options Description

Metronome in 
Record / Play

Allows you to specify whether the metronome should be heard 
during playback, recording or both (when Click is activated on 
the Transport panel).

Use Count Base If this option is activated, a field appears to the right where you 
specify the “rhythm” of the metronome. Normally, the metro-
nome plays one click per beat, but setting this to e.g. “1/8” 
gives you eighth notes – two clicks per beat. It’s also possible 
to create unusual metronome rhythms such as triplets etc.
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Precount Options Description

Precount Bars Sets the number of bars the metronome will count in before it 
starts recording if precount is activated on the Transport panel.

Use Time Signature at 
Project Time

When this is activated, the precount will be in the time signa-
ture set in the Tempo track. Furthermore, any tempo changes 
in the Tempo track during the precount will be applied.

Use Signature Lets you set a time signature for the precount. In this mode, 
tempo changes in the Tempo track won’t affect the precount.

MIDI Click Description

Activate MIDI Click Selects whether or not the metronome will sound via MIDI.

MIDI Port/Channel This is where you select a MIDI output and channel for the met-
ronome click.

Hi Note/Velocity Sets the MIDI note number and velocity value for the “high note” 
(the first beat in a bar). 

Lo Note/Velocity Sets the MIDI note number and velocity for the “low notes” (the 
other beats). 

Audio Click Description

Activate Audio Click Selects whether or not the metronome will sound via the audio 
hardware. Use the Audio Click Volume slider to adjust the level 
of the audio click.

Audio Click Volume Sets the volume of the audio click.
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5
The Project window
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Background

The Project window is the main window in Cubase SE. This provides 
you with an overview of the project, allowing you to navigate and per-
form large scale editing. Each project has one Project window.

About tracks

The Project window is divided vertically into tracks, with a timeline 
running horizontally from left to right. The following track types are 
available:

Track type Description

Audio For recording and playing back audio events and audio parts. Each audio 
track has a corresponding audio channel in the mixer.
An audio track can have one automation “subtrack” for automating mixer 
channel parameters, insert effect settings etc.

Folder Folder tracks function as containers for other tracks, making it easier to or-
ganize and manage the track structure. They also allow you to edit several 
tracks at the same time. See page 119.

FX Channel FX channel tracks are used for adding send effects. Each FX channel 
can contain up to eight effect processors – by routing effect sends from 
an audio channel to an FX channel, you send audio from the audio chan-
nel to the effect(s) on the FX channel. Each FX channel has a corre-
sponding channel strip in the mixer – in essence an effect return channel. 
See page 195 for more about FX Channel tracks and send effects.
An FX channel can also have an automation subtrack for automating 
mixer channel parameters, effect settings etc. All FX channel tracks are 
automatically placed in a special FX channel folder in the Track list, for 
easy management.

Group 
Channel

By routing several audio channels to a Group channel, you can submix 
them, apply the same effects to them, etc. (see page 177).
A Group channel track contains no events as such, but displays settings 
and automation curves for the corresponding Group channel. Each Group 
channel track has a corresponding channel strip in the mixer. In the Project 
window, Group channels are organized as subtracks in a special Group 
Tracks folder. 

MIDI For recording and playing back MIDI parts. Each MIDI track has a corre-
sponding MIDI channel strip in the mixer. A MIDI track can have an auto-
mation “subtrack” for automating mixer channel parameters, insert and 
send effect settings etc. 
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About parts and events

Events are the basic building blocks in Cubase SE. Different event 
types are handled differently in the Project window:

• Video events and automation events (curve points) are always viewed and 
rearranged directly in the Project window.

• MIDI events are always gathered in MIDI parts, containers for one or more 
MIDI events. MIDI parts are rearranged and manipulated in the Project win-
dow. To edit the individual MIDI events in a part, you have to open the part in 
a MIDI editor (see page 394). 

• Audio events can be displayed and edited directly in the Project window, but 
you can also work with audio parts containing several events. This is useful if 
you have a number of events which you want to treat as one unit in the project.

An audio event and an audio part.

Marker The Marker track displays markers, and allows you to move and rename 
them directly in the Project window (see page 132). There can only be 
one Marker track in the project.

Video For playing back video events. A project can only have one Video track.

Track type Description
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Window Overview

The Track list

The Track list is the area to the left in the Project window. It contains 
name fields and various settings for the tracks. Different track types 
have different controls in the Track list. To see all the controls you may 
have to resize the track in the Track list (see page 85):

• The Track list area for an audio track:

The toolbar.The info line.

Track list with var-
ious track types.

The event display, showing audio parts and 
events, MIDI parts, automation, markers, etc.

The Inspector.

The ruler.

Mute & Solo Record Enable
Track name

Output activ-
ity indicator

Show/hide 
automation

Indicates whether effect sends, EQ or insert 
effects are activated for the track. Click to bypass.

Monitoring on/off

Lock track button

Automation Read/
Write buttons

Edit channel settings
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• The Track list area for an automation subtrack (revealed by clicking 
the + button on a track):

• The Track list area for a MIDI track:

The Inspector

The area to the left of the Track list is called the Inspector. This shows 
additional controls and parameters for the track you have selected in 
the Track list. If several tracks are selected (see page 90), the Inspector 
shows the setting for the first (topmost) selected track.

To hide or show the Inspector, click the Inspector icon in the toolbar.

The Inspector icon.

Automation Read/Write buttons

Automation parameter 
(click to select parameter)

Expand automation track 
(show more parameters)

Mute Lock track button

Record Enable

Track name

MIDI Output Bank Program MIDI channel

Drum map assign Lock trackMonitoring on/off

Read/Write buttons

Edit channel settings

Mute & Solo

Indicates whether effect sends or insert effects 
are activated for the track. Click to bypass.
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• For most track classes, the Inspector is divided into a number of sec-
tions, each containing different controls for the track. You can hide or 
show sections by clicking on their respective headlines.
Clicking the headline for a hidden section brings it to view and hides the other sec-
tions. [Ctrl]/[Command]-clicking the headline allows you to hide or show a section 
without affecting other sections. Finally, [Alt]/[Option]-clicking a headline shows or 
hides all sections in the Inspector.

• It’s also possible to use key commands for showing different Inspec-
tor settings.
These are set up under the Inspector heading in the Key Commands dialog.

• Folding a section does not affect the functionality but merely hides the 
section from view.
In other words, if you have set up a track parameter or activated an effect for example, 
your settings will still be active even if you fold the Inspector section.

Which sections are available in the Inspector depends on the selected 
track’s class.
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Sections

In general, the Inspector contains the same controls as the Track list, 
but there are also some additional buttons and parameters. Below is a 
list of all common, possible settings and sections, their controls and 
usage, followed by descriptions of which sections are actually avail-
able for each type of track:

Parameter Description

Auto Fades 
Settings button

Opens a dialog in which you can make separate Auto Fade settings 
for the track. See page 151.

Edit button Opens the Channel Settings window for the track, allowing you to 
view and adjust effect and EQ settings, etc. See page 168.

Volume Use this to adjust the level for the track. Changing this setting will move 
the track’s fader in the mixer window, and vice versa. See page 164 to 
learn more about setting levels.

Pan Use this to adjust the panning of the track. As with the Volume setting, 
this corresponds to the Pan setting in the mixer.

Delay This adjusts the playback timing of the audio track. Positive values de-
lay the playback while negative values cause the track to play earlier. 
The values are set in milliseconds.

In This lets you specify which Input bus or MIDI input the track should 
use (see page 14 for information about Input busses).
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Audio tracks

For audio tracks, all settings and sections listed above are available.

MIDI tracks

When a MIDI track is selected, the Inspector contains a number of ad-
ditional sections and parameters, affecting the MIDI events in real time 
(e.g. on playback). Which sections are available for MIDI tracks is de-
scribed in the “MIDI Devices and Features” pdf document.

Marker tracks

When the marker track is selected, the Inspector shows the marker list. 
See page 128.

Video tracks

When a Video track is selected, the Inspector contains a lock button 
for locking the track (see page 106) and a mute button.

Out Here you decide to which output the track should be routed. For au-
dio tracks you select an output bus (see page 14) or Group channel, 
for MIDI tracks you select a MIDI output.

Inserts section Allows you to add insert effects to the track, see page 190. The Edit 
button at the top of the section opens the control panels for the added 
insert effects.

Equalizers 
section

Lets you adjust the EQs for the track. You can have up to four bands 
of EQ for each track, see page 170. 

Equalizer Curve 
section

Lets you adjust the EQs for the track graphically, by clicking and 
dragging points in a curve display.

Sends section Allows you to route an audio track to one or several FX channels (up to 
eight), see page 195. For MIDI tracks, this is where you assign MIDI 
send effects. The Edit button at the top of the section opens the con-
trol panel for the first effect in each FX channel.

Channel section Shows a duplicate of the corresponding mixer channel strip. The 
channel overview strip to the left lets you activate and deactivate 
insert effects, EQs and sends.

Parameter Description
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Folder tracks

When a folder track is selected, the Inspector shows the folder and its 
underlying tracks, much like a folder structure in the Windows Explorer 
or Mac OS X Finder.

• You can click one of the tracks shown under the folder in the Inspector 
to have the Inspector show the settings for that track.
This way, you don’t have to “open” a folder track to make settings for tracks within it.

Here, an audio track within the folder is selected.

FX channel tracks

When an FX channel track is selected, the following controls and sec-
tions are available:

• Edit button.
• Volume control.
• Pan control.
• Output routing pop-up menu.
• Inserts section.
• Equalizers section.
• Channel section.

FX channel folder tracks

FX channel tracks are automatically placed in a special folder, for easier 
management. When this folder track is selected, the Inspector shows 
the folder and the FX channels it contains. You can click one of the FX 
channels shown in the folder to have the Inspector show the settings for 
that FX channel – this way you don’t have to “open” a folder track to ac-
cess the settings for the FX channels in it.
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Group channel tracks

When a Group channel track is selected, the following controls and 
sections are available:

• Edit button.
• Volume control.
• Pan control.
• Output routing pop-up menu.
• Inserts section.
• Equalizers section.
• Sends section.
• Channel section.

Group channel folder tracks

Just like FX channel tracks, all Group channel tracks are placed in a 
separate folder – when this is selected, the Inspector shows the folder 
and the Group channels it contains. You can click one of the Group 
channels shown in the folder to have the Inspector show the settings 
for that Group channel – this way, you don’t have to “open” a folder 
track to access the settings for the Group channels in it.
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The toolbar

The toolbar contains tools and shortcuts for opening other windows 
and various project settings and functions:

• In addition, the toolbar can contain a number of other tools and short-
cuts, not visible by default. How to set up the toolbar and specify which 
tools should be displayed or hidden is described on page 561.

Active project 
indicator

Show/hide 
Inspector

Show/hide info line

Open Pool

Open Mixer
Constrain delay compen-
sation (see page 217)

Project window tools

Transport controls 
(Previous/Next Marker, Cycle, Stop, Play, and Record)

Snap on/off

Snap mode

Grid pop-up menu

Quantize value

Color pop-up menu

Autoscroll on/off
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The info line

The info line shows information about the currently selected event or 
part in the Project window. You can edit almost all values in the info 
line using regular value editing. Length and position values are dis-
played in the format currently selected for the ruler (see page 79).

• To hide or show the info line, click this icon on the toolbar:

The following elements can be selected for display and editing on the 
info line:

• Audio events.
• Audio parts.
• MIDI parts.
• Video events.
• Markers.
• Automation curve points.

When several elements are selected

• If you have several elements selected, the info line will show information about 
the first item in the selection. The values will be shown in yellow to indicate 
that several elements are selected.

• If you edit a value on the info line, the value change is applied to all selected 
elements, relatively to the current values. 

An example: You have two audio events selected. The first is one bar 
long and the other two bars long. The info line shows the length of the 
first event (one bar). If you now edit this value to 3 bars in the info line, 
the other event will be resized by the same amount – and will thus be 
4 bars long.

• If you press [Ctrl]/[Command] and edit on the info line, the values will be abso-
lute instead. In our example above, both events would be resized to 3 bars. Note 
that [Ctrl]/[Command] is the default modifier key for this – you can change this 
in the Preferences dialog (Editing-Tool Modifiers page, under the Info Line cat-
egory).
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Editing Transpose and Velocity for MIDI parts

When one or several MIDI parts are selected, the info line contains 
Transpose and Velocity fields.

• Adjusting the Transpose field transposes the selected parts in semitone 
steps.
Note that this transposition doesn’t change the actual notes in the part – it’s just a 
“play parameter”, affecting the notes on playback. The transposition you specify for a 
part on the info line is added to the transposition set for the whole track with the Trans-
pose track parameter in the Inspector.

• Adjusting the Velocity field shifts the velocity for the selected parts – 
the value you specify is added to the velocities of the notes in the parts.
Again, this velocity shift only affects the notes on playback, and again, the value you 
specify is added to the Vel.Shift. value set for the whole MIDI track in the Inspector.

Getting on-the-fly info with the Arrow tool

If the option “Select Tool: Show Extra Info” is activated in the Prefer-
ences (Editing page), a tool tip will be shown for the Arrow tool, display-
ing various info depending on where you point it. For example, in the 
Project window’s event display, the tool will show the current pointer 
position and the name of the track and event you’re pointing at.

The ruler

The ruler at the top of the event display shows the timeline. Initially, the 
Project window ruler uses the display format specified in the Project 
Setup dialog (see page 81), as do all other rulers and position dis-
plays in the project. However, you can select an independent display 
format for the ruler by clicking the arrow button to the right of it and 
selecting an option from the pop-up menu that appears (you can also 
bring up this pop-up menu by right-clicking (Win) or [Ctrl]-clicking 
(Mac) anywhere in the ruler).

Option Positions and lengths displayed as

Bars+Beats Bars, beats, sixteenth notes and ticks. By default there are 120 
ticks per sixteenth note.
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• The selection you make here affects the ruler, the info line and tool tip 
position values (appear when you drag an event in the Project window).
You can also select independent formats for other rulers and position displays. 

• To set the display format globally (for all windows), use the primary 
display format pop-up on the Transport panel, or hold down [Ctrl]/
[Command] and select a display format in any ruler.

• If you use the “Timecode” option and the option “Show Timecode 
Subframes” is activated in the Preferences dialog (Transport page), 
the frames will also display subframes.
There are 80 subframes per frame.

Seconds Hours, minutes, seconds and milliseconds.

Timecode This format displays hours, minutes, seconds and frames. The 
number of frames per second (fps) is set in the Project Setup di-
alog (see page 81). You can choose from 24, 25, 29.97 and 30 
fps or 29.97 and 30 dfps (“drop frame”).

Samples Samples.

Time Linear When this is selected, the ruler will be linear relative to time. This 
means that if there are tempo changes on the Tempo track, the 
distance between the bars will vary in Bars+Beats mode.

Bars+Beats Linear When this is selected, the ruler will be linear relative to meter po-
sition – bars and beats. This means that if there are tempo 
changes on the Tempo track, there will still be the same distance 
between bars in Bars+Beats mode. If the ruler is set to a time-
based mode, the distance between seconds will vary depending 
on the tempo changes.

Option Positions and lengths displayed as
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Operations

Creating a new project

You create a new project in the following way:

1. Select “New Project” from the File menu.
A dialog appears, listing a number of project templates, including any custom templates 
you may have created (see page 541). 

2. Select a template and click OK.
A file dialog appears, allowing you to specify a location for the project folder. This will 
contain all files related to the project. 

3. Select an existing folder or type the name of a new one. Click OK.
A Project window appears. The new project will be based on the selected template, 
and include tracks, events and settings from the template.

The Project Setup dialog

General settings for the project are made in the Project Setup dialog. 
This is opened by selecting “Project Setup...” from the Project menu.
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The following settings are available in the Project Setup dialog:

While most Project Setup settings can be changed at any time, you should 
select a sample rate once and for all when starting with a new project! All 
audio files must be of this sample rate to play back correctly.

Setting Description

Start The start time of the project. Allows you to have the project start at 
another time than zero. When you change this setting you will be 
asked whether you want to keep the project content at its timecode 
positions. “Yes” means that all events will stay at their original time-
code positions - i.e they will be moved in relation to the start of the 
project. “No” means that all events keep their position relative to the 
project start.

Length The length of the project.

Frame Rate Used when synchronizing Cubase SE with external equipment. If 
Cubase SE is the master, this determines the frame rate of the sent 
sync signal. See page 502.

Display Format This is the global display format used for all rulers and position dis-
plays in the program. However, you can make independent display 
format selections for the individual rulers and displays if you like.
For descriptions of the different display format options, see page 79.

Display Offset Offsets the time positions displayed in the ruler etc., allowing you to 
compensate for the Start position setting. Typically, if you synchro-
nize Cubase SE to an external source starting at a frame other than 
zero, you set the Start position to this value. However, if you still 
want the display in Cubase SE to start at zero, set the Display Offset 
to the same value too.

Sample Rate The sample rate at which Cubase SE records and plays audio.

Record Format / 
File Type

When you record audio in Cubase SE, the files that are created will 
be of this resolution and file type. See page 40.

Stereo Pan Law Decides whether panning should use power compensation or not. 
This is explained on page 167.
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Zoom and view options

Zooming in the Project window is done according to the standard 
zoom procedures (see the Getting Started book), with the following 
special notes:

• When you are using the Zoom tool (magnifying glass), the result de-
pends on the option “Zoom Tool Standard Mode: Horizontal Zooming 
Only” in the Preferences – Editing dialog.
If this is activated and you drag a selection rectangle with the Zoom tool, the window 
will only be zoomed horizontally (track height will not change). If the option is off, the 
window will be zoomed both horizontally and vertically.

• When using the vertical zoom sliders, the tracks are scaled relatively. 
In other words, if you have made any individual track height adjustments (see below), 
the relative height differences are maintained.

You find the following options are available on the Zoom submenu on 
the Edit menu:

Option Description

Zoom In Zooms in one step, centering on the project cursor.

Zoom Out Zooms out one step, centering on the project cursor.

Zoom Full Zooms out so that the whole project is visible. “The whole project” 
means the timeline from the project start to the length set in the 
Project Setup dialog (see above).

Zoom to Selection Zooms in horizontally and vertically so that the current selection 
fills the screen.

Zoom to Selection 
(Horiz)

Zooms in horizontally so that the current selection fills the screen.

Zoom to Event This option is available only in the Sample Editor (see page 282).

Zoom In Vertical Zooms in one step vertically.

Zoom Out Vertical Zooms out one step vertically.

Zoom In Tracks Zooms in selected track(s) one step vertically.

Zoom Out Tracks Zooms out selected track(s) one step vertically.

Zoom Selected 
Tracks 

This zooms in vertically on the selected track(s) and minimizes the 
height of all other tracks.
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• If the option “Zoom while Locating in Time Scale” is activated in the 
Preferences (Transport page), you can also zoom by clicking in the 
main ruler and dragging up or down with the mouse button pressed.
Drag up to zoom out; drag down to zoom in.

• You can zoom the contents of parts and events vertically, using the 
Waveform Zoom slider in the top right corner of the event display.
This can be useful to better view quiet audio passages.

To get an approximate reading on the level of the audio events by view-
ing the waveforms, make sure the slider is all the way down. Otherwise, 
zoomed waveforms may be mistaken for clipped audio.

• If you activate the option Quick Zoom in the Preferences (Editing page), 
the contents of parts and events will not be continuously redrawn when 
you zoom manually.
Instead, the contents are redrawn once you have stopped changing the zoom – activate 
this if screen redraws are slow on your system.
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Resizing tracks in the Track list

• You can change the height of an individual track by clicking on its lower border 
in the Track list and dragging up or down.
To change the height of all tracks simultaneously, hold down [Ctrl]/[Command] and re-
size one of the tracks in this way. If “Snap Track Heights” is activated on the Track 
scale pop-up (see below), the track height will change in fixed increments when you 
resize it.

• You can also change the width of the Track list area, by dragging the 
border between the Track list and the event display.

• The controls shown for tracks in the Track list will by default adapt to 
the track size. This means that when resizing a track’s height or width 
some of the controls will be dynamically placed where they best “fit in”.

• You can use the Track scale pop-up (opened by clicking the arrow button 
above the vertical zoom control) to set the number of tracks to view in the cur-
rent Project window.
The track height will be adjusted to show only the number of tracks specified on the 
pop-up menu. By selecting “Zoom N Tracks” from the pop-up you can manually set the 
number of tracks to fit in the current Project window.
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Zoom presets and Cycle markers

The pop-up menu to the left of the horizontal zoom control allows you 
to select, create and organize zoom presets. These are useful if you 
want to toggle between different zoom settings (e.g. one where the 
whole project is displayed in the project window and another with a 
high zoom factor for detailed editing). With this pop-up menu, you can 
also zoom in on the area between cycle markers in the project.

The upper part of the menu lists the zoom presets:

• To store the current zoom setting as a preset, select Add from the 
pop-up menu.
A dialog appears, allowing you to type in a name for the preset.

• To select and apply a preset, select it from the pop-up menu.

• The “Zoom Full” preset is always available. Selecting this option Zooms 
out so that the whole project is visible. “The whole project” means the 
timeline from the project start to the length set in the Project Setup dia-
log (see page 81).

• If you want to delete a preset, select “Organize…” from the pop-up 
menu.
In the dialog that appears, select the preset in the list and click the Delete button. The 
preset is removed from the list.
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• If you want to rename a preset, select “Organize…” from the pop-up 
menu.
In the dialog that appears, select the desired preset in the list and click the Rename 
button. A second dialog opens, allowing you to type in a new name for the preset. 
Click OK to close the dialogs.

Zoom presets are global for all projects, i.e. they are available in all 
projects you open or create.

The middle part of the pop-up lists any cycle markers you have added 
in the project:

• If you select a cycle marker from this menu, the event display is zoomed 
in to encompass the marker area (see page 134).

• You cannot edit the cycle markers in this pop-up menu. For information 
on editing markers, see page 128.

Only the cycle markers you create in the current project are available on 
the menu.

Adjusting how parts and events are shown

The Preferences dialog on the File menu (the Cubase SE menu, under 
Mac OS X) contains several settings for customizing the display in the 
Project window.

The Event Display page contains common settings for all track types:

Option Description

Colorize Event 
Background

Determines whether the backgrounds or “contents” (waveforms, 
etc.) of parts and events will be colorized. See page 90.

Show Event Names Determines whether the names of parts and events should be 
shown in the Project window.

Transparent Events When this is activated, events and parts will be transparent, 
showing the waveforms and MIDI events only.

Show Data on Small 
Track Heights

If this is activated, the contents of events and parts will be 
shown, even if the height of a track is very small.
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The Event Display–Audio page contains settings for audio events:

Option Description

Interpolate Audio 
Images

If the option is deactivated, single sample values are drawn as 
“steps”. If the option is activated they are interpolated to form 
“curves”.

Wave Image Style Determines whether audio waveforms should be displayed as 
solid images, frames or “inverted” images (solid+frame). This se-
lection affects all waveform images in the Project window, Sam-
ple Editor and Audio Part Editor.
Note that the “Framed” and “Solid and Framed” styles are more 
demanding for the computer. If the system feels slower in these 
modes, please switch back to “Solid” wave image style.

Show Event Volume 
Curves Always

If this is activated the “volume curves” created with the volume 
and fade handles are always shown – if not, the curves are only 
shown for selected events.

Show Waveforms Determines whether audio waveforms should be shown at all.

Background Color 
Modulation

When this is activated, the backgrounds of audio waveforms are 
displayed in a different way, reflecting the waveform dynamics. 
This is especially useful to get an overview when working with 
small track heights.
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The Event Display–MIDI page contains settings for MIDI parts:

The Event Display–Markers page contains settings for marker events:

The Event Display–Video page contains settings for video events:

Option Description

Default Edit Action Determines which editor should be opened when you double 
click a MIDI part or select it and press [Ctrl]/[Command]-[E]: the 
Key, Drum, List or Score editor. Note that this setting is overrid-
den for tracks with drum maps if the option “Edit as Drums when 
Drummap is assigned” (see below) is activated.

Part Data Mode Determines if and how events in MIDI parts should be shown in 
the Project window: as lines, as score notes or as drum notes. If 
“No Data” is selected, events will not be shown at all. Note that 
this setting is overridden for tracks with drum maps if the option 
“Edit as Drums when Drum Map is assigned” (see below) is ac-
tivated.

Show Controllers Governs whether non-note events (controllers, etc.) should be 
shown in MIDI parts in the Project window.

Edit as Drums 
when Drum Map is 
assigned

If this is activated, parts on MIDI tracks with drum maps assigned 
will be shown with drum note symbols in the Project window. 
Also, the parts will automatically open in the Drum editor when 
double clicked (overriding the Default Edit Action setting above).

Note Name Style Determines how MIDI note names (pitches) should be displayed 
in editors, etc.

Option Description

Show Marker Names When this is activated, the names of the Markers are shown.

Option Description

Show Video 
Thumbnails

When this is activated, thumbnail frames of the video contents 
are shown on the Video track.

Video Cache Size This determines how much memory is available for video thumb-
nails. If you have long video clips and/or work with a large zoom 
factor (so that a lot of frames are shown in the thumbnails), you 
may have to raise this value.
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Handling tracks

To add a track to the project, select “Add Track” from the Project 
menu and select a track type from the submenu that appears. The 
new track is added below the currently selected track in the Track list.

• The items on the “Add Track” submenu are also available on the 
Quick menu.
This is accessed by right-clicking (Win)/[Ctrl]-clicking (Mac) in the Track list.

• There is an additional option at the bottom of the Add Track submenu, 
called “Multiple...”. Selecting this brings up a dialog allowing you to 
add more than one track in one operation.
The number of tracks to add is entered in the “Count” value field. You can set whether 
audio, MIDI or group tracks should be created by selecting from the Track pop-up in 
the dialog. For audio and group tracks, the channel configuration – mono or stereo – 
can be set in the Configuration pop-up.

Once you have created tracks, you can manipulate and rearrange 
them in various ways:

• To rename a track, double click in the name field and type in a new 
name.
If you hold down any modifier key when pressing [Return] to close the name field, all 
events on the track will get the name you entered.
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• To select a track, click on it in the Track list.
A selected track is indicated by a light grey color in the Track list. 

It is possible to select several tracks, by pressing [Ctrl]/[Command] and clicking them. 
To select a continuous range of tracks, use [Shift]-clicking.

• To move a track, click and drag it up or down in the list.

• To duplicate a track, complete with all contents and channel settings, 
right-click (Win)/[Ctrl]-click (Mac) in the Track list and select “Duplicate 
track” from the context menu.
The duplicated track will appear above the original track.

• You can select a default color for a track by activating “Show Track 
Colors” above the track list and selecting a color at the top of the In-
spector. This color will be used for all events on the track and will also 
be shown in the Mixer. If you like, you can override the default track 
color for individual events and parts by using the Color tool or the 
Color Selector pop-up menu. This is described in detail in the Getting 
Started manual. 
The option “Colorize Event Background” in the Preferences dialog (Event Display 
page) determines whether the backgrounds or waveforms of events will be colorized.

• To remove a track, right-click (Win)/[Ctrl]-click (Mac) on it in the Track 
list and select “Remove Track” from the context menu that appears.
You can also remove multiple selected tracks, by selecting “Remove Selected Tracks” 
either from the Project menu or from the context menu. Furthermore, you can remove all 
tracks not containing any events by selecting “Remove Empty Tracks” from the Project 
menu.

This track is selected.
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Disabling tracks

Tracks can be disabled by selecting “Disable Track” from the Track 
list context menu. Disabling a track in a way is the same as Muting it 
(see page 107), since a disabled track will not be played back. How-
ever, disabling a track not only “zeroes” the output volume from the 
track, but actually shuts down all disk activity for it. See page 29 for 
more information.

Adding events to a track

There are a number of ways to add events to a track:

• By recording (see page 35).
This is possible for audio and MIDI tracks.

• By selecting “Audio File...” or “Video File...” from the Import submenu on the 
File menu.
This opens a file dialog, allowing you to locate the file you wish to import. When you 
import a file this way, a clip is created for the file and an event that plays the whole clip 
is added to the selected track, at the position of the project cursor.
You can also import MIDI files by using the Import submenu, but this works in a slightly 
different way (see page 544).

• By grabbing audio CD tracks and converting them to audio files (see page 550).
• By using Copy and Paste on the Edit menu.

This allows you to copy all kinds of events between projects. You can also copy events 
within the project, from the Audio Part Editor or Sample Editor.

• By drawing.
Some types of events (markers and automation events) can be drawn directly into the 
Project window. For audio and MIDI tracks, you can draw parts (see page 94).

• By dragging files and dropping them on the track at the desired position.
You can create events by dragging and dropping from the following locations:

• The Desktop.
• The Pool.
• A Library (A Pool file that is not attached to a project).
• The Project window of another open project.
• The Audio Part Editor of any open project.
• The Sample Editor of any open project – press [Ctrl]/[Command] and drag to 

create an event of the current selection.
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• The “Find media” dialog.

While you drag the clip in the Project window, its position will be indicated by a 
marker line and a numerical position box. See also page 334.

Audio file import options

When you are importing audio files you can specify how the files 
should be treated by Cubase SE: 

• You can choose to copy the file into the project’s audio folder and have the 
project make reference to the copied file rather than the original file. This 
helps you keep your project “self-contained”.

• Furthermore, you may want all files in the project to have the same sample rate 
and sample size (resolution).

The Preferences dialog (Editing – Audio page) contains a setting that 
lets you decide which options, if any, to use. Select the desired option 
on the “On Import Audio Files” pop-up:

• Open Options Dialog.
An Options dialog appears when you import, allowing you to select whether you want 
to copy the files to the Audio folder and/or convert them to the project settings. Note:

- When importing a single file of a format other than the project settings, you can spec-
ify which properties (sample rate and/or resolution) should be changed.

- When importing multiple files at the same time, you can select to have the imported 
files automatically converted if necessary, i.e. if the sample rate is different than the 
project’s or the resolution is lower than the project setting.
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• Use Settings.
No Options dialog will appear when you import. Instead, you can choose to make any 
of the options below the pop-up the standard action(s). Activate any number of the fol-
lowing options to have them performed automatically each time you import audio files:

Creating parts

Parts are containers for MIDI or audio events. If you record MIDI, a 
MIDI part is automatically created, containing the recorded events. 
You can also create empty audio or MIDI parts and later add events to 
them. There are two ways to do this:

• Draw a part on a MIDI or audio track with the Pencil tool.
You can also draw parts by pressing [Alt]/[Option] and using the Arrow tool.

• Double click with the Arrow tool on a MIDI or audio track, between the 
left and right locator.

To add events to a MIDI part, you use the tools and functions in a MIDI 
editor (see page 398). Adding events to audio parts is done in the Au-
dio Part Editor (see page 295) by pasting or by using drag and drop.

• You can also gather existing audio events into a part, by using the 
“Events to Part” function on the Audio menu.
This creates an audio part containing all selected audio events on the same track. To 
remove the part and make the events appear as independent objects on the track 
again, select the part and use the “Dissolve Part” function on the Audio menu.

Option Description

Copy Files to Working 
Directory

If files are not already in the project’s audio folder they are 
copied there before being imported.

Convert and Copy to 
Project If Needed

If files are not already in the project’s audio folder they are 
copied there before being imported. Furthermore, if the 
files have a different sample rate or a lower resolution than 
the project settings, they are automatically converted.
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Auditioning audio parts and events

Audio parts and events can be auditioned in the Project window with 
the Speaker tool:

1. Select the Play tool.
Note that the Play tool and the Scrub tool share the same tool button. If the rightmost 
tool icon on the toolbar isn’t a Speaker symbol, first click on the icon to select it, then 
click again and select “Play” from the pop-up menu that appears.

2. Click where you want playback to start, and keep the mouse button 
pressed.
Only the track on which you click is played back, starting at the click position. 

3. Release the mouse button to stop playback.

Scrubbing

The Scrub tool allows you to locate positions in the audio by playing 
back, forwards or backwards, at any speed:

1. Select the Scrub tool.
Note that the Play tool and the Scrub tool share the same tool button. If the rightmost 
tool icon on the toolbar isn’t a “Scrub symbol”, first click on the icon to select it, then 
click again and select “Scrub” from the pop-up menu that appears.

2. Click at the desired position and keep the mouse button pressed.
The project cursor is moved to the position at which you click.

3. Drag to the left or right.
The project cursor follows the mouse pointer and the audio is played back. The speed 
and pitch of the playback depends on how fast you move the pointer.

You can adjust the responsiveness of the Scrub function in the Pref-
erences dialog (VST page).
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Editing parts and events

This section describes techniques for editing in the Project window. If 
not explicitly stated, all descriptions apply to both events and parts, 
even though we use the term “event” for convenience.

• When you are using the tools for editing, you can in many cases get ad-
ditional functions by pressing modifier keys (e.g. pressing [Alt]/[Option] 
and dragging with the Arrow tool creates a copy of the dragged event). 
On the following pages, the default modifier keys are described – you can customize 
these in the Preferences dialog on the Editing –Tool Modifiers page (see page 579).

Selecting events

Selecting events is done using any of the following methods:

• Use the Arrow tool.
The standard selection techniques apply.

• Use the Select submenu on the Edit menu.
The options are:

Note that these functions work differently when the Range Selection 
tool is selected (see page 109).

Option Description

All Selects all events in the Project window.

None Deselects all events.

In Loop Selects all events that are partly or wholly between the left 
and right locator.

From Start to Cursor Selects all events that begin to the left of the project cursor.

From Cursor to End Selects all events that end to the right of the project cursor.

All on Selected Tracks Selects all events on the selected track.

Select Event This is available in the Sample Editor (see page 277).

Left/Right Selection 
Side to Cursor

These two functions are only used for range selection editing 
(see page 109).
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• Select all events on a track by right-clicking in its Track list and select-
ing “Select All Events” from the pop-up menu that appears.

• You can also use the arrow keys on the computer keyboard, to select 
the closest event to the left, right, above or below.
If you press [Shift] and use the arrow keys, the current selection will be kept, allowing 
you to select several events.

• If the option “Auto Select Events under Cursor” is activated in the 
Preferences dialog (Editing page), all events on the selected track(s) 
that are “touched” by the project cursor are automatically selected.
This can be helpful when rearranging your project, since it allows you to select whole 
sections (on all tracks) by selecting all tracks and moving the project cursor.

• It is also possible to select ranges, regardless of the event and track 
boundaries.
This is done using the Range Selection tool (see page 109).

Moving events

To move events in the Project window, use the following methods:

• Click and drag to a new position.
All selected events will be moved, maintaining their relative positions. You can only 
drag events to tracks of the same type. If Snap is activated, this determines to which 
positions you can move the events (see page 113).
Note also, that you can restrict movement to be either horizontal or vertical only, by 
holding down [Ctrl]/[Command] while dragging.

You will note that there is a slightly delayed response when you move 
an event by dragging. This helps you avoid accidentally moving events 
when you click on them in the Project window. You can adjust this delay 
with the Drag Delay setting in the Preferences dialog (Editing page).

• Select the event and edit the Start position in the info line.
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• Use the “Move to” functions on the Edit menu.
The following functions are available:

• Use the Nudge buttons in the toolbar.
These move the selected events to the left or right. The amount of movement depends on 
the selected display format (see page 81) and the value set on the Grid pop-up menu.

Here, clicking this button will move the Event 2 frames to the right.

When the Range Selection tool is used, the Nudge buttons move the 
selection range (see page 111).

• The Nudge buttons are not visible in the toolbar by default. 
You can decide which items should be visible by right-clicking (Windows) or [Ctrl]-click-
ing (Mac OS X) in the toolbar and checking them in the pop-up menu that appears. See 
page 561 for more information.

Function Description

Move to Cursor Moves the selected event to the project cursor position. If there are 
several selected events on the same track, the first event will start at 
the cursor, and the following will be lined up end-to-start after the 
first one.

Move to Origin Moves the selected events to their original positions, i.e. the posi-
tions at which they were originally recorded.

Move to Front,
Move to Back

This function doesn’t actually change the position of the events, but 
moves the selected events to the front or back, respectively. This is 
useful if you have overlapping events, and want to see one that is 
partially obscured.
For audio events, this is an extra important feature, since only the 
visible sections of events will be played back. Moving an obscured 
audio event to front (or moving the obscuring event to back) will al-
low you to hear the whole event on playback.
Note that it is also possible to use the “To Front” function on the 
event context menu for this (although this works in a different way, 
see page 48).
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Duplicating events

Events can be duplicated in the following ways:

• Hold down [Alt]/[Option] and drag the event to a new position.
If Snap is activated, this determines to which positions you can copy the events (see 
page 113). 

If you hold down [Ctrl]/[Command] as well, movement direction is re-
stricted to either horizontal or vertical. That means if you drag an event 
vertically it can not be moved horizontally at the same time.

• Audio and MIDI parts can also be duplicated by pressing [Alt]/[Option] 
+ [Shift] and dragging.
This creates a shared copy of the part. If you edit the contents of a shared copy, all 
other shared copies of the same part are automatically edited in the same way.

Shared copies are indicated by showing the name in italic text and an icon in the 
right corner of the part.

Note:

• When you duplicate audio events, the copies are always shared. This means 
that shared copies of audio events always refer to the same audio clip (see 
page 257).

• You can convert a shared copy to a real copy by selecting “Convert to Real 
Copy” from the Edit menu. This creates a new version of the clip (that can be 
edited independently) and adds this to the Pool. Note that no new files are 
created by this operation – for that you need to use the “Bounce Selection” 
function from the Audio menu.

• Selecting “Duplicate” from the Edit menu creates a copy of the se-
lected event and places it directly after the original.
If several events are selected, all of these are copied “as one unit”, maintaining the 
relative distance between the events.
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• Selecting “Repeat...” from the Edit menu opens a dialog, allowing you to 
create a number of copies (regular or shared) of the selected event(s).
This works just like the Duplicate function, but you can specify the number of copies.

• You can also perform the Repeat function by dragging: Select the 
event(s) to repeat, press [Alt]/[Option], click the handle in the lower 
right corner of the last selected event and drag to the right.
The longer to the right you drag, the more copies are created (as shown by the tooltip).

• Selecting “Fill Loop” from the Edit menu creates a number of copies 
starting at the left locator and ending at the right locator.
The last copy is automatically shortened to end at the right locator position.

Using Cut, Copy and Paste

You can cut or copy selected events, and paste them in again, using 
the functions on the Edit menu.

• When you paste an event it is inserted on the selected track, positioned 
so that its snap point is aligned with the cursor position.
If the selected track is of the wrong type, the event will be inserted on its original track. 
See page 113 for information about the snap point.

• If you use the “Paste at Origin” function, the event is pasted at its orig-
inal position (the position from which you cut or copied it).
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Renaming events

By default, audio events show the name of their clip, but you can enter 
a separate descriptive name for separate events if you like. This is done 
by selecting the event and typing in a new name in the “Description” 
field in the info line.

• You can also give all events on a track the same name as the track by 
changing the track name, holding down a modifier key and pressing 
[Return].
See page 90.

Splitting events

You can split events in the Project window in the following ways:

• Click with the Scissors tool on the event you want to split.
If Snap is activated, this determines the exact split position (see page 113). You can 
also split events by pressing [Alt]/[Option] and clicking with the Arrow tool.

• Select “Split at Cursor” from the Edit menu.
This splits the selected events at the position of the project cursor. If no events are se-
lected, all events (on all tracks) that are intersected by the project cursor will be split.

• Select “Split Loop” from the Edit menu.
This splits events on all tracks at the left and right locator positions.

• If you split a MIDI part so that the split position intersects one or several 
MIDI notes, the result depends on the option “Split MIDI Events” in the 
Preferences dialog (Editing page). 
If the option is activated, the intersected notes will be split (creating new notes at the 
beginning of the second part). If it is deactivated, the notes will remain in the first part, 
but “stick out” after the end of the part.

Gluing events together

Clicking on an event with the Glue Tube tool glues it together with the 
next event on the track. The result is a part containing the two events, 
with one exception:

• If you first split an event and then glue the two sections together again 
(without moving or editing them first), they become a single event again.
In other words, gluing can create a single event if the two events are lined up end to 
start and play a continuous section of the same clip.
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Resizing events

Resizing events means to move their start or end positions individually. 
In Cubase SE, there are three types of resizing:

To select one of the resizing modes, select the Arrow tool and then 
click again on the Arrow tool icon on the toolbar. This opens a pop-up 
menu from which you can select one of the resizing mode options.

The icon on the toolbar will change, indicating the selected resizing mode.

Resizing type Description

Normal Sizing The contents of the event stay fixed, and the start or 
end point of the event is moved to “reveal” more or 
less of the contents.

Sizing Moves Contents The contents follow the moved start or end of the 
event (see the figure below).

Sizing Applies Time Stretch The contents will be time stretched to fit the new event 
length (see separate description on page 104).
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The actual resizing is done by clicking and dragging the lower left or 
right corner of the event. If Snap is activated, the Snap value determines 
the resulting length (see page 113).

Normal sizing.

Sizing moves contents.

• If several events are selected, all will be resized in the same way.

• You can also resize events with the Scrub tool.
This works just the same as when resizing with the Arrow tool, but the audio under the 
pointer is played back (scrubbed) while you drag.
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• It is also possible to resize events by using the Trim buttons (located 
in the Nudge palette) on the toolbar.
This will move the start or end position of the selected Event(s) by the amount set on 
the Grid pop-up menu. The sizing type currently selected applies to this method too, 
with the exception of “Sizing Applies Time Stretch” which is not possible with this 
method. You can also use key commands for this (by default, press [Ctrl]/[Command] 
and use the left and right arrow key).

• Note that the Nudge palette is not visible in the toolbar by default. See 
page 561 for instructions on how to show and hide items in the toolbar.

Resizing events using time stretch

If you want to resize a part and make its contents “fit” the new size, 
you should use this option. Proceed as follows:

1. Click the Arrow icon on the toolbar and select the “Sizing Applies 
Time Stretch” option from the pop-up menu.

2. Point close to the end point of the part you want to stretch.
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3. Click and drag left or right.
When you move the mouse, a tooltip information shows the current mouse position 
and length of the part. Note that the snap value applies, as with any part operation.

4. Release the mouse button.
The part is “stretched” or “compressed” to fit the new length.

• For MIDI parts, this means that the note events are stretched (moved 
and resized).
Controller data will be moved.

• For audio parts, this means that the events are moved, and that the 
referenced audio files are time stretched to fit the new length.
A dialog box shows the progress of the time stretch operation.

• You can adjust which algorithm should be used for the time stretch algo-
rithm on the Preferences page (Editing–Audio page).
For more information about time stretch, see page 272.

Sliding the contents of an event or part

You can move the contents of an event or part without changing its 
position in the Project window. By default, this is done by pressing 
[Ctrl]/[Command]+[Alt]/[Option], clicking in the event or part and 
dragging to the left or right.

When sliding the contents of an audio event, you cannot slide past the 
start or end of the actual audio clip. If the event plays the whole clip, you 
cannot slide the audio at all.
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Locking events

If you want to make sure you don’t edit or move an event by accident, 
you can lock it. Locking can affect one (or any combination) of the fol-
lowing properties:

• To specify which of these properties should be affected by the Lock 
function, use the “Lock Event Attributes” pop-up menu in the Prefer-
ences dialog (Editing page).

• To lock events, select them and select “Lock...” from the Edit menu.
The events will be locked according to the options specified in the Preferences dialog.

• You can adjust the lock options for a locked event by selecting it and 
selecting “Lock...” from the Edit menu again.
This opens a dialog in which you can activate or deactivate the desired lock options.

• To unlock an event (turn off all lock options), select it and select 
“Unlock” from the Edit menu.

• It is also possible to lock a whole track, by clicking the padlock symbol 
in the Track list or in the Inspector.
This disables all editing of all events on the track.

Lock Options Description

Position If this is locked, the event cannot be moved.

Size If this is locked, the event cannot be resized.

Other If this is locked, all other editing of the event is disabled. This includes 
adjusting the fades and event volume, processing, etc.

The padlock symbol indicates that 
one or more of the lock options are 
activated for the event.
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Muting events

You can Mute individual events in the Project window in the following 
ways:

• To mute or unmute a single event, click on it with the Mute tool.

• To mute or unmute several events, select them – either by using the 
standard selection techniques, or by using one of the options on the 
Edit–Select submenu – and click on one of the selected events with 
the Mute tool.
All selected events will be muted.

• You can also click in an empty area with the Mute tool and drag a se-
lection rectangle around several events you want to mute or unmute, 
and then click on one of them with the Mute tool.

• You can mute events by selecting them and selecting “Mute” from the 
Edit menu.
Similarly, you can unmute the selected events by selecting “Unmute” from the Edit menu.

• You can also change the mute status of selected events on the info line.

Muted events can be edited as usual (with the exception of adjusting 
fades), but are not played back.

Muted events are “greyed out”.

• You can also mute whole tracks by clicking the Mute (“M”) button in 
the Track list, the Inspector or the mixer.
Clicking the Solo (“S”) button for a track mutes all other tracks. Note that there are two 
modes for the track solo function: 
If the option “Enable Solo on Selected Track” is activated in the Preferences (Editing 
page) and you have soloed a track, selecting another track in the track list will automat-
ically solo that track instead – the solo state “moves” with the track selection.
If the option isn’t activated, the track you solo stays soloed, regardless of the selection.
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Removing events

To remove an event from the Project window, use any of the following 
methods:

• Click on the event with the Eraser tool.
Note that if you press [Alt]/[Option] while you click, all following events on the same 
track will be deleted, but not the event you clicked and all events before it.

• Select the event(s) and press [Backspace], or select “Delete” from 
the Edit menu.

Creating new files from events

As described in the Getting Started book, an audio event plays a sec-
tion of an audio clip, which in turn refers to one or more audio files on 
the hard disk. However, in some situations you may want to create a 
new file that consists only of the section played by the event. This is 
done with the function “Bounce Selection” on the Audio menu:

1. Select one or several audio events.

2. Set up fade in, fade out and event volume (on the info line or using the 
volume handle) as desired.
These settings will be applied to the new file. For details on fades and event volume, 
see page 138.

3. Select “Bounce Selection” from the Audio menu.
You are asked whether you want to replace the selected event or not.

• If you click “Replace”, a new file is created, containing only the audio 
in the original event. A clip for the new file is added to the Pool, and 
the original event is replaced by a new event playing the new clip.

• If you click “No” a new file is created and a clip for the new file is 
added to the Pool.
The original event is not replaced.

You can also apply the Bounce Selection function to an audio part. In 
that case, the audio from all events in the part will be combined into a 
single audio file. If you choose “Replace” when asked, the part will be 
replaced with a single audio event playing a clip of the new file.
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Range editing

Editing in the Project window isn’t necessarily restricted to handling 
whole events and parts. You can also work with selection ranges, 
which are independent from the event/part and track boundaries.

Creating a selection range

To make a selection range, drag with the Range Selection tool.

When the Range Selection tool is selected, the Select submenu on 
the Edit menu has the following items for making selection ranges:

Option Description

All Makes a selection that covers all tracks, from the start of the 
project to the end (as defined by the Length setting in the 
Project Setup dialog).

None Removes the current selection range.

Invert Only used for event selection (see page 96).

In Loop Makes a selection between the left and right locator, on all tracks.

From Start to Cursor Makes a selection on all tracks, from the start of the project to 
the project cursor.

From Cursor to End Makes a selection on all tracks, from the project cursor to the 
end of the project.

All on Selected Tracks Only used for event selection (see page 96).

Select Event This is available in the Sample Editor (see page 286).

Left Selection Side 
to Cursor

Moves the left side of the current selection range to the project 
cursor position.

Right Selection Side 
to Cursor

Moves the right side of the current selection range to the project 
cursor position.



CUBASE SE
5 – 110 The Project window

• Double clicking on an event with the Range Selection tool creates a 
selection range encompassing the event.
If you hold down [Shift] you can double click several events in a row, and the selection 
range will expand to encompass them all. Double clicking a second time on an event 
opens it for editing in the Sample Editor.

Adjusting the size of the selection range

You can adjust the size of a selection range in the following ways:

• By dragging its edges.
The pointer takes the shape of a double arrow when you move it over an edge of the 
selection range.

• By holding down [Shift] and clicking.
The closest selection range edge will be moved to the position at which you clicked.

• By adjusting the selection range start or end position on the info line.
• By using the Trim buttons on the toolbar.

The left Trim buttons will move the start of the selection range and the right buttons will 
move the end. The edges will be moved by the amount specified on the Grid pop-up.

This Trim button will move the end of the selection range to the right by 1 beat.

• By using the Nudge buttons on the toolbar.
These will move the whole selection range to the left or the right. The amount of move-
ment depends on the selected display format (see page 81) and the value specified on 
the Grid pop-up menu.

Note that the contents of the selection are not moved – using the Nudge 
buttons is the same as adjusting the start and end of the selection range 
at the same time, by the same amount.



CUBASE SE
The Project window 5 – 111

• The Trim buttons and the Nudge buttons are located in the Nudge palette, 
which is not visible in the toolbar by default. 
See page 561 for instructions on how to show and hide items in the toolbar.

Making selection ranges for several non-contiguous tracks

As described above, selection ranges can cover several tracks. How-
ever, it is also possible to exclude tracks from a selection range:

1. Create a selection range from the first to the last desired track.

2. Press [Ctrl]/[Command] and click in the selection range on the tracks 
you want to exclude from the selection.

3. In the same manner, you can add a track to the selection range by 
[Ctrl]/[Command]-clicking in the selection range area on the track.

Moving and duplicating

• To move a selection range, click and drag it to a new position.
This will move the contents of the selection range to the new position. If the range in-
tersected events or parts, these will be split before moving, so that only the sections 
within the selection range are affected.

• To duplicate a selection range, hold down [Alt]/[Option] and drag.
You can also use the Duplicate, Repeat and Fill Loop functions, just as when duplicat-
ing events (see page 99).
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Using Cut, Copy and Paste

When working with selection ranges, you can either use Cut, Copy 
and Paste on the Edit menu, or use the functions “Cut Time” and 
“Paste Time” on the Range submenu on the Edit menu. These work 
differently to their related functions on the Edit menu:

Deleting selection ranges

Again, you can either use “regular” Delete or “Delete Time”:

• If you use the Delete function on the Edit menu (or press [Backspace]), 
the data within the selection range is replaced by empty track space.
Events to the right of the range keep their position.

• If you use “Delete Time” on the Edit menu’s Range submenu, the se-
lection range is removed and events to the right are moved to the left 
to close up the gap.

Function Description

Cut Cuts out the data in the selection range and moves it to the 
Clipboard. The selection range is replaced by empty track 
space in the Project window, meaning that events to the right 
of the range keep their positions.

Copy Copies the data in the selection range to the clipboard.

Paste Pastes the clipboard data at the start position and track of the 
current selection. Existing events are not moved to make room 
for the pasted data.

Paste at Origin Pastes the clipboard data back at its original position. Existing 
events are not moved to make room for the pasted data.

Cut Time Cuts out the selection range and moves it to the Clipboard. 
Events to the right of the removed range are moved to the left 
to fill out the gap.

Paste Time Pastes the clipboard data at the start position and track of the 
current selection. Existing events are moved to make room for 
the pasted data.

Paste Time at Origin Pastes the clipboard data back at its original position. Existing 
events are moved to make room for the pasted data.
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Other functions

On the Range submenu on the Edit menu, you will find three more 
range editing functions:

Options

Snap

The Snap function helps you to find exact positions when editing in 
the Project window. It does this by restricting horizontal movement 
and positioning to certain positions. Operations affected by Snap in-
clude moving, copying, drawing, sizing, splitting, range selection, etc.

• You turn Snap on or off by clicking the Snap icon in the toolbar.

Snap activated.

• When you are moving audio events with Snap activated, it isn’t neces-
sarily the beginning of the event that is used as Snap position reference. 
Instead, each audio event has a snap point, which you can set to a rele-
vant position in the audio (such as a downbeat, etc.).
The snap point is preferably set in the Sample Editor since it will allow for a higher de-
gree of precision (see page 284). You can however also set the snap point directly in 
the Project window, in the following way: 

Function Description

Split Splits any events or parts that are intersected by the selection range, at the 
positions of the selection range edges.

Crop All events or parts that are partially within the selection range are cropped, 
that is, sections outside the selection range are removed. Events that are 
fully inside or outside the selection range are not affected.

Insert 
Silence

Inserts empty track space from the start of the selection range. The length 
of the silence equals the length of the selection range. Events to the right of 
the selection range start are moved to the right to “make room”. Events that 
are intersected by the selection range start are split, and the right section is 
moved to the right.
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1. Select an event.

2. Place the project cursor at the desired position within the selected 
audio event.

3. Pull down the Audio menu and select “Snap Point To Cursor”.
The snap point is set at the cursor position.

The snap point for an event is displayed as a blue line in the Project window.

Exactly how Snap works depends on which mode is selected on the 
Snap mode pop-up menu.

The following sections describe the different Snap modes:

Grid

In this mode, the Snap positions are set with the Grid pop-up menu to 
the right. The options depend on the display format selected for the 
ruler. For example, if the ruler is set to show bars and beats, the grid can 
be set to bars, beats or the quantize value set with the next pop-up 
menu to the right. If a time- or frame-based ruler format is selected, the 
grid pop-up menu will contain time- or frame-based grid options, etc.

When seconds is selected as ruler format, the grid pop-up menu contains time-
based grid options.
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Grid Relative

When you move events and parts in this mode they will not be “mag-
netic” to the grid. Rather, the grid determines the step size for moving 
the events. This means that a moved event will keep its original posi-
tion relative to the grid.

For example, if an event starts at the position 3.04.01 (one beat before 
bar 4), Snap is set to Grid Relative and the Grid pop-up is set to “Bar”, 
you can move the event in steps of one bar – to the positions 4.04.01, 
5.04.01 and so on. The event will keep its relative position to the grid, 
i.e. stay one beat before the bar lines.

• This only applies when dragging existing events or parts – when you 
create new events or parts this mode works like the Grid mode.

Events

In this mode, the start and end positions of other events and parts be-
come “magnetic”. This means that if you drag an event to a position 
near the start or end of another event, it is automatically aligned with 
the start or end of the other event. For audio events, the position of the 
snap point is also magnetic (see page 284).

• Note that this includes marker events on the marker track.
This allows you to snap events to marker positions, and vice versa.
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Shuffle

Shuffle mode is useful when you want to change the order of adjacent 
events. If you have two adjacent events and drag the first one to the 
right, past the second event, the two events will change places.

The same principle works when changing the order of more than two 
events:

Magnetic Cursor

When this mode is selected, the project cursor becomes “magnetic”. 
Dragging an event near the cursor causes the event to be aligned with 
the cursor position.

Grid + Cursor

This is a combination of the “Grid” and “Magnetic Cursor” modes.

Events + Cursor

This is a combination of the “Events” and “Magnetic Cursor” modes.

Events + Grid + Cursor

This is a combination of the “Events”, “Grid” and “Magnetic Cursor” 
modes.

1 2 3 4 5

52431

Dragging event 2 past event 4...

...changes the order of events 2, 3 and 4.
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Snap to Zero Crossing

When this option is activated in the Preferences dialog (Editing–Audio 
page), splitting and sizing of audio events is done at zero crossings (po-
sitions in the audio where the amplitude is zero). This helps you avoid 
pops and clicks which might otherwise be caused by sudden amplitude 
changes.

This setting affects all windows in all open projects – with the exception 
of the Sample Editor (which has its own Snap to Zero Crossing button).

Autoscroll

Autoscroll activated.

When this option is activated, the waveform display will scroll during 
playback, keeping the project cursor visible in the window.

• If the option “Stationary Cursor” is activated in the Preferences dialog 
(Transport page), the project cursor will be positioned in the middle of 
the screen (if possible).
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About folder tracks

Just as the name implies, a folder track is a folder that contains other 
tracks. Moving tracks into a folder is a way to structure and organize 
tracks in the Project window. For example, grouping several tracks in a 
folder track makes it possible for you to “hide” tracks (thus giving you 
more working space on the screen). You can solo and mute several 
tracks in a quicker and easier way, and perform editing on several tracks 
as one entity. Folder tracks can contain any type of track including other 
folder tracks. 

A folder track

Tracks in the 
folder
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Handling folder tracks

Creating a folder track

Folder tracks are created just like any other track: Select “Add Track” 
from the Project menu and select “Folder” from the submenu that ap-
pears.

Moving tracks into a folder

You can move any type of track into a folder by using drag and drop:

1. In the Track list, click on a track that you want to move into a folder, 
and drag it onto a folder track.
A green arrow pointing to a folder appears when you drag the track onto the folder 
track in the list.

2. Release the mouse button.
The track is now placed in the folder track, and all parts and events on the track will be 
represented by a corresponding folder part (see page 123), that is a graphical repre-
sentation of all parts and events in the folder.

Since you can move any type of track into a folder track, it is possible 
to create sub-folders by moving one folder track into another. This is 
called “nesting”. For example, you could have a folder containing all 
the vocals in a project, and each vocal part could have a nested folder 
containing all the takes, in a subfolder for easier handling etc.
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Removing tracks from a folder

To remove a track from a folder, simply drag it out of the folder and re-
lease it in the Track list.

Hiding/showing tracks in a folder

You can hide or show the tracks located in a folder by clicking on the 
“Show/Hide” button (the plus sign) in the Track list for the folder track. 
Hidden tracks are still played back as usual.

When a folder is “closed” this way, the folder part(s) still give you a 
graphic representation of the parts and events within the folder.

Muting and soloing folder tracks

One of the main advantages of using folder tracks is that they provide 
you with a way to mute and solo several tracks as one unit. Muting and 
soloing a folder track affects all tracks in the folder. You can also solo 
or mute individual tracks in the folder. 

Muting a folder track

You can mute a folder track (and thereby mute all tracks within it) the 
same way you mute other tracks by clicking in the Mute (“M”) button 
in the Track list.

Soloing a folder track

You can solo a folder track (and thereby mute all tracks outside the 
folder) the same way you solo other tracks, by selecting it and clicking 
the Solo button.

Soloing or muting tracks within a folder

This can be done by showing the tracks in the folder and using the 
Mute and Solo buttons in the Track list as usual for any tracks inside 
the folder.
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Working with folder parts

A folder part is a graphic representation of events and parts on the 
tracks in the folder. Folder parts indicate the position and length of the 
events and parts, as well as on which track they are (their vertical po-
sition). If part colors are used, these are also shown in the folder part.

Folder parts are created automatically when there are parts or events 
on the tracks within the folder. The following rules apply:

• If there is a gap between parts/events on the tracks, there will be two 
separate folder parts.

• Parts or events that overlap within the folder may be represented by 
the same folder part or by two different folder parts – depending on 
how much they overlap.
If a part/event overlaps by half its length or less it will be placed in a new folder part.

The MIDI part overlaps the audio events by more than half its length, which means 
it is included in the same folder part.
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If you move the MIDI part slightly to the right, the overlap is less than half its length. 
This means a new folder part is created.

Handling and editing folder parts

Any Project window editing you perform to a folder part affects all its 
contained events and parts (those elements on the track within the 
folder that are represented by the folder part). You can select several 
folder parts if you like – this allows you to handle and edit them to-
gether. The editing you can perform includes:

• Moving a folder part. This will move its contained events and parts (possibly 
resulting in other folder parts, depending on how the parts overlap).

• Using cut, copy and paste.
• Deleting a folder part. This will delete its contained events and parts.
• Splitting a folder part with the Scissors tool (see the example below).
• Gluing folder parts together with the Glue tube tool. This will only work if the 

adjacent folder parts contain events or parts on the same track.
• Resizing a folder part resizes the contained events and parts according to the 

selected resizing method. This is set by clicking the Arrow tool icon on the tool-
bar and selecting either “Normal Sizing” or “Sizing Moves Contents” from the 
pop-up menu – see page 102. The third option on the pop-up, “Sizing Applies 
Time Stretch” cannot be used to resize folder parts.

• Muting a folder part. This will mute its contained events and parts.

In short, most of the editing you can do in the Project window applies 
to folder parts as well.
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An example

Editing tracks within folder parts

Tracks inside a folder can be edited as one entity, by performing the 
editing directly on the folder part containing the tracks as explained 
above. You can also edit individual tracks within the folder, by show-
ing the contained tracks, selecting parts and opening editors as usual.

Double clicking a folder part opens the editors for the corresponding 
track classes present in the folder. The following applies:

• All MIDI parts located on the tracks within the folder are displayed as 
if they were on the same track, just like when opening the Key Editor 
with several MIDI parts selected.
To be able to easily discern the different tracks in the editor, give each track a different 
color in the Project window and use the “Part Colors” option in the editor (see page 
469).

• If the folder contains tracks with audio events and/or audio parts, the 
Sample and/or Audio Part Editors are opened, with each audio event 
and audio part in a separate window.

Splitting the folder part with the Scissors tool...

...will split all contained parts or events 
present at that position.
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About markers

Markers are used to quickly locate any position. If you often find your-
self jumping to a specific position, you can set up that position as a 
marker. There are two types of markers: 

• Cycle markers, which allow you to store the start and end positions of a range.
• Standard markers which store a specific position. 

Markers can be created and edited in several ways: 

• By using the Marker window (see below).
• By using the Marker track (see page 132).
• By using key commands (see page 136).

• The left and right locators are handled separately – see page 28.

The Marker window

In the Marker window you can perform most editing operations con-
cerning markers. Markers are displayed sequentially starting from the 
top of the window in the order that they occur in the project. Most 
functions in the Marker window are also available in the Inspector 
when the Marker track is selected.

To open the Marker window, select “Markers” from the Project menu, 
click the “Show” button in the Marker section on the Transport panel 
or use the key command (by default [Ctrl]/[Command]-[M]).
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The Marker window columns

The Marker window is divided into six columns which are used for per-
forming the following operations:

• The leftmost column is the Locate column. 
Clicking in this column will move the project cursor to the corresponding Marker posi-
tion. A blue arrow indicates the Marker at the project cursor position (or the closest 
marker before the project cursor).

• The ID column is used to edit marker ID-numbers. 
See page 130.

• The Position column displays the markers’ time positions (or start positions 
for cycle markers).
The marker positions can be edited directly in this column.

• The End and Length columns display the end positions and length of cycle 
markers – see page 132.
These values can also be edited directly in the respective column.

• The Description column lets you enter names or descriptions for markers.

Click on a column heading to sort the marker list by that column. The 
Marker columns can also be reordered.

Adding and removing markers in the Marker window

You add position markers (in Stop mode, during playback or during re-
cording) by clicking the Add button or by using the respective keycom-
mand. Markers are always added at the current project cursor position. 

• To add a cycle marker, select “Cycle Markers” from the Show pop-up 
menu and click the Add button.
This adds a cycle marker between the left and right locator. You can also draw cycle 
markers on the Marker track (see page 133).

• To remove a marker, select it and click the Remove button.
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Moving marker positions in the Marker window

The Move button in the Marker window can be used to “reprogram” 
marker positions. Proceed as follows:

1. Set the project cursor to the position to which you want to move (or 
re-program) a marker.

2. Select the marker which you want to change in the Marker window.
Do not select the marker by clicking in the leftmost column, as this will move the 
project cursor you set up in the previous step.

• If a cycle marker is selected, the Move operation affects the cycle 
marker start position.
The length of the range is not affected.

3. Click the Move button.

You can also move markers by editing their position numerically in the 
Position column.

About marker ID-numbers

Each time you add a marker it is automatically and sequentially as-
signed an ID-number, starting from ID 1 and onwards. ID numbers 
can be changed at any time if needed – this allows you to assign 
specific markers to key commands (see below). 

IDs for cycle markers are shown in brackets and start from [1]. These 
may also be changed, for the same reason.

Assigning markers to key commands

As explained earlier, marker ID-numbers are assigned automatically 
and sequentially each time you add a marker. The nine first markers 
(1-9) can be recalled by using key commands – by default these are 
[Shift]-[1] to [9] on the typewriter part of the keyboard. This means 
that even if you have more than nine markers, you cannot use key 
commands to navigate to markers numbered 10 or higher.
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If you want to keep all current markers, but want to specify which 
markers should be accessed with key commands, the solution is to 
reassign the marker ID-numbers. Proceed as follows:

1. First decide which of the current markers with an ID between 1 and 9 
you want to reassign to a new ID-number, and thus remove its key 
command assignment.
Memorize the ID-number.

2. Type in this ID-number in the ID column of the marker you want to ac-
cess with a key command and press enter.
The two marker ID-numbers are switched, and the key commands now locates to the 
marker selected in this step.

3. Repeat as necessary for other markers.

• You can also simply remove a marker with an ID-number between 1 to 
9 to free up a key – see page 129.

• For more about marker key commands, see page 136.
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Using the Marker track

The Marker track is used for viewing and editing markers. Markers 
shown on the Marker track are exactly the same as shown in the Marker 
window, and any changes made on the Marker track are reflected in the 
Marker window and vice versa. Standard position markers in the Marker 
track are shown as marker events, vertical lines with the marker name (if 
assigned) and number beside it. If you select the Marker track, all mark-
ers are shown in the Inspector, much like in the Marker window.

About cycle markers

Cycle markers are shown on the Marker track as two markers bridged 
by a horizontal line. Cycle markers are ideal for storing sections of a 
project. By setting cycle markers for sections of a song, for example 
“Intro”, “Verse”, “Chorus” etc., this enables you to quickly navigate to 
the song sections, and also to optionally repeat the section (by acti-
vating Cycle on the Transport panel). 

In addition, Cycle markers appear on the horizontal Zoom pop-up menu 
in the Project window. If you select a Cycle marker from the pop-up 
menu, the screen is automatically zoomed to encompass the Cycle 
marker range.

Opening the Marker track

To open the Marker track, select “Marker” from the Project menu – 
Add Track submenu. You can only have one Marker track in a project.

MarkersMarkers Cycle marker Locators
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Editing markers on the Marker track

The following basic editing functions can be performed directly on the 
Marker track:

• Adding position markers “on the fly”.
Use the respective key command or the “Add Marker” button in the Track list for the 
Marker track to add position markers at the current cursor position during playback. 

• Adding a cycle marker at the left and right locator positions.
Clicking the “Add Cycle Marker” button in the Track list for the Marker track adds a 
cycle marker spanning the area between the left and right locator.

• Selecting markers.
You can use standard selection techniques like dragging to make a selection rectangle 
or using [Shift] to select separate markers.

• Drawing position markers.
By clicking with the Pencil tool (or pressing [Alt]/[Option] and clicking with the Arrow 
tool), you can create or “draw” position marker events at any position on the track. If snap 
is activated on the toolbar, this determines at which positions you can draw markers.

• Drawing cycle markers.
To draw a cycle marker range, you press [Ctrl]/[Command] and use the Pencil tool or 
the Arrow tool. Snap settings are applied if activated. 

Cycle markers can freely overlap. 

Add Marker/Add Cycle Marker buttons
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• Resizing a cycle marker.
Select a cycle marker by clicking on it. As you can see, two handles appear at the bot-
tom of the start and end events. If you click and hold one of the handles you can drag 
the event left or right to resize the cycle marker. This can also be done numerically on 
the info line.

• Moving markers.
Click and drag to move the selected markers, or edit marker positions on the info line. 
As usual, snap is taken into account if activated.

• Removing markers.
This is done exactly the same way as for other events, i.e. by selecting and pressing 
[Delete], using the Erase tool etc.

• Naming markers.
A selected marker’s name can be edited by clicking the name on the info line.

Navigating using cycle markers

Cycle markers represent ranges rather than single positions. There-
fore you don’t use them for moving the project cursor, but for moving 
the left and right locators:

• If you double click on a cycle marker, or select it from the Cycle pop-
up menu in the Track list, the left and right locators are moved to en-
compass the cycle marker.
To move the project cursor position to the start or the end of the cycle marker, move it 
to the corresponding locator (e.g. by using the numeric pad keys [1] and [2]).

• You can also use key commands for this – see page 136.

Zooming to cycle markers

• By selecting a cycle marker on the Zoom pop-up menu, the event dis-
play is zoomed in to encompass the selected range only.
You can also do this by pressing [Alt]/[Option] and double clicking on the cycle marker 
in the event display.
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Editing cycle markers using tools

Cycle markers can be edited on the Marker track using the following 
tools. Note that the snap value applies as with regular events:

The other tools cannot be used with cycle markers.

Using markers to make range selections in the Project window

Besides enabling you to quickly move the project cursor and locators, 
markers can be used in conjunction with the Range Selection tool to 
make range selections in the Project window. This is useful if you 
quickly want to make a selection that spans all tracks in the project. 

• Double click with the Range Selection tool between any two markers 
– this creates a selection range between the markers, spanning all 
tracks in the project (just as if you had used the Range Selection tool 
to draw a rectangle).
Any functions or processing you perform will now affect the selection only.

Moving and Copying sections

This is a quick way to move or copy complete sections of the project 
(on all tracks):

1. Set markers at the start and end of the section you want to move or 
copy.

2. Select the Range Selection tool and double click on the Marker track 
between the markers.
Everything in the project within the cycle marker boundaries is selected.

Tool Use

Pencil Press [Ctrl]/[Command] and use the Pencil tool to create new 
ranges (as described above).

Eraser Click with the Eraser tool to delete a cycle marker. If you hold down 
[Alt]/[Option] when you click, all consecutive markers will also be 
deleted.

Selection Range This is described on page 135.
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3. Click on the Marker track in the selected range and drag the range to 
a new position.
The selection in the Project window is moved to the same position.

• If you hold down [Alt]/[Option] while you drag the range, the selection 
in the Project window is copied instead.

Marker key commands

You can use key commands for the following marker operations:

If you need to change the key command assignments, the marker com-
mands can be found in the Transport category in the Key Commands 
dialog.

• For the [Shift]-[Pad1] to [Pad9] commands to work, Num Lock must be 
deactivated on the computer keyboard

Operation Description Default key

Insert Marker Creates a new marker at the current project 
cursor position.

[Insert] (Win)

Locate Next Marker Moves the project cursor to the right to the 
next marker position (if any).

[Shift]-[N]

Locate Previous Marker Moves the project cursor to the left to the 
previous marker position (if any).

[Shift]-[B]

To Marker 1-9 Moves the project cursor to the specified 
marker (number 1 to 9).

[Shift]-[1] to [9]

Set Marker 1-9 Moves the specified marker (number 1 to 9) 
to the current project cursor position.

[Ctrl]-[1] to [9]

Recall Cycle Marker 1-9 Moves the left and right locators to encom-
pass the specified cycle marker (1 to 9).

[Shift]-[Pad1] to 
[Pad9]



8
Fades, crossfades and

envelopes
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Creating fades

There are two main types of fade-ins and fade-outs in audio events in 
Cubase SE: fades created by using the fade handles (see below) and 
fades created by processing (see page 140).

Fades created by using the fade handles

Selected audio events have blue handles in the upper left and right cor-
ners. These can be dragged to create a fade-in or fade-out respectively.

Creating a fade-in. The fade is automatically reflected in the shape of the event’s 
waveform, giving you a visual feedback of the result when you drag the fade handle. 

Fades created with the handles are not applied to the audio clip as 
such but calculated in real time during playback. This means that sev-
eral events referring to the same audio clip can have different fade 
curves. It also means that having a huge number of fades may demand 
a lot of processor power.

• If you select multiple events and drag the fade handles on one of them, the 
same fade will be applied to all selected events.

• A fade can be edited in the Fade dialog, as described on the following pages. 
You open the dialog by double clicking in the area above the fade curve, or by select-
ing the event and selecting “Open Fade Editor(s)” from the Audio menu (note that this 
will open two dialogs if the event has both fade-in and fade-out curves).
If you adjust the shape of the fade curve in the Fade dialog, this shape will be main-
tained when you later adjust the length of a fade.

• You can make the fade longer or shorter at any time, by dragging the handle.
You can actually do this even without selecting the event first, i.e. without visible han-
dles. Just move the mouse pointer along the fade curve until the cursor turns into a bi-
directional arrow, then click and drag.

• If the option “Show Event Volume Curves Always” is activated in the Prefer-
ences dialog (Event Display–Audio page), the fade curves will be shown in all 
events, regardless of whether they are selected or not.
If the option is deactivated, the fade curves are shown in selected events only.
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Creating and adjusting fades with the Range Selection tool

“Handle-type” fades can also be created and adjusted with the Range 
Selection tool, in the following way:

1. Select a section of the audio event with the Range Selection tool.
The result depends on your selection, in the following way:

• If you select a range from the beginning of the event, a fade-in will be created 
within the range. 

• If you select a range that reaches the end of an event, a fade-out will be cre-
ated in the range. 

• If you select a range encompassing a middle section of the event, but not 
reaching neither the start nor the end, both a fade-in and a fade-out will be 
created outside of the selected range. In other words, the fade-in will cover 
the area from the beginning of the event to the beginning of the selected 
range, and the fade-out will cover the area from the end of the selected range 
to the end of the event.

2. Pull down the Audio menu and select “Adjust Fades to Range”.
The fade areas are adjusted according to the selection range.

You can select multiple audio events on separate tracks with the Range 
Selection tool, and apply the fade to all of them simultaneously.
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About the volume handle

A selected audio event also has a blue handle in the top middle. This 
is the volume handle, and it provides a quick way of changing the vol-
ume of an event, directly in the Project window. It stands in direct cor-
relation with the volume setting in the info line, that is, dragging the 
volume handle also changes the value in the info line.

Removing fades

To remove a fade, select the event and select “Remove Fades” from 
the Audio menu.

You can also use the Range Selection tool to remove fades and 
crossfades:

1. Drag the Range Selection tool in the Project window, so that the se-
lection encloses all of the fades and crossfades you wish to remove.

2. Select “Remove Fades” from the Audio menu.

Fades created by processing

If you have selected an audio event or a section of an audio event (us-
ing the Range Selection tool), you can apply a fade-in or fade-out to 
the selection by using the “Fade In” or “Fade Out” functions on the 
Process submenu on the Audio menu. These functions open the cor-
responding Fade dialog, allowing you to specify a fade curve.

Note that the length of the fade area is determined by your selection. In 
other words, you specify the length of the fade before you enter the 
Fade dialog. 

Drag the Volume handle up or down 
to change the volume of the event.

The volume change is displayed 
numerically in the info line.

The event waveform re-
flects the volume change.
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Also note that you can select multiple events and apply the same pro-
cessing to all of them simultaneously.

Fades created this way are applied to the audio clip rather than to the 
event. This has the following consequences:

• If you later create new events that refer to the same clip, these will have the 
same fades.

If other events refer to the same audio clip, you will be asked whether 
you want the processing to be applied to these events or not.

• Continue will apply the processing to all events that refer to the audio clip.
• New Version will create a separate, new version of the audio clip for the se-

lected event.
• You can also choose to put a checkmark in the “Do not ask this message again” 

box. Regardless of whether you then choose “Continue” or “New Version”, any 
and all further processing you do will conform to the option you select.

You can change this setting at any time in the Preferences dialog (Edit-
ing–Audio page), under “On Processing Shared Clips”.
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The Fade dialogs

The Fade dialogs appear when you edit an existing fade or use the 
“Fade In”/”Fade Out” functions on the Audio menu’s Process submenu. 
The picture below shows the Fade In dialog; the Fade Out dialog has 
identical settings and features.

• If you open the Fade dialog(s) with several events selected, you can 
adjust the fade curves for all these events at the same time.
This is useful if you want to apply the same type of fade-in to more than one event, etc.

Curve Kind

These determine whether the fade curve should consist of spline curve 
segments (left button), damped spline segments (middle button) or 
linear segments (right button).

Fade display

Shows the shape of the fade curve. The resulting waveform shape is 
shown in dark grey, with the current waveform shape in light grey.

You can click on the curve to add points, and click and drag existing 
points to change the shape. To remove a point from the curve, drag it 
outside the display.
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Restore button

The Restore button (to the right above the fade display) is only avail-
able when editing fades made by dragging the fade handles. Click 
this to cancel any changes you have made since opening the dialog.

Curve shape buttons

These buttons give you quick access to some common curve shapes.

Default button

Clicking the “As Default” button stores the current settings as the de-
fault fade. This shape will be used whenever you create new fades.

Presets

If you have set up a fade-in or fade-out curve that you may want to ap-
ply to other events or clips, you can store it as a preset by clicking the 
Store button.

• To apply a stored preset, select it from the pop-up menu. 

• To rename the selected preset, double click on the name and type a 
new one. 

• To remove a stored preset, select it from the pop-up menu and click 
Remove.

Stored fade-in presets will only appear in the Fade In dialog, and fade-
out presets will only appear in the Fade Out dialog.
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Preview, Apply and Process

The buttons in the bottom row are different depending on whether you 
are editing a fade made with the fade handles or applying a fade using 
processing:

The Edit Fade dialogs have the following buttons:

The Process Fade dialogs have the following buttons:

Button Function

OK Applies the set fade curve to the event, and closes the dialog.

Cancel Closes the dialog.

Apply Applies the set fade curve to the event, without closing the dialog.

Button Function

Preview Plays back the fade area. Playback will repeat until you click the button 
again (the button is labeled “Stop” during playback).

Process Applies the set fade curve to the clip, and closes the dialog.

Cancel Closes the dialog without applying any fade.

The Edit Fade dialog. The Process Fade dialog.
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Creating crossfades

Overlapping audio material on the same track can be crossfaded, for 
smooth transitions or special effects. You create a crossfade by se-
lecting two consecutive audio events and selecting the Crossfade 
command on the Audio menu (or using the corresponding key com-
mand, by default [X]). The result depends on whether the two events 
overlap or not:

• If the events overlap, a crossfade is created in the overlapping area.
The crossfade will be of the default shape – initially a linear, symmetric crossfade, but 
you can change this as described below.

• If the events don’t overlap but are directly consecutive (lined up end-
to-start, with no gap) it’s still possible to crossfade them – provided 
that their respective audio clips overlap! In this case, the two events 
are resized so that they overlap, and a crossfade of the default length 
and shape is applied.
The default crossfade length and shape are set in the Crossfade dialog, see page 149.

Overlapping section.
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An example:

The events in themselves do not overlap, but their clips do. Therefore, the events 
can be resized so that they overlap, which is required for a crossfade to be created.

When you select the Crossfade function, the two events are resized so that they 
overlap, and a default crossfade is created in the overlapping section.

• If the events don’t overlap, and cannot be resized enough to overlap, a 
crossfade cannot be created.

• Once you have created a crossfade, you can edit it by selecting one 
or both crossfaded events, and selecting “Crossfade” from the Audio 
menu again (or by double clicking in the crossfade zone). 
This opens the Crossfade dialog, as described below.

Removing crossfades

To remove a crossfade, select the events and select “Remove Fades” 
from the Audio menu, or use the Range Selection tool:

1. Drag the Range Selection tool in the Project window, so that the se-
lection encloses all of the fades and crossfades you wish to remove.

2. Select “Remove Fades” from the Audio menu.

• You can also remove a crossfade by clicking and dragging it outside 
the track.

Audio clips.

Audio events.
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The Crossfade dialog

The Crossfade dialog contains separate settings for the fade-in and 
fade-out curve in the crossfade, as well as common settings.

The left part of the Crossfade dialog contains two sections with set-
tings for the fade-in and fade-out curves in the crossfade. These two 
sections have identical settings.

Play buttons

• The “Play Fade Out” and “Play Fade In” buttons allow you to audition 
the fade-out or fade-in part only, without the crossfade.

• The “Play Crossfade” button plays back the whole crossfade.

You can also use the Transport play controls to play back the cross-
faded audio events. However, that method will play back all unmuted 
audio events on other tracks as well.

Curve kind buttons

These buttons determine whether the corresponding fade curve should 
consist of spline curve segments (left button), damped spline segments 
(middle button) or linear segments (right button).
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Fade Displays

Shows the shape of the fade-out and fade-in curve, respectively. You 
can click on the curve to add points, and click and drag existing points 
to change the shape. To remove a point from the curve, drag it outside 
the display.

Curve shape buttons

These buttons give you quick access to some common curve shapes.

Equal Power and Gain

If you activate the “Equal Power” checkbox, the fade curves are ad-
justed, so that the energy (power) of the crossfade will be constant all 
along the crossfade region.

Equal Power curves have only one editable curve point. You cannot use 
the Curve kind buttons or the presets when this mode is selected.

If you activate the “Equal Gain” checkbox, the fade curves are adjusted 
so that the summed fade-in and fade-out amplitudes will be the same 
all along the crossfade region. This is often suitable for short cross-
fades.

Length settings

You can adjust the length of the crossfade area numerically in the 
“Length” field. If possible, the length change will be applied equally to 
“both sides” of the crossfade (i.e. Cubase SE tries to “center” the 
crossfade).

To be able to resize a crossfade this way, it must be possible to resize 
the corresponding event. For example, if the left crossfaded event already 
plays its audio clip to the end, its endpoint cannot be moved any further 
to the right.



CUBASE SE
Fades, crossfades and envelopes 8 – 149

Default buttons

Clicking the “As Default” button stores all of the current settings as 
the default crossfade. These settings will then be used whenever you 
create new crossfades.

• The Crossfade Length setting is included in the Default settings. 
However, it is only applied if the events to be crossfaded don’t overlap 
– otherwise the crossfade will be in the overlap area (see page 145).

Clicking the “Recall Default” button copies the curves and settings in 
the Default crossfade to the Crossfade dialog.

Presets

If you have set up a crossfade shape that you may want to apply to 
other events, you can store it as a preset by clicking the Store button.

• To apply a stored preset, select it from the pop-up menu. 

• To rename the selected preset, double click on the name and type a 
new one. 

• To remove a stored preset, select it from the pop-up menu and click 
Remove.
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Auto Fades and Crossfades

Cubase SE features an Auto Fade function that can be set both glo-
bally, i.e. for the entire project, and separately for each audio track. The 
idea behind the Auto Fade function is to create smoother transitions 
between events by applying short (1 - 500 ms) fade-ins and fade-outs.

As mentioned earlier, fades are calculated in real time during playback. 
This means that the larger the number of audio tracks with Auto Fades 
activated in a project, the higher the demands on the processor.

Making global Auto Fade settings

1. To make Auto Fades settings globally for the project, select “Auto 
Fades Settings…” from the Project menu.
This opens the Auto Fades dialog for the project.

2. Use the checkboxes in the upper right corner to activate or deactivate 
Auto Fade In, Auto Fade Out and Auto Crossfades, respectively.

3. Use the Length value field to specify the length of the Auto Fade or 
Crossfade (1-500 ms).
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4. To adjust the shapes of Auto Fade In and Auto Fade Out, select the 
“Fades” tab and make settings as in the regular Fade dialogs.

5. To adjust the shape of the Auto Crossfade, select the “Crossfades” 
tab and make settings as in the regular Crossfade dialog.

6. If you want to use the settings you have made in forthcoming new 
projects, click the “As Default” button.
The next time you create a new project, it will use these settings by default.

7. Click OK to close the dialog.

Making Auto Fade settings for a separate track

By default, all audio tracks will use the settings you have made in the 
project’s Auto Fades dialog. However, since Auto Fades use comput-
ing power, a better approach may be to turn Auto Fades off globally, 
and activate them for individual tracks, as needed:

1. Right-click (Win) or [Ctrl]-click (Mac) the track in the Track list and 
select “Auto Fades Settings...” from the context menu (or select the 
track and click the “Auto Fades Settings” button in the Inspector).
The Auto Fades dialog for the track appears. This is identical to the project’s Auto 
Fades dialog, with the addition of a “Use Project Settings” option.

2. Deactivate the “Use Project Settings” option.
Now, any settings you make will be applied to the track only.

3. Set up the Auto Fades as desired and close the dialog.

Reverting to project settings

If you want a track to use the global Auto Fade settings, open the Auto 
Fades dialog for the track and activate the “Use Project Settings” 
checkbox. This makes the track use the Auto Fade settings you have 
made for the project.
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About this chapter

This chapter contains detailed information about the elements used 
when mixing audio and MIDI, and the various ways you can configure 
the mixer. 

Some mixer related features are not described in this chapter. These 
are the following:

• Setting up and using audio effects.
See page 188.

• Setting up and using MIDI effects.
See page 352.

• Automation of all mixer parameters.
See page 222.

• How to mix down several audio tracks (complete with automation and 
effects if you wish) to a single audio file.
See page 487.
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Overview

The mixer offers a common environment for controlling levels, pan, 
solo/mute status etc. for both audio and MIDI channels. 

Opening the mixer

The mixer can be opened in several ways:

• By selecting Mixer from the Devices menu.

• By clicking the Mixer icon on the toolbar

• By using a key command (by default [F3]).

• By clicking the Mixer button in the Devices panel.
You open the Devices panel by selecting Show Panel from the Devices menu.
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What channel types can be shown in the mixer?

The following track based channel types are shown in the mixer:

• Audio
• MIDI
• Effect return channels (FX channel tracks are referred to as effect return 

channels in the mixer). 
• Group channels. 

The order of audio, group, effect return and MIDI channel strips (from 
left to right) in the mixer corresponds to the Project window Track list 
(from the top down). If you reorder tracks of these types in the Track 
list, this will in turn be mirrored in the mixer.

In addition to the above, the following channel types are also shown in 
the mixer:

• Activated ReWire channels (see page 530).
• VST Instrument channels (see page 214).

ReWire channels cannot be reordered and always appear to the right 
of other channels in the main mixer pane (see below). VST instrument 
(VSTi) channels can be reordered in the Track list which will in turn be 
mirrored in the mixer.

Folder, Marker, Video and Automation tracks are not shown in the mixer.

Output busses in the mixer

The output busses are represented by output channels in the mixer. 
They appear in a separate “pane” separated by a movable divider and 
with its own horizontal scrollbar, see page 163.
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Configuring the mixer

As mentioned earlier, the mixer window can be configured in various 
ways to suit your needs and to save screen space. Here follows a run 
through of the various view options (the following descriptions assume 
that you have an active project containing some tracks):

Setting the width of channel strips

Each channel strip’s width can be sized to either “Wide” or “Narrow” mode 
by using the Narrow/Wide button. This is the two left/right arrows just 
above the fader strip (to the left of the View options pop-up menu).

The Narrow/Wide button

• Narrow channel strips contain a narrow fader, miniature buttons and 
the View options pop-up menu.

Wide and narrow channel strips

• When selecting wide or narrow channel strips in the common panel 
(“All Wide” or “All Narrow”), all channel strips are affected.
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Selecting what channel types to show/hide

You can specify what channel types to show or hide in the mixer. In the 
common panel you find a vertical strip with different indicator buttons. 
Each indicator represents a channel type to show or hide:

• To hide or show a channel type, click the corresponding indicator.
If an indicator is dark, the corresponding channel type will be shown in the mixer. If it is 
orange, the corresponding channel type will be hidden.

Selecting individual channels to show/hide

You can also show/hide individual channels of any type in the mixer. 
This is done by first assigning channels a “Can Hide” status. After 
having done so you can hide all channels assigned this status at any 
time. Proceed as follows:

1. Pull down the View options pop-up menu for the channel you want to 
hide and activate the “Can Hide” option.

Audio Channels

Group Channels

ReWire Channels

MIDI Channels

VST Instrument Channels

Effect Return Channels

Output Channels

For hiding individual channels – see below.
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2. Repeat this for all channels you want to hide.

3. Click the bottom “hide button” in the common panel.
This hides all channels set to “Can Hide”. To show them, click the button again.

Channel view sets

Channel view sets are saved configurations of the mixer, allowing you 
to quickly switch between different layouts. Proceed as follows:

1. Set up the mixer the way you wish to store it as a view set.
The following settings will be stored:

• Settings for individual channel strips (e.g. narrow or wide mode and whether 
the channel strip is (or can be) hidden or not).

• The hide/show status for channel types.

2. Click the “Store View Set” button (the plus sign) at the top of the 
common panel.

3. A dialog appears, allowing you to type in a name for the view set.
Do so and click OK to store the current mixer view set.

• You can now return to this stored configuration at any time, by clicking 
the “Select Channel View Set” button (the down arrow at the top of 
the common panel) and selecting it from the pop-up menu.

• To remove a stored channel view set, select it and click the “Remove 
View Set” button (the minus sign).

Some remote control devices (such as Steinberg’s Houston) feature 
this function, which means that you can use the remote device to switch 
between the channel view sets.
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The audio channel strips

The mixer showing (from left to right): the common panel, a VST Instrument 
channel, a stereo audio channel, an effect return channel and a group channel strip.

All audio related channel types (audio, output channels, group, effect 
return, VST Instrument or ReWire) basically have the same channel 
strip layout, with the following differences:

• Only audio track channels have a Record Enable and Monitor button.
• VST Instrument channels have an additional button for opening the instrument’s 

control panel.

The common panel 
(see page 162).

Level fader

Channel automation controls

Pan control

Edit button 
(opens the Channel 
Settings window).

Insert/EQ/Send indicators and 
bypass buttons (see below).Record Enable and Monitor buttons

Channel 
name field

Opens the control panel 
for the VST Instrument.

 Channel View options pop-up

Level meter
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About the Insert/EQ/Send indicators and bypass buttons

The three indicator buttons in each audio channel strip have the fol-
lowing functionality:

• If an Insert or Send effect or EQ module is activated for a channel, the 
corresponding button is lit. 
The effect indicators will be blue, the EQ indicator will be green.

• By clicking these buttons when lit, the corresponding EQ or effects 
section will be bypassed.
Bypass is indicated by yellow buttons. Clicking the button again deactivates bypass.

The MIDI channel strips

The MIDI channel strips allow you to control volume and pan in your 
MIDI instrument (provided that they are set up to receive the corre-
sponding MIDI messages). The settings here are also available in the 
Inspector for MIDI tracks.

Level fader 
(MIDI volume)

Level (velocity) meter

Channel automa-
tion controls

Pan control

Monitor and 
Record Enable 
buttons

Edit button

Mute and Solo

Bypass Inserts

Disable Sends
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The common panel

The common panel appears to the left in the mixer windows and con-
tains settings for changing the look and behavior of the mixer, as well 
as global settings for all channels.

Global automation Read/
Write buttons, see the 
chapter “Automation”.

Channel settings copy/paste, 
see page 175.

Global Solo/Mute, see 
page 166.

These indicator buttons select what chan-
nel types are shown/hidden in the mixer.

Channel select pop-up

Store/Remove View set buttons (+/-) and 
View set pop-up menu, see page 159.

Toggles “All Wide” (left arrows) or 
“All Narrow” channel strips in the mixer.

Opens the VST Connections 
window, see page 16.

Resets the settings to default 
(for all or selected channels).
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The output channels

The output busses you have set up in the VST Connections window 
are represented by output channels in the mixer. These are shown in a 
separate “pane” (to the right of the regular channel strips), with its own 
divider and horizontal scrollbar. The output channel strips are very sim-
ilar to other audio channels.

• How to set up input and output busses is described in the chapter 
“VST Connections: Setting up input and output busses”.

• How to route audio channels to busses is described on page 179.

Bus volume fader

Bus level meter
Read/Write 
Automation

Clip indicator

Edit button

Inserts/EQ indicator 
and Bypass buttons

Pan controlMute and Solo 
buttons
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Basic mixing procedures

Setting volume in the mixer

In the mixer, each channel strip has a fader for volume control. 

• For audio channels, the faders control the volume of the channels be-
fore they are routed directly or via a group channel to an output bus.

• An output channel fader determines the master output level of all audio 
channels routed to that output bus.

• MIDI channels handle fader volume changes in the mixer by sending 
out MIDI volume messages to the connected instrument(s).
Connected instruments must be set to respond to MIDI messages (such as MIDI vol-
ume in this case) for this to function properly.

• The fader settings are displayed numerically below the faders, in dB 
for audio channels and in the MIDI volume 0 to 127 value range for 
MIDI channels.
You can click in the fader value fields and enter a volume setting by typing.

• To make fine volume adjustments, hold down [Shift] when you move 
the faders.

• If you hold down [Ctrl]/[Command] and click on a fader, it will auto-
matically be set to position 0.0 dB for audio channels, or MIDI volume 
100 for MIDI channels.
Most mixer parameters can be reset to default values by [Ctrl]/[Command]-clicking 
this way.

You can use the faders to set up a volume balance between the audio 
and MIDI channels and perform a manual mix, by moving the faders 
and other controls while playing back. By using the Write function 
(see page 231), you can automate the levels and most mixer actions.

It is also possible to make static volume settings for an event on the info 
line or with the volume handle (see page 140).
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About the level meters for audio channels

When playing back audio in Cubase SE, the level meters in the mixer 
show the level of each audio channel.

• Directly below the level meter is a small level readout – this shows the 
highest registered peak level in the signal.
Click this to reset the peak levels.

If the peak level of the audio goes above 0dB, the numerical level indi-
cator will show a positive value (i.e. a value above 0dB).

Cubase SE uses 32 bit floating point processing internally, so there is 
virtually limitless headroom – signals can go way beyond 0dB without 
clipping. Therefore:

• Having higher levels than 0 dB for individual audio channels is not a 
problem in itself. The audio quality will not be degraded by this. 
However, when many high level signals are mixed in an output bus this may require that 
you lower the output channel level a lot (see below). Therefore it’s good practice to 
keep the max levels for individual audio channels roughly around 0 dB.

About the level meters for output channels

Output channels have clip indicators.

• When you are recording, clipping can occur when the analog signal is 
converted to digital in the audio hardware. 

• In the output busses, the floating point audio is converted to the reso-
lution of the audio hardware. In the integer audio domain, the maximum 
level is 0dB – higher levels will cause the clip indicator for each bus to 
light up.
If the clip indicators light up for a bus, this indicates actual clipping – digital distortion 
which should always be avoided.

If the clip indicator lights up for an output channel, reset the clip indicator 
by clicking on it, and lower the level until the indicator doesn’t light up.
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Using Solo and Mute

The Mute (top) and Solo buttons.

You can use the Mute and Solo buttons to silence one or several 
channels. The following applies:

• The Mute button silences the selected channel.
Clicking the Mute button again un-mutes the channel. Several channels can be muted 
simultaneously. A muted channel is indicated by a lit Mute button, and also by the lit 
Global Mute indicator on the common panel. 

• Clicking the Solo button for a channel mutes all other channels.
A soloed channel is indicated by a lit Solo button, and also by the lit Global Solo indi-
cator on the common panel. Click the Solo button again to turn off Solo.

• Several channels can be soloed at the same time.
However, if you press [Ctrl]/[Command] and click the Solo button for a channel, any 
other soloed channels will automatically be un-soloed (i.e. this Solo mode is exclusive).

• [Alt]/[Option]-clicking a Solo button activates “Solo Defeat” for that channel.
In this mode (indicated by a red solo button without any other channels being muted) 
the channel will not be muted if you solo another channel (see page 203 for a practical 
use of this). To turn off Solo Defeat, [Alt]/[Option]-click the Solo button again. 

• You can un-mute or un-solo all channels by clicking the Mute or Solo indica-
tor on the common panel.

A muted channel in 
the mixer.

A lit Global Mute indicator on the 
common panel shows that one or 
more channels are muted.
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Setting pan in the mixer

The pan control.

The pan controls in the mixer are used to position a channel between 
the left and right side of the stereo spectrum. For stereo audio chan-
nels, pan controls the balance between the left and right channels.

• To make fine pan adjustments, hold down [Shift] when you move the 
pan control.

• To select center pan position, hold down [Ctrl]/[Command] and click 
on the pan control.

• For MIDI channels, the pan control sends out MIDI pan messages.
The result depends on how your MIDI instrument is set to respond to pan – check your 
documentation for details.

About the “Stereo Pan Law” Preference (audio channels only)

In the Project Setup dialog there is a pop-up menu named “Stereo 
Pan Law”, on which you can select one of three pan settings. This is 
all related to the fact that without power compensation, the power of 
the sum of the left and right side will be higher (louder) if a channel is 
panned center than if it’s panned left or right. 

To remedy this, the Stereo Pan Law setting allows you to attenuate 
signals panned center, by -6, -4.5 or -3dB (default). Selecting the 
0dB option effectively turns off “constant-power panning”. Experiment 
with the different settings to see which fits best in a given situation.
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Audio specific procedures

This section describes the options and basic procedures regarding 
audio channels in the mixer.

Using channel settings 

For each audio channel strip in the mixer (and in the Inspector and 
Track list for each audio track) there is an Edit button (“e”).

Clicking this opens the VST Audio Channel Settings window. This 
window contains a simplified common panel, a duplicate of the mixer 
channel strip, a section with five insert effect slots (see page 190), 
four EQ modules and an associated EQ curve display (see page 170) 
and a section with eight effect sends (see page 198). Every channel 
has its own channel settings (although you can view each in the same 
window if you like – see below).

Click the Edit button to open 
the Channel Settings window:
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The Channel Settings window is used for the following operations:

• Apply equalization, see page 170.
• Apply send effects, see page 195.
• Apply insert effects, see page 190.
• Copy channel settings and apply them to another channel, see page 175.

All channel settings are applied to both sides of a stereo channel.

Changing channels in the Channel Settings window

You can view any channel’s settings from a single window. 

If the option “Mixer Selection Follows Project” is activated in the Pref-
erences dialog (Editing page), this can be done “automatically”:

• Open the Channel Settings window for a track and position it so that 
you can see both the Project window and the Channel Settings 
window.

Selecting a track in the Project window automatically selects the corre-
sponding channel in the mixer (and vice versa). If a Channel Settings 
window is open, this will immediately switch to show the settings for 
the selected channel. This allows you to have a single Channel Settings 
window open in a convenient position on the screen, and use this for all 
your EQ and channel effect settings.

You can also select a channel manually (thereby changing what is 
shown in the open Channel Settings window). 
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Proceed as follows:

1. Open the Channel Settings window for any channel.

2. Open the Channel Select pop-up menu on the common panel.

3. Select a channel from the pop-up to show the settings for that chan-
nel in the open Channel Settings window.

• Alternatively, you can select a channel in the mixer by clicking the strip 
at the bottom of the channel strip (above the channel name).
This selects the channel, and the Channel Settings window will be updated.

• To open several Channel Settings windows at the same time, press 
[Alt]/[Option] and click the Edit buttons for the respective channels.

Making EQ settings

Each audio channel in Cubase SE has a built-in parametric equalizer 
with up to four bands. There are several ways to view and adjust the 
EQs:

• By selecting the “Equalizers” or “Equalizer Curve” tab in the Inspector.
The “Equalizer Curve” section shows a display in which you can “draw” an EQ curve. 
Setting EQ in the Inspector is only possible for track-based audio channels (not for 
ReWire channels).

• By using the Channel Settings window.
This offers both parameter dials and a clickable curve display and also lets you store 
and recall EQ presets.
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Below we describe how to set up EQ in the Channel Settings window, 
but the parameters are the same in the Inspector (apart from the pre-
sets and reset function).

In the Channel Settings window you find the EQ section in the middle 
(or to the right, if you are making settings for an FX channel track). The 
section consists of four EQ modules with parameter dials, an EQ 
curve display and some additional functions at the top.

Using the parameter dials

1. Activate an EQ module by clicking its power button.
Although the modules are labeled “lo”, “lo mid” and so on, they all have the same fre-
quency range (20Hz to 20kHz). The only difference between the modules is that the 
“lo” and “hi” bands can act as shelving or high/low-pass filters (described below).

2. Set the desired frequency with the outer ring of the parameter dial.
This is the center frequency of the frequency range to be cut or boosted.

3. Set the amount of cut or boost with the gain control – the inner para-
meter dial.
The range is ± 24 dB.

4. Set the Q value with the lower dial.
This determines the width of the affected frequency range. Higher values give narrower 
frequency ranges.
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• If you set the Q value for the “lo” EQ module to minimum, it will act as 
a low shelving filter.
If you set it to its maximum value, it will act as a high-pass filter.

• If you set the Q value for the “hi” EQ module to minimum, it will act as 
a high shelving filter.
If you set it to its maximum value, it will act as a low-pass filter.

5. If needed, you can activate and make settings for up to four modules.
Note that you can edit the values numerically as well, by clicking in a value field and en-
tering the desired gain, frequency or Q value.

Using the curve display

When you activate EQ modules and make settings with the parameter 
dials you will see that your settings are automatically reflected in the 
curve display above. You can also make settings directly in the curve 
(or combine the two methods any way you like):

1. To activate an EQ module, click in the curve display.
This adds a curve point and one of the modules below are activated.

2. Make EQ settings by dragging the curve point in the display.
This allows you to adjust gain (drag up or down) and frequency (drag left or right).

3. To set the Q parameter, press [Shift] and drag the curve point up or 
down.
You will see the EQ curve become wider or narrower as you drag.

• You can also restrict the editing by pressing [Ctrl]/[Command] (sets 
gain only) or [Alt]/[Option] (sets frequency only) while you drag the 
curve point.

4. To activate another EQ module, click somewhere else in the display 
and proceed as above.

5. To turn off an EQ module, double click its curve point or drag it out-
side the display.

EQ reset (Channel Settings window only)

To the right above the EQ curve display in the Channel Settings win-
dow you will find a reset button. Clicking this will turn off all EQ mod-
ules and reset all EQ parameters to their default values.
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EQ bypass

Whenever one or several EQ modules are activated for a channel, the 
EQ button will light up in green in the mixer channel strip, Inspector 
(Equalizer and Channel sections), Track list and Channel Settings 
window (top right corner of the EQ section).

Clicking the EQ button will bypass all EQ modules for the channel, al-
lowing you to compare the sound with and without EQ. When the EQ 
is in Bypass mode, the EQ button is yellow.

Using EQ presets (Channel Settings window only)

Some useful basic presets are included with the program. You can 
use them as they are, or as a starting point for further “tweaking”. 

• To call up a preset, pull down the presets pop-up menu above the EQ 
curve display and select one of the available presets.

• To store the current EQ settings as a preset, click the store button 
(plus sign) to the left of the presets field.
The settings are stored with the default name “Preset” and a number. To rename a pre-
set, double click in the preset pop-up field and enter a new name.

• To remove a preset, select it and click the remove (minus sign) button.
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EQ in the channel overview

If the “Channel” section is selected in the Inspector, you will get an 
overview of which EQ modules, insert effects and effect sends are 
activated for the channel.

By clicking the “hi”, “hi mid”, “lo mid” or “lo” indicator, you can turn the 
corresponding EQ module on or off.

The channel overview in the Inspector.
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Copying settings between audio channels

It is possible to copy all channel settings for an audio channel and 
paste them onto another channel. This applies to all audio channel 
types. For example, you can copy EQ settings from an audio track and 
apply these to a group or VST Instrument channel, if you want them to 
have the same sound. Proceed as follows:

1. Select the channel you want to copy settings from by clicking the nar-
row horizontal strip just above the channel name field (or just above 
the pan control). A selected channel is indicated by these two fields 
being highlighted.
You can also select channels with the Channel Select pop-up menu – see page 169.

Selecting a channel in the channel strip (left), and in the common panel (right).

2. Click the “Copy” button in the common panel.

3. Select the channel you want to copy the settings to and click the 
Paste button.
The settings are applied to the selected channel.

4. To copy the same settings to several channels, repeat step 3.
The copied settings are retained in memory until you copy new channel settings, or 
close the project.

Channel settings can be copied from stereo channels and pasted to 
mono channels and vice versa.
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Output channels do not have sends, but channel settings can still be 
copied to/from other audio channel types. When copying from an output 
or effect channel, any send settings in the channel you paste into are 
unaffected.

Initialize Channel and Reset Mixer

The Initialize Channel button can be found at the bottom of the Chan-
nel Settings common panel. It resets the selected channel to the de-
fault settings. Similarly, the mixer common panel holds a Reset Mixer 
button – when you click this you will be asked whether to reset all 
channels or just the selected channel.

Default settings are:

• All EQ, Insert and Send effect settings are deactivated and reset.
• Solo/Mute is deactivated.
• The fader is set to 0dB.
• Pan is set to center position.

Changing the meter characteristics 

On the Mixer context menu, opened by right-clicking (Win) or [Ctrl]-
clicking (Mac) anywhere on the mixer panel, there is a submenu named 
“Global Meter Settings”, allowing you to adjust the meter characteris-
tics in the following way:

• If “Fast Release” is activated, the meters respond very quickly to level 
peaks.
If “Fast Release” is deactivated, the meters respond more like standard meters.
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Using group channels

You can route the outputs from multiple audio channels to a group. 
This enables you to control the channel levels using one fader, apply 
the same effects and equalization to all of them etc. To create a group 
channel, proceed as follows:

1. Select Add Track from the Project menu and select “Group Channel” 
from the submenu that appears.

2. Select the desired channel configuration and click OK.
A group channel track is added to the Track list and a corresponding group channel 
strip is added to the mixer. By default the first group channel strip is labeled “Group 1”, 
but you can rename it just like any channel in the mixer.

3. Pull down the Output routing pop-up for a channel you want to route 
to the group channel, and select the group channel.
The output of the audio channel is now redirected to the selected group.

4. Do the same for the other channels you wish to route to the group.

Settings for group channels

The group channel strips are (almost) identical to audio channel strips 
in the mixer. The descriptions of the mixer features earlier in this chap-
ter apply to group channels as well. Some things to note:

• You can route the output of a group to an output bus or to another 
group with a higher number.
You cannot route a group to itself. Routing is done with the Output Routing pop-up 
menu in the Inspector (select an automation track for the Group in the Track list).

• There are no input routing pop-ups, monitor buttons or record enable 
buttons for group channels.
This is because inputs are never connected directly to a group.

• Solo functionality is automatically linked for a channel routed to a 
group and the group channel itself.
This means that if you solo a group channel, all channels routed to the group are auto-
matically soloed as well. Similarly, soloing a channel routed to a group will automati-
cally solo the group channel.
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• Mute functionality depends on the setting “Group Channels: Mute 
Sources as well” in the Preferences dialog. 
By default, when you mute a group channel no audio will pass through the group. How-
ever, other channels that are routed directly to that group channel will remain unmuted. If 
any of those channels have aux sends routed to other group channels, FX channels or 
output busses, those will still be heard. 

If the option “Group Channels: Mute Sources as well” is activated in 
the Preferences dialog (VST page) muting a group channel will cause 
all other channels directly routed to it to be muted as well. Pressing 
mute again will unmute the group channel and all other channels di-
rectly routed to it. Channels that were muted prior to the group channel 
being muted will not remember their mute status and will be unmuted 
when the group channel is unmuted.

The option “Group Channels: Mute Sources as well” does not affect how 
mute automation is written. Writing mute automation on a group channel 
only affects the group channel and not channels routed to it. When writ-
ing the automation you will see the other channels being muted when 
this option is checked. However, upon playback, only the group channel 
will respond to the automation.

One application of group channels is to use them as “effect racks” – 
see page 194.
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About output busses

As described in the Getting Started book, Cubase SE uses a system 
of input and output busses which are set up using the VST Connec-
tions window . This is described in the chapter “VST Connections: 
Setting up input and output busses”.

Output busses let you route audio from the program to the outputs on 
your audio hardware. 

Routing audio channels to busses

To route the output of an audio channel to one of the active busses, 
proceed as follows:

1. In the Project window, select the desired audio track.

2. In the Inspector for the audio track, open the topmost tab.
If another tab is shown in the Inspector, just click on the track name in the top section 
of the inspector to display the tab with the input/output settings.

3. Pull down the output routing pop-up menu (“out:”) and select one of 
the busses.
This pop-up menu contains the output busses configured in the VST Connections 
window, as well as available group channels.

Viewing the output busses in the mixer

Output busses are shown as output channels in a separate pane to 
the right in the mixer. You show or hide this pane by clicking the Hide 
Output Channels button in the mixer’s common panel to the left:

Each output channel resembles a regular audio channel strip. Here 
you can do the following:

• Adjust master levels for all configured output busses using the level faders.
• Add effects or EQ to the output channels (see page 193).
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MIDI specific procedures

This section describes basic procedures for MIDI channels in the mixer.

Using Channel Settings

For each MIDI channel strip in the mixer (and MIDI track in the Track 
list or the Inspector) there is an Edit (“e”) button. 

Clicking this opens the MIDI Channel Settings window. This window 
contains a duplicate of the mixer channel strip, a section with two MIDI 
inserts and a section with two MIDI send effects. Every MIDI channel 
has its own channel settings.

The MIDI Channel Settings window.
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Utilities

Link/Unlink channels

This function is used to “link” selected channels in the mixer so that 
any change applied to one channel will be mirrored by all channels in 
that group. You can link as many channels as you like, and you can 
also create as many groups of linked channels as you like. To link 
channels in the mixer, proceed as follows:

1. Press [Ctrl]/[Command] and click on the strip just above the name 
field for all the channels that you want to link.
There is an identical select channel field just above the pan control. Selected channels 
are indicated by highlighted select fields. [Shift]-clicking allows you to select a continu-
ous range of channels.

2. Right-click (Win) or [Ctrl]-click (Mac) somewhere on the grey mixer 
panel.
The Mixer context menu appears.

3. Select “Link Channels” from the context menu.

• To unlink channels, select one of the linked channels and select “Unlink 
Channels” from the Mixer context menu.
The channels are unlinked. Note that you do not need to select all the channels that are 
linked, only one of them.

• It is not possible to remove individual channels from Link status. 
To make individual settings to a linked channel, press [Alt]/[Option] when changing the 
setting.
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What will be linked?

The following rules apply for linked channels:

• Fader levels will be “ganged”.
The relative level offset between channels will be kept if you move a linked channel 
fader.

The three channels shown are linked. Pulling down one fader changes the levels for 
all three channels, but keeps the relative level mix.

• Any individual channel settings you have made before linking will re-
main until you alter the same setting for any of the linked channels.
For example, if you link three channels, and one of them was muted at the time you ap-
plied the Link Channel function, this channel will remain muted after linking. However, 
if you mute another channel then all linked channels will be muted. Thus, the individual 
setting for one channel is lost as soon as you change the same parameter setting for 
any of the linked channels.

• Only level, mute, solo, select, monitor and record enable will be linked 
between channels.
Effect/EQ and pan settings are not linked.

• By pressing [Alt]/[Option], you can make individual settings and 
changes for channels that are linked.

Linked channels can also have individual automation subtracks. These 
are completely independent, and are not affected by the Link function.
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Saving mixer settings

Saving/Loading mixer settings does not apply to MIDI channels in the 
mixer – only audio related channels (group, audio, effect return, VSTi 
and ReWire) are saved with this function!

It is possible to save complete mixer settings for selected or all audio 
channels in the mixer. These can later be loaded into any project. Chan-
nel settings are saved as mixer settings files. These have the Windows 
file extension “.vmx”. 

Right-clicking (Win) or [Ctrl]-clicking (Mac) somewhere on the mixer 
panel or in the Channel Settings window brings up the Mixer context 
menu where four Save/Load items can be found. The following options 
are available:

• “Save Selected Channels” will save all channel settings for the selected 
channels.

• “Save All Mixer Settings” saves all channel settings for all channels.

When you select any of the above options, a standard file dialog 
opens where you can select a name and storage location on your disk 
for the file.
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Loading mixer settings 

Load Selected Channels

To load mixer settings saved for selected channels, proceed as follows:

1. Select the same number of channels in the new project to match the 
number of channels you saved settings for in the previous project.
For example, if you saved settings for six channels, then select six channels in the mixer.

• Mixer settings will be applied in the same order as they appear in the 
mixer, when saved. 
Thus, if you save settings from channels 4, 6 and 8 and apply these settings to chan-
nels 1, 2 and 3, the settings saved for channel 4 would be applied to channel 1, the 
settings saved for channel 6 to channel 2 and so on.

2. Right-click (Win) or [Ctrl]-click (Mac) the mixer panel to open the 
context menu, and select “Load Selected Channels”.
A standard file dialog appears, where you can locate the saved file.

3. Select the file and click “Open”.
The channel settings are applied to the selected channels.

If you choose to apply mixer settings to fewer channels than you saved, 
the order of the saved channels in the mixer applies – i.e. the saved 
channels that are “left over” and not applied will be the channels with 
the highest channel numbers (or furthest to the right in the mixer).

Load All Mixer Settings

Selecting “Load All Mixer Settings” from the context menu allows you 
to open a saved mixer settings file, and have the stored settings ap-
plied to all channels for which there is information included in the file. 
All channels, master settings, VST Instruments, sends and master ef-
fects will be affected.

• Please note that if the saved mixer settings were 24 channels, and the 
mixer you apply it to currently contains 16 channels, only the settings for 
channels 1 to 16 will be applied – this function will not automatically add 
channels.
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About the VST Performance window

The VST Performance window is opened by selecting it from the De-
vices menu. It indicates the current load on the CPU and the hard disk 
transfer rate. It is recommended that you check this from time to time, 
or keep it open always. Even though you have been able to activate a 
number of audio channels in the project without getting any warning, 
you may possibly run into performance problems when adding EQ or 
effects.

• The upper bar graph shows the CPU (processor) load.
If the red Overload indicator lights up, you need to decrease the number of EQ mod-
ules, active effects and/or audio channels playing back simultaneously.

• The lower bar graph shows the hard disk transfer load.
If the red overload indicator lights up, the hard disk is not supplying data fast enough to 
the computer. You may need to reduce the number of tracks playing back by using the 
Disable Track function (see page 29). If this doesn’t help, you need a faster hard disk. 
Note that the overload indicator may occasionally blink, typically when you locate dur-
ing playback. This does not indicate a problem, but happens because the program 
needs an instant for all channels to load data for the new playback position.

• The CPU and Disk load meters can also be shown on the Transport 
panel and on the Project window toolbar.
There they are shown as two miniature vertical meters (by default at the left side of the 
panel/toolbar).
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About this chapter

Cubase SE comes with a number of effect plug-ins included. This 
chapter contains general details about how to assign, use and orga-
nize effect plug-ins. The effects and their parameters are described in 
the separate pdf document “Audio Effects and VST Instruments”.

This chapter describes audio effects, i.e. effects that are used to process 
audio, group, VST Instrument and ReWire channels. For info on how to 
use MIDI effects, see page 352.

Overview

There are two ways to use audio effects in Cubase SE:

• As insert effects.
An insert effect is inserted into the signal chain of an audio channel, which means that 
the whole channel signal passes through the effect. This makes inserts suitable for ef-
fects for which you don’t need to mix dry and wet sound, e.g. distortion, filters or other 
effects that change the tonal or dynamic characteristics of the sound. You can have up 
to five different insert effects per channel. 

• As send effects.
Each audio channel has eight effect sends, each of which can be freely routed to an ef-
fect (or to a chain of effects). Send effects are practical for two reasons: you can control 
the balance between the dry (direct) and wet (processed) sound individually for each 
channel using the sends, and several different audio channels can use the same send ef-
fect. In Cubase SE, send effects are handled by means of FX channel tracks.
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About VST plug-ins and tempo sync

Version 2.0 of the VST plug-in standard (and later) allows plug-ins to 
receive MIDI from the host application (in this case, Cubase SE). A 
typical use for this feature is tempo-based effects (such as delays, 
auto-panning, etc.), but it is also used in other ways for certain plug-ins.

• MIDI timing information is automatically provided to any VST 2.0 plug-
in that “requests it”.
You don’t need to make any special settings for this.

• In many cases you set up tempo sync by specifying a base note value 
and a multiplier. The resulting timing interval is the base note value 
multiplied with the multiplier value.
For example, if you set the base note value to 1/16 (a sixteenth note) and the multiplier 
to 3, the resulting timing is 3/16. In the case of a delay effect, this means the interval 
between each delay repeat will be three sixteenth notes.

• When MIDI receive is available (or necessary) for other purposes than 
timing, the setting up and operation is described in the documentation 
for the corresponding effect.
Please refer to the pdf document “Audio Effects and VST Instruments” for details 
about the included effects.

About plug-in delay compensation

A plug-in effect may have some inherent delay or latency. This means 
that it takes a brief time for the plug-in to process the audio fed into 
it – as a result, the output audio will be slightly delayed. This may hap-
pen with dynamics processors featuring “look-ahead” functions, etc.

However, Cubase SE provides full plug-in delay compensation 
throughout the entire audio path. All plug-in delays are compensated 
for, maintaining the sync and timing of all audio channels.

Normally, you don’t have to make any settings for this. However, in the 
“Plug-In Information” dialog, you can switch off plug-in delay compen-
sation for individual plug-ins by unchecking the corresponding option 
in the “Use Delay Compensation” column (see page 208). Note that 
you have to re-load the plug-in for the change to take effect.

You can also constrain the delay compensation, which is useful to 
avoid latency when recording audio or playing a VST Instrument in 
real time. See page 217.
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Insert effects

Background

As the name implies, insert effects are inserted into the audio signal 
path – this means that the audio will be routed through the effect. You 
can add up to five different insert effects independently for each audio 
channel (audio track, group channel track, FX channel track, VST Instru-
ment channel or ReWire channel) or bus. The signal passes through 
the effects in series from the top downwards, with the signal paths 
shown in this figure:

• Applying insert effects on many channels uses up a lot of CPU power!
It might often be more efficient to use send effects, especially if you want to use the 
same type of effect on several channels. Remember that you can use the VST Perfor-
mance window to keep an eye on the CPU load.

Which effect plug-ins can I use as insert effects?

Most effect plug-ins will work fine as insert effects. In general, the only 
restrictions are with the number of inputs and outputs in the effects:

• For a plug-in to be usable as an insert effect, it has to have at least 1 
or 2 inputs and 1 or 2 outputs.
Different effects feature different amounts of inputs and outputs, but the number of in-
puts and outputs actually used is determined by whether you use the insert effects on 
a single (mono) audio channel or a stereo channel pair.

Insert effect 1

Insert effect 2

Insert effect 3

EQ

Volume (fader)

Insert effect 4

Insert effect 5
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• For stereo audio channels, you need to use an effect with at least two 
inputs (stereo).
It is possible to use a mono-input effect with a stereo channel pair, but then only the 
one channel in the pair will be processed, which is probably not what you want. It is 
also possible to use an effect with more than two inputs of course, since both chan-
nels in the stereo pair will be processed even though the effect actually accommo-
dates more.

• For mono audio channels, you can use mono- or stereo-input effects.
However, since the audio channel is in mono, the output of the effect will also be in 
mono. For stereo output effects, the left channel will then be used.

Routing an audio channel or bus through insert effects

Insert effect settings are available in the Channel Settings window 
and the Inspector (audio tracks, group tracks and FX tracks only). The 
examples below show the Channel Settings window, but the proce-
dures are similar for all sections:

1. Bring up the Channel Settings window or he Inserts section in the In-
spector.
In the Channel Settings window, the inserts are located immediately to the right of the 
channel strip.

2. Pull down the effect type pop-up for one of the insert slots, and select 
an effect.

The effect is loaded and automatically activated and its control panel 
appears. You can hide or show the control panel for the effect by 
clicking the “e” button for the insert slot.



CUBASE SE
10 – 192 Audio effects

• If the effect has a Dry/Wet Mix parameter you can use this to adjust 
the balance between the dry signal and the effect signal.
See page 204 for details about editing effects.

• When one or several insert effects are activated for a channel, the in-
sert effects buttons light up in blue in the mixer and Track list. Click 
the button for a channel to bypass (disable) all its inserts.
When the inserts are bypassed, the buttons are yellow. Click the button again to en-
able the inserts. Note that the bypass button is also available in the Inspector and the 
Channel settings window for the audio track.

• To remove an effect, pull down the effect type pop-up menu and se-
lect “No Effect”.
You should do this for all effects that you don’t intend to use, to minimize unnecessary 
CPU load.

• When you have several insert effects for a channel, you can bypass 
separate effects by clicking the bypass button of the respective slot.
When an effect is bypassed, the button is yellow.

The “Reverb A” insert effect slot is bypassed.
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Insert effects in the channel overview

If the “Channel” section is selected in the Inspector, you will get an 
overview of which EQ modules, insert effects and effect sends are 
activated for the channel.

You can activate or deactivate individual insert effect slots by clicking 
the corresponding number (in the upper half of the overview).

The channel overview in the Inspector.

About adding insert effects to busses

As already stated, all output busses have five insert slots, just like reg-
ular audio channels. The procedures for adding insert effects are the 
same (except that you cannot use the Inspector here).

• Insert effects added to an output bus will affect all audio routed to that 
bus, like a “master insert effect”.
Typically you would add compressors, limiters, EQ or other plug-ins to tailor the dynam-
ics and sound of the final mix.
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Using group channels for insert effects

Like all other channels, group channels can have up to five insert ef-
fects. This is useful if you have several audio tracks that you want to 
process through the same effect (e.g. different vocal tracks that all 
should be processed by the same compressor). Another special use 
for group channels and effects is the following:

If you have a mono audio track and want to process this through a ste-
reo insert effect (e.g. a stereo chorus or an auto panner device), you 
cannot just insert the effect as usual. This is because the audio track 
is in mono – the output of the insert effect will then be in mono as well, 
and the stereo information from the effect will be lost.

One solution would be to route a send from the mono track to a stereo 
fx channel track, set the send to pre fader mode and lower the fader 
completely for the mono audio track. However, this makes mixing the 
track cumbersome, since you cannot use the fader. Here’s another 
solution:

1. Create a group channel track in stereo and route it to the desired out-
put bus.

2. Add the desired effect to the group channel as an insert effect.

3. Route the mono audio track to the group channel.

Now the signal from the mono audio track is sent directly to the group, 
where it passes through the insert effect, in stereo.
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Send effects

Background

Send effects are handled through FX channel tracks. These are spe-
cial tracks that each can contain up to five insert effects. The signal 
path is as follows:

• By routing an effect send from an audio track to an FX channel track, 
the audio is sent to the FX channel and through its insert effect(s).
Each audio channel has eight sends, which can be routed to different FX channels. You 
control the amount of signal sent to the FX channel by adjusting the effect send level.

• If you have added several effects to the FX channel, the signal passes 
through the effects in series, from the top (the first slot) downward.
This allows for “custom” send effect configurations – you could e.g. have a chorus fol-
lowed by a reverb followed by an EQ and so on.

• The FX channel track has its own channel strip in the mixer, the effect 
return channel.
Here you can adjust the effect return level and balance, add EQ and route the effect 
return to any output bus.

• Each FX channel track has an automation subtrack, for automating 
various effect parameters. 
See page 233 for information.
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Setting up send effects

Adding an FX channel track

1. Pull down the Project menu and select “FX Channel” from the “Add 
Track” submenu.
A dialog appears.

2. Select a channel configuration for the FX channel track.
Normally, stereo is a good choice since most effect plug-ins have stereo outputs.

3. Select an effect for the FX channel track.
This is not strictly necessary at this point – you can leave the Plug-in pop-up menu set 
to “No Effect” and add effects to the FX channel later if you like.

4. Click OK.
An FX channel track is added to the Track list, and the selected effect, if any, is loaded 
into the first insert effect slot for the FX channel (in that case, the lit Inserts tab for the 
FX channel track in the Inspector indicates that an effect has been assigned and auto-
matically activated).

• All FX channel tracks you create will appear in a kind of “folder” in the 
Track list.
This makes it easy to manage and keep track of all your FX channel tracks, and also al-
lows you to save screen space by folding the FX Channel folder.

FX channel tracks are automatically named “FX 1”, “FX 2” etc., but you can rename 
them if you wish. Just double click the name of an FX channel track in either the 
Track list or the Inspector and type in a new name.
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Adding and setting up effects

As mentioned above, you can add a single insert effect when you cre-
ate the FX channel track if you like. To add and set up effects after the 
FX channel track is created, you can either use the Inspector for the 
track (click the Inserts tab) or the FX Settings window:

1. Make sure the FX channel is routed to the correct output bus.
This is done with the output routing pop-up menu in the Inspector.

2. Click the Edit (“e”) button for the FX channel.
The FX Settings window appears, similar to a regular Channel Settings window.

To the left in the window is the Inserts section with five effect slots.

3. To add an insert effect in an empty slot (or replace the current effect in 
a slot), click on the slot and select an effect from the pop-up menu.
This works just like when selecting insert effects for a regular audio channel.

4. When you add an effect, its control panel will automatically appear. 
Typically you should set the Wet/Dry Mix control to all “wet”.
This is because you control the balance between wet and dry signal with the effect 
sends. For more about making settings in the effect control panels, see page 204.
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• If you like, you can add up to five effects for the FX channel.
Note that the signal will pass through all the effects in series. It is not possible to adjust 
the effect send- and return levels separately for each effect – this is done for the FX 
channel as a whole. If what you want is several separate send effects (where you can 
control their send and return levels independently) you should instead add more FX 
channel tracks – one for each effect.

• To remove an insert effect from a slot, click the slot and select “No 
Effect” from the pop-up menu.
You should do this for all effects that you don’t intend to use, to minimize unnecessary 
CPU load.

• You can also bypass individual effects (or all effects) by clicking the 
corresponding Bypass Inserts button(s) for the FX channel track.
See page 191.

• You can also adjust level, pan and EQ for the effect return in this 
window.
As always, this can also be done in the mixer or in the Inspector.

• Remember that effects rely heavily on the CPU power in your computer. 
The more activated effect units, the more computer power will be used for effects.

Setting up the sends

The next step is to set up and route a send for an audio channel to the 
FX channel. This can be done in the Channel Settings window or in the 
Inspector for the audio track. The example below shows the Channel 
Settings window, but the procedure is similar for all sections:

1. Click the “e” button for an audio channel to bring up its Channel Set-
tings window.
In the Inspector, you would click the Sends tab.

In the channel settings window, the send section is located to the far 
right. Each of the eight sends has the following controls and options:

• A send on/off switch
• A send level slider
• A pre/post fader switch
• An Edit button
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2. Pull down the routing pop-up menu for a send by clicking in the empty 
slot, and select the desired routing destination.

• If the first item on this menu, “No Bus” is selected, the send isn’t routed any-
where.

• Items called “FX 1”, “FX 2” etc. correspond to existing FX tracks. If you have 
renamed an FX track (see page 196) that name will appear on this menu in-
stead of the default.

• The menu also allows for routing a send directly to output busses, separate 
output bus channels or Group channels.

3. In this case, select an FX channel track from the pop-up menu.
Now the send is routed to the FX channel.

4. Click the power button for the effect send so that it lights up in blue.
This activates the send.
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5. Click and drag the send level slider to a moderate value.
The send level determines how much of the signal from the audio channel is routed to 
the FX channel via the send.

Setting the Send level.

6. If you want the signal to be sent to the FX channel before the audio 
channel’s volume fader in the mixer, click on the Pre Fader button for 
the send so that it lights up.
Normally you want the effect send to be proportional to the channel volume (post fader 
send). The pictures below show where the sends are “tapped” from the signal in pre 
and post fader mode:

A send set to pre fader mode.

• You can choose whether a send in pre fader mode should be affected 
by the channel’s Mute button or not.
This is done with the option “Mute Pre-Send when Mute” in the Preferences (VST page).

Insert effects 1-5

EQ

Volume (fader)

Pre-fader sends

Post-fader sends
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• When one or several sends are activated for a channel, the Send 
Effects buttons light up in blue in the mixer and the Track list. Click the 
button for a channel to bypass (disable) all its effect sends.
When the sends are bypassed, the button is yellow. Click the button again to enable 
the sends. Note that this button is also available in the Inspector and the Channel set-
tings window.

Click this button to bypass the sends.

• You can also bypass individual sends in the channel overview.
See page 193.

• Alternatively, in the same manner you can bypass the send effects by 
clicking the “Bypass Inserts” button for the FX channel.
The difference is that this bypasses the actual send effects which may be used by sev-
eral different channels. Bypassing a send affects that send and that channel only.
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Setting effect levels

After you have set up the sends as described in the previous sections, 
the following is now possible:

• You can use the send level slider in the Channel Settings or the Inspec-
tor to set the send level.
By adjusting the send level you control the amount of signal sent from the audio chan-
nel to the FX channel.

Setting the effect send level.

• In the mixer, you can use the level fader for the FX channel to set the 
effect return level.
By adjusting the return level you control the amount of the signal sent from the FX 
channel to the output bus.

Setting the effect return level.



CUBASE SE
Audio effects 10 – 203

FX channels and the Solo Defeat function

When mixing, you might sometimes want to solo specific audio chan-
nels, and listen only to these while other channels are muted. How-
ever, this will mute all FX channels as well. If the soloed audio channels 
have sends routed to FX channels, this means you won’t hear the send 
effects for the channels.

To remedy this, you can use the Solo Defeat function for the FX chan-
nel:

1. First press [Alt]/[Option] and click on the Solo button for the FX 
channel.
This activates the Solo Defeat function for the FX channel. In this mode, the FX channel 
will not be muted if you solo another channel in the mixer.

2. You can now solo any of the audio channels without having the effect 
return (the FX channel) muted.

3. To turn off the Solo Defeat function for the FX channel, [Alt]/[Option]-
click the Solo button for the FX channel again.
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Making settings for the effects

Selecting effect presets

Most VST effect plug-ins come with a number of useful presets for in-
stant selection. You can select presets in the control panel for the ef-
fect.

Editing effects

All inserts and sends have an Edit (“e”) button. Clicking this opens the 
selected effect’s control panel in which you can make parameter set-
tings.

The contents, design and layout of the control panel depends on the 
selected effect. However, all effect control panels have a power but-
ton, a Bypass button, Read/Write automation buttons (for automating 
effect parameter changes – see page 233), a preset selection pop-up 
menu and a file pop-up menu for saving or loading programs. In Cu-
base SE for Mac OS X these are located at the bottom of the control 
panel, whereas they are at the top of the control panel in Cubase SE 
under Windows.

The Rotary effect control panel.
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• Please note that all effects can be edited using a simplified control 
panel (horizontal sliders only, no graphics) if you prefer this. To edit 
effects using this “basic” control panel instead, press [Ctrl]/[Com-
mand]+[Shift] and click on the Edit button for the effect send or slot.

Making settings

Effect control panels may have any combination of knobs, sliders, but-
tons and graphic curves. 

• For specifics about the included effects and their parameters, please re-
fer to the separate pdf document “Audio Effects and VST Instruments”. 

Naming effects

If you edit the parameters for an effect, these settings are saved auto-
matically in the project. If you want to name the current settings, the 
following points apply:

• The basis for the current settings may have been a preset effect program, in 
which case there is a name in the preset field.

• The basis for the current settings may have been a default setting program 
location in which case “Default” is displayed in the preset field.

In both cases, if you have changed any effect parameter settings, 
these are already saved! To name the current settings, click the Name 
field, type in a new name and press [Return]. The new name replaces 
the previous name on the program pop-up menu.

Saving effects

You can save your edited effects for further use (e.g. in other projects) 
by using the file pop-up menu to the right of the name field.

1. Pull down the file pop-up menu.

• If you want to save the current program only, select “Save Effect”.
Effect programs have the Windows file extension “fxp”.

• If you want to save all programs for the effect, select “Save Bank”.
Effect banks have the Windows file extension “fxb”.

2. In the file dialog that appears, select a name and location for the file 
and click Save.
It might be a good idea to prepare a special folder for your effects.
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Loading effects

1. Pull down the file pop-up menu.

2. Select “Load Effect” or “Load Bank”.

3. In the file dialog that opens, locate the file and click Open.
If you loaded a Bank, it will replace the current set of all effect programs. If you loaded 
a single effect, it will replace the currently selected effect program only.

Automating effect parameters

Effects parameters can be automated – see the chapter “Automation”.

Installing and managing effect plug-ins

There is a wide range of additional effect plug-ins available in the two 
formats supported by Cubase SE (VST and DirectX). The two formats 
are handled differently when it comes to installation and organizing:

VST plug-ins

Mac OS X

Plug-ins in Mac OS 9.X format cannot be used.

There is a large number of VST plug-ins available for purchase or 
download. To install a VST plug-in under Mac OS X, quit Cubase SE 
and drag the plug-in file to one of the following folders:

• /Library/Audio/Plug-Ins/VST/
This is only possible if you are the system administrator. Plug-ins installed in this folder 
will be available to all users, for all programs that support them.

• Users/Username/Library/Audio/Plug-Ins/VST/
“Username” above is the name you use to log on to the computer (the easiest way to 
open this folder is to go to your “Home” folder and use the path /Library/Audio/Plug-
Ins/VST/ from there). Plug-ins installed in this folder are only available to you.

When you launch Cubase SE again, the new effects will appear on 
the effect pop-up menus.
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• An effect plug-in may also come with its own installation application, in 
which case you should use this.
Generally, always read the documentation or readme files before installing new plug-ins.

Windows

Under Windows, VST plug-ins are usually installed simply by drag-
ging the files (with the extension “.dll”) into the Vstplugins folder in the 
Cubase SE application folder, or into the Shared VST Plug-in folder – 
see below. When you launch Cubase SE again, the new effects will 
appear on the Effect pop-up menus.

• If the effect plug-in comes with its own installation application, you 
should use this.
Generally, always read the documentation before installing new plug-ins.

Organizing VST plug-ins

If you have a large number of VST plug-ins, having them all on a single 
pop-up menu in the program may become unmanageable. For this rea-
son, the plug-ins installed with Cubase SE are placed in appropriate 
subfolders according to the effect type.

• Under Windows, you can rearrange this by moving, adding or renam-
ing subfolders within the Vstplugins folder if you like. 
When you launch the program and pull down an Effects pop-up menu, the subfolders 
will be represented by hierarchical submenus, each listing the plug-ins in the corre-
sponding subfolder.

• Under Mac OS X, you cannot change the hierarchic arrangement of 
the “built-in” VST plug-ins.
You can however arrange any additional plug-ins you have installed (in the /Library/
Audio/Plug-Ins/VST/ folders, see above) by placing them in subfolders. In the program, 
the subfolders will be represented by hierarchical submenus, each listing the plug-ins in 
the corresponding subfolder.
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About shared VST plug-ins (Windows only)

While Cubase SE’s own plug-ins reside in the Vstplugins folder within 
the Cubase SE program folder, the program can also access plug-ins 
in an additional location, called the shared VST plug-ins folder. This lets 
you use plug-ins installed by other VST compatible applications, etc. 
You can change what folder is considered the “shared” Vstplugins 
folder at any time in the Plug-in Information window, see page 208.

DirectX plug-ins (Windows only)

To be able to use DirectX plug-ins, you must have Microsoft DirectX 
installed on your computer (Version 8.1 – or later – recommended 
and included on the Cubase SE DVD). 

DirectX plug-ins should not be placed in the Vstplugins folder, as 
these are installed under the operating system rather than for Cubase 
SE exclusively. Rather, you should follow the installation instructions 
included with the plug-ins. See also page 211.

• On the effect menus, all DirectX plug-ins are listed on the DirectX sub-
menu. 
Selecting, activating and editing them is done as with VST effects.

The Plug-in Information window

On the Devices menu, you will find an item called “Plug-in Informa-
tion”. Selecting this opens a dialog listing all the available VST and Di-
rectX compatible plug-ins in your system (including VST Instruments), 
along with all MIDI plug-ins. The plug-ins are described in the sepa-
rate pdf document “MIDI devices and features”.

Managing and selecting VST plug-ins

To see which VST plug-ins are available in your system, click the “VST 
Plug-ins” tab at the top of the window. The window now displays all 
plug-ins in the Cubase SE and the shared Vstplugins folder. 

• The plug-ins are color-coded to help you find plug-ins of a specific type - 
refer to the color fields at the top of the window.

• To enable a plug-in (make it available for selection), click in the left column.
Only the currently enabled plug-ins (shown with a check sign in the left column) will 
appear on the effect menus.



CUBASE SE
Audio effects 10 – 209

• The second column indicates how many instances of the plug-in are currently 
used in Cubase SE.
Clicking in this column for a plug-in which is already in use produces a pop-up show-
ing exactly where each use occurs - select an instance to open the control panel for 
the plug-in. 

• Plug-ins which crash when you try to start them, will be marked as "unload-
able" in the VST plugin window and skipped at the next start.
These plug-ins can be activated again in the VST plug-in window.

• If you activate the “Show used only” checkbox, only the plug-ins that are used 
will be shown in the list.

• A plug-in may be in use even if it isn’t enabled in the left column. 
You might for example have opened a project containing effects that currently are dis-
abled on the menu. The left column purely determines whether or not the plug-in will 
be visible on the effect menus.

• All columns can be resized by using the divider in the column header.

The other columns show the following information about each plug-in:

Column Description

Name The name of the plug-in.

Nb I/O This column shows the number of inputs and outputs for each plug-in.

Category This indicates the category of each plug-in.

Vendor The manufacturer of the plug-in.

VST Version Shows with which version of the VST protocol a plug-in is compatible.

Delay (sample) This shows the delay (in samples) that will be introduced if the effect is 
used as an Insert. This is automatically compensated for by Cubase SE.

Use Delay 
Compensation

This option (checked by default) means that plug-in delay compensa-
tion is used for this plug-in (see page 189). Note that you can tempo-
rarily constrain delay compensation - see page 217.

Nb Params The number of parameters for the plug-in.

Nb Programs The number of programs for the plug-in.

Old Host 
Behaviour

Check this column for a specific plug-in if you want it to be processed 
like it was by previous versions of Cubase SE, to avoid problems such 
as feedback-like sounds. Note that you have to reload the plug-in for 
the change to take effect. 
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Update Button

Pressing this button will make Cubase SE re-scan the designated 
Vstplugins folders for updated information about the plug-ins.

Export List button

• If you click this button, a text file with the plug-in info is generated.
This document could be useful if you need to contact Steinberg Technical Support – 
or you might want to use it just as a handy reference of the installed effects.

Changing the Shared Plug-ins Folder (Windows only)

If you like, you can change what folder is to be the “shared” Vstplugins 
folder. For example, if you have Steinberg’s Cubase VST 5.1 installed 
on your computer, you can get access to the Cubase VST 5.1-specific 
plug-ins in Cubase SE by switching to the Vstplugins folder within the 
Cubase VST 5.1 folder.

The currently selected Shared Folder is displayed in the text field at the 
top of the window. Clicking the “Change...” button opens a file dialog 
where you can browse to another Vstplugins folder on your hard drive. 
Clicking OK selects the new folder as the shared VST plug-ins folder.

After selecting a new shared plug-ins folder, you will first be prompted 
to confirm your choice, and you will then need to restart Cubase SE for 
the effects in the new folder to become available.

Modified The last modification date of the plug-in file.

Path The path and name of the folder in which the plug-in file is located.

Column Description
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• Similarly, you can also add additional Shared Plug-ins folders by click-
ing the “Add” button and browsing to another Vstplugins folder on 
your hard drive.
If you have several folders assigned as Shared Plug-ins Folders, you can at any time 
use the text field pop-up menu to decide which of the assigned folders should be the 
designated active one.

• To remove a Shared Plug-ins Folder, select it and click the “Remove” 
button.

Managing and selecting DirectX plug-ins (Windows only)

To see which DirectX plug-ins are available in your system, click the 
“DirectX Plug-ins” tab at the top of the window.

• To enable a plug-in (make it available for selection), click in the left-
most column.
Only the currently enabled plug-ins (shown with a check sign in the left column) will 
appear on the Effect menus.

The idea here is that there could be a variety of DirectX plug-ins in 
your system, many of which are not intended for musical audio pro-
cessing. Disabling these helps you keep the effect menus in Cubase 
SE more manageable.

• The second column indicates how many instances of the plug-in are 
currently used in Cubase SE.
Clicking in this column for a plug-in which is already in use produces a pop-up show-
ing exactly where each use occurs.

Please note that a plug-in may be in use even if it isn’t enabled in the left 
column. You might for example have opened a project containing effects 
that currently are disabled on the menu. The left column purely deter-
mines whether or not the plug-in will be visible on the effect menus.
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VST Instruments
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Introduction

VST Instruments are software synthesizers (or other sound sources) 
that are contained within Cubase SE. They are played internally via 
MIDI, and their audio outputs appear on separate channels in the 
mixer, allowing you to add effects or EQ, just as with audio tracks.

Some VST Instruments are included with Cubase SE, others can be 
purchased separately from Steinberg and other manufacturers.

Activating and using VST Instruments

1. Pull down the Devices menu and select VST Instruments.
The VST Instruments panel appears with 16 slots. 

2. Pull down the pop-up menu for an empty slot in the panel and select 
the desired instrument.
The instrument is loaded and activated, and its control panel is automatically opened.

• If you look in the Project window, you will find that a special “folder” for 
the chosen instrument has been added, within a “VST Instruments” 
folder (where all your VST Instruments will appear).
The separate folder for the added instrument contains two or more automation tracks: 
one for automating the plug-in parameters and one for each mixer channel used by the 
VST Instrument. For example, if you add a VST Instrument with four separate outputs 
(four separate mixer channels), the folder will contain five automation tracks. To keep 
the screen less cluttered, you may want to close the folder for the VST Instrument until 
you need to view or edit any of the automation tracks.
For more about automation, see page 223.
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3. Select the mixer channel automation track(s) for the VST Instrument 
and use the “Out” pop-up menu in the Inspector to route them to the 
desired output channels or groups.

4. Select an unused MIDI track in the Project window.

5. Pull down the output pop-up menu for the MIDI track in the Track list 
or in the Inspector.
The pop-up menu will now contain an additional item, with the name of the activated 
VST Instrument.

6. Select the VST Instrument on the MIDI output pop-up menu.
The MIDI output from the track is now routed to the selected instrument. 

7. Depending on the selected instrument, you may also need to select a 
MIDI channel for the track.
For example, a multi-timbral VST Instrument can play back different sounds on different 
MIDI channels – check the instrument’s documentation for MIDI implementation details.

8. Make sure the option “MIDI Thru Active” is activated in the Preferences 
dialog (MIDI page).

9. Click the Monitor button for the MIDI track (in the Track list, Inspector 
or mixer). 
When this is activated (or when the track is record enabled, see page 50) incoming 
MIDI is passed on to the selected MIDI output (in this case the VST Instrument).

10.Open the mixer.
You will find one or more additional channel strips for the instrument’s audio outputs. 
VST Instrument channel strips have the same features and functionality as group chan-
nel strips, with the addition of an Edit button at the bottom of the strip for opening the 
VST Instrument control panel.
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11.Play the instrument from your MIDI keyboard.
You can use the mixer settings to adjust the sound, add EQ or effects, etc. – just as 
with regular audio channels. Of course, you can also record or manually create MIDI 
parts that play back sounds from the VST Instrument.

You can have up to 16 VST Instruments activated at the same time, dif-
ferent models or several instances of the same instrument. However, 
software synthesizers can consume quite a lot of CPU power – keep an 
eye on the VST Performance window to avoid running out of processor 
power.

About latency

Depending on your audio hardware and its ASIO driver, the latency 
(the time it takes for the Instrument to produce a sound when you 
press a key on your MIDI controller) may simply be too high to allow 
comfortable real-time VST Instrument playback from a keyboard. 

If this is the case, a workaround is to play and record your parts with 
another MIDI Sound Source selected, and then switch to the VST In-
strument for playback.

• You can check the latency for your audio hardware in the Device Setup 
dialog (VST Audiobay page).
The input and output latency values are shown under the ASIO Driver pop-up menu. 
For live VST Instruments playing, these values should ideally be a few milliseconds 
(although the limit for “comfortable” live playing is a matter of personal taste).
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Constrain Delay Compensation

Cubase SE features full delay compensation throughout the entire au-
dio path. This means that any delay inherent in the VST plug-ins you 
use will automatically be compensated for during playback, so that all 
channels are kept in perfect sync (see page 189).

However, when you play a VST Instrument in real time or record live 
audio (with monitoring through Cubase SE activated), this delay com-
pensation may sometimes result in added latency. To avoid this, you 
can click the Constrain Delay Compensation button on the Project 
window toolbar. This function tries to minimize the latency effects of 
the delay compensation, while maintaining the sound of the mix as far 
as possible.

• In the Preferences dialog (VST page) you will find a setting called Delay 
Compensation Threshold. Only plug-ins with a delay higher than this 
setting will be affected by the Constrain Delay Compensation function.

• VST plug-ins (with higher delay than the threshold value) which are 
activated for VST Instrument channels, audio track channels that are 
record enabled, group channels and output channels will be turned 
off when you activate Constrain Delay Compensation.

• VST plug-ins activated for FX channels are not turned off but their de-
lay is disregarded by the program (delay compensation is turned off).

After recording or using a VST Instrument with Constrain Delay Com-
pensation, you should turn off the function to restore full delay compen-
sation.
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Selecting patches and making settings

• To select a patch for a VST Instrument, use its patch pop-up menu in 
the VST Instruments window.
The available patches depends on the VST Instrument. Not all VST Instruments come 
with pre-made patches.

• To access the parameters for the VST Instrument, click the Edit button 
in the VST Instruments window or in its channel strip (at the bottom of 
the fader strip) in the mixer.
This opens a “control panel” for the VST Instrument.

Selecting patches from the Project window

When a VST Instrument is selected as MIDI output for a track, you can 
also select patches by name, using the program pop-up menu in the 
Track list or Inspector. Although this is set up automatically and trans-
parently, there are a couple of things to note:

• If the VST Instrument supports the VST 2.1 standard (or later), select-
ing a patch will cause Cubase SE to send MIDI Program Change and 
Bank Select messages to the VST Instrument, just as with “real” phys-
ical MIDI instruments.
A consequence of this is that you can enter Program Change events in MIDI parts any-
where on the track, having the VST Instrument change patch at the desired locations 
(“automating” the patch selection).

• If the VST Instrument supports the original VST 2.0 standard only, 
only limited support of patch selection is offered.
In this case, selecting a patch will actually ask the VST Instrument to change “Plug-in 
Program”, which is not the same as selecting a “Patch” by sending MIDI Program 
Change and Bank Select messages.
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Automating a VST Instrument

• Automation of the VST Instrument channel settings is done in the 
same way as automating regular channels.

• Automation of the specific parameters for a VST Instrument is done in 
the same way as automating VST effect parameters.

See page 222.
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Background

Cubase SE provides very comprehensive automation features. Virtually 
every mixer and effect parameter can be automated.

There are two main methods you can use to automate parameter 
settings:

• By manually drawing curves on automation subtracks in the Project 
window.
See page 236.

• By using the Write/Read buttons and adjusting parameters in the mixer.
See page 231.

The methods are not different in terms of how the automation data is 
applied – they only differ in the way the automation events are created; 
manually drawing them or recording them. Any applied automation data 
will be reflected in both the mixer (a fader will move for example) and in 
a corresponding automation track curve (although this may be hidden).
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About automation subtracks

Audio tracks, group tracks and FX channel tracks all have automation 
subtracks. These allow you to view and edit the automation of all mixer 
settings for the track, including settings for the track’s insert effects. 
There is one automation subtrack for each parameter, and subtracks 
can be shown or hidden in any combination.

Similarly, MIDI tracks have automation subtracks for mixer settings, 
track parameters as well as send and insert effect settings (if used).

VST Instruments have special automation tracks that appear in the 
Project window when you add a VST Instrument. There is one auto-
mation track for the plug-in parameters and one track for each mixer 
channel used by the instrument. These tracks all have automation 
subtracks, giving you access to all parameters and mixer settings.

Finally, for ReWire channels and input/output channels, automation 
tracks are automatically added as soon as you activate automation 
(with the Write button) in the corresponding mixer channel strip or 
Channel Settings window. These automation tracks have subtracks 
for all parameters as well.

What can be automated?

Mixing in Cubase SE can be completely automated. The following pa-
rameter settings can be recorded automatically – or manually drawn 
in – on automation subtracks:

For each audio or group track and ReWire channel:

• Volume
• Mute
• Pan left/right
• 5 x insert effect program selection and effect parameters (if inserts are used)
• 8 x effect send on/off switches
• 8 x effect send levels
• EQ master bypass
• Settings for 4 EQ modules (enable/freq/quality/gain)
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For each FX channel track and input/output bus:

• Volume
• Mute
• Pan left/right
• 5 x insert effect program selection and effect parameters (if inserts are used)
• EQ master bypass
• Settings for 4 EQ modules (enable/freq/quality/gain)

For each VST Instrument

• VST Instrument plug-in parameters and program selection

plus (for each mixer channel/separate output used by the instrument):

• Volume
• Mute
• Pan left/right
• 5 x insert effect program selection and effect parameters (if inserts are used)
• 8 x effect send on/off switches
• 8 x effect send levels
• EQ master bypass
• Settings for 4 EQ modules (enable/freq/quality/gain)

For each MIDI track

• Volume
• Pan
• Mute
• Track parameters on/off switch
• Transpose
• Vel. shift
• Random 1-2 min/max/target
• Range 1-2 min/max/target
• 4 x insert effect on/off switches
• 4 x send effect on/off switches
• 4 x MIDI insert effect parameters (if used)
• 4 x MIDI send effect parameters (if used)
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Automation track operations

Opening automation subtracks 

Every track/channel has a number of automation subtracks, each 
showing one automation parameter.

For audio, group, MIDI and FX channel tracks, there are two ways you 
can open an automation subtrack for the channel:

• By right-clicking (Win) or [Ctrl]-clicking (Mac) the track in the Track 
list and selecting “Show Automation” from the pop-up that appears.

• By clicking on the “Show/Hide Automation” button (the plus sign) in 
the Track list for the channel.
An automation subtrack opens in the Track list, and a straight black horizontal line is 
shown as well as a greyed out mirror image of the audio events’ waveform (or MIDI 
events for MIDI tracks) in the event display. By default, the volume parameter is as-
signed to the first subtrack.

Click the “+” button to open an automation subtrack.

For VST Instruments, automation tracks appear automatically when 
you add VST Instruments.

For ReWire channels and output busses, automation tracks are auto-
matically created when the Write automation button (see page 231) is 
activated in either:

• The corresponding channel strip in the mixer.
• The corresponding Channel Settings window.
• The mixer common panel (“Write All”).
• The area above the Track list (“Write All”)
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Opening additional automation subtracks

• If you click on the “Append Automation Track” button (the “+” sign) 
for an automation subtrack, another subtrack opens, by default show-
ing the next parameter in the Add Parameter list (see below).

Assigning a parameter to an automation subtrack

Default parameters are already assigned to automation subtracks 
when you open them, according to their order in the Add Parameter 
list (see below). To select what parameter an open subtrack should 
display, proceed as follows:

1. If none exists, open an automation subtrack using one of the methods 
described above.

2. Click in the parameter display for the automation subtrack.
A pop-up list is shown containing some of the automation parameters plus the item 
“More...” at the bottom of the list.
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• If the parameter you wish to automate is on the pop-up you can select 
it directly.
The parameter will then replace the current parameter in the automation subtrack. 

• If you wish to add a parameter not available on the pop-up and want 
to view all parameters that can be automated, go on to the next step.

3. Select “More...”.
The Add Parameter dialog appears. This dialog shows a list with all parameters, sorted 
into different categories, that can be automated for the selected channel, including the 
parameters for any assigned insert effects. See page 223 for a list of the available pa-
rameters according to channel type.

The Add Parameter dialog for an audio track.



CUBASE SE
12 – 228 Automation

4. Select a parameter from the list and click OK.
The parameter will then replace the current parameter in the automation subtrack.

• To view the parameters in each category click the “+” sign for the cate-
gory folder.

• Note that the “replacing” of the parameter displayed in the subtrack is 
completely non-destructive. 
For example, if the subtrack contained any automation data for the parameter you just 
replaced, this data would still be there, although it would not be visible after you re-
placed the parameter. If you click in the parameter display you can switch back to the 
replaced parameter. All automated parameters are indicated by an asterisk (*) after the 
parameter name on the pop-up menu.

The Volume parameter is automated.

You can click the “Show/Hide Automation” button (the plus sign) for 
the automation subtrack to open additional subtracks and repeat the 
above procedure to assign a parameter to each subtrack.

Removing automation subtracks 

To remove automation subtracks from the Track list, proceed as follows:

• To remove a single subtrack, click the parameter name and select 
“Remove Parameter” from the pop-up menu.
Note that this will also delete any automation events on the subtrack, and the subtrack 
will be closed.

• To remove all currently unused subtracks from a track in the Track list, 
select “Remove Unused Parameters” from any of its subtrack para-
meter name pop-ups.
All subtracks that do not contain automation events will be closed for the selected track.
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Hiding automation subtracks

• To hide a single automation subtrack, click the “Hide Automation” 
button (the minus sign) in the Track list.

• To hide all automation subtracks for a track, right-click (Win) or [Ctrl]-
click (Mac) the track for which you wish to hide the automation sub-
tracks, and select “Hide Automation” from the pop-up menu that ap-
pears.

• To hide all automation subtracks for all tracks in the Track list, right-
click (Win) or [Ctrl]-click (Mac) any track and select “Hide All Automa-
tion” from the pop-up menu that appears.
This option is also available on the Project menu.

Showing only used automation subtracks

If a lot of automation subtracks are used, it may be impractical to have 
them all open in the Track list. If you want to view only the subtracks 
that are used (i.e. those that actually contain automation events) and 
hide all empty automation subtracks, do one of the following:

• Right-click (Win) or [Ctrl]-click (Mac) any track in the Track list and 
select the option “Show Used Automation for All Tracks” from the 
pop-up menu.
This will close all automation subtracks not containing any automation events, while leav-
ing used subtracks open for all tracks. This option is also available on the Project menu.

• Right-click (Win) or [Ctrl]-click (Mac) a specific track and select the 
option “Show Used Automation” from the pop-up menu.
This will close all automation subtracks not containing any automation events, while 
leaving used subtracks open for the selected track.
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Muting automation subtracks

You can mute individual automation subtracks by clicking their Mute 
buttons in the Track list. While clicking the Read (R) button (see page 
231) for an automation subtrack will activate or deactivate Read mode 
for all automated parameters of the track, using the Mute button allows 
you to turn off automation for a single parameter.

The “Automation follows Events” setting

If you activate “Automation follows Events” on the Edit menu (or in the 
Preferences–Editing dialog), automation events will automatically fol-
low when you move an event or part on the track. 

This makes it easy to set up automation related to a specific event or 
part, rather than to a specific position in the project. For example, you 
can automate the panning of a sound effect event (having the sound 
pan from left to right, etc.) – if you need to move the event, the auto-
mation will automatically follow! The rules are:

• All automation events for the track between the start and end of the 
event or part will be moved.
If there are automation events in the new position (to which you move the part or 
event), these will be overwritten.

• If you duplicate an event or part (by [Alt]/[Option]-dragging or by us-
ing the Duplicate or Repeat functions) the automation events will be 
duplicated as well.

• This function affects copying and pasting as well.
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Using Write/Read automation

All track types except folder, marker, video and ruler tracks feature 
Write (W) and Read (R) buttons in the mixer, in the Track list and in the 
Channel Settings window. Furthermore, the control panels for all plug-
in effects and VST Instruments also feature Write and Read buttons.

The Write and Read buttons for a channel in the mixer, and for an automation 
subtrack in the Track list.

• If you activate Write for a channel, all mixer parameters you adjust dur-
ing playback for that specific channel will be recorded as automation 
events.

• If you activate Read for a channel, all your recorded mixer actions for 
that channel will be performed during playback, just like you per-
formed them in Write mode.

• The W and R buttons for a track in the Track list are mirrors of the W 
and R buttons in the corresponding channel strip in the mixer.

• Some track types require that you activate the Write button (either for 
the track or globally – see below) to create an automation track for it.
These are: VST Instrument, ReWire and Input/Output tracks. The first time the Write 
button is activated for these track types, automation subtracks will be created for them. 
You can then proceed with automating the parameters of the tracks (by editing the au-
tomation subtracks or by writing, as described below). To play back the automation, 
make sure the Read button for the tracks is activated.
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There are also global Read All and Write All Automation buttons in the 
mixer’s common panel and at the top of the Track list:

The global Write and Read buttons in the mixer, and in the Track list.

• When Read All is activated, all your recorded mixer actions for all 
channels will be performed during playback.

• When Write All is activated, all mixer actions you perform during play-
back (for all channels) will be recorded as automation events.

Recording your actions – an example

If the settings in your current project are crucial, you may not want to 
“experiment” with automation until you know more about how it all fits 
together. If so, you can create a new project for the following example. 
It doesn’t even have to contain any audio events, just a few audio 
tracks. Proceed as follows:

1. Open the Mixer window.

2. Click the “Write All” button in the mixer common panel.
Cubase SE is now in global Write mode. 

3. Start playback, and adjust some volume faders and/or other parame-
ter settings in the mixer or perhaps in a Channel Settings window.
Stop playback when you are done, and return to the position where you started playback.

4. Deactivate Write mode, and click the Read All button in the mixer 
common panel.
Cubase SE is now in global Read mode.

5. Start playback, and watch the Mixer window.
All your actions performed during the previous playback will be reproduced exactly.
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6. If you wish to redo anything that was recorded, activate Write mode 
again, and start playback from the same position.

• You can have Write and Read activated simultaneously, if you want to 
watch and listen to your recorded mixer actions while you’re recording 
fader movements for another mixer channel, etc.

Recording plug-in automation

Every parameter for every assigned effect or VST Instrument can be 
automated in much the same manner as described above.

The following example assumes that you have assigned an insert ef-
fect to an FX channel track (see page 198), and describes how to 
record automation for the effect:

1. Activate Write All in the mixer common panel or in the Track list to put 
Cubase SE in global Write mode.

2. Select the FX channel track in the Track list and open its Inserts sec-
tion in the Inspector.
If the Inspector is hidden, click the “Show Inspector” button in the Project window 
toolbar.

3. Open the control panel for the effect by clicking the Edit button (“e”) 
above the insert effect slot in the Inspector.

4. Click the Write button in the control panel to activate Write mode.
All effects and VST Instruments have Write/Read buttons on their control panels. 
These work exactly like the corresponding buttons in the mixer or in the Track list. In 
the previous example, we used global Write mode, in which mixer and parameter 
changes are recorded on all tracks, but in this example we’ll use Write mode for one 
track only.

5. Start playback and adjust some effect parameters in the control panel.
When you are finished, stop playback and return to the position where you started 
playback.

6. Deactivate Write and instead click the Read button on the control 
panel.

7. Start playback, and watch the control panel.
All actions you performed during the previous playback will be reproduced exactly.
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Assigning an automated parameter to an automation subtrack

To select which parameter is currently shown in the automation track 
for the FX channel, proceed as follows:

1. Click in the parameter display for the FX channel automation subtrack.
The parameter display pop-up list is shown containing the automation parameters for 
the plug-in. The parameter(s) you previously automated are indicated by an asterisk af-
ter the parameter name in the list.

Automated parameters for the DoubleDelay effect.

2. Select the parameter you wish to view from the parameter display 
pop-up.
The automation curve for the parameter you selected is displayed on the automation 
subtrack.

• To view VST Instrument parameters you use the same method, but for 
the first automation track for the instrument.
As described earlier, each VST Instrument have two or more automation tracks – one 
for the plug-in settings and one for each VST Instrument mixer channel.

Where did the automation data I recorded end up?

When using Write All automation, you can write automation data on 
all channels’ automation tracks. In the previous write operations, you 
probably added automation events for many different channels and 
parameters.

• To view all the automation events you recorded during the operations, 
select “Show Used Automation” from the Project menu.
Now the automation data for every channel parameter that you adjusted in the mixer 
during Write mode is shown on corresponding subtracks in the Project window. The 
automation events recorded are shown as points in the automation curves. 
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Working with automation curves

About automation curves 

There are two kinds of automation curves, “ramp” and “jump”:

• Jump curves are created for any parameter that only has on/off values, 
like a Mute button, for example.

• Ramp curves are created for any parameter that generates continuous 
multiple values, such as fader or dial movements etc. 

Examples of jump and ramp automation curves shown in the event display.

About the static value line

When you first open an automation subtrack for a parameter, it 
doesn’t contain any automation events (unless you have previously 
adjusted that parameter with write automation activated), and this is 
reflected in the event display as a straight horizontal black line, the 
“static value” line. This line represents the current parameter setting.

• If you have manually added any automation events or used write auto-
mation for the corresponding parameter, and then deactivate Read 
mode, the automation curve will be greyed-out in the automation sub-
track event display and the static value will be used instead.
As soon as Read mode is activated the automation curve will become available.
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Editing automation events

Drawing automation events

By using write automation in the mixer, you generate automation events 
by moving parameter dials and fader settings in the mixer. You can also 
add them manually, by drawing automation curves on an automation 
subtrack. Proceed as follows:

1. Open a volume automation subtrack for an audio track by clicking the 
“+” sign.
The static value line is shown in the event display.

2. Select the Pencil tool.
You can also use the various modes of the Line tool for drawing curves, see below.

3. If you click on the static value line, an automation event is added, read 
automation mode is automatically activated, and the static value line 
changes to a blue automation curve.

4. If you click and hold, you can draw a curve, by adding a multitude of 
single automation events.
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5. When you release the mouse button, the number of automation events 
is reduced to a few events, but the basic shape of the curve still remains 
the same.
This “thinning” of events is governed by the Automation Reduction Level setting in the 
Preferences dialog, see page 241.

6. If you now activate playback, the volume will change with the automa-
tion curve.
In the mixer the corresponding fader moves accordingly.

7. Simply redo the operation if you are not happy with the result.
If you draw over existing events, a new curve is created.

• If the automation subtrack is in Read mode already, you can also add 
automation events by clicking with the Arrow tool.
If you are trying to add a point between two existing points and the new point doesn’t 
deviate from the existing curve, it will be removed by reduction (see page 241) as soon 
as you release the mouse button.

Using the various modes of the Line tool to draw automation curves

The Line tool can be very useful for drawing automation events. The 
various modes are accessed by clicking on the Line tool on the tool-
bar and selecting from the pop-up that appears.

• Clicking and dragging with the Line tool in Line mode shows a line in the au-
tomation subtrack, and creates automation events aligned with this line.
This is a quick way to create linear fades, etc.
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• The Line tool in Parabola mode works in the same way, but aligns the automa-
tion events with a parabolic curve instead, giving more “natural” curves and 
fades.
Note that the result depends on the direction from which you draw the parabolic curve.

• The Sine, Triangle and Square Line tool modes create automation events 
aligned with continuous curves.
If snap is activated and set to Grid, the period of the curve (the length of one curve 
“cycle”) is determined by the grid setting. If you press [Shift] and drag, you can set the 
period length manually, in multiples of the grid value.

Selecting automation event points

• To select a single automation event point, click on it with the Arrow tool.
The point turns red, and you can drag it in any horizontal or vertical direction between 
two points.

• To select multiple curve points, you can either [Shift]-click or drag a 
selection rectangle with the Arrow tool.
All events inside the selection rectangle will become selected.

Drawing a selection rectangle around some points to select them.

When selected, several points can be moved in all directions as “one”, 
i.e. the curve shape formed by the selected event points remains intact.
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• To select all automation events on a subtrack, right-click (Win) or 
[Ctrl]-click (Mac) the automation subtrack in the Track list and choose 
“Select All Events” from the context menu.

Removing automation events

There are several ways to remove event points:

• By selecting points and pressing [Backspace] or [Delete] or selecting 
Delete from the Edit menu.

• By clicking on a point with the Eraser tool.

• By selecting a range (with the Range Selection tool), and pressing 
[Backspace] or [Delete] or selecting Delete from the Edit menu.

• By clicking in the parameter display on a subtrack and selecting 
“Remove Parameter” from the pop-up.
This will remove all automation events from the subtrack, and the subtrack will be closed.

Editing automation events

Automation events can be edited much like other events. You can use 
cut, copy and paste, you can nudge events etc. There are however four 
items on the Edit menu that are not applicable to automation events. 
These are:

• Split at Cursor
• Split Loop
• Move to Front
• Move to Back
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Tips and common methods

There are no hard and fast rules when it comes to describing which 
automation method you should use. You can for example never even 
open an automation subtrack, and stick with write automation through-
out a project. Or you can stick to drawing automation curves to auto-
mate settings in a project. Both methods have their advantages, but it 
is of course up to you to decide what to use and when.

• Editing curves on automation subtracks offers a graphical overview in 
relation to the track contents and the time position.
This makes it easy to quickly change parameter values at specific points, without hav-
ing to activate playback. For example, this method gives you a good overview if you 
have a voice-over or a dialog on one track and a music bed on another track, the level 
of which needs to be lowered with a specific amount every time the dialog occurs.

• By using write automation in the mixer you don’t have to manually se-
lect parameter subtracks from the Add Parameter list.
You can work much like you would using a “real” physical mixer. Every action you per-
form is automatically recorded on subtracks which you can later open for viewing and 
editing of the parameters you changed.

These are just two examples of advantages for each method. Generally, 
editing curves and using write automation are two methods that com-
plement each other, and depending on the nature of your projects you 
will probably work out what method works best for a given situation.
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Options and Settings

About the Automation Reduction Level preference

This item can be found on the Editing page in the Preferences dialog. 
Automation reduction reduces the number of automation events after 
you have used write automation or added automation events manually. 
When you write (or draw with the Pencil tool) automation events, 
these are added as a continuous stream of densely packed events. 
This is necessary because the program cannot “guess” what you will 
be doing next! However, when you are done, the reduction function 
will remove all superfluous event points and the automation curve now 
contains only the event points necessary to reproduce your actions.

For example, all event points that might exist between two other points, 
but do not deviate from the curve, will be automatically removed by re-
duction.

If you try to add an event that doesn’t deviate from the existing curve between two 
existing points...

...it will be removed when the mouse is released. If you moved the selected event by 
any amount so that the resulting curve isn’t a straight line, the event would of course 
be added.

• If you feel you need a lower (or higher) reduction level of events than 
the default setting of roughly 75% reduction, you can change it, but 
normally the default setting works well. 

• A minimum reduction level setting is not recommended as this will 
simply retain a lot of unnecessary events.
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About this chapter

It is possible to control the Cubase SE Mixer via MIDI. Currently, the 
following MIDI control devices are supported:

• Steinberg Houston (see page 248)
• Tascam US-428 (see page 248)

There is also a Generic Remote Device, allowing you to use any MIDI 
controller to remote control Cubase SE (see page 250).

Setting Up

Connecting the remote device

Connect the MIDI Out on the remote unit to a MIDI In on your MIDI in-
terface. Depending on the remote unit model, you may also need to 
connect a MIDI Out on the interface to a MIDI In on the remote unit 
(this is necessary if the remote unit features “feedback devices” such 
as indicators, motorized faders, etc.).

If you will be recording MIDI tracks, you don’t want any MIDI data from 
the remote unit to accidentally be recorded as well. To avoid this, you 
should also make the following setting:

1. Open the Device Setup dialog from the Devices menu.

2. Select “All MIDI Inputs” in the list to the left.

3. Check the list to the right and locate the MIDI input to which you have 
connected the MIDI remote unit.

4. Click in the “Active” column for that input to set it to “No”.

5. Click OK to close the Device Setup dialog.

Now you have removed the remote unit input from the “All MIDI Inputs” 
group. This means that you can record MIDI tracks with the “All MIDI 
Inputs” port selected without risking to record the data from the re-
mote unit at the same time.
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Selecting a remote device

1. Pull down the Devices menu and select Device Setup.
A dialog window opens with a list of devices shown in the left part of the window. 

2. If you can’t find the remote device you are looking for, click on the plus 
sign in the top left corner and select the device from the pop-up that 
appears.
It is added to the Devices list.

• Note that it is possible to select more than one remote device of the 
same type.
If you have more than one remote device of the same type, these will be numbered in 
the Devices list.

3. Now select your MIDI control device model from the Devices list.
Depending on the selected device, either a list of programmable function commands 
or a blank panel is shown in the right half of the dialog window.

4. Select the correct MIDI input from the pop-up menu.
If necessary, select the correct MIDI output from the pop-up menu.

5. Click OK to close the dialog.
You can now use the MIDI control device to move faders and knobs, activate Mute and 
Solo, etc. The exact parameter configuration depends on which external MIDI control 
device you are using.
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Operations

Writing automation using remote controls

Automating the mixer using a remote control device is basically done 
in the same way as when you operate on-screen controls in Write 
mode. However, when it comes to replacing existing automation data, 
there is one important difference:

• If you activate Write mode and move a control on the remote control 
device, all data for the corresponding parameter is replaced from the 
position where you moved the control, up until the position where 
playback is stopped!
In other words, as soon as you have moved a control in Write mode, it remains “active” 
until you stop playback. The reason for this is explained below.

As a consequence, an additional precaution must be taken:

• Make sure you move only the controller you want to replace!

In order to replace existing automation data for a control, the computer 
needs to know how long the user actually “grabbed” or used the con-
trol. When doing this “on screen”, the program simply detects when the 
mouse button is pressed and released. When you are using an external 
remote control device, however, there is no mouse button involved, and 
Cubase SE cannot tell whether you “grab and hold” a fader, or simply 
move it and release it. Instead, you have to indicate that you have “re-
leased” the control by stopping playback.

This is only relevant when you are using a remote control device and 
Write mode is activated in the mixer.
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Assigning remote key commands

You can assign any Cubase SE function (that can be assigned a key 
command) to generic buttons, wheels or other controls. As of this 
writing, these devices are:

• Tascam US-428
• Steinberg Houston

Proceed as follows:

1. Open the Device Setup dialog and select one of the remote devices 
that support this feature.
On the right side of the window there are three columns. This is where you assign 
commands.

2. Use the “Button” column to locate a Remote device control or button 
to which you wish to assign a Cubase SE function.

3. Click in the “Category” column for the control, and select one of the 
Cubase SE function categories from the pop-up menu that appears.

4. Click in the “Command” column, and select the desired Cubase SE 
function from the pop-up menu that appears.
The available items on the pop-up menu depend on the selected category.

5. Click “Apply” when you are done.

The selected function is now assigned to the button or control on the 
remote device.

A note about remote controlling MIDI tracks

While most remote control devices will be able to control both MIDI 
and audio channels in Cubase SE, the parameter setup may be differ-
ent. For example, audio-specific controls (such as EQ) will be disre-
garded when controlling MIDI channels.
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Remote control device specifics

Steinberg Houston

Houston is a MIDI/USB remote control device designed especially for 
use with VST audio applications such as Cubase SE. With clearly laid 
out controls (including touch sensitive motorized faders, rotary knobs, 
transport controls and a jog/shuttle wheel) Houston allows you to 
control virtually every mixer parameter in Cubase SE, without having 
to use the computer keyboard or mouse.

• For details about parameters and hands-on mixing techniques, please 
see the Houston documentation.

Tascam US-428

The US-428 can remote control up to 64 mixer channels. 

• When the Tascam US-428 device is added in the Device Setup dialog, 
you can open the Remote Status window by selecting “Tascam US-
428” from the Devices menu.
This indicates which bank (group of eight channels in Cubase SE) is currently being 
controlled by the remote device. To select another bank, use the pop-up menu in the 
window or use the Bank Left/Right buttons on the remote device.

• The US-428 transport keys will have the equivalent functionality in 
Cubase SE.

• To set markers, hold down “Set” while pressing a locator key.

• If you hold down the function key [Null] and then move a fader, the 
Select and Rec indicators above the fader will indicate whether the 
fader position is below or above the current fader level in Cubase SE.
If the upper indicator is lit, the fader position on the panel is above the fader level in 
Cubase SE and vice versa. When both indicators are dark, fader positions are matched 
for that channel.

The US-428 supports “MIDI Feedback”, allowing for mute/solo, channel 
selection, EQ band, Aux 1 to 4 and transport status to be indicated on 
the panel. For this (and the fader position indication described above) to 
work, you need to select the “US-428 Control” port as input and output.
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Cubase SE mixer

The following US-428 controls will remote control the following mixer 
parameter for each channel strip:

• Fader: volume

• Mute/Solo: mute and solo (selected via the Solo switch)

• Select: selects channel for editing

• Pan-Dial: pan

• EQ-Gain
Controls the EQ gain for each band selected with the Low, LoMid, HiMid and High 
buttons. These correspond to the four EQ bands in Cubase SE, starting from the left-
most band.

• EQ-Freq
Controls the EQ frequency for each band selected with the Low, LoMid, HiMid and 
High buttons. These correspond to the four EQ bands in Cubase SE, starting from the 
leftmost band.

• EQ-“Q”
Controls the EQ “Q” for each band selected with the Low, LoMid, HiMid and High but-
tons. These correspond to the four EQ bands in Cubase SE, starting from the leftmost 
band.

• Aux 1 to Aux 4 and shuttle wheel: 
The effect send levels for sends 1 to 4. 

• The shuttle wheel will act as position shuttle if no Aux send button is 
selected.
Press the activated button to deselect it.

• Holding down the “Asgn” button and pressing the Low, LoMid, HiMid 
and High EQ buttons switches the corresponding EQ band “On” but-
ton status.

• Holding down the “Asgn” button and pressing the Aux1 to Aux4 but-
tons switches the corresponding Effect Send 1-4 “On” button status.
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The Generic Remote device

If you have a generic MIDI controller, you can use this for remote con-
trol of Cubase SE by setting up the Generic Remote device:

1. Open the Device Setup dialog on the Devices menu.
If the Generic Remote device isn’t on the Devices list, you need to add it:

2. Click the “+” sign in the top left corner and select the “Generic Re-
mote” device from the pop-up menu.

• When the Generic Remote device is added in the Device Setup dia-
log, you can open the Remote Status window by selecting “Generic 
Remote” from the Devices menu.

The Remote Status window
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3. Select the Generic Remote device in the Devices list to the left.
The settings for the Generic Remote device are displayed, allowing you to specify 
which control on your device should control which parameter in Cubase SE.

4. Use the MIDI Input and Output pop-up menus to select the MIDI 
Port(s) to which your remote device is connected.

5. Use the pop-up menu to the right to select a bank.
The concept of banks is based on the simple fact that most MIDI devices can control 
a limited number of channels at a time (often 8 or 16). For example, if your MIDI control 
device has 16 volume faders, and you are using 32 mixer channels in Cubase SE, you 
would need two banks of 16 channels each. When the first bank is selected you con-
trol channel 1 to 16; when the second Bank is selected you control channel 17 to 32. 
Since you can control Transport functions as well, you may need several banks.
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6. Set up the upper table according to the controls on your MIDI control 
device.
The columns have the following functionality:

• If you find that the upper table holds too many or too few controls, you 
can add or remove controls with the Add and Delete buttons to the 
right of the upper table.

Column Description

Control Name Double clicking this field allows you to enter a descriptive name for the 
control (typically a name written on the console). This name is automat-
ically reflected in the Control Name column in the lower table.

MIDI Status Clicking in this column pulls down a pop-up menu, allowing you to spec-
ify the type of MIDI message sent by the control. The options are Control-
ler, Program Change, Note On, Note Off, Aftertouch and Polyphonic 
Pressure. Also available are Continuous Control NRPN and RPN, a way 
to extend the available control messages. The “Ctrl JLCooper” option is a 
special version of a Continuous Controller where the 3rd byte of a MIDI 
message is used as address instead of the 2nd byte (a method sup-
ported by various JL-Cooper remote devices).

MIDI Channel Clicking in this column pulls down a pop-up menu, allowing you to se-
lect the MIDI channel on which the controller is transmitted.

Address The Continuous Controller number, the pitch of a note or the address of 
a NRPN/RPN Continuous Controller.

Max. Value The maximum value the control will transmit. This value is used by the 
program to “scale” the value range of the MIDI controller to the value 
range of the program parameter.

Flags Clicking in this column pulls down a pop-up menu, allowing you to acti-
vate or deactivate three flags:
Receive – activate this if the MIDI message should be processed on 
reception.
Transmit – activate this if a MIDI message should be transmitted when 
the corresponding value in the program changes.
Relative – activate this if the control is an “endless” dial, which reports 
the number of turns instead of an absolute value.
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• If you are uncertain of which MIDI message a certain controller sends, 
you can use the Learn function:
Select the control in the upper table (by clicking in the Control Name column), move 
the corresponding control on your MIDI device and click the Learn button to the right 
of the table. The MIDI Status, MIDI Channel and Address values are automatically set 
to those of the moved control.

7. Use the lower table to specify which Cubase SE parameters you want 
to control.
Each row in the table is associated to the controller in the corresponding row in the 
upper table (as indicated by the Control Name column). The other columns have the 
following functionality:

8. If needed, select another bank and make settings for this.
Note that you only need to make settings in the lower table for this – the upper table is 
already set up according to the MIDI remote device.

Column Description

Device Clicking in this column pulls down a pop-up menu, used for determining 
which device in Cubase SE should be controlled. The special option 
“Command” allows you to perform certain command actions by remote 
control. One example of this is the selection of remote banks.

Channel/
Category

This is where you select the channel to be controlled or, if the “Com-
mand” Device option is selected, the Command category.

Value/Action Clicking in this column pulls down a pop-up menu, allowing you to se-
lect the parameter of the channel to be controlled (typically, if the “VST 
Mixer” Device option is selected you can choose between volume, pan, 
send levels, EQ, etc.).
If the “Command” Device option is selected, this is where you specify 
the “Action” of the category.

Flags Clicking in this column pulls down a pop-up menu, allowing you to acti-
vate or deactivate three flags:
Push Button – When activated, the parameter is only changed if the re-
ceived MIDI message shows a value unequal to 0.
Toggle – When activated, the parameter value is switched between 
minimum and maximum value each time a MIDI message is received. 
The combination of Push Button and Toggle is useful for remote con-
trols which do not latch the state of a button. One example is controlling 
mute status with a device on which pressing the Mute button turns it on, 
and releasing the Mute button turns it off. If Push Button and Toggle are 
activated, the Mute status will change between on and off whenever the 
button is pressed on the console.
Not Automated – When activated, the parameter will not be automated. 
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• If you need, you can add banks by clicking the Add button below the 
Bank pop-up.
Clicking the Rename button allows you to assign a new name to the currently selected 
bank, and you can remove an unneeded bank by selecting it and clicking the Delete 
button.

9. When you are finished, close the Generic Remote Setup window.
Now, you can control the specified Cubase SE parameters from the MIDI remote de-
vice. To select another bank, use the pop-up menu in the Remote Status window (or 
use a control on the MIDI remote device, if you have assigned one for this).

Importing and Exporting Remote Setups

The Export button in the upper right corner of the Generic Remote 
Setup window allows you to export the current setup, including the 
Control configuration (the upper table) and all banks. The setup is 
saved as a file (with the Windows file extension “.xml”). Clicking the 
Import button allows you to import saved Remote Setup files.

• The last imported or exported Remote Setup will automatically be 
loaded when the program starts or the Generic Remote control is 
added in the Device Setup dialog.
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Background

Audio processing in Cubase SE can be called “non-destructive”, in 
the sense that you can always undo changes or revert to the original 
versions. This is possible because processing affects audio clips 
rather than the actual audio files, and because audio clips can refer to 
more than one audio file. This is how it works:

1. If you process an event or a selection range, a new audio file is created 
in the Edits folder, within your project folder. 
This new file contains the processed audio, while the original file is unaffected. 

2. The processed section of the audio clip (the section corresponding to 
the event or selection range) is then made to refer to the new, pro-
cessed audio file.
The other sections of the clip will still refer to the original file.

• Furthermore, the original, unprocessed audio file can still be used by 
other clips in the project, by other projects or by other applications.

...the clip will refer both to the original file and a 
new file, containing the processed section only.

This event plays a section of this clip... ...which refers to this audio file.

After processing the event...
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Audio processing

Basically, you apply processing by making a selection and selecting a 
function from the Process submenu on the Audio menu. Processing is 
applied according to the following rules:

• Selecting events in the Project window or the Audio Part Editor will apply pro-
cessing to the selected events only.
Processing will only affect the clip sections that are referenced by the events.

• Selecting an audio clip in the Pool will apply processing to the whole clip.

• Making a selection range will apply processing to the selected range only.
Other sections of the clip are not affected.

If you attempt to process an event that is a shared copy (i.e. the event 
refers to a clip that is used by other events in the project), you are 
asked whether you want to create a new version of the clip or not.

Select “New Version” if you want the processing to affect the selected event only. 
Select “Continue” if you want the processing to affect all shared copies. 

• If you activate the “Do not show this message again” option, any and all 
further processing you do will conform to the selected method (“Con-
tinue” or ”New Version”). 
You can change this setting at any time by using the “On Processing Shared Clips” 
pop-up menu in the Preferences dialog (Audio page).
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Common settings and features

If there are any settings for the selected Audio processing function, 
these will appear when you select the function from the Process sub-
menu. While most settings are specific for the function, some features 
and settings work in the same way for several functions:

The “More...” button

If the dialog has a lot of settings, some options may be hidden when 
the dialog appears. To reveal these, click the “More...” button.

To hide the settings, click the button again (now labeled “Less...”).

The Preview, Process and Cancel buttons

These buttons have the following functionality:

Button Description

Preview Allows you to listen to the result of the processing with the current set-
tings. Playback will continue repeatedly until you click the button again 
(the button is labeled “Stop” during Preview playback). You can make ad-
justments during Preview playback, but the changes are not applied until 
the start of the next “lap”. Some changes may automatically restart the 
Preview playback from the beginning.

Process Performs the processing and closes the dialog.

Cancel Closes the dialog without processing.
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Pre/post crossfade

Some processing functions allow you to gradually mix the effect in or 
out. This is done with the pre and post crossfade parameters. If you 
activate Pre-crossfade and specify a value of e.g. 1000 ms, the pro-
cessing will be applied gradually from the start of selection, reaching 
full effect 1000 ms after the start. Similarly, if you activate post-cross-
fade, the processing will gradually be removed, starting at the speci-
fied interval before the end of the selection.

The sum of the pre- and post-crossfade times cannot be larger than the 
length of the selection.

Envelope

The Envelope function allows you to apply a volume envelope to the 
selected audio. The dialog contains the following settings:

Curve Kind buttons

These determine whether the envelope curve should consist of spline 
curve segments (left button), damped spline segments (middle button) 
or linear segments (right button).
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Fade display

Shows the shape of the envelope curve. The resulting waveform shape 
is shown in dark grey, with the current waveform shape in light grey. 
You can click on the curve to add points, and click and drag existing 
points to change the shape. To remove a point from the curve, drag it 
outside the display.

Presets

If you have set up an envelope curve that you may want to apply to other 
events or clips, you can store it as a preset by clicking the Store button. 

• To apply a stored preset, select it from the pop-up menu. 

• To rename the selected preset, double click on the name and type a 
new one in the dialog that appears. 

• To remove a stored preset, select it from the pop-up menu and click 
Remove.

Fade In and Fade Out

These function are described in the chapter “Fades, crossfades and 
envelopes” (see page 138).

Gain

Allows you to change the gain (level) of the selected audio. The dialog 
contains the following settings:

Gain

This is where you set the desired gain, between -50 and +20dB. The 
setting is also indicated below the Gain display as a percentage.



CUBASE SE
Audio processing and functions 14 – 261

Clip detection text

If you use the Preview function before applying the processing, the 
text below the slider indicates whether the current settings result in 
clipping (audio levels above 0 dB). If that is the case, lower the Gain 
value and use the Preview function again.

• If you want to increase the level of the audio as much as possible with-
out causing clipping, you should use the Normalize function instead 
(see page 263).

Pre- and Post-Crossfade

See page 259.

Merge Clipboard

This functions mixes the audio from the clipboard into the audio 
selected for processing, starting at the beginning of the selection.

For this function to be available, you need to have Cut or Copied a range 
of audio in the Sample Editor first.

The dialog contains the following settings:

Sources mix

Allows you to specify a mix ratio between the Original (the audio se-
lected for processing) and the Copy (the audio on the clipboard).

Pre- and Post-Crossfade

See page 259.
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Noise Gate

Scans the audio for sections weaker than a specified threshold level, 
and replaces them with silence. The dialog contains the following 
settings:

Threshold

The level below which you want audio to be silenced. Levels below 
this value will close the gate.

Attack Time

The time it takes for the gate to open fully after the audio level has 
exceeded the threshold level.

Min. Opening Time

This is the shortest time the gate will remain open. If you find that the 
gate opens and closes too often when processing material that varies 
rapidly in level, you should try raising this value.

Release Time

The time it takes for the gate to close fully after the audio level has 
dropped below the threshold level.

Linked Channels

This is available for stereo audio only. When it is activated, the Noise 
Gate is opened for both channels as soon as one or both channels 
exceed the Threshold level. When Linked Channels is deactivated, 
the Noise Gate works independently for the left and right channel.
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Dry/Wet mix

Allows you to specify a mix ratio between “dry” and processed sound.

Pre- and Post-Crossfade

See page 259.

Normalize

The Normalize function allows you to specify the desired maximum 
level of the audio. It then analyzes the selected audio and finds the 
current maximum level. Finally it subtracts the current maximum level 
from the specified level, and raises the gain of the audio by the result-
ing amount (if the specified maximum level is lower than the current 
maximum, the gain will be lowered instead). A common use for Nor-
malizing is to raise the level of audio that was recorded at too low an 
input level. The dialog contains the following settings:

Maximum

The desired maximum level for the audio, between -50 and 0dB. The 
setting is also indicated below the Gain display as a percentage.

Pre- and Post-Crossfade

See page 259.



CUBASE SE
14 – 264 Audio processing and functions

Phase Reverse

Reverses the phase of the selected audio, turning the waveform “upside 
down”. The dialog contains the following settings:

Phase Reverse on

When processing stereo audio, this pop-up menu allows you to specify 
which channel(s) should be phase reversed.

Pre- and Post-Crossfade

See page 259.

Pitch Shift

This function allows you to change the pitch of the audio with or without 
affecting its length. You can create “harmonies” by specifying several 
pitches, or apply pitch shift based on a user specified envelope curve.
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When the “Transpose” tab is selected, the dialog contains the follow-
ing parameters:

Keyboard display

This offers a way to specify the transpose interval in semitones, and 
gives a graphic overview of the transposition setting.

• The “root note” is indicated in red.
This has nothing to do with the actual key or pitch of the original audio, it just provides 
a way to display transpose intervals. If you like, you can change the root note by using 
the settings to the right below the keyboard display, or by pressing [Alt]/[Option] and 
clicking in the keyboard display.

• To specify a transpose interval, click on one of the keys.
The key is indicated in blue, and the program plays test tones in the base pitch and 
transpose pitch, to give you an audible confirmation.

• If “Multi Shift” is activated (see below), you can click on several keys 
to create “chords”.
Clicking on a blue (activated) key removes it.

Pitch Shift settings

The “Semitones” and “Fine tune” settings allow you to specify the 
amount of pitch shift. You can transpose the audio ±16 semitones, 
and fine tune it by ±200 cents (hundredths of semitones).

Volume

Allows you to lower the volume of the pitch shifted sound.

Multi Shift

When this is activated, you can add more than one transpose value, 
creating multi-part harmonies. This is done by adding intervals in the 
keyboard display, as described above.

• If the intervals you add make up a standard chord, this chord is dis-
played to the right.
Note however, that to include the base pitch (the original, untransposed sound) in the 
processed result, you need to click the base key in the keyboard display as well, so 
that it is displayed in blue.
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Listen Key/Chord button

Clicking this button plays a test tone, pitched according to the acti-
vated interval key on the keyboard display. If “Multi Shift” is activated, 
this button is called “Listen Chord”, and plays all activated intervals, 
as a chord.

Pitch Shift Base

This allows you to set the root note (the red key in the keyboard dis-
play). This has no actual relation to the pitch of the audio material, but 
should be viewed as an aid for easily setting up intervals and chords.

Time Correction

When this is activated, the pitch shift process will not affect the length 
of the audio. When this is deactivated, raising the pitch will shorten 
the audio section and vice versa, much like changing the playback 
speed on a tape recorder.

Using envelope based Pitch Shift
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When the “Envelope” tab is selected, you can specify an envelope 
curve on which the pitch shift should be based. This allows you to 
create pitch bend effects, pitch shift different sections of the audio by 
different amounts, etc.

Envelope display

Shows the shape of the envelope curve, over the waveform image of 
the audio selected for processing. Envelope curve points above the 
center line indicate positive pitch shift, while curve points below the 
center line indicate negative pitch shift. Initially, the envelope curve will 
be a horizontal, centered line, indicating zero pitch shift.

• You can click on the curve to add points, and click and drag existing 
points to change the shape. To remove a point from the curve, drag it 
outside the display.

Curve Kind

These buttons determine whether the envelope curve should consist 
of spline curve segments (left button), damped spline segments (mid-
dle button) or linear segments (right button).

Spline curve segment envelope.
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The same envelope with damped spline segments selected

The same envelope with linear segments selected.

Range

This parameter determines the vertical pitch range of the envelope. If 
set to “4”, moving a curve point to the top of the display corresponds to 
pitch shifting by + 4 semitones. The maximum range is +/- 16 semi-
tones. 

Transpose and Fine Tune

Allows you to adjust the value of a curve point numerically:

1. Click on a curve point to select it.
The selected point is shown in red.

2. Adjust the Transpose and Fine Tune parameters to change the pitch 
of the curve point in semitones and cents, respectively.

Pitch Shift Mode

These are the same parameters as on the Transpose tab.
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Example

Let’s say that you wish to create a pitch bend effect, so that the pitch is 
raised linearly by exactly 2 semitones in a specific part of the selected 
audio.

1. Remove all curve points by clicking the Reset button.

2. Select a linear curve by clicking the right Curve Kind button.

3. Create a point where you want the pitch bend to start by clicking on 
the envelope line.
Since this is the starting point for the pitch bend, you want its pitch to be zero (the en-
velope line should still be straight). If necessary, use the Fine Tune parameter to set the 
curve point to 0 cents, because this point governs the start point, where you want the 
pitch transition to begin.

4. Create a new curve point at the horizontal position where you want 
the pitch bend to reach the full value.
This curve point determines the rise time of the pitch bend effect, i.e. the further away 
from the starting point the new point is positioned, the longer it will take for the pitch 
bend to reach the full value, and vice versa.

5. Make sure the Range parameter is set to 2 semitones or higher.

6. With the second point still selected, use the Transpose and Fine Tune 
parameters to set the pitch to exactly 2 semitones.

7. Create a new curve point to set the duration of the pitch bend, i.e. the 
time the pitch should remain transposed by 2 semitones.

8. Finally, create a point where you want the pitch bend to end.
You don’t need to create a new point if this should be the end of the audio file being 
processed. There is always an end point at the right side of the waveform display.

9. If necessary, make additional settings in the Pitch Shift Mode section.

10.Click Process.
The pitch bend is applied according to the specified settings.
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Remove DC Offset

This function will remove any DC offset in the audio selection. A DC 
offset is when there is too large a DC (direct current) component in 
the signal, sometimes visible as the signal not being visually centered 
around the “zero level axis”. DC offsets do not affect what you actually 
hear, but they affect zero crossing detection and certain processing, 
and it is recommended that you remove them.

It is recommended that this function is applied to complete audio clips, 
since the DC offset (if any) is normally present throughout the entire re-
cording.

There are no parameters for this function.

Reverse

Reverses the audio selection, as when playing a tape backwards. 
There are no parameters for this function.

Silence

Replaces the selection with silence. There are no parameters for this 
function.
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Stereo Flip

This function works with stereo audio selections only. It allows you to 
manipulate the left and right channel in various ways. The dialog con-
tains the following parameters:

Mode

This pop-up menu determines what the function does:

Option Description

Flip Left-Right Swaps the left and right channel.

Left to Stereo Copies the left channel sound to the right channel.

Right to Stereo Copies the right channel sound to the left channel.

Merge Merges both channels on each side, for mono sound.

Subtract Subtracts the left channel information from the right and vice 
versa. This is typically used as a “Karaoke effect”, for removing 
centered mono material from a stereo signal.
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Time Stretch

This function allows you to change the length and “tempo” of the se-
lected audio, without affecting the pitch. The dialog contains the fol-
lowing parameters:

Input section

This section contains information and settings regarding the “input”, 
the audio selected for processing:

Parameter Description

Length in Samples The length of the selected audio, in samples.

Length in Seconds The length of the selected audio, in seconds.

Tempo in BPM If you are processing music, and know the actual tempo of the 
audio, you can enter it here as beats per minute. This makes it 
possible to time stretch the audio to another tempo, without hav-
ing to compute the actual time stretch amount.

Bars If you use the tempo setting, you need to specify the length of 
the selected audio here, as bars, beats, 1/16-notes and ticks 
(with 120 ticks per 1/16-note).

Time Signature If you use the tempo setting, you specify the time signature here.
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Output section

These settings are used if you want to stretch the audio to fit within a 
specific time span or tempo. The values will change automatically if 
you adjust the Timestretch amount (see below).

Timestretch

The Timestretch parameter determines the amount of timestretch, as 
a percentage of the original length. If you use the settings in the Out-
put section to specify the amount of timestretch, this value will change 
automatically. The possible timestretch range depends on the “Effect” 
option:

• If the “Effect” checkbox is deactivated, the range is 75-125%.
This is the preferred mode if you want to preserve the character of the sound.

• If the “Effect” checkbox is activated, you can specify values between 
10 and 1000%. 
This mode is mainly useful for special effects, etc.

Algorithm

Allows you to select a time stretch algorithm: Standard or Drum mode. 
Standard is quicker and gives lower audio quality. Drum mode is a spe-
cial algorithm, optimized for processing rhythmic material. 

Parameter Description

Samples The desired length in samples.

Seconds The desired length in seconds.

BPM The desired tempo (beats per minute). For this to work, you have to 
know the actual tempo of the audio, and specify this (along with time 
signature and length in bars) in the Input section to the left.

Range Allows you to specify the desired length as a range between two 
time positions.

Set to Locators 
Range

Clicking this button sets the Range values to the length of the Cycle.
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Freeze Edits

The Freeze Edits function on the Audio menu allows you to make all 
processing permanent for a clip:

1. Select the clip in the Pool or one of its events in the Project window.

2. Select “Freeze Edits…” from the Audio menu.

• If there is only one edit version of the clip (no other clips refer to the 
same audio file), the following dialog will appear:

If you select “Replace”, all edits will be applied to the original audio file (the one listed 
in the clip’s Path column in the Pool). If you select “New File”, the Freeze Edits opera-
tion will create a new file in the Audio folder within the project folder (leaving the origi-
nal audio file unaffected).

• If the selected clip (or the clip played by the selected event) has sev-
eral edit versions (i.e. there are other clips referring to the same audio 
file), the following alert will appear:

As you can see, you don’t have the option to Replace the original audio file in this case. 
This is because that audio file is used by other clips. Select “New File” to have a new 
file created in the Audio folder within the project folder.



15
The Sample Editor
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Background

The Sample Editor allows you to view and manipulate audio at the au-
dio clip level, by cutting and pasting, removing or drawing audio data 
or applying effects. 

Opening the Sample Editor

You open the Sample Editor by double clicking an audio event in the 
Project window or the Audio Part Editor, or by double clicking an au-
dio clip in the Pool. You can have more than one Sample Editor open 
at the same time.

• Note that double clicking on an audio part in the Project window will 
open the Audio Part Editor, even if the part only contains a single au-
dio event.
See page 294.
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Window overview

The Elements menu

If you right-click (Win) or [Ctrl]-click (Mac) in the Sample Editor to 
bring up the Quick menu, you will find a sub menu called “Elements”. 
By activating or deactivating options on this submenu, you can decide 
what you want shown in the editor window. Some of these options are 
also available as icons on the toolbar.
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The toolbar

The toolbar contains tools and various settings:

• You can customize the toolbar by right-clicking it (Win) or [Ctrl]-clicking 
it (Mac) and using the pop-up menu to hide or show items.

Selecting Setup from the pop-up menu allows you to reorder sections 
on the toolbar, store presets, etc. See page 561.

The Sample Editor tools Audition, Loop & 
Volume controls

Autoscroll

Show EventShow info line

Snap to Zero Crossing Length of the current selection range

Start and end of current selection rangeHitpoint mode Hitpoint controls

Musical controls
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The thumbnail display

The thumbnail display provides an overview of the whole clip. The sec-
tion currently shown in the Sample Editor’s main waveform display is in-
dicated by a blue rectangle in the thumbnail, while the current selection 
range is shown in blue.

• You can move the blue rectangle in the thumbnail to view other sections 
of the clip.
Click in the lower half of the rectangle and drag it to the left or right to move it.

• You can resize the blue rectangle (by dragging its left or right edge) to 
zoom in or out, horizontally.

• You can define a new viewing area by clicking in the upper half of the 
overview and dragging a rectangle with the pointer.

The ruler

The Sample Editor ruler is located between the thumbnail and the 
waveform display. It shows the timeline in the display format specified in 
the Project Setup dialog (see page 81). If you like, you can select an in-
dependent display format for the ruler by clicking on the arrow button to 
the right of it and selecting an option from the pop-up menu that ap-
pears (this affects the values in the info line too). For a list of the display 
format options, see page 79.
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The waveform display and the level scale

The waveform display shows the waveform image of the edited audio 
clip – in the style selected in the Preferences dialog (Event Display–Au-
dio page), see page 87. To the left of it, a level scale can be shown, in-
dicating the amplitude of the audio.

• When the level scale is shown, you can select whether the level 
should be shown as a percentage or in dB.
This is done by right-clicking the level scale and selecting an option from the pop-up 
menu that appears. This also allows you to hide the level scale.
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• To display the level scale after hiding it, right-click (Win) or [Ctrl]-click 
(Mac) to bring up the Quick menu and activate “Level Scale” on the 
Elements submenu.
This submenu also allows you to select whether you want the zero axis and/or the half 
level axis indicated in the waveform display.

The info line

The info line at the bottom of the window shows information about the 
edited audio clip. You cannot edit the values on the info line.

• To hide or show the info line, click the Show Info button on the toolbar.

• Initially, length and position values are displayed in the format speci-
fied in the Project Setup dialog (see page 81), but you can change 
this by clicking in the middle field of the info line and selecting another 
display format from a pop-up menu.
This selection affects the Sample Editor ruler as well.

Half level axisZero axis

Audio format and length Current selection range

Selected display format (for info line and ruler) Number of edits made to clip

Zoom factor
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Operations

Zooming

Zooming in the Sample Editor is done according to the standard 
zoom procedures, with the following special notes:

• The vertical zoom slider changes the vertical scale relative to the height 
of the editor window, in a way similar to the waveform zooming in the 
Project window (see page 83).
The vertical zoom will also be affected if you drag a rectangle with the Zoom tool and 
the option “Zoom Tool Standard Mode” (Preferences – Editing dialog) is deactivated.

• The following options relevant to the Sample Editor are available on 
the Zoom submenu on the Edit menu:

• You can also zoom by resizing the rectangle in the thumbnail display.
See page 279.

• The current zoom setting is shown in the info line, as a “samples per 
screen pixel” value.

• Note that you can zoom in horizontally to a scale with less than one 
sample per pixel! 
This is required for drawing with the Pencil tool (see page 289).

Option Description

Zoom In Zooms in one step, centering on the position cursor.

Zoom Out Zooms out one step, centering on the position cursor.

Zoom Full Zooms out so that the whole clip is visible in the editor.

Zoom to Selection Zooms in so that the current selection fills the screen.

Zoom to Event Zooms in so that the editor shows the section of the clip corre-
sponding to the edited audio event. This is not available if you 
opened the Sample Editor from the Pool (in which case the 
whole clip is opened for editing, not an event).

Zoom In/Out Vertical This is the same as using the vertical zoom slider (see above).
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• If you have zoomed in to one sample per pixel or less, the appearance 
of the samples depends on the option “Interpolate Audio Images” in 
the Preferences dialog (Event Display–Audio page).
If the option is deactivated, single sample values are drawn as “steps”. If the option is 
activated they are interpolated to “curves” form.

Auditioning

While you can use the regular play commands to play back audio 
when the Sample Editor is open, it is often useful to listen to the ed-
ited material only:

• You can adjust the auditioning level with the miniature level fader on the 
toolbar.

By using the Speaker tool

If you click somewhere in the waveform display with the Speaker tool 
and keep the mouse button pressed, the clip will be played back from 
the position at which you clicked. Playback will continue until you re-
lease the mouse button.

By using the Play icon

Clicking the Play icon on the toolbar plays back the edited audio, ac-
cording to the following rules:

• If you have made a selection, this selection will be played back.
• If there is no selection, but the option “Show Event” is activated (see page 290), 

the section of the clip corresponding to the event will be played back.
• If there is no selection, and “Show Event” is deactivated, the playback will 

start at the cursor position (if the cursor is outside the display, the whole clip 
is played back).

• If the Loop icon is activated, playback will continue repeatedly until you deac-
tivate the Play icon. Otherwise, the section will be played back once.
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Scrubbing

The Scrub tool allows you to locate positions in the audio by playing 
back, forwards or backwards, at any speed:

1. Select the Scrub tool.

2. Click in the waveform display and keep the mouse button pressed.
The project cursor is moved to the position at which you click.

3. Drag to the left or right.
The project cursor follows the mouse pointer and the audio is played back. The speed 
and pitch of the playback depends on how fast you move the pointer.

• You can adjust the response of the Scrub tool with the Scrub Re-
sponse (Speed) setting in the Preferences dialog (VST page).
There you will also find a separate Scrub Volume setting.

Adjusting the snap point

The snap point is a marker within an audio event (or clip – see below). 
This is used as a reference position when you are moving events with 
snap activated, so that the snap point is “magnetic” to whatever snap 
positions you have selected. 

By default, the snap point is set at the beginning of the audio event, 
but often it is useful to move the snap point to a “relevant” position in 
the event, such as a downbeat, etc.: 

1. Activate the “Audio Event” option so that the event is displayed in the 
editor.

2. Scroll so that the event is visible, and locate the “S” flag in the event.
If you haven’t adjusted this previously, it will be located at the beginning of the event.
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3. Click on the “S” flag and drag it to the desired position.
When you drag the snap point, a tool tip shows its current position (in the position for-
mat selected on the Sample Editor ruler.

You can also adjust the snap point by setting the project cursor:

1. Place the cursor at the desired position (intersecting the event).
You may want to do this by scrubbing, to spot the right position exactly.

2. Pull down the Audio menu and select “Snap Point To Cursor”.
The snap point will be set to the position of the cursor. This method can also be used 
in the Project window and the Audio Part Editor.

• It is also possible to define a snap point for a clip (for which there is no 
event yet).
To open a clip in the Sample Editor, double click it in the Pool (or drag it from the Pool 
to the Sample Editor). After having set the snap point using the procedure described 
above, you can insert the clip into the project from the Pool or the Sample Editor, tak-
ing the snap point position into account.
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Making selections

To select an audio section in the Sample Editor, you click and drag 
with the Range Selection tool.

• If Snap to Zero Crossing is activated on the toolbar, the start and end 
of the selection will always be at zero crossings (see page 291).

• You can resize the selection by dragging its left and right edge or by 
[Shift]-clicking.

• The current selection is indicated to the right on the toolbar.
You can fine-tune the selection by changing these values numerically. Note that the 
values are relative to the start of the clip, rather than to the project timeline.

Using the Select submenu

The Select submenu on the Edit menu contains the following selection 
functions:

Function Description

All Selects the whole clip.

None Selects no audio (the selection length is set to “0”).

In Loop Selects all audio between the left and right locator.

From Start to Cursor Selects all audio between the clip start and the project cursor.

A selected range
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Editing selection ranges

Selections in the Sample Editor can be manipulated in several ways. 
Please note:

• If you attempt to edit an event that is a shared copy (i.e. the event re-
fers to a clip that is used by other events in the project), you are asked 
whether you want to create a new version of the clip or not (if you ha-
ven’t made a “permanent” choice already – see below).
Select “New Version” if you want the editing to affect the selected event only. Select 
“Continue” if you want the editing to affect all shared copies. 
Note: If you activate the option “Do not show this message again” in the dialog, any 
and all further editing you do will conform to the selected method (“Continue” or “New 
Version”). You can change this setting at any time with the “On Processing Shared 
Clips” pop-up menu in the Preferences dialog (Editing – Audio page).

Cut, Copy and Paste

The Cut, Copy and Paste commands on the Edit menu work accord-
ing to the following rules:

• Selecting Copy copies the selection to the clipboard.

• Selecting Cut removes the selection from the clip and moves it to the 
clipboard.
The section to the right of the selection is moved to the left to fill out the gap.

From Cursor to End Selects all audio between the project cursor and the end of the 
clip. For this to work, the project cursor must be within the clip 
boundaries.

Select Event Selects the audio that is included in the edited event only. This is 
not available if you opened the Sample Editor from the Pool (in 
which case the whole clip is opened for editing, not an event).

Left Selection Side 
to Cursor

Moves the left side of the current selection range to the project 
cursor position. For this to work, the cursor must be within the 
clip boundaries.

Right Selection Side 
to Cursor

Moves the right side of the current selection range to the project 
cursor position (or the end of the clip, if the cursor is to the right 
of the clip).

Function Description
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• Selecting Paste copies the data on the clipboard into the clip.
If there is a selection in the editor, this will be replaced by the pasted data. If there is no 
selection (if the selection length is “0”), the pasted data will be inserted starting at the 
selection line. The section to the right of the line will be moved to make room for the 
pasted material.

The pasted data will be inserted at the selection line.

Insert Silence

Selecting “Insert Silence” from the Range submenu on the Edit menu 
will insert a silent section with the same length as the current selection, 
at the selection start. 

• The selection will not be replaced, but moved to the right to make room. 
If you want to replace the selection, use the “Silence” function instead (see page 270).

Delete

Selecting Delete from the Edit menu (or pressing [Backspace]) re-
moves the selection from the clip. The section to the right of the 
selection is moved to the left to fill out the gap.

Processing

The functions on the Process submenu on the Audio menu can be 
applied to selections in the Sample Editor, as can the effects on the 
Plug-ins submenu. See the chapter “Audio processing and functions”.
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Creating a new event from the selection

You can create a new event that plays only the selected range, using 
the following method:

1. Make a selection range.

2. Press [Ctrl]/[Command] and drag the selection range to the desired 
audio track in the Project window.

Creating a new clip or audio file from the selection

You can extract a selection from an event and either create a new clip 
or a new audio file, in the following way:

1. Make a selection range.

2. Select “Bounce Selection” from the Audio menu.

A new clip is created and added to the Pool, and another Sample Ed-
itor window will open with the new clip. The new clip will refer to the 
same audio file as the original clip, but will only contain the audio cor-
responding to the selection range.

Drawing in the Sample Editor

It is possible to edit the audio clip at sample level, by drawing with the 
Pencil tool. This can be useful if you need to manually edit out a spike 
or click, etc.

1. Zoom in to a zoom value lower than 1.
This means that there is more than one screen pixel per sample.

2. Select the Pencil tool.

3. Click and draw at the desired position in the waveform display.
When you release the mouse button, the edited section is automatically selected.
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Options and settings

Show audio event

This is only available if you opened the Sample Editor by double clicking 
on an audio event in the Project window or the Audio Part Editor.

When the option “Audio Event” is activated on the Elements submenu 
on the Quick menu (or the Show Audio Event button is activated on 
the toolbar), the section corresponding to the edited event is shown 
with a white background in the waveform display and Thumbnail. The 
sections of the audio clip that are “outside” the event are shown with 
a grey background.

• In this mode, you can adjust the start and end of the event in the clip, 
by dragging the event handles in the waveform display.
When you move the pointer over the event handles (no matter what tool may be se-
lected), it takes on the shape of an arrow, to indicate that you can click and drag.
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Snap to Zero Crossing

Snap to Zero Crossing activated.

When this option is activated, all audio edits are done at zero cross-
ings (positions in the audio where the amplitude is zero). This helps 
you avoid pops and clicks which might otherwise be caused by sud-
den amplitude changes.

• This setting affects the Sample Editor only. In the Project window and 
other editors, the Snap to Zero Crossing setting in the Preferences 
dialog (Editing–Audio page) is used.

Autoscroll

Autoscroll activated.

When this option is activated, the waveform display will scroll during 
playback, keeping the project cursor visible in the editor.
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The Audio Part Editor
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Background

The Audio Part Editor allows you to view and edit the events inside 
audio parts. Essentially, this is the same type of editing that you do in 
the Project window, which means that this chapter contains a lot of 
references to the chapter “The Project window”.

Audio parts are created in the Project window, in one of the following 
ways:

• By selecting one or several audio events on the same track, and se-
lecting “Events to Part” from the Audio menu.

• By gluing together two or more audio events on the same track with 
the Glue Tube tool.

• By drawing an empty part with the Pencil tool.

• By double clicking between the left and right locator on an audio track.
With the last two methods, an empty part is created. You can then add events to the 
part by pasting, or by using drag and drop from the Pool.

Opening the Audio Part Editor

You open the Audio Part Editor by selecting one or more audio part(s) 
in the Project window and double clicking on any one of them (or us-
ing the Edit-Open key command, by default [Ctrl]/[Command]-[E]). 
The Audio Part Editor can display several parts at once, and you can 
also have more than one Audio Part Editor open at the same time.

• Note that double clicking on an audio event in the Project window will 
open the Sample Editor (see page 276).
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Window overview

The toolbar

The tools, settings and icons on the toolbar have the same functional-
ity as in the Project window, with the following differences:

• A Solo button (see page 298).
• Separate tools for audition (Speaker) and scrubbing (see page 299).
• No Line, Glue Tube or Color tool.
• Play and Loop icons and an Audition Volume control (see page 298).
• Part List controls for handling several parts: Activating parts for editing, restrict-

ing editing to active parts only and showing part borders (see page 299).

• You can customize the toolbar, hiding or reordering its items.
This is described on page 561.

The ruler and info line

These have the same functionality and appearance as their counter-
parts in the Project window.
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• Note that you can select a separate display format for the Audio Part 
Editor ruler by clicking on the arrow button on the right and selecting 
an option from the pop-up menu that appears.
For a list of the available formats, see page 79.

About lanes

If you make the editor window larger, this will reveal additional space 
below the edited events. This is because an audio part is divided ver-
tically in lanes. 

Lanes can make it easier to work with several audio events in a part:

In the left figure it is unnecessarily hard to discern, select and edit the 
separate events. In the right figure, some of the events have been 
moved to a lower lane, making selection and editing much easier.

Lanes
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• To move an event to another lane without accidentally moving it hori-
zontally, press [Ctrl]/[Command] and drag it up or down.
This is the default modifier key for this – you can adjust this in the Preferences dialog if 
you like.

Overlapping events

Only one event per track can be played back at the same time! This 
means that if you have overlapping events, on the same lane or different 
lanes, these will cut each other off, according to the following rules:

• For events on the same lane, the ones that are on top (visible) will be 
played.
To move overlapping events to the front or back, use the Move to Front and Move to 
Back functions on the Edit menu.

• For events on different lanes, the event on the lowest lane gets play-
back priority.

The “greyed-out” sections of the upper event will not be played since the event on 
the lower lane has playback priority! Note that in the actual program, playback 
priority between lanes is not indicated by event sections being greyed out.
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Operations

Zooming, selecting and editing in the Audio Part Editor is done just as in 
the Project window (see page 81).

• Note that if a part is a shared copy (i.e. you have previously copied the 
part by [Alt]/[Option]+[Shift]-dragging), any editing you perform will 
affect all shared copies of this part.
To indicate that it is a shared copy, its name is displayed in italics and a symbol is dis-
played in the lower right corner of the part in the Project window (see page 99).

Auditioning

There are three ways to listen to the events in the Audio Part Editor:

By using the Speaker tool

If you click somewhere in the editor’s event display with the Speaker 
tool and keep the mouse button pressed, the part will be played back 
from the position at which you clicked. Playback will continue until you 
release the mouse button.

By using the Audition icon

The Audition and Audition Loop icons.

Clicking the Audition icon on the toolbar plays back the edited audio, 
according to the following rules:

• If you have selected events in the part, only the section between the first and 
last selected event will be played back.

• If you have made a range selection, only this section will be played back.
• If there is no selection, the whole part will be played back. Note that if the 

project cursor is within the part, playback starts from the current cursor position. 
If the project cursor is outside the part, playback starts from the beginning of the 
part.

• If the Audition Loop icon is activated, playback will continue until you deactivate 
the Audition icon. Otherwise, the section will be played back once.
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By using regular playback

You can of course use the regular playback controls while in the Audio 
Part Editor. Furthermore, if you activate the Solo Editor button on the 
toolbar, only the events in the edited part will be played back.

Scrubbing

In the Audio Part Editor, the Scrub tool has a separate icon on the tool-
bar. Apart from that, scrubbing works exactly as in the Project window 
(see page 95).

Handling several parts

When you open the Audio Part Editor with several parts selected – all 
on the same track or on different tracks – they might not all “fit” in the 
editor window, which can make it hard to get an overview of the differ-
ent parts when editing.

Because of this, the toolbar features a few functions to make working 
with multiple parts easier and more comprehensive:

• The Part List menu lists all parts that were selected when you opened 
the editor, and lets you select which part should be active for editing.
When you select a part from the list, it is automatically made active and centered in the 
display.

• Note that it is also possible to activate a part by clicking on it with the 
Arrow tool.
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• The button “Edit Active Part Only”, lets you restrict editing operations 
to the active part only.
If you for example select “All” from the Select submenu on the Edit menu with this op-
tion activated, all events in the active part will be selected but not the events in other 
parts.

“Edit Active Part Only” activated on the toolbar.

• You can zoom in on an active part so that it fills the screen by select-
ing “Zoom to Event” from the Zoom submenu on the Edit menu.

• The button “Show Part Borders” can be used if you want to see 
clearly defined borders for the active part.
When this is activated, all parts except the active one are grayed out, making the bor-
ders easily discernible. There are also two “markers” in the ruler with the name of the 
active part, marking its beginning and end. These can be moved freely to change the 
part borders.

“Show Part Borders” activated on the toolbar.

• It is possible to cycle between parts, making them active, with key 
commands.
In the Key Commands dialog – Edit category, there are two functions: “Activate Next 
Part” and “Activate Previous Part”. If you assign key commands to these, you can use 
them to cycle between parts. Please refer to page 571 for instructions on how to set 
up key commands.
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Common methods

Assembling a “perfect take”

When you record audio in Cycle mode, an event is created for each 
recorded lap (see page 48). These events are named “Take X”, where 
“X” is the number of the take. You can create a perfect take by putting 
together sections of the different takes in the Audio Part Editor. First, 
you have to create an audio part from the takes.

Creating an audio part from events

1. In the Project window, use the Object Selection tool to draw a rectan-
gle around the recorded events.
This is necessary, since clicking on the event may just select the event on top (the last 
take). If in doubt, check the info line – the info text should be yellow.

2. Pull down the Audio menu and select “Events to Part”.
The events are converted to an audio part.

• Note that the events cycle record mode also makes it easy to combine 
different takes in the Project window – see page 48.



CUBASE SE
16 – 302 The Audio Part Editor

Assembling a take

1. Double click the part to open the Audio Part Editor.
Now, the different takes will be placed on different lanes, with the last take at the bottom.

2. Use the tools to cut out pieces of the takes and assemble the final 
result.
This can include splitting with the Scissors tool, resizing events with the Arrow tool or 
deleting with the Eraser tool. 

• Remember that the events on the lowest lane have playback priority. 
Use the Audition icon to audition the result.

3. Close the Audio Part Editor.
You have now assembled a “perfect take”!
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Options and Settings

The following options and settings are available in the Audio Part Editor:

• Snap
You can specify an independent Snap mode (and snap value for the Grid mode) in the 
editor. The functionality is exactly the same as in the Project window.

• Autoscroll
When Autoscroll is activated on the toolbar, the window will scroll during playback, 
keeping the project cursor visible in the editor. This setting can be activated or deacti-
vated individually for each window.
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Working with hitpoints and

slices
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Background

Hitpoint detection is a special feature of the Sample Editor. It auto-
matically detects attack transients in an audio file, and then adds a 
type of marker, a “hitpoint”, at each transient. These hitpoints allow 
you to create “slices”, where each slice ideally represents each indi-
vidual sound or “beat” in a loop (drum or other rhythmic loops work 
best with this feature). When you have successfully sliced the audio 
file, you can do a number of useful things with it:

• Change the tempo without affecting pitch.
• Extract the timing (a groove map) from a drum loop. This can then be applied 

to quantize other events.
• Replace individual sounds in a drum loop.
• Edit the actual playing in the drum loop without affecting the basic feel.
• Extract sounds from loops.

• The term “loop” is used throughout this chapter. Loop in this context 
usually means an audio file with a musical timebase, i.e. the length of 
the loop represents a certain number of bars and/or beats at a certain 
tempo. Playing the loop back at the right tempo in a cycle set to the cor-
rect length will produce a continuous loop, without gaps.
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Using hitpoints

The basic functionality of using hitpoints to slice up a loop is to make 
a loop fit the tempo of a song, or alternatively to create a situation that 
allows the song tempo to be changed whilst retaining the timing of a 
rhythmic audio loop, just like when using MIDI files. 

What audio files can be used?

Here are some guidelines to what type of audio files will render the 
best results when slicing files using hitpoints:

• Each individual sound in the loop should have some noticeable attack. 
Slow attacks, legato playing etc. may not produce the desired result.

• Poorly recorded audio might be difficult to slice correctly.
However, the hitpoint detection function can automatically normalize the audio to im-
prove the detection results – see below.

• There may be problems with sounds drowned in smearing effects, like short 
delays.

Calculating hitpoints and slicing a loop – a quick tutorial

Before proceeding, find a suitable loop using the criteria above. At 
this point it doesn’t matter whether you know the original tempo of the 
loop, as this will be automatically detected. Proceed as follows:

1. Open the event or clip for editing in the Sample Editor.
You could do this by double clicking an event on an audio track in the Project window 
or a clip in the Pool. In this example, we assume you work with an event on a track.

2. Select the Audio Tempo Definition tool on the Sample Editor toolbar.

3. Enter the length and the time signature of the loop in the respective 
fields on the toolbar. The tempo is calculated automatically.
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4. Click the Hitpoint Mode button on the toolbar.
Now the Sensitivity slider is added, and the Use menu is activated. The items on this 
pop-up don’t affect the actual detection but rather which hitpoints will be shown after-
wards. If you e.g. know that your loop is based on 1/16th notes, select “1/16”. If you’re 
uncertain, set this to “All” – you can change this setting afterwards if needed.

5. Select “Calculate Hitpoints” on the Audio menu – Hitpoints submenu.

Now a dialog appears with settings for the hitpoint detection. On the 
Presets pop-up you can choose a preset detection mode best suited 
to the audio material. Alternatively you can select “Advanced” where 
you can specify settings yourself. 

• The “Sense” parameter sets the sensitivity of the detection. 
The higher the setting the more transients will be detected.

• The “Threshold” parameter sets the level threshold.
The lower you set this the more low level transients will be detected.

6. Click Process.
The hitpoints are detected.
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As you now can see, hitpoints have been set at the beginning of each 
sound in the loop (or at least at most of them).

7. If you now move the hitpoint sensitivity slider to the left, this gradually 
hides the hitpoints. Moving the slider to the right increases the sensitiv-
ity to reveal additional hitpoints detected during the calculate process.
The basic aim is to add, remove or in various other ways edit the hitpoints so that one 
individual sound is played between each hitpoint. This is described in detail starting on 
page 311.

In the next step, the loop will adapt to the project tempo of Cubase SE.

8. Pull down the Audio menu, and select “Create Audio Slices from Hit-
points” from the Hitpoints submenu.
Now the following happens:

• The Sample Editor closes.
• The audio event is “sliced” so that there is a separate event for each hitpoint. 
• The audio event is replaced by an audio part, containing the slices (double 

click the part to view the slices in the Audio Part Editor).
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• The loop is automatically adapted to the project tempo.

The slices in the Audio Part Editor. Here, the project tempo was higher than the 
loop’s original tempo – this means the slice events will overlap slightly.

• If you opened the Sample Editor for a clip in the Pool, you will find that 
the icon for the clip changes in the Pool (to indicate that it is sliced).
Dragging the sliced clip from the Pool to an audio track will create an audio part with 
the slices adapted to the project tempo, just as above.

9. If you activate cycle playback on the Transport panel, the loop should 
now play back seamlessly at the tempo set in the program!

• Note that if the project tempo is lower than the loop’s original tempo, 
there may be audible gaps between each slice event in the part.
This can be remedied by using the Close Gaps function on the Advanced submenu – 
see page 325. You should also consider activating auto fades for the part’s audio track 
– fade-outs set to about 10 ms will help eliminate any clicks between the slices when 
you play back the part. See page 150.

• If the project tempo is higher than the loop’s original tempo, you may 
want to activate auto crossfades for the track.
You can use the Close Gaps functions in this case as well if needed.
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Editing hitpoints

In this section, we go back a bit and look at what can be done with hit-
points in the Sample Editor. There are two ways to invoke the hitpoint 
calculation:

• Select Calculate Hitpoints from the Hitpoints submenu on the Audio menu.
• Select the Hitpoint Edit tool from the toolbar or Quick menu.

The last method will calculate hitpoints if they haven’t already been calculated.

As outlined in the previous section, this makes the program calculate 
(or detect) hitpoints in the audio event, and you can use the Sensitivity 
slider to change how many hitpoints are shown. 

For some loops, this may be all that is needed to set the hitpoints so 
that each slice to be created will contain a single “hit” or sound. How-
ever there will almost certainly be cases when the automatic calcula-
tion may add a hitpoint where there shouldn’t be one, and fail to add a 
hitpoint where one is needed, even if the Sensitivity slider is set to 
maximum. If there are too many or too few hitpoints in a loop, it will 
most probably not play back properly.

When this occurs, you have to edit the hitpoints manually in the Sam-
ple Editor.

Auditioning slices

A slice is a section of the waveform, from one hitpoint to the next. 

The first thing you should do before editing hitpoints is to listen to 
each slice in the Sample Editor, to determine what they contain. The 
aim is basically to avoid “double hits”, like a snare hit being followed 
by a hi-hat hit within the same slice. You also want to determine 
whether any hitpoints have been added that should be removed: 
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1. Open a loop in the Sample Editor.
If you have already created slices you can open them in the Sample Editor by double 
clicking any event in the Audio Part Editor. If it is a new loop, follow the instructions in 
the tutorial.

2. Select the Hitpoint Edit tool.
When you point in the waveform display the pointer changes to a speaker icon.

3. Now you can simply point and click in any slice area and the corre-
sponding slice will be played back, from the beginning to the end.
Listen for “double hits” and slices that contain parts of a single sound. 

If you find hitpoints that need to be removed or instances where a hit-
point needs to be added, the first thing to try is to change the sensitiv-
ity setting – see the following section.

Setting the sensitivity

The loop is first analyzed to determine where hitpoints should appear 
(where the individual “beats” in the loop are), then you manually set the 
sensitivity with the Sensitivity slider to determine how many hitpoints 
there should be.

• Try raising the sensitivity to add “missing” hitpoints, and lowering it to 
remove unwanted hitpoints.
This may or may not work, depending on the situation, but as a general rule you should 
try this first.

• Audition the slices again to determine if changing the sensitivity has 
improved matters.
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The “Use” pop-up menu

The “Use” pop-up menu on the toolbar affects which hitpoints are 
shown and is a useful tool for removing unwanted hitpoints. The op-
tions on the pop-up menu are:

How many slices do I need?

If your main reason for slicing the loop is to change the tempo, you 
generally need as many slices as you can get, but never more than 
one per individual “hit” in the loop.

Option Description

All All hitpoints are shown (taking the Sensitivity slider into account).

1/4, 1/8, 1/16, 1/32 Only hitpoints that are close to the selected note value positions 
within the loop (e.g. close to exact sixteenth note positions, if you 
have selected the 1/16 option) will be shown. Again, the Sensi-
tivity slider is taken into account.

Metric Bias This is like the “All” mode, but all hitpoints that are close to even 
meter divisions (1/4 notes, 1/8 notes, 1/16 notes, etc.) get a 
“sensitivity boost” – they are visible at lower Sensitivity slider set-
tings. This is useful if you are working with dense or cluttered ma-
terial with a lot of hitpoints, but you know that the material is 
based on a strict meter. By selecting Metric Bias it will be easier 
to find the hitpoints close to the meter position (although most 
other hitpoints are also available, at higher sensitivity settings).
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Disabling slices

You might run into situations where there are too many slices – a sin-
gle sound may have been split into two slices for example. You could 
of course reduce the sensitivity to get rid of the hitpoints you don’t 
want, but then other hitpoints could disappear too, which may be un-
desirable. What you need to do in a situation like this is to disable an 
individual slice, using the Hitpoint Edit tool:

1. Select the Hitpoint Edit tool.

2. Press [Alt]/[Option] and move the pointer to the handle (the triangle).
The pointer turns into a cross in the Sample Editor window. 

3. Click on the handle of the hitpoint you wish to disable.
The hitpoint handle is diminished and its line disappears to indicate that it is disabled.

4. Now, the hitpoint won’t be taken into account when you create slices.

5. To reactivate a disabled hitpoint, [Alt]/[Option]-click on the hitpoint 
handle with the Hitpoint Edit tool.

Locking slices

If you lock a hitpoint by clicking on its handle with the Hitpoint Edit tool, 
it will stay even if you drag the Sensitivity slider all the way to zero. This 
can be used in situations where one or several slices contain double 
hits, but raising the sensitivity adds a lot of unwanted slices.

1. Find the place where you hear double hits when auditioning.

2. Remember the current slider setting.
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3. Raise the Sensitivity slider to a higher value so that a hitpoint appears, 
separating the two sounds.
Most likely this will add a lot of other unwanted hitpoints as well.

4. Audition to make sure you got what you wanted.

5. Select the Hitpoint Edit tool and point at the handle.
The speaker icon changes to a normal arrow pointer.

6. Lock the new slice by clicking on its handle.
Locked hitpoints are dark blue in color.

7. Drag the Sensitivity slider to the original setting.
The locked hitpoint will remain shown.

• You can unlock a locked hitpoint by clicking it again with the Hitpoint 
Edit tool with [Alt]/[Option] pressed.

Setting hitpoints manually

If you cannot get the desired result by adjusting sensitivity, disabling 
or locking, you can add, move and delete hitpoints manually.

Adding hitpoints

Manually adding hitpoints can be done in situations where a hitpoint is 
missing at a specific point, but doesn’t appear even if the sensitivity is 
set to full.

1. Zoom in on the waveform at the point where you wish to add a hitpoint.

2. Audition the area with the Hitpoint Edit tool to make sure that the start 
of the sound is in view.

3. Activate Snap to Zero Crossing on the Sample Editor toolbar.
By finding zero crossings in the waveform (positions where the amplitude is close to 
zero), manually added slices won’t introduce any clicks or pops. All hitpoints found by 
the Calculate function are automatically placed at zero crossings.
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4. Press [Alt]/[Option] with the Hitpoint Edit tool selected so that the 
mouse pointer changes to a pencil tool and click just before the start 
of the sound.
A new hitpoint appears. Manually added hitpoints are locked by default.

• If you click and keep the mouse button pressed, you can adjust the 
position of the new hitpoint by dragging.
Releasing the mouse button adds the hitpoint.

5. Audition the new slice with the Play tool to make sure you got what 
you wanted.

Moving hitpoints

If you manually added a hitpoint, and it was either placed too far away 
from the start of the sound, or too far into the sound, you can manually 
move the hitpoint. It is also possible to move calculated hitpoints this 
way.

1. Make sure Snap to Zero Crossing is activated on the Sample Editor 
toolbar.

2. Select the Hitpoint Edit tool.

3. Click on the hitpoint handle and drag it to the new position.

Deleting hitpoints

To delete a hitpoint, select the Hitpoint Edit tool and drag it to the left 
out of the Sample Editor window. Hitpoints that you have created 
manually can also be deleted by clicking its handle with the Hitpoint 
Edit tool.
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About Q-points

Optionally, hitpoints can have individual Q-points. These are mainly 
used for audio quantizing. Their function is to define the point to which 
the quantizing will apply. Sometimes a slice might have a slow attack, 
and a peak further into the slice which you wish to use as the Q-point. 
When you apply quantize, the Q-point will define the point which will 
be stretched to a grid position when quantizing.

• To activate Q-points, open the Preferences–Editing–Audio page on 
the File menu and check the “Hitpoints have Q-Points” option.
Next time you use the Calculate Hitpoints function, the hitpoints will have Q-points. 
Manually added hitpoints do not have Q-points.

• To offset the position of a Q-point in relation to the hitpoint, simply point 
and click on the “Q” icon and drag it to the right to the desired position.
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Using the Audio Tempo Definition tool

When this tool is selected, you can set the tempo, length (in bars and 
beats) and time signature for an audio file. The Audio Tempo Definition 
tool can be used to determine the tempo of an audio clip when calculat-
ing hitpoints. In case you have an audio clip with an unknown length and 
tempo you can calculate the tempo by defining the length of one bar:

Determining the tempo of an audio clip

You can use the Audio Tempo Definition tool to determine the tempo 
of an audio clip with an unknown length and source tempo. 

For this to work properly the audio clip must have a steady tempo that 
doesn’t vary over time. 

After importing the audio file, the first thing you should do is to make 
sure that, with the Audio Tempo Definition tool selected, the first down-
beat of the audio clip is aligned with the first beat of the first bar in the 
Sample Editor:

1. Import the audio file.

2. Double-click the audio event to open the Sample Editor.

3. Select the Audio Tempo Definition tool.

When the Audio Tempo Definition tool is selected, the Sample Editor 
ruler does not reflect the audio event position in the Project window, 
but instead displays the length of the audio file in bars and beats. 

In case the audio file starts with a downbeat there is no problem. But 
in case it doesn’t, you can offset the ruler in the Sample Editor.

4. Audition the file to determine where the first downbeat occurs.
Stop the auditioning when you have located it.
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5. Move the mouse pointer to the upper part of the ruler until the pointer 
changes to a hand symbol.

6. Click and drag the ruler to the right until the first bar in the ruler 
matches the first downbeat in the sample.

7. Release the mouse button.
Now the ruler grid is offset so that it starts on the first downbeat in the sample.

8. Audition the file to determine where the next downbeat occurs, i.e. the 
first beat of the second bar in the sample.
Stop the auditioning when you have located it.
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9. In this example the second downbeat in the sample is located at the 
start of the second beat of the second bar (at the cursor position in 
the picture).

10.Place the mouse pointer at the start of bar 2 in the waveform display.
The pointer changes to a metronome icon with a blue line indicating the pointer posi-
tion. The pointer will snap to the grid positions.
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11.Click and drag the grid to the right until the second bar in the ruler is 
aligned with the position of the second downbeat of the sample, and 
release the mouse button.
The correct tempo is automatically calculated, based on the time it takes for one bar to 
finish.
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Creating slices

After you have specified the correct loop length and time signature 
and worked on the hitpoints in the Sample Editor so that one sound 
per slice is heard, it is time to actually slice the file (if that is what you 
want to do – there are other uses for hitpoints as well, as described on 
the following pages). This is done by selecting “Create Audio Slices 
from Hitpoints” from the Hitpoints submenu on the Audio menu.

Now the following happens:

• If you edited an event on an audio track, the Sample Editor closes.

• The audio event is “sliced” so that there is a separate event for each 
hitpoint.
In other words, the sections between the hitpoints become separate events, all referring 
to the same original file.

• On the audio track, the audio event is replaced by an audio part, con-
taining the slices.
If you edited a clip from the Pool, you need to drag it to an audio track to get a part with 
the slices.

• The loop is automatically adapted to the tempo set in Cubase SE.
This takes the loop length settings you made into account: if the loop was e.g. one bar 
long, the part is resized to fit exactly one bar in the Cubase SE tempo, and the slices 
are moved accordingly – keeping their relative positions intact within the part.

Now, you can change the tempo and have the loop automatically fol-
low. Furthermore, you can double click the part to edit the slices in the 
Audio Part Editor. You can: 

• Remove or mute slices.
• Change the loop by reordering, replacing or quantizing slices.
• Apply processing to individual slices.
• Create new files from individual slices using the “Bounce Selection” function 

on the Audio menu.
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Other hitpoint functions

On the various submenus on the Audio menu you will also find the fol-
lowing functions:

Create Markers from Hitpoints

This is located on the Hitpoints submenu. If an audio event contains 
calculated hitpoints, this function can be used to add markers – one 
for each hitpoint – to an automatically created marker track (see page 
132). This can be useful for locating to hitpoints.

Divide Audio Events at Hitpoints

This Hitpoints submenu item can be used when you simply wish to 
create separate events according to the hitpoints for a file. This means 
that you do not have to make the same considerations as when slicing 
for tempo changes. You can use any method you like to set hitpoints, 
use sensitivity, note values, manually or any combination.

• The slices created will appear in the Project window as separate 
events.

Set Audio Event from Loop

This Advanced submenu function will resize the event according to 
the loop range in the Sample Editor. For example, if you have a long 
loop event and want to “extract” the first bar only, select the Audio 
Tempo Definition tool and adjust the end loop point handle in the ruler 
to one bar. Then use Set Audio Event from Loop before calculating 
hitpoints.
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Set Tempo from Event

This Advanced submenu function sets the project tempo according to 
the original tempo of the loop (as calculated by the Audio Tempo Def-
inition tool). The result depends on whether you are using the Tempo 
track or a fixed tempo.

• If you are using fixed tempo, you will be asked to confirm that you want to 
change this – click Yes to set the fixed tempo to the event’s original tempo.

• If you are using the Tempo track, but there are no tempo changes, you will be 
asked whether to change the global tempo or not:
Click Yes to change the global tempo (the first tempo event on the Tempo track) or No 
to insert tempo events at the beginning and end of the audio event (i.e. the project 
tempo will be adapted to the loop tempo but only during the course of the event).

• If you are using the Tempo track with tempo changes, new tempo events will 
be inserted at the beginning and end of the audio event.
The project tempo will be adapted to the loop tempo during the course of the event.

Stretch to Project Tempo

The Stretch to Project Tempo function on the Advanced submenu 
(Audio menu) makes use of the tempo calculated by the Audio Tempo 
Definition tool and applies time stretch to the selected event, so that it 
fits the current project tempo.

This can be used for stretching a whole loop (not sliced) to the project 
tempo. Note: for this function to be available, you must close the Sam-
ple Editor and select the audio event in the Project window.
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Using the Close Gaps function

If you have sliced a loop for tempo changes, lowering the tempo be-
low the loop’s original tempo will create gaps between the slices. The 
lower the tempo is in relation to the original tempo, the wider the gaps 
will be. This can be fixed using the “Close Gaps” function on the Ad-
vanced submenu on the Audio menu:

1. Set the desired tempo.

2. Select the part in the Project window.

3. Select “Close Gaps” from the Advanced submenu.
Now time stretch is applied on each slice to close the gaps. Depending on the length 
of the part, this can take a little while.

4. The waveform is redrawn and the gaps are now closed!

• Note that this feature creates new clips in the Pool, one for each slice.

• Close Gaps can also be used when the project tempo is higher than 
the original loop tempo.
This will use the time stretch function to shrink the slices to fit.

• If you decide to change the tempo again after using the Close Gaps 
function, you should undo the Close Gaps operation or start over 
again, using the original unstretched file.

• You can also use this function on individual events (in the Audio Part 
Editor or Project window).
The events don’t have to be slices – you can use Close Gaps simply to stretch an au-
dio event to the start position of the next event.
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Background

What is the Pool?

Every time you record on an audio track, a file is created on your hard 
disk. A reference to this file – a clip – is also added to the Pool. Two 
general rules apply to the Pool:

• All clips, audio or video, that belong to a project are listed in the Pool. 

• There is a separate Pool for every project.

The way the Pool displays folders and their contents is similar to the 
way the Mac OS X Finder and the Windows Explorer display folders 
and lists of files.

What can you do in the Pool?

In the Pool you can, amongst other things, perform the following oper-
ations:

Operations that affect files on disk

• Import clips (audio files can automatically be copied and/or converted).
• Convert file formats.
• Rename clips (this will also rename the referred files on disk).
• Delete clips (if you select the “Move to Trash” option and empty the Trash 

folder – see page 335).
• Prepare File Archives for backup.
• Minimize Files.

Operations that only affect clips

• Copy clips.
• Audition clips.
• Organize clips.
• Apply audio processing to clips.
• Save or import complete Pool files.
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Opening the Pool

You open the Pool in any of the following ways:

• By clicking the Pool icon in the Project window.

• By selecting “Pool” on the Project menu or “Open Pool Window” on the Pool 
menu.

• By using a key command (by default [Ctrl]/[Command]-[P]).
The content of the Pool is divided into three main folders: 

• The Audio folder
This contains all audio clips currently in the project.

• The Video folder
This contains all video clips currently in the project.

• The Trash folder 
Unused clips can be moved to the Trash folder for later permanent removal from the 
hard disk.

These folders cannot be renamed or deleted from the Pool, but any 
number of subfolders can be added (see page 345).
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Window Overview

Toolbar overview

Audio folder

Trash folder Video folder

Audio clip name

Waveform image

Column HeadingsToolbar

Open/Close 
all Folders

View Pop-upHide/show 
info line

Import Button Project Folder Path

Pool Record Folder PathPlay and Loop buttons, 
audition volume control

Search Button
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The info line

Click the “Show Info” button on the toolbar to show or hide the info line 
at the bottom of the Pool window. It shows the following information:

How clips are displayed in the Pool

• Audio clips are represented by a waveform icon followed by the clip name.

• Video clips are represented by a camera icon followed by the clip name.

The Pool window columns

Various information about the clips can be viewed in the Pool window 
columns. The columns contain the following information:

Column Description

Media This column contains the Audio, Video and Trash folders. If the folders are 
opened, the clip names are shown and can be edited. This column is al-
ways shown.

Used This column displays the number of times a clip is used in the project. If a 
column row is empty, the corresponding clip is not used.

Status This column displays various icons that relate to the current Pool and clip 
status. See page 332 for a description of the icons.

Tempo This shows the tempo of audio files for which a tempo has been set using 
the Audio Tempo Definition tool. If no tempo has been specified, the col-
umn displays “???”. 

Number of audio 
files in the Pool

Number of files in the Pool that are not 
in the project folder (e.g. video files)

Total size of all audio 
files in the Pool

Number of audio 
files in use
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About the Status column symbols

The Status column can display various symbols that relate to the clips 
status. The following symbols can be shown:

Info This column shows the following information for audio clips: The sample 
rate, bit resolution, number of channels and the length in seconds. For video 
clips, it displays the frame rate, number of frames, and length in seconds.

Type This column shows the file format of the clip.

Date This column shows the date when the clip was created.

Origin Time This column shows the original start position where a clip was recorded in 
the project. As this value can be used as a basis for the “Insert into Project” 
Pool menu item (and other functions), you can change it if the Origin Time 
value is redundant. This can either be done by editing the value in the col-
umn, or by selecting the corresponding clip in the Pool, moving the project 
cursor to the new desired position and selecting “Update Origin” from the 
Pool menu. 

Image This column displays waveform images of audio clips. 

Path This column shows the path to the location of a clip on the hard disk.

Symbol Description

This indicates the current Pool Record folder (see page 344).

This symbol is shown if a clip has been processed.

The question mark indicates that a clip is referenced to the project but is 
missing from the Pool (see page 338).

This indicates that the clip file is external, i.e. located outside the current 
Audio folder for the project.

This indicates that the clip has been recorded in the currently open version 
of the project. This is useful for finding recently recorded clips quickly.

Column Description
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Sorting the Pool contents

You can sort the clips in the Pool by name, date etc. This is done by 
clicking on the corresponding column heading. Clicking again on the 
same heading switches between ascending and descending sort order.

Operations

Renaming clips in the Pool

To rename a clip in the Pool, select it and click on the existing name, 
type in a new name and press [Return].

Renaming a clip in the Pool is much preferred to renaming it outside 
Cubase SE (for example on the computer desktop). This way Cubase SE 
already “knows” about the change, and won’t lose track of the clip the 
next time you open the project. See page 338 for details about lost files.

Copying clips in the Pool

To make a duplicate clip, proceed as follows:

1. Select the clip you wish to copy.

2. Select “New Version” on the Pool menu.
A new version of the clip appears in the same Pool folder, with the same name but with 
a “version number” after it, to indicate that the new clip is a duplicate. The first copy 
made of a clip will logically get the version number “2” and so on.

Copying a clip does not create a new file on disk, but just a new edit ver-
sion of the clip (referring to the same original file).

The arrow indicates the 
sort column and sort order.
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Inserting clips into a project

Using menus

1. Select the clip(s) you want to insert into the project.

2. Pull down the Pool menu and select an “Insert into Project” option.
The “At Cursor” option will insert the clip(s) at the current project cursor position. 
The “At Origin” option will insert the clip(s) at their Origin Time position(s).

• Note that the clip will be positioned so that its snap point is aligned 
with the selected insert position.
You can also open the Sample Editor for a clip by double clicking it, and perform the 
insert operation from there. This way you can set the snap point before inserting a clip.

3. The clip is inserted on a new audio track, created automatically, or on 
a selected track.
If several tracks are selected, the clip will be inserted on the first selected track.

By using drag and drop

You can use drag and drop to insert clips into the Project window. 
You can also use drag and drop from the Sample Editor for a clip by 
making a selection range and pressing [Ctrl]/[Command] while drag-
ging. Note:

• Snap is taken into account if activated.

• While you drag the clip in the Project window, its position will be indi-
cated by a marker line and a numerical position box.
Note that these indicate the position of the snap point in the clip. For example, if you 
drop the clip at the position 22.00, this will be where the snap point ends up. See 
page 284 for info about how to set the snap point.

• If you position the clip in an empty area in the event display (i.e. below 
existing tracks), a new track is created for the inserted event.

Snap point
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Deleting clips

Removing clips from the Pool

To remove a clip from the Pool without deleting it from the hard disk, 
proceed as follows:

1. Select the file(s) and select “Delete” from the Edit menu (or press 
[Backspace] or [Delete]).

• If you try to delete a clip that is used by one or more events, the program 
will ask you if you want to remove these events from the project.

Canceling means that neither the clip nor the associated events are deleted.

2. Click Remove.
A new prompt asks whether you want to move the clip to the Trash or remove it from 
the Pool.

3. Select “Remove from Pool”.
The clip is no longer associated with the project, but still exists on the hard disk, and 
can be used in other projects etc. This operation can be undone.

Deleting from the hard disk

To delete a file permanently from the hard disk, it must first be moved 
to the Trash folder:

• Follow the instructions for deleting clips above and select “Trash”.

When clips are in the Trash folder they can be removed permanently.

• Select “Empty Trash” on the Pool menu.
A dialog box asks you if you are sure you want to follow through. Remember that this 
operation cannot be undone!

Before you permanently delete audio files from the hard disk, you 
should make sure that these aren’t used by another project!
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Removing unused clips from the Pool

This function finds all clips in the Pool that are not used in the project, 
and either moves them to the Pool Trash folder where they can be 
permanently deleted, or removes them from the Pool:

1. Select “Remove Unused Media” on the Pool menu.
A prompt appears with the text “Move to Trash or Remove From Pool?”

2. Make your selection.

Locating events referring to a clip in the Pool

If you want to find out which events in the project refer to a particular 
clip in the Pool, proceed as follows:

1. Select the clip in the Pool.

2. Select “Select in Project” on the Pool menu.
All events that refer to the selected clip are now selected in the Project window.

Locating clips in the Pool

You can perform a search of the Pool to locate particular clips, in the 
following way:

1. Select “Search Media…” from the Pool menu.
This opens the Find Media window, in which you can specify various 
criteria to match. You can search by any one (or a combination) of the 
following properties:

• Name.
• Size (in seconds, minutes, frames or bytes).
• Bitsize (resolution).
• Channels (stereo or mono).

2. Tick the box beside the property you would like to search by, and enter 
the desired name or value.
For the “Size” property, you can search for sizes smaller or greater than a value, or 
between two values. This is determined by the second pop-up menu.

3. Press Start.
The search result appears in the lower half of the window. 

• To select the found clips in the Pool, click the “Select in Pool” button.
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• To insert a found clip directly into the project, select it in the list in the 
dialog and select one of the “Insert into Project” options from the Pool 
menu.
The options are described on page 334.

The “Search Media…” command is also accessible from the Project 
window – the Pool window does not have to be open.

Locating selected events

If you quickly want to find the clip for an event in the Project window, 
you can also use the following method:

1. Select one or several events in the Project window.

2. Pull down the Audio menu and select “Find Selected in Pool”.
The corresponding clip(s) will be located and highlighted in the Pool. If the Pool window 
isn’t already open it will be opened.

Searching for audio files on disk

The Pool can help you locate audio files on your hard disk or other 
media. This works much like the regular file search, but with a couple 
of extra features:

1. Click the Search button in the toolbar.
A lower pane appears in the window, displaying the search functions.

2. Use the Location pop-up menu to specify where to search.
The pop-up menu will list all your local drives and removable media. 
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• If you want to limit the search to certain folders, choose “Select Search 
Path…” and select the desired folder in the dialog that appears.
The search will include the selected folder and all subfolders. Note also that folders 
you have recently selected using the “Select Search Path” function will appear on the 
pop-up menu, allowing you to quickly select any of them.

3. Specify the name of the file(s) to search for in the Name field.
You can use partial names or wildcards (*), if you like. Note however, that the function 
only searches for audio files of the supported formats.

4. Click the Search button in the search pane.
The search is started and the Search button is labeled Stop – click this to cancel the 
search if needed.

When the search is finished, the found files are listed to the right.

• To audition a file, select it in the list and use the playback controls to 
the left (Play, Stop, Pause and Loop).
If Auto Play is activated, selected files will automatically be played back.

• To import a found file into the Pool, select it in the list and click the Im-
port button in the search pane.

5. To close the search pane, click the Search button in the toolbar again.

About missing files

When you open a project, you may get a warning that one or more 
files are “missing”. If you click Close in the warning dialog, the project 
will open anyway, without the missing files. In the Pool you can check 
which files are considered missing. This is indicated by a question 
mark in the Status column.

A file is considered missing under one of the following conditions:

• The file has been moved or renamed outside the program since the last 
time you worked with the project, and you ignored the Resolve Missing 
files dialog when you opened the project for the current session.

• You have moved or renamed the file outside the program during the 
current session.

• You have moved or renamed the folder in which the missing files are 
located.
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Locate missing files

1. Select “Find Missing Files” from the Pool menu.
The Resolve Missing Files dialog opens. 

2. In the dialog that appears, decide if you want the program to try to find 
the file for you (Search), if you want to do it yourself (Locate) or if you 
want to specify in which directory the program should search for the 
file (Folder).

• If you select Locate, a file dialog opens, allowing you to locate the file 
manually.
Click “Open” when you have located the file.

• If you select Folder, a dialog opens to let you specify the directory in 
which the missing file can be found.
This might be the preferred method if you have renamed or moved the folder contain-
ing the missing file, but the file still has the same name. Once you select the correct 
folder, the program finds the file and you can close the dialog.

• If you select Search, the program will scan your hard disks for a file 
with the proper name and display them in a list. 
The dialog allows you to specify which folder or disk should be scanned. Click the 
Search Folder button, select a directory or a disk and then click the Start button. If 
found, select the file from the list and click “Accept”. Afterwards Cubase SE tries to 
map all other missing files automatically.

Reconstructing missing edit files

If a missing file cannot be found (e.g. if you have accidentally deleted 
it from the hard disk) it will normally be indicated with a question mark 
in the Status column in the Pool. However, if the missing file is an edit 
file (a file created when you process audio, stored in the Edits folder 
within the project folder), it may be possible for the program to recon-
struct it by recreating the editing to the original audio file:

1. Open the Pool and locate the clip(s) for which files are missing.

2. Check the Status column – if this says “Reconstructible”, the file can 
be reconstructed by Cubase SE.

3. Select the reconstructible clips and select “Reconstruct” from the 
Pool menu.
The editing is performed and the edit files are recreated.



CUBASE SE
18 – 340 The Pool

Removing missing files from the Pool

If the Pool contains audio files that cannot be found or reconstructed, 
you may want to remove these:

• Select “Remove Missing Files” from the Pool menu to remove all 
missing files from the Pool (and remove their corresponding events 
from the Project window).

Auditioning clips in the Pool

There are two methods you can use to audition clips in the Pool:

• By selecting a clip and activating the Play button.
The whole clip will play back, unless you stop playback by clicking the Play button again.

The Play button.

• By clicking somewhere in the waveform image for a clip.
The clip will play from the position in the waveform you click until the end of the clip, 
unless you stop playback by clicking the Play button, or by clicking anywhere else in 
the pool window.

Clicking in the waveform image to audition a clip.

If you have activated the Loop button before you audition, the follow-
ing will happen:

The Loop button.
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• If you click the Play button to audition a clip, it will repeat indefinitely 
until you stop playback by clicking the Play or Loop button again.

• If you click in the waveform image to audition, the section from the 
point you clicked to the end of the clip will repeat indefinitely until you 
stop playback.

Opening clips in the Sample Editor

The Sample Editor allows you to perform detailed editing on the clip 
(see the Sample Editor chapter for details). If you double click on a 
clip waveform icon, the clip will open in the Sample Editor.

One practical use for this is to set a snap point for a clip (see page 
284). When you later insert the clip from the Pool into the project, you 
can have it properly aligned according to the set snap point.

Import Medium...

The Import Medium dialog lets you import files directly into the Pool. It 
is opened from the Pool menu or with the Import button in the Pool 
window.

Clicking the Import button...

...opens the Import dialog:
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This is a standard file dialog, where you can navigate to other folders, 
audition files etc. The following audio file formats can be imported:

• Wave (see page 491)
• AIFF and AIFC (Compressed AIFF)
• REX or REX 2 (see page 553)
• Sound Designer II 
• MPEG Layer 2 and Layer 3 (mp2 and mp3 files – see page 554)
• Ogg Vorbis (ogg files – see page 554)
• Windows Media Audio (Windows – see page 554)
• Stereo or mono
• Any sample rate (although files with another sample rate than the one used in 

the project will play back at the wrong speed and pitch – see below).
• 8, 16 or 24 bit resolution

In addition, AVI, QuickTime, WMV (Windows only), DV (Mac OS X 
only) and MPEG 1 and 2 video files can be imported into the Pool.

It is also possible to use the commands on the Import submenu on the 
File menu to import audio or video files into the Pool.

For video files to be played back correctly, the right codecs have to be 
installed.

When you select a file in the Import Medium dialog and click Open, 
the Import Options dialog will appear.
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It contains the following options:

• Copy File to Working Directory.
Activate this if you want a copy of the file to be made in the Project’s Audio folder, and 
have the clip refer to this copy. If the option is off, the clip will refer to the original file in 
the original location (and will thus be marked as “external” in the Pool – see page 332).

• Convert to Project.
Here you can choose to convert the sample rate and/or the sample size (resolution) to 
the current format used in the project. The options will only be available if necessary (if 
the sample rate is different than the one set for the project and/or if the sample size is 
lower than the record format used in the project).
Note that if you are importing several audio files in one go, the Import Options dialog 
will instead contain a “Convert if needed” checkbox. When this is activated, the im-
ported files will be converted only if the sample rate is different or the sample size is 
lower than the project’s.

• Do not Ask again.
If this is ticked, you will always import files according to the settings you have made, 
without this dialog appearing. This can be reset in the Preferences–Audio Editing dialog. 

You can always convert later should you so wish, by using the Convert 
Files (see page 348) or Conform Files (see page 349) options.

Importing audio CD tracks

You can import tracks (or sections of tracks) from an audio CD directly 
into the Pool by using the “Import Audio CD” function on the Pool menu. 
This opens a dialog in which you can specify which tracks should be 
grabbed from the CD, converted to audio files and added to the Pool.

For details about the Import Audio CD dialog, see page 550.
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Changing the Pool Record folder

The Pool Record folder.

The Pool Record folder is where all audio clips that you record in the 
project will end up in the Pool. The Pool Record folder is indicated by 
the text “Record” in the Status column, and by a red dot on the folder 
itself, as shown in the picture above. By default, this is the main Audio 
folder. You can, however, at any time create a new Audio subfolder 
and designate this as your Pool Record folder. Proceed as follows:

1. Select the Audio folder or any audio clip.
You cannot designate the Video folder (or a subfolder in it) as the Pool Record folder.

2. Select “Create Folder” on the Pool menu.
A new empty audio subfolder appears in the Pool.

3. Select the new folder.

4. Select “Set Pool Record Folder” on the Pool menu, or click in the new 
folders Status column.
The new folder now becomes the Pool Record folder, and any audio recorded in the 
project will from this point on end up in this folder.
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Organizing clips and folders

If you accumulate a large number of clips in the Pool, it may sometimes 
be difficult to quickly find specific items. In such cases, organizing 
clips in new subfolders with suitable names that reflect the content 
can be a solution. For example, you could put all sound effects in one 
folder, all lead vocals in another etc. Proceed as follows:

1. Select the type of folder, audio or video, in which you want to create a 
subfolder.
You cannot put audio clips in a video folder and vice versa.

2. Select “Create Folder” on the Pool menu.
A new empty subfolder named “New Folder” appears in the Pool.

3. Click on the name and type in a new appropriate name for the folder.

4. Select and drag the clips you wish to move to the new folder.

5. Repeat steps 1-4 as necessary.

Applying processing to clips in the Pool

You can apply audio processing to clips from within the Pool, just like 
you can to events in the Project window. Simply select the clip(s) and 
select a processing method from the Audio menu. To find out more 
about audio processing, see page 256.

Freeze Edits

If you have applied processing to a clip, either in the Project window 
or in the Pool, this is indicated by the red and grey waveform symbol in 
the Status column. You can also use the Freeze Edits function to cre-
ate a new file with processing applied or replace the original with a 
processed version – see page 274.
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Minimize File

This item on the Pool menu allows you to change the size of audio 
files according to the audio clips referenced in a project. The files pro-
duced using this option will only contain the audio file portions actu-
ally used in the project, which can significantly reduce the size of the 
project (given that large portions of the audio files are unused). 

• This operation will permanently alter the selected audio files in the Pool 
(the process cannot be undone), so be careful with this command!
If this is not what you want, you can use the “Save Project to New Folder” File menu 
item instead. This function also has the option of minimizing files, but copies all files 
into a new folder, leaving the original project untouched. See page 542.

It is useful for archiving purposes. If you have completed a project and 
wish to minimize the project size as much as possible, use this function. 

Proceed as follows:

1. Select the file(s) you wish to minimize in the Pool.

2. Select “Minimize File” from the Pool menu.
An alert appears informing you that the entire Edit History will be cleared. You will at 
this point have the option of cancelling or continuing the operation.

3. After the operation is finished, another alert asks you to save the 
project, to update the new file references.
Do so.

The audio file(s) in the Pool Record folder will now be cropped so that 
only the audio actually used in the project remains in the correspond-
ing audio file.
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Prepare Archive

This Pool menu command should be used when you want to archive a 
project. It checks that every clip referenced in the project is located in 
the same folder. To be more precise, it does the following:

• Any files that are located outside the current project folder will be 
copied to it.
Please note that audio files that reside within the project folder will not be copied to 
the audio folder. You will therefore have to copy them there manually before backing 
up the audio folder or save them separately during backup, see below.

• If any processing has been applied, you will be asked whether you 
want to Freeze Edits.
If you do this, you don’t have to archive the Edit folder. Everything belonging to the 
project will be contained in the project file and the Audio folder.

• Once you have performed a Prepare Archive, you can copy the project 
file, the Audio folder and any other audio material you saved in the 
project folder to backup disks, etc.
It is not necessary to archive the Images folder, since these can be recreated by Cu-
base SE. You may also find a file with the extension “.csh” in the project folder. This 
contains image information for edited clips and other data that can be recreated, and 
can safely be deleted.

Video clips are always referenced, and are not stored in the project folder.
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Convert Files

Selecting Convert Files on the Pool menu opens the Convert Options 
dialog which operates on selected files. Use the pop-up menus to 
specify which audio file attributes you want to keep and which you 
want to convert. The options are:

• Sample Rate
Keep as is, or convert to a sample rate between 8.000 and 96.000 kHz.

• Sample Width
Keep the sample width (resolution) as is, or convert to 16 bit or 24 bit.

• Channels
Keep as is, or convert the file to Mono or Stereo Interleaved.

• File Format
Keep as is, or convert to Wave or AIFF format.

Options

When you convert a file, you can use the Options pop-up to set one 
of the following options regarding what to do with the new file:

Option Description

New Files Creates a copy of the file in the audio folder and converts this new file 
according to the chosen attributes. The new file is added to the Pool, 
but all clip references will still point to the original, unconverted file.

Replace Files Converts the original file without changing clip references. The refer-
ences are however saved with the next save action.
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Conform Files

By using this Pool menu command, you will change all selected files 
that have different file attributes than what is specified for the project, 
to conform to this standard. Proceed as follows:

1. Select all clips in the Pool.

2. Select “Conform Files” on the Pool menu.
A dialog opens allowing you to choose between keeping or replacing the original un-
converted files in the Pool. The following applies:

• Clip/event references in the pool are always redirected to the conformed files.
• If any 'keep' option is selected, original files remain in the Project’s Audio 

folder and new files are created.
• If you select the “Replace” option, files in the Pool and in the Project’s Audio 

folder are replaced.

New + Replace 
in Pool

Creates a new copy with the chosen attributes, replaces the original 
file with the new one in the Pool and redirects the current clip refer-
ences from the original file to the new file. This is the option to select 
if you want your audio clips to refer to the converted file, but still want 
to keep the original file on disk (e.g. if the file is used in other projects).

Option Description
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Options and Settings

Customizing the view

• You can specify which of the columns should be shown or hidden by 
selecting the View pop-up on the toolbar and ticking items on or off.

• You can rearrange the order of the columns by clicking on a column 
heading and dragging the column to the left or to the right.
The mouse pointer changes to a hand when you place it on the column heading.

• The width of a column can also be adjusted by placing the pointer 
between two column headers and dragging left or right.
The pointer changes to a divider when you place it between two column headers.



19
MIDI realtime parameters and

effects
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Introduction

For each MIDI track, you can set up a number of track parameters and 
MIDI effects. These affect how the MIDI data is played back, “transform-
ing” MIDI events in real time before they are sent to the MIDI outputs.

On the following pages, the available parameters and effects are 
described. Keep in mind:

• The actual MIDI events will not be affected – the changes happen “on the fly”.
• Since the track parameter settings don’t actually change the MIDI data on the 

track, they will not be reflected in the MIDI editors. To convert the settings to 
“real” MIDI events, you need to use the Merge MIDI in Loop function (see 
page 368).
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The Inspector – General handling

The track parameters and effects are set up in the Inspector (although 
some settings are available in the mixer as well). Here’s a brief rundown 
on how to handle the Inspector:

• To show or hide the Inspector, click the Inspector icon on the Project 
window’s toolbar.

• The Inspector for a MIDI track is divided into five sections. You can 
fold or unfold the sections individually by clicking on the section name.
Clicking the name for a hidden section brings it to view and hides the other sections. 
[Ctrl]/[Command]-clicking the tab allows you to hide or show a section without affect-
ing other sections. Finally, [Alt]/[Option]-clicking a tab shows or hides all sections in 
the Inspector.

• Folding a section does not affect the functionality but merely hides the 
section from view. 
In other words, your settings will still be active even if you fold the Inspector settings.



CUBASE SE
19 – 354 MIDI realtime parameters and effects

Basic track settings

The topmost Inspector section contains the basic settings for the se-
lected MIDI track. These are settings that either affect the basic func-
tionality for the track (mute, solo, enable record, etc.) or send out 
additional MIDI data to the connected devices (program change, vol-
ume, etc.). The section contains all settings in the Track list (see page 
70), with a few additional parameters:

Parameter Description

Track name field Click once to show/hide the topmost Inspector section. Double-
click to rename the track.

Edit button This opens the channel settings window for the track (a window 
showing a channel strip with volume fader and other controls, 
along with effect settings – see page 168).

Mute/Solo buttons Mutes or solos the MIDI track.

Read/Write buttons Used for automating the track settings – see page 231.

Record enable button Activate this to make the track ready for recording.

Input transformer but-
ton

Opens the Input Transformer dialog, allowing you to transform 
incoming MIDI events in real time. 

Monitor button When this is activated (and MIDI Thru Active is on in the Pref-
erences–MIDI dialog), incoming MIDI will be routed to the se-
lected MIDI output.

Lock button Activating this disables all editing of all events on the track.
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• Note that the functionality of the “Programs” settings (used for selecting 
sounds in the connected MIDI instrument) depends on which instrument 
the MIDI output is routed to, and how you have set up this in the MIDI 
Device Manager.
The MIDI Device Manager allows you to specify which MIDI instruments and other de-
vices are connected to the various MIDI outputs, thus making it possible to select 
patches by name. See the MIDI Devices and Features pdf for details about the MIDI 
Device Manager.

• Many of the basic track settings are duplicated in “mixer channel strip 
form”, in the Channel section at the bottom of the Inspector.
See page 356.

Volume Use this to adjust the level for the track. Changing this setting 
will move the track’s fader in the Mixer window, and vice versa. 
See page 164 for more about setting levels.

Pan Use this to adjust the panning of the track. 

Delay This adjusts the playback timing of the MIDI track. Positive val-
ues delay the playback while negative values cause the track to 
play earlier. The values are set in milliseconds.

In/Out/Chn pop-ups This is where you select MIDI input, MIDI output and MIDI 
channel for the track.

Open Device button If the MIDI track is routed to a VST instrument, clicking this but-
ton opens the control panel for the VST instrument.

Bnk/Prg/Programs Allows you to select sounds by sending MIDI Bank Select and 
Program Change messages (see below)

Map pop-up Allows you to select a drum map for the track – see page 438.

Parameter Description
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Other Inspector sections

Apart from the basic track settings (above), the Track Parameters and 
the effect sections (both described on the following pages), the Inspec-
tor for a MIDI track also contains the following:

The Channel section

This contains a single channel strip, allowing you to set volume, pan, 
mute/solo and other parameters for the track. This is a “mirror” of the 
track’s channel strip in the Cubase SE mixer – see page 161.

VST Instrument section

If the MIDI track is routed to a VST Instrument, an additional section 
will appear at the bottom of the Inspector, labeled with the name of 
the VST instrument. Clicking this section shows a duplicate of the In-
spector settings for the VST Instrument channel. This makes it easy to 
adjust the channel settings for the VST Instrument while you are edit-
ing the MIDI track.

• If the VST Instrument has multiple outputs (and thus several mixer 
channels), there will be a setting called “Output” at the top of the VST 
Instrument section.
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Track parameters

The following settings will affect the MIDI events on the track in real 
time during playback. They will also be in effect if you play “live” with the 
track selected and record enabled (provided that “MIDI Thru Active” is 
activated on the Preferences–MIDI page). This makes it possible to 
e.g. transpose or adjust the velocity of your live playing.

• If you want to compare the result of your track parameters with the “un-
processed” MIDI, you can use the Bypass button in the Track Parameters 
section.
When this is activated, the Track Parameter settings will be temporarily disabled. A 
bypassed section is indicated by a yellow Bypass button.
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Transpose

This allows you to transpose all notes on the track in semitones. The 
available range is -127 to +127 semitones, but remember that the to-
tal range of MIDI note numbers is 0 to 127. Furthermore, not all instru-
ments can play back notes over the whole range. Therefore, extreme 
transpositions can give rather strange and unwanted results.

• You can also transpose individual MIDI parts using the Transpose field 
in the info line.
The transposition in the info line (for the individual part) is added to the transpose value 
you have set up for the whole track in the Inspector-

Velocity Shift

This setting lets you change the dynamics of all notes on the track. 
The value in this field is added to the velocity of each note message 
that is sent out (use negative values to lower the velocities). The range 
is -127 to +127 with 0 representing no change in velocity.

Note that the effects of changing the velocity depends on the sound 
and instrument.

• You can also adjust the velocity of events in individual MIDI parts using 
the Velocity field in the info line.
The velocity shift in the info line (for the individual part) is added to the velocity shift you 
have set up for the whole track in the Inspector.
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Velocity Compression

This function multiplies the velocity values with the factor you specify. 
This factor is set using a numerator (left value) and a denominator 
(right value), resulting in a fractional number (1/2, 3/4, 3/2 etc.). For 
example, if you set the factor to 3/4, the velocities will be three quar-
ters of their original values. The point is, that this will also affect the 
difference in velocity between the notes, thereby compressing or ex-
panding the velocity scale. Typically, you would combine this setting 
with the Velocity Shift parameter. An example:

Let’s say you have three notes with the velocity values 60, 90 and 
120, and wish to “even out” the velocity differences somewhat. If you 
set the Velocity Compression value to 1/2, the notes will play back 
with the velocities 30, 45 and 60. By adding 60 in the Velocity Shift 
field, you will have the notes playing back with the velocities 90, 105 
and 120, meaning you have in effect compressed the velocity range. 

In a similar way, you can use Velocity Compression values greater 
than 1/1 together with negative values in the Velocity Shift field, to ex-
pand the velocity range.

Remember that the maximum velocity is always 127 no matter how 
much you try to expand.

Length Compression

This value adjusts the lengths of all notes on the track. As with Veloc-
ity Compression, the value is set with a numerator and denominator. 
For example, the value 2/1 means that all note lengths will be doubled, 
while 1/4 means all note lengths will be quarter of the actual lengths.
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Random

The Random settings let you introduce random variations to various 
properties of MIDI notes. Anything from very subtle variations to dra-
matic changes can be applied. There are two separate “Random gen-
erators”, each of which are set up in the following way:

1. Pull down the Random pop-up menu and select which note property 
should be randomized.
The options are position, pitch, velocity and length. 

• Keep in mind that depending on the content of the track, certain para-
meter changes might not be immediately noticeable, or have any effect 
at all (as would be the case if applying random length to a percussion 
track playing “one-shot” samples for example). 
To best audition the random changes choose a track with clearly defined rhythm and 
note content, if possible (as opposed to a string pad).

2. Set the desired range of random deviation by entering values in the 
two number fields.
The two values govern the limits of the randomization, so that the values will vary be-
tween the left value and the right value (you cannot set the left value higher than the 
right value). The maximum random range for each property is listed in the table below: 

• Note again that you can make independent settings for the two random 
generators.

• To deactivate the Random function, pull down the Random pop-up 
menu(s) and select “OFF”.

Property Range

Position -500 to +500 ticks

Pitch -120 to +120 semitones

Velocity -120 to +120 

Length -500 to +500 ticks
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Range

The Range function lets you specify a note (pitch) or velocity range 
and either force all notes to fit within this range, or exclude all notes 
outside this range from playback. As with the Random function, there 
are two separate Range settings. Set them up as follows:

1. Pull down the Range pop-up menu and select one of the following 
four modes:

2. Use the two fields to the right to set the min and max values.
These values will be shown as numbers (0-127) for the velocity modes and as note 
numbers (C-2 to G8) for the pitch modes.

Note again that you can make independent settings for the two Range 
functions.

• To deactivate the Range function, pull down the Range pop-up 
menu(s) and select “OFF”.

Mode Description

Vel. Limit This function affects all velocity values outside the specified range. 
Velocity values below the Min setting (the lower limit of the range) are 
set to the Min value, and velocity values above the Max setting are set 
to the Max value. Notes with velocity values within the set range are 
not affected. Use this if you want to force all velocity values to fit 
within a certain range.

Vel. Filter Velocity Filter works by excluding all notes with velocity values out-
side the specified range. Notes with velocity values below the Min 
setting or above the Max setting will not be played back. Use this to 
“isolate” notes with certain velocity values.

Note Limit This function allows you to specify a pitch range, and forces all notes 
to fit within this range. Notes outside the specified range are trans-
posed up or down in octave steps until they fit within the range.
Note: If the range is too “narrow”, so that some notes cannot be fit 
within the range by octave-transposing, these notes will get a pitch in 
the middle of the range. For example, if you have a note with a pitch 
of F3, and the range is C4-E4, that note will be transposed to D4.

Note Filter Note Filter works by excluding all notes with pitches outside the 
specified range. Notes lower than the Min setting or higher than the 
Max setting will not be played back. Use this to “isolate” notes with 
certain pitches.
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MIDI effects

Cubase SE comes with a number of MIDI effect plug-ins, capable of 
transforming the MIDI output from a track in various ways.

Just like the MIDI track parameters, MIDI effects are applied in real time 
to the MIDI data played back from the track (or to MIDI you play live 
“thru” the track).

What are MIDI effects?

Although a MIDI effect can be similar to an audio effect, it’s important 
to remember that you’re not processing the sound resulting from MIDI 
playback, but the MIDI data (the “instructions” for how the music 
should be played back). 

A MIDI effect will change properties of the MIDI events (e.g. change 
the pitch of notes) and/or generate new MIDI events (for example, a 
MIDI delay may add new MIDI notes, “echoing” the original notes).

• The included MIDI effect plug-ins are described in the separate “MIDI 
Devices and Features” pdf document.

Insert and send effects

As with audio effects, there are two ways to route the MIDI events on 
a track to an effect:

• If you add an insert effect, the MIDI events will be sent to the effect, which 
will process the data and pass it on to the track’s MIDI output (or to an-
other insert effect).
In other words, the MIDI events will be routed “through” the insert effect.

• If you use a send effect, the MIDI events will be sent both to the track’s 
MIDI output and to the effect.
That is, you will get both the unprocessed MIDI events and the output of the MIDI effect. 
Note that the effect can send its processed MIDI data to any MIDI output – not necessar-
ily to the one used by the track.
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There are separate sections in the Inspector for Inserts and Sends:

Inserts section

This allows you to add up to two MIDI insert effects. The section con-
tains the following items:

• Effects that display their controls in the Inspector can be forced to appear 
in a separate control panel window by pressing [Alt]/[Option] and clicking 
the Edit button.

Item Description

Edit button Opens the Channel Settings window for the MIDI track.

Bypass button Click this to temporarily disable all insert effects for the track 
(useful for comparing with the unprocessed MIDI, etc.).

Inserts section tab This lights blue if any insert effect is activated.

Effect selection 
pop-up menu (x 2)

Selecting an effect from this pop-up menu automatically activates 
it and brings up its control panel (which can be a separate window 
or a number of settings below the insert slot in the Inspector).
To remove an insert effect completely, select “No Effect”.

On button (x 2) Allows you to turn the selected effect on or off.

Edit button (x2) Click this to bring up the control panel for the selected effect. De-
pending on the effect, this may appear in a separate window or 
below the insert slot in the Inspector. Clicking the button again 
hides the control panel.
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Sends section

This allows you to add up to two MIDI send effects. Unlike audio send 
effects, you can select and activate send effects individually for each 
track. The section contains the following items:

• Effects that display their controls in the Inspector can be forced to ap-
pear in a separate control panel window by pressing [Alt]/[Option] and 
clicking the Edit button.

Item Description

Edit button Opens the Channel Settings window for the MIDI track.

Bypass button Click this to temporarily disable all send effects for the track 
(useful for comparing with the unprocessed MIDI, etc.).

Sends section tab This lights blue if any send effect is activated.

Effect selection 
pop-up menu (x 2)

Selecting an effect from this pop-up menu automatically activates 
it and brings up its control panel (which can be a separate window 
or a number of settings below the send slot in the Inspector).
To remove a send effect completely, select “No Effect”.

On button (x 2) Allows you to turn the selected effect on or off.

Edit button (x 2) Click this to bring up the control panel for the selected effect. 
Depending on the effect, this may appear in a separate window 
or below the sends slot in the Inspector. Clicking the button 
again hides the control panel.

Output pop-up 
menu (x 2)

This determines to which MIDI output the effect should send the 
processed MIDI events.

Channel setting (x 2) This determines on which MIDI channel the effect should send 
the processed MIDI events.

Pre button (x 2) If this is activated, the MIDI signals will be sent to the send effects 
before the track parameters and insert effects.
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About presets

Several of the MIDI plug-ins come with a number of presets for instant 
use. The controls for handling presets consist of a Presets pop-up 
menu along with Store (+) and Remove (-) buttons.

• To load a preset, select it from the Presets pop-up menu.

• To store your current settings as a preset, click the (+) button to the 
right.
A dialog appears, asking you to specify a name for the preset. The stored preset will 
then be available for selection from the pop-up menu for all instances of that MIDI 
plug-in, in all projects.

• To remove a stored preset, select it and click the (-) button to the right.
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Applying a MIDI insert effect – an example

Here is a step-by-step example of how to add a MIDI insert effect to a 
MIDI track:

1. Select the MIDI track and open the Inspector.

2. Click the Inserts tab in the Inspector.

3. Click in one of the insert slots to show the MIDI effect pop-up menu.

4. Select the desired MIDI effect from the pop-up menu.
The effect is automatically activated (the power button for the insert slot lights up) and 
its control panel appears, either in a separate window or in the Inserts section below 
the slot (depending on the effect).

Now all MIDI from the track will be routed through the effect.

5. Use the control panel to make settings for the effect.
All included MIDI effects are described in the “MIDI Effects” chapter in the separate 
“MIDI Devices and Features” pdf.

• You can bypass the insert effect by clicking its power button (above 
the insert slot).

• To bypass all insert effects for the MIDI track, use the bypass button in 
the Inserts section in the Inspector, in the mixer channel strip or in the 
Track list.

• To remove an insert effect, click in its slot and select “No Effect”.
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Managing plug-ins

Selecting Plug-in Information from the Devices menu opens a window 
in which all loaded plug-ins, audio and MIDI, are listed.

• To view the MIDI effect plug-ins, click the MIDI Plug-ins tab.

• The leftmost column allows you to deactivate plug-ins.
This is useful if you have plug-ins installed that you don’t want to use in Cubase SE. 
Only plug-ins that are activated (ticked checkbox) will appear on the MIDI effect pop-
up menus.

• The second column shows how many instances of each plug-in are 
currently used in the project.

• The remaining columns show various information about each plug-in 
and cannot be edited.
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Merge MIDI in Loop

As mentioned, the parameters and effects described in this chapter do 
not change the MIDI events themselves, but work rather like “filters”, af-
fecting the music on playback. However, sometimes you may want to 
make these settings permanent, i.e. convert them to “real” MIDI events 
on the track. You might for example want to transpose a track and then 
edit the transposed notes in a MIDI editor. For this, you need to use the 
Merge MIDI in Loop function on the MIDI menu. This combines all MIDI 
events on all unmuted tracks, applies track parameters and effects and 
generates a new MIDI part, containing all the events as you would hear 
them play back.

1. Make sure only the desired MIDI track(s) are unmuted.
If you only want to include events from a single track in the Merge operation, you may 
want to solo the track.

2. Set up the left and right locator around the area you want to merge.
Only events starting within this cycle area will be included.

3. Select the track on which you want the new part to be created.
This could be a new track or an existing track. If there are data in the cycle area on the 
track, you can choose whether this should be kept or overwritten (see below).

4. Select Merge MIDI in Loop from the MIDI menu.
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5. Fill in the dialog that appears.
The options in the dialog are:

6. Click OK.
A new part is created between the locators on the destination track, containing the 
processed MIDI events.

Applying effects to a single part

Normally, the MIDI track parameters and effects affect a whole MIDI 
track. This may not always be what you want – you may want to apply 
some MIDI effects to a single part for example (without having to cre-
ate a separate track for that part only). The Merge MIDI in Loop func-
tion can help:

1. Set up your track parameters and MIDI effects the way you want them 
for the part.
This will of course affect the whole track, but focus on the part for now.

2. Set the locators to encompass the part.
This is easiest done by selecting the part and selecting Locators to Selection from the 
Transport menu (or using the corresponding key command, by default [P]).

3. Make sure the track holding the part is selected in the Track list.

4. Select Merge MIDI in Loop.

5. In the dialog that appears, activate the desired effect options, make 
sure that Erase Destination is activated and click OK.
Now a new part is created on the same track, containing the processed events. The 
original part is deleted.

6. Turn off or reset all track parameters and effects, so that the track 
plays back as usual.

Option Description

Include Inserts If this is activated, any MIDI insert effects activated for the 
track(s) will be applied.

Include Sends If this is activated, any MIDI send effects activated for the track(s) 
will be applied.

Erase Destination If this is activated, all MIDI data between the left and right locator 
on the destination track will be deleted.
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Introduction
This chapter describes the various MIDI processing functions available 
on the MIDI menu. These offer various ways to change MIDI notes and 
other events, in the Project window or within a MIDI editor.

MIDI functions vs. track parameters

In some cases, the result of a MIDI function can also be obtained by 
using MIDI track parameters and effects (see page 352). For example, 
the MIDI functions transpose and quantize are also available as a track 
parameter and a MIDI effect, respectively. The main difference is that 
track parameters don’t affect the actual MIDI events on the track in any 
way, while MIDI functions change the events “permanently” (although 
recent changes can be undone). Use the following guidelines to de-
cide which path to choose:

• If you want to adjust a few parts or events only, use MIDI functions. The track 
parameters and effects affect the output of the whole track (although they can 
be made permanent in a specific area with the Merge MIDI in Loop function).

• If you want to experiment with different settings, track parameters can be the 
best way to go.

• Track parameter settings are not reflected in the MIDI editors, since the actual 
MIDI events aren’t affected. This can be potentially confusing; if e.g. you’ve 
transposed notes using track parameters, the MIDI editors will still show the 
notes with their original pitch (but they will play back at their transposed pitch). 
MIDI functions can be a better way in those cases.

Of course, there are also MIDI functions that have no track parameter 
counterpart, and vice versa.

What is affected by the MIDI functions?

Which events are affected when you use a MIDI function depends on 
the function, the active window and the current selection:

• A MIDI function may only apply to MIDI events of a certain type.
For example, quantization affects notes only, while the Delete Controllers function 
obviously applies to MIDI controller events.

• In the Project window, the MIDI functions apply to all selected parts, affecting 
all events (of the relevant types) in them.

• In the MIDI editors, the MIDI functions apply to all selected events. If no 
events are selected, all events in the edited part(s) will be affected.



CUBASE SE
MIDI processing and quantizing 20 – 373

Quantizing

What is quantizing?

Quantizing in its fundamental form is a function that automatically 
moves recorded notes, positioning them on exact note values:

However, quantizing is not only a method of correcting errors, it can 
also be used creatively in various ways. For example, the “quantize 
grid” does not have to consist of perfectly straight notes, some notes 
can automatically be excluded from quantizing, etc.

• Normally, MIDI quantizing affects MIDI notes only (not other event types).
However, you can choose to move the controllers together with their respective notes 
by activating the “Move Controller” option in the Quantize Setup dialog, see page 378.

• It is also possible to quantize audio events, which is especially useful 
when working with Cubase SE’s loop slicing features – see page 306.

For example, if you record a series of eighth notes, some of them may end up slightly 
beside the exact eighth note positions.

Quantizing the notes with the quantize grid set to eighth notes 
will move the “misplaced” notes to exact positions.
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Setting Up

At its most basic, setting up quantizing consists of selecting a note 
value from the Quantize pop-up menu on the toolbar (in the Project 
window or a MIDI editor).

Straight note values

Triplet note values

Dotted note values
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By default, this allows you to quantize to exact note values (straight, 
triplet or dotted notes) only. If you want more options, select “Quan-
tize Setup...” from the MIDI menu (or “Setup...” from the Quantize 
pop-up menu) to open the Quantize Setup dialog.

Any settings you make in the dialog are immediately reflected in the 
Quantize pop-up menus. However, if you want your settings permanently 
available on the Quantize pop-up menus, you have to use the presets 
functions (see page 377).

The dialog contains the following settings:
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Grid display

The grid display shows one bar (four beats), with blue lines indicating 
the quantize grid (the positions that notes will be moved to).

The Grid and Type pop-ups

These are used to determine the basic note value for the quantizing 
grid. In other words, these have the same functionality as the Quantize 
pop-up menu on the toolbar.

Swing

The Swing slider is only available when a straight note value is selected 
for the grid and Tuplet is off (see below). It lets you offset every second 
position in the grid, creating a swing or shuffle feel. When you adjust 
the Swing slider, the result is shown in the grid display below.

A straight eighth note grid compared with a grid with 62% swing.

Tuplet

Allows you to create more rhythmically complex grids, by dividing the 
grid into smaller steps.
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Magnetic Area

This allows you to specify that only notes within a certain distance 
from the grid lines should be affected by quantizing. 

• When the slider is set to 0%, the Magnetic Area function is deactivated, 
i.e. all notes are affected by quantizing.
If you move the slider gradually to the right, you will note how the magnetic areas are 
shown around the blue lines in the grid display.

Presets

The controls in the lower left corner of the dialog allow you to store 
the current settings as a preset, available on the Quantize menus in 
the toolbars. The usual preset procedures apply:

• To store the settings as a preset, click the Store button. 

• To “load” a stored preset, showing the stored settings in the dialog, 
just select it from the pop-up menu. 
This is useful if you want to modify an existing preset.

• To rename the selected preset, double click on the name and type in 
a new one. 

• To remove a stored preset, select it from the pop-up menu and click 
Remove.

Auto and Apply

These functions allow you to apply quantizing directly from the dialog, 
as described below.

If you don’t want to apply the quantizing you have set up in the dialog, 
you can close the window by clicking its standard close box. You can 
also leave the dialog open while you continue working.

Only notes within the indicated zones will be affected by quantizing.
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The Non Quantize setting

This is an additional setting that affects the result of the quantizing. It 
allows you to set a “distance” in ticks (120ths of sixteenth notes).

Events that already are within the specified distance from the quantize 
grid will not be quantized. This allows you to keep slight variations 
when you quantize, but still correct notes that are too far from the grid.

The Random Quantize setting

This is an additional setting that affects the result of the quantizing. It 
allows you to set a “distance” in ticks (120ths of sixteenth notes).

Events will be quantized to random positions within the specified “dis-
tance” from the quantize grid, thus creating a more “loose” quantizing. 
Much like the Non Quantize setting, this allows for slight variations, 
while keeping notes from ending up too far from the grid.

The Iterative Strength setting

This affects the results of the Iterative Quantize function, as described 
below.

The Move Controller setting

When this is activated, controllers related to notes (pitch bend, etc.) 
are automatically moved with the notes when these are quantized.
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Applying quantize

There are several ways to apply the quantize:

• The standard method is to select “Over Quantize” from the MIDI menu 
(or using a key command, by default [Q]).
This quantizes the selected MIDI parts or notes, according to the current Quantize 
pop-up menu setting.

• You can also apply quantizing directly from the Quantize Setup dialog, 
by clicking the “Apply” button.

• If you activate the “Auto” checkbox in the Quantize Setup dialog, any 
change you make in the dialog is immediately applied to the selected 
MIDI parts or notes.
A great way of using this feature is to set up a playback loop, and adjust the settings in 
the dialog until you get the desired result. 

When you apply quantize, the result is based on the original position of 
the notes. Therefore, you can freely try different quantize settings with 
no risk of “destroying” anything. See also Undo and Freeze Quantize, 
page 382.

The Auto Quantize function

If you activate the Auto Q button on the Transport panel, all MIDI re-
cordings you make are automatically quantized according to the set-
tings you have made in the Quantize Setup dialog.
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Iterative Quantize

Another way to apply “loose” quantization is to use the Iterative Quan-
tize function on the MIDI menu. It works like this:

Instead of moving a note to the closest quantize grid position, Iterative 
Quantize moves it only part of the way. You specify how much the 
notes should be moved towards the grid with the Iterative Strength 
setting in the Quantize Setup dialog.

Iterative Quantize is also different from “regular” quantization, in that 
the operation is not based on the notes’ original positions but on their 
current, quantized position. This makes it possible to repeatedly use 
Iterative Quantize, gradually moving the notes closer to the quantize 
grid until you’ve find the desired timing.
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Quantize Lengths

This function is only available from within the MIDI editors.

This function (on the Advanced Quantize submenu on the MIDI menu) 
will quantize the length of the notes, without changing their start posi-
tions. At its most basic level, this function will set the length of the notes 
to the Length Quantize value on the MIDI editors’ toolbar. However, if 
you have selected the “Quantize Link” option on the Length Quantize 
pop-up menu, the function will resize the note according to the quantize 
grid, taking the Swing, Tuplet and Magnetic Area settings into account. 
An example:

1. Length Quantize set to “Quantize Link”.

2. Some notes, all a 1/16th note of length.

3. Here, the quantize value has been set to straight 1/16th notes with Swing at 
100%. Since Snap is activated (see page 468), the quantize grid is reflected in the 
note display’s grid.

4. Selecting Quantize Lengths will adjust the note lengths according to the grid. If 
you compare the result to the first figure above, you will find that notes that started 
within the odd sixteenth note “zones” got the longer grid length, and notes in the 
even zones got the shorter length.
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Quantize Ends

The Quantize Ends function on the Advanced Quantize submenu will 
only affect the end positions of notes. Apart from that, it works just like 
regular quantizing, taking the Quantize pop-up menu setting into ac-
count.

Undo and Freeze Quantize

As mentioned above, the original position of each quantized note is 
stored. Therefore, you can make the selected MIDI notes revert to their 
original, unquantized state at any time, by selecting Undo Quantize from 
the Advanced Quantize submenu. This is independent from the regular 
Undo History.

However, there may be situations when you want to make the quantized 
positions “permanent”. For example, you may want to quantize notes a 
second time, having the results based on the current quantized posi-
tions rather than the original positions. To make this possible, select the 
notes in question and select “Freeze Quantize” from the Advanced 
Quantize submenu. This makes the quantized positions permanent.

After you have performed a Freeze Quantize for a note, you cannot undo 
its quantization.
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Transpose 

The Transpose item on the MIDI menu opens a dialog with settings for 
transposing the selected notes:

Semitones

This is where you set the amount of transposition.

Scale Correction

Scale Correction transposes the selected notes by forcing them to the 
closest note of the selected scale type. This can be used for creating 
interesting key and tonal changes, either by itself or in conjunction with 
the other settings in the Transpose dialog.

• To activate Scale Correction, click the checkbox.

• Select a root note for the scale from the note drop-down menu.
Make sure to select the correct root note if you want to keep the result in the same key 
as the original notes, or select an entirely different key if you want to experiment.

• Select the desired scale type from the Scale drop-down menu.
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Keep Notes in Range

When this checkbox is activated, transposed notes will remain within 
the Upper and Lower Barrier values.

• If a note ends up outside the barriers after transposition, it will be shifted 
to another octave, keeping the correct transposed pitch if possible.
If this isn’t possible (if you have set a very narrow range between the Upper and Lower 
Barrier), the note will be transposed “as far as possible”, i.e. to the Upper or Lower 
Barrier note. If you set the Upper and Lower Barriers to the same value, all notes will be 
transposed to this pitch!

OK and Cancel

Clicking OK performs the transposition. Clicking Cancel closes the 
dialog without transposing.

Other MIDI menu functions

The following items can be found on the MIDI menu–Functions sub-
menu:

Legato

Extends each selected note so that it reaches the next note. You can 
specify the desired gap or overlap with the “Legato Overlap” setting in 
the Preferences dialog (Editing page).

When using Legato with this setting, each note will be extended to end 5 ticks 
before the next note.
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Fixed Lengths

This function is only available from within the MIDI editors.

This function resizes all selected notes to the length set with the 
Length Quantize pop-up menu on the MIDI editor toolbar.

Delete Doubles

This function removes double notes, i.e. notes of the same pitch on 
the exact same position. Double notes can occur when recording in 
Cycle mode, after Quantizing, etc.

This function always affects whole MIDI parts.

Delete Controllers

This function removes all MIDI controllers from the selected MIDI parts.

This function always affects whole MIDI parts.

Delete Continuous Controllers

This function removes all “continuous” MIDI controller events from the 
selected MIDI parts. That is, “on/off” events such as sustain pedal 
events are not removed.

This function always affects whole MIDI parts.
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Delete Notes

Allows you to delete very short or weak notes. This is useful for auto-
matically removing unwanted “ghost notes” after recording. Selecting 
“Delete Notes...” opens a dialog in which you set up the criteria for the 
function:

The parameters have the following functionality:

Minimum Length

When the Minimum Length checkbox is activated, the note length is 
taken into account, allowing you to remove short notes. You can either 
specify the minimum length (for notes to be kept) in the value display 
or by dragging the blue line in the graphical length display below.

• The graphical length display can correspond to 1/4 bar, one bar, two 
bars or four bars.
You change this setting by clicking in the field to the right of the display.

In this case, the whole length display corresponds to one bar, and the Minimum 
Length is set to 1/32nd notes (60 ticks).
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Minimum Velocity

When the Minimum Velocity checkbox is activated, the velocity of 
notes is taken into account, allowing you to remove weak notes. You 
specify the minimum velocity (for notes to be kept) in the value display.

Remove when under

This setting is only available when both Minimum Length and Minimum 
Velocity is activated. By clicking the value display, you select whether 
both length and velocity criteria must be met for notes to be deleted, 
or whether one of the criteria will suffice.

OK and Cancel

Clicking OK performs the automatic delete according to the rules set 
up. Clicking Cancel closes the dialog without deleting notes.

Restrict Polyphony

Selecting this item opens a dialog in which you can specify how many 
“voices” should be used (for the selected notes or parts). Restricting 
the polyphony this way is useful when you have an instrument with 
limited polyphony and want to make sure all notes will be played. The 
effect is achieved by shortening notes as required, so that they end 
before the next note starts.

Pedals to Note Length

This function scans for Sustain pedal on/off events, lengthens the af-
fected notes to match the Sustain pedal off position, and then removes 
the Sustain Controller on/off events.

Delete Overlaps (mono)

This function allows you to make sure that no two notes of the same 
pitch overlap (i.e. that one starts before the other ends). Overlapping 
notes of the same pitch can confuse some MIDI instruments (a new 
Note On is transmitted before the Note Off is transmitted). This com-
mand can then be used to automatically rectify the problem.
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Delete Overlaps (poly)

This function shortens notes when required, so that no note begins 
before another ends. This happens regardless of which pitch the 
notes have.

Velocity

This function opens a dialog that allows you to manipulate the velocity 
of notes in various ways.

To apply the function, select one of the three processing types from 
the Type pop-up, adjust the settings and click OK (to close the dialog 
without applying, click Cancel).

The following types of velocity processing are available:

Add/Subtract

This simply adds a fixed number to the existing velocity values. You 
set the value (positive or negative) with the Amount parameter.

Compress/Expand

Compresses or expands the “dynamic range” of MIDI notes by scaling 
the velocity values according to the Ratio setting (0 – 300%). The prin-
ciple behind this is that multiplying different velocity values with a factor 
higher than 1 (over 100%) will also make the differences between ve-
locity values greater, while using a factor lower than 1 (under 100%) 
will make the differences smaller. In short:



CUBASE SE
MIDI processing and quantizing 20 – 389

• To compress (“even out” velocity differences), use ratio values below 
100%.
After compression, you would probably want to add a velocity amount (with the Add/
Subtract function) to maintain the average velocity level. 

• To expand (create greater difference in velocity), use ratio values 
above 100%.
Before you expand, you may want to adjust the velocity with the Add/Subtract function, 
so that the average velocity is somewhere in the middle of the range. If the average ve-
locity is high (near 127) or low (near 0), expansion will not work properly, simply be-
cause velocity values can only be between 0 and 127!

Limit

This function allows you to make sure that no velocity values fall outside 
a given range (the Lower and Upper values). Any velocity values outside 
this range are raised/lowered to exactly the Lower/Upper values.

Fixed Velocity

This function sets the velocity of all selected notes to the Insert Veloc-
ity value on the toolbar in the MIDI editors.

Thin Out Data

Thins out MIDI data. Use this to ease the load on MIDI devices if you 
have recorded very dense controller curves etc.

Reverse

This function inverts the order of the selected events (or of all events 
in the selected parts), causing the MIDI music to play backwards. 
Note though, that the effect is different from reversing an audio re-
cording. With MIDI, the individual notes will still play as usual in the 
MIDI instrument – it’s only the order of playback that is changed.
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Dissolve Part

The Dissolve Part function on the MIDI menu has two separate uses:

• When you work with MIDI parts (on MIDI channel “Any”) containing 
events on different MIDI channels.
Dissolve Part separates the events according to MIDI channel.

• When you want to separate MIDI events according to pitch.
A typical example would be drum and percussion tracks, where each pitch usually 
corresponds to a separate drum sound.

Dissolving parts into separate channels

Setting a track to MIDI channel “Any” will cause each MIDI event to 
play back on its original MIDI channel, rather than a channel set for the 
whole track. There are two main situations when “Any” channel tracks 
are useful:

• When you record several MIDI channels at the same time.
You may for example have a MIDI keyboard with several keyboard zones, where each 
zone sends MIDI on a separate channel. Recording on an “Any” channel track allows 
you to play back the recording with different sounds for each zone (since the different 
MIDI notes play back on separate MIDI channels).

• When you have imported a MIDI file of Type 0.
MIDI files of Type 0 contain only one track, with notes on up to 16 different MIDI chan-
nels. If you were to set this track to a specific MIDI channel, all notes in the MIDI file 
would be played back with the same sound; setting the track to “Any” will cause the 
imported file to play back as intended.

The Dissolve Part function scans MIDI parts for events on different 
MIDI channels and distributes the events into new parts on new tracks, 
one for each MIDI channel found. This allows you to work with each 
musical part individually. Proceed as follows:

1. Select the part(s) containing MIDI data on different channels.

2. Select “Dissolve Part” from the MIDI menu.

3. In the dialog that appears, select the “Separate Channels” option.
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Now, for each MIDI channel used in the selected part(s), a new MIDI 
track is created and set to the corresponding MIDI channel. Each event 
is then copied into the part on the track with the corresponding MIDI 
channel. Finally, the original part(s) are muted.

An example:

Dissolving parts into separate pitches

The Dissolve Part function can also scan MIDI parts for events of dif-
ferent pitch, and distribute the events into new parts on new tracks, 
one for each pitch. This is useful when the different pitches are not 
used in a regular melodic context, but rather for separating different 
sounds (e.g. MIDI drum tracks or sampler sound FX tracks). By dis-
solving such parts, you can work with each sound individually, on a 
separate track. Proceed as follows:

1. Select the part(s) containing MIDI data.

2. Select “Dissolve Part” from the MIDI menu.

3. In the dialog that appears, select the “Separate Pitches” option.
A new MIDI track is created for each used pitch in the selected part(s). The events are 
then copied into the parts on the track for the corresponding pitch. Finally, the original 
part(s) are muted.

This part contains events on 
MIDI channel 1, 2 and 3.

Selecting “Dissolve Part” 
creates new parts on new 
tracks, set to channel 1, 2 
and 3. Each new part con-
tains only the events on the 
respective MIDI channel.

The original MIDI 
part is muted.
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About editing MIDI

There are several ways to edit MIDI in Cubase SE. You can use the 
tools and functions in the Project window for large-scale editing, or 
use the functions on the MIDI menu to process MIDI parts in various 
ways (see page 372). For hands-on graphical editing of the contents 
of MIDI parts, you use the MIDI editors:

• The Key Editor is the default MIDI editor, presenting notes graphically in 
an intuitive piano roll-style grid.
The Key Editor also allows for detailed editing of non-note events such as MIDI con-
trollers.

• The Drum Editor is similar to the Key Editor, but takes advantage of the 
fact that with drum parts, each key corresponds to a separate drum 
sound. 
This is the editor to use when you’re editing drum or percussion parts.

• The List Editor shows all events in the selected MIDI parts as a list, allow-
ing you to view and edit their properties numerically.

• The Score Editor shows MIDI notes as a musical score.
The Score Editor offers basic score editing and printing – see page 453.

About this chapter

This chapter describes how to use the MIDI Editors. Please note that 
a lot of features are identical in these editors (especially in the Key and 
Drum Editors) – they are all described in the Key Editor section. The 
sections about the Drum Editor (see page 427), the List Editor (see 
page 442) and the Score Editor (see page 450) describe the specific 
features of these editors only.
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Opening a MIDI editor

There are two ways to open a MIDI editor:

• Select one or several parts (or a MIDI track, with no parts selected) and select 
Open Key Editor, Open Drum Editor or Open List Editor from the MIDI menu 
or Open Score Editor from the Scores submenu (or use the corresponding 
key command).
The selected parts (or all parts on the track, if no part was selected) will open in the 
chosen editor.

• Double click a part.
Which editor opens depends on the settings in the Preferences dialog (Event Display–
MIDI page):

Double clicking will open the editor selected on the Default Edit Action pop-up 
menu. However, if the option “Edit as Drums when Drum Map is assigned” is 
activated and a drum map is selected for the edited track (see page 438), the Drum 
Editor will open. This way you can double click to open the Key Editor (or the Score 
Editor or List Editor, depending on your preferences) but drum tracks will 
automatically open in the Drum Editor.

• If the part you open for editing is a shared copy, any editing you perform 
will affect all shared copies of this part. 
Shared copies are created by pressing [Alt]/[Option]+[Shift] and dragging, or by using 
the Repeat function with the “Shared copies” option activated. In the Project window, 
shared copies are indicated by the part name in italics and an icon in the right corner of 
the part (see page 99).
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Handling several parts

When you open a MIDI editor with several parts (or a MIDI track con-
taining several parts) selected, you might find it somewhat hard to get 
an overlook of the different parts when editing.

If so, the editor toolbar features a few functions to make working with 
multiple parts easier and more comprehensive:

• The Part List menu lists all parts that were selected when you opened 
the editor (or all parts on the track, if no parts were selected), and lets 
you select which part should be active for editing.
When you select a part from the list, it is automatically made active and centered in the 
note display.

• Note that it is also possible to activate a part by using the Arrow tool and 
clicking on an event in a part.

• The button “Edit Active Part Only” lets you restrict editing operations 
to the active part only.
If you for example select “All” from the Select submenu on the Edit menu with this op-
tion activated, only events in the active part will be selected. Similarly, if you select 
notes by dragging with the Arrow tool (making a selection rectangle), only the notes in 
the active part will be selected.

“Edit Active Part Only” activated on the toolbar.

• You can zoom in on the active part so that it fills the screen by select-
ing “Zoom to Event” from the Zoom submenu on the Edit menu.
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• The button “Show Part Borders” can be used if you want to see clearly 
defined borders for the active part.
When this is activated, all parts except the active one are grayed out, making the bor-
ders easily discernible. In the Key Editor, there are also two “markers” in the ruler with 
the name of the active part, marking its beginning and end. These can be moved freely 
to change the size of the part.

“Show Part Borders” activated on the toolbar.

• It is possible to cycle between parts, making them active, with key 
commands.
In the Key Commands dialog – Edit category, there are two functions: “Activate Next 
Part” and “Activate Previous Part”. If you assign key commands to these, you can use 
them to cycle between parts in the editors. Please refer to page 571 for instructions on 
how to set up key commands.
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The Key Editor – Overview 

The toolbar

As in other windows, the toolbar contains tools and various settings. 
The user can configure what toolbar items should be shown or hidden 
and store/recall different toolbar configurations – see page 561.

Show/Hide Info line

Solo Editor button Key Editor tools

AutoscrollAudition

Part listShow/Hide Part borders

Edit active part only

Nudge Tools

Snap on/offVelocity for inserted notes

Grid modes
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The info line

The info line shows information about selected MIDI notes. You can edit 
all values on the info line using regular value editing (see page 412 for 
details). Length and position values are displayed in the format currently 
selected for the ruler (see below).

• To hide or show the info line, click the icon in the toolbar.

Quantize settings Step Input

MIDI Input

Step/MIDI input controls

Color pop-up menu Chord recognition display

Mouse pointer display: Current pitch- and meter position
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The ruler

The ruler shows the time line, by default in the display format selected 
on the Transport panel. You can select a separate format for a MIDI 
editor ruler by clicking the arrow button to the right of it and selecting 
an option from the pop-up menu that appears. For a list of the avail-
able formats, see page 79.

At the bottom of the pop-up menu there are two additional items:

• If “Time Linear” is selected, the ruler, note display and controller dis-
play will be linear in relation to time.
This means that if the ruler shows bars and beats, the distance between the bar lines 
will vary depending on the tempo.

• If “Bars+Beats Linear” is selected, the ruler, note display and control-
ler display will be linear in relation to tempo.
I.e. if the ruler shows bars and beats, the distance between beats will be constant.

In most cases, you would probably set the display format to 
“Bars+Beats” in “Bars+Beats Linear” mode when editing MIDI.
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The note display

The note display is the main area in the Key Editor. It contains a grid, in 
which MIDI notes are shown as boxes. The width of a box corresponds 
to the note length, and the vertical position of a box corresponds to the 
note number (pitch), with higher notes higher up in the grid. The piano 
keyboard to the left serves as a guide for finding the right note number.

The chord recognition function

Cubase SE features a handy chord recognition function that helps you 
identify chords in the key editor note display. To find out which chord 
some simultaneously played notes make up, place the project cursor 
over the notes. All MIDI notes currently “touched” by the project cursor 
are analyzed and the chord recognition display in the toolbar shows 
you which chord the notes form.

In the picture above, the project cursor touches the notes C, Eb and G. As shown 
in the chord recognition display, this results in a C minor chord.
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The controller display

The area at the bottom of the Key Editor window is the controller dis-
play. This consists of one or several controller lanes, each showing 
one of the following properties or event types:

• Velocity values of the notes.
• Pitch Bend events.
• Aftertouch events.
• Poly Pressure events.
• Program Change events.
• Any type of continuous controller event.

To change the size of the controller display, drag the divider between 
the controller display and the note display. This will make the control-
ler display larger and the note display smaller, or vice versa.

Velocity values are shown as vertical bars in the controller display, 
with higher bars corresponding to higher velocity values:

Each velocity bar corresponds to a note in the note display.
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Events in the controller display (that is, anything other than velocity 
values) are shown as “blocks”, the heights of which correspond to the 
“values” of the events. However, events that have been recorded (or 
drawn with a low quantize value) may appear more like “filled curves”, 
simply because they are positioned very closely:

If you zoom in on the upper “curve”, you will find that it consists of separate events.

• Unlike notes, events in the controller display have no length. The value 
of an event in the display is “valid” until the start of the next event:

For a description of editing in the controller display, see page 416.

If you delete the second event… …the first event will be “valid” until 
the start of the third event.
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Key Editor operations

Zooming

Zooming in the Key Editor is done according to the standard zoom 
procedures, using the zoom sliders, the Zoom tool or the Zoom sub-
menu on the Edit menu.

• When you drag a rectangle with the Zoom tool, the result depends on 
the option “Zoom Tool Standard Mode: Horizontal Zooming Only” in 
the Preferences dialog (Editing page).
If this is on, the window will only be zoomed horizontally; if not, the window will be 
zoomed both horizontally and vertically.

Playing back

You can play back your music as usual when working in a MIDI editor. 
There are a couple of features making it easier to edit during playback:

Solo button

If you activate the Solo button, only the edited MIDI parts will be heard 
during regular playback.

Autoscroll

As described on page 117, the Autoscroll function makes the window 
“follow” the project cursor during playback, so that the current play 
position is visible at all times. However, when you are working in a 
MIDI editor, you may want to deactivate Autoscroll – this way, the 
events you are working with will stay visible.

The Autoscroll button on the toolbar of each MIDI editor is indepen-
dent for the editor. For example, this means you can have Autoscroll 
deactivated in the Key Editor and activated in the Project window.
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Auditioning

If the speaker icon on the toolbar is activated, individual notes will au-
tomatically be played back (auditioned) when you move or transpose 
them, or when you create new notes by drawing. This makes it easier 
to hear what you’re doing.

Creating and editing notes

To draw new notes in the Key Editor, you use the Pencil tool or the 
Line tool.

Drawing notes with the Pencil tool

With the Pencil tool, you insert single notes by clicking at the desired 
time position (horizontal) and pitch position (vertical).

• When you move the pointer in the note display, its bar position is indi-
cated in the toolbar, and its pitch is indicated both in the toolbar and 
on the piano keyboard to the left.
This makes it easy to find the right note and insert position.
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• If Snap is activated, this determines the start position of the created 
note (see page 468).

• If you just click once, the created note will have the length set on the 
Length Quantize pop-up menu on the toolbar.
You can create a longer note by clicking and dragging the pointer with the mouse button 
pressed. The length of the created note will be a multiple of the Length Quantize value.

Drawing notes with the Line tool

The Line tool can be used for creating series of contiguous notes. To 
use the Line tool, click and drag to draw a line and then release the 
mouse button.

• The Line tool has several different modes.
To select one of the modes, click on the Line tool icon on the toolbar when the tool is 
already selected. This opens a pop-up menu from which you can select one of the Line 
modes.

The tool icon will change appearance according to the selected mode.

Mode Description

Line This is the default mode for the Line tool. When this mode is selected, 
you click and drag to create a straight line, in any angle. When you re-
lease the mouse button a series of notes will be created, aligned with 
the line. If Snap is activated, the notes will be spaced and sized ac-
cording to the Quantize value.

Parabola, Sine, 
Triangle, Square

These modes insert events along different curve shapes. While they 
can be used for creating notes, they’re probably best suited for con-
troller editing (see page 421).

Paint Allows you to insert multiple notes by dragging with the mouse button 
pressed. If Snap is activated, the notes will be positioned and sized 
according to the Quantize and Length Quantize values. If you press 
[Ctrl]/[Command] while painting, movement will be restricted to hori-
zontal only (i.e. the painted notes will have the same pitch).
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Setting velocity values

When you draw notes in the key editor, the notes will get the velocity 
value set in the insert velocity field on the toolbar.

You can use one of three different methods for determining the velocity:

• Selecting a predefined velocity value from the insert velocity pop-up 
menu.
The menu contains five different predefined velocity values. The “Setup...” item opens 
a dialog that allows you to specify which five velocity values should be available on the 
pop-up menu (you can also open this dialog by selecting “Insert Velocities...” from the 
MIDI menu).

• Manually entering the desired velocity value by clicking in the insert 
velocity field and typing the desired value.

• Using a key command.
You can assign a key command to each of the five available velocity values in the Key 
Commands dialog (MIDI category – the items Insert Velocity 1-5). This allows for quick 
switching between different velocity values when entering notes. See page 571 for in-
structions on how to set up key commands.



CUBASE SE
21 – 408 The MIDI editors

Selecting notes

Selecting notes is done using any of the following methods:

• Use the Arrow tool.
The standard selection techniques apply.

• Use the Select submenu on the Edit menu or Quick menu.
The Select menu options are:

• You can also use the left and right arrow keys on the computer key-
board to step from one note to the next or previous.
If you press [Shift] and use the arrow keys, the current selection will be kept, allowing 
you to select several notes.

• To select all notes of a certain pitch, press [Ctrl]/[Command] and click 
on the desired key in the keyboard display to the left.

You can also press [Shift] and double click on a note to select all the following notes of 
the same pitch.

• If the option “Auto Select Events under Cursor” is activated in the 
Preferences dialog (Editing page), all notes currently “touched” by the 
project cursor are automatically selected.

Option Description

All Selects all notes in the edited part.

None Deselects all events.

In Loop Selects all notes that are partially or completely inside the 
boundaries of the left and right locators.

From Start to Cursor Selects all notes that begin to the left of the project cursor.

From Cursor to End Selects all notes that end to the right of the project cursor.

All notes of the corresponding 
pitch are selected.
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Moving and transposing notes

To move notes in the editor, use any of the following methods:

• Click and drag to a new position.
All selected notes will be moved, maintaining their relative positions. If Snap is acti-
vated, this determines to which positions you can move the notes, see page 468.

Note also that you can restrict movement to horizontal or vertical only by 
holding down [Ctrl]/[Command] while dragging.

• Use the up and down arrow keys on the computer keyboard.
This method allows you to transpose the selected notes, without risking to move them 
horizontally. You can also use the Transpose function (see page 383) or the info line 
(see page 399) for this. Note that pressing [Shift] and using the up and down arrow 
keys will transpose notes in steps of one octave.

• Use the Move to Cursor function on the Edit menu.
This moves the selected notes to the project cursor position.

• Select a note and adjust its position or pitch on the info line.
See page 412.

• Use the Move buttons in the Nudge palette on the toolbar.
This moves the selected note(s) by the amount set on the Quantize pop-up menu. By 
default, the Nudge palette isn’t shown on the toolbar – see page 561 for more info.

You can also adjust the position of notes by quantizing (see page 373).

Duplicating and repeating notes

Notes are duplicated much in the same way as events in the Project 
window:

• Hold down [Alt]/[Option] and drag the note(s) to a new position.
If Snap is on, this determines to which positions you can copy notes (see page 468).

• Selecting Duplicate from the Edit menu creates a copy of the selected 
note and places it directly after the original.
If several notes are selected, all of these are copied “as one unit”, maintaining the rel-
ative distance between the notes.

• Selecting Repeat from the Edit menu opens a dialog, allowing you to 
create a number of copies of the selected note(s).
This works like the Duplicate function, but you can specify the number of copies.
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• You can also perform the Repeat function by dragging: Select the 
note(s) to repeat, press [Alt]/[Option], click the right edge of the last 
selected note and drag to the right.
The longer to the right you drag, the more copies (as indicated by the tooltip).

Using cut and paste

You can use the Cut, Copy and Paste options on the Edit menu to 
move or copy material within a part or between different parts. When 
you paste copied notes, you can either use the regular Paste function 
or the Paste Time function on the Edit menu’s Range submenu.

• “Paste” inserts the copied notes at the project cursor position, without affect-
ing existing notes.

• “Paste Time” inserts at the project cursor position, but moves (and if neces-
sary, splits) existing notes to make room for the pasted notes.

Selecting “Paste Time” with this data on the clipboard 
and the project cursor here…

…will give you this.
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Resizing notes

To resize a note, use one of the following methods:

• Position the arrow tool at the start or end of the note, so that the pointer 
takes on the shape of a small double arrow. Click and drag to the left or 
right to resize the note.
This method allows you to resize the note from either direction.

• Click with the Pencil tool within the note box and drag to the left or the 
right (to make the note shorter or longer, respectively).

With both these methods, the resulting length will be a multiple of the 
Length Quantize value on the toolbar.

• Use the Trim Start/End buttons on the Nudge palette on the toolbar.
This resizes the selected note(s) by moving their start or end positions, in steps accord-
ing to the Length Quantize value on the toolbar. By default, the Nudge palette isn’t 
shown on the toolbar – see page 561 for more info.

• Select the note and adjust its length on the info line.
See page 412 for details on info line editing.

Splitting notes

There are three ways to split notes:

• Clicking on a note with the Scissors tool splits the note at the position 
you pointed (taking the Snap setting into account if activated).
If several notes are selected, they are all split at the same position if applicable.

• If you select “Split at Cursor”, all notes that are intersected by the 
project cursor are split at the cursor position.

• If you select “Split Loop”, all notes that are intersected by the left or 
right locator are split at the locator positions.

Gluing notes

Clicking on a note with the Glue Tube tool will “glue it together” with 
the next note of the same pitch. The result will be one long note span-
ning from the start of the first note to the end of the second note, and 
with the properties (velocity, etc.) of the first note.
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Muting notes

Individual notes can be muted in the Key Editor, as opposed to muting 
an entire MIDI part in the Project window. This allows you to exclude 
notes from playback, but keep the option to bring them back again at 
any time. To mute a note, use one of the following methods:

• Click on it with the Mute tool.
• Drag a rectangle with the Mute tool, enclosing all notes you want to mute.
• Select the note(s) and choose Mute from the Edit menu. 

The default key command for this is [Shift]+[M].

Muted notes are “dimmed” in the note display.

To unmute a note, either click it or enclose it with the Mute tool, or se-
lect it and choose Unmute from the Edit menu. The default key com-
mand for this is [Shift]+[U].

Deleting notes

To delete notes, either click on them with the Eraser tool or select 
them and press [Backspace].

Editing on the info line

The info line shows the values and properties of the selected event(s). 
If a single event is selected, its values are displayed on the info line. If 
several events are selected, the info line shows the values of the first 
of these events, in yellow.

Several events selected.
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You can edit the values on the info line using regular value editing. This 
allows you to move, resize, transpose or change velocity of events in a 
very precise manner. It’s also possible to click the Pitch or Velocity field 
in the info line and play a note on your MIDI keyboard - the pitch or ve-
locity will be adjusted according to the note you played.

• If you have several events selected and change a value, all selected 
events will be changed relatively.
In other words, the value will be changed by an equal amount for all selected events.

• If you have several events selected, hold down [Ctrl]/[Command] and 
change a value, the change will be absolute.
In other words, the value setting will be the same for all selected events.

Editing Notes via MIDI

You can change the properties of notes via MIDI. For example, this 
can be a fast way to get the right velocity value, since you will hear the 
result even as you edit:

1. Select the note you want to edit.

2. Click on the MIDI connector symbol on the toolbar.

The symbol should be lit. This enables editing via MIDI.

3. Use the note buttons on the toolbar to decide which properties 
should be changed by the MIDI input.
You can enable editing of pitch, note-on and/or note-off velocity.

With this setting, the edited notes will get the pitch and velocity values of the notes 
input via MIDI, but the note-off velocities will be kept as they are.

4. Play a note on your MIDI instrument.
The note selected in the editor will get the pitch, velocity and/or note-off velocity of the 
played note.
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The next note in the edited part is automatically selected, making it 
easy to quickly edit a series of notes.

• If you want another try, select the note again (easiest by pressing the 
[←] key on the computer keyboard) and again play a note on your MIDI 
instrument.

Step input

Step input, or step recording, is when you enter notes one at a time 
(or one chord at a time) without worrying about the exact timing. This 
is useful e.g. when you know the part you want to record but are not 
able to play it exactly as you want it.

Proceed as follows:

1. Click the Step Input button on the toolbar to activate Step Input mode.

2. Use the note buttons to the right to decide which properties should 
be included when you input the notes.
For example, you may not want to include the velocity and/or note-off velocity of the 
played notes. It’s also possible to turn off the pitch property, in which case all notes will 
get the pitch C3, no matter what you play.

3. Click anywhere in the note display to set the start position (the desired 
position of the first note or chord).
The step input position is shown as a blue line in the note display, and in the lower 
mouse pointer display in the toolbar.
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4. Specify the desired note spacing and length with the Quantize and 
Length Quantize pop-up menus.
The notes you input will be positioned according to the Quantize value and have the 
length set with the Length Quantize value. For instance, if you set Quantize to 1/8 
notes and Length Quantize to 1/16 note, the notes will be sixteenth notes, appearing 
on each eighth note position.

5. Play the first note or chord on your MIDI instrument.
The note or chord appears in the editor and the step input position advances one 
quantize value step.

• If Insert mode is activated, all notes to the right of the step input posi-
tion will be moved to “make room” for the inserted note or chord.

Insert mode activated.

6. Continue in the same way with the rest of the notes or chords.
You can adjust the Quantize or Length Quantize value as you go along, to change the 
timing or note lengths. You can also move the step input position manually by clicking 
anywhere in the note display.

• To insert a “rest”, press the right arrow key on the computer keyboard.
This advances the step input position one step.

7. When you’re done, click the Step Input button again to deactivate 
step input.
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Editing in the controller display

About controller lanes

By default, the controller display has a single lane, showing one event 
type at a time. However, you can easily add lanes by right-clicking 
(Windows) or [Ctrl]-clicking (Mac) in the display and selecting “Create 
new controller lane” from the Quick menu. This allows you to view and 
edit different controllers at the same time.

The controller display with three lanes set up.

• To remove a lane, right-click in it and select “Remove this Lane” from 
the Quick menu.
This hides the lane from view – it doesn’t affect the events in any way.

• If you remove all lanes, the controller display will be completely hidden.
To bring it back again, select “Create new controller lane” from the Quick menu.
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Selecting event type

Each controller lane shows one event type at a time. To select which 
type should be displayed, use the pop-up menu to the left of the lane.

• Selecting “Setup…” opens a dialog in which you can specify which 
continuous controller event types you want available on the pop-up 
menu.

• Each MIDI track has its own controller lane setup (number of lanes 
and selected event types). 
When you create new tracks, they get the controller lane setup last used.

Controller types in 
this list are already 
listed on the pop-
up menu.

Controller types 
in this list are not 
listed on the 
pop-up menu.

Click this button 
to add the 
selected control-
ler type to the 
pop-up menu.

Click this button to 
remove the control-
ler type selected in 
the left list from the 
pop-up menu.
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Controller Lane presets

Once you have added the required number of controller lanes and se-
lected the event types you need, you can store this combination as a 
controller lane preset. You could for example have a preset with one 
velocity lane only, another with a combination of velocity, pitch bend 
and modulation, and so on. This can make working with controllers 
much quicker.

• To add the current controller lane setup as a preset, pull down the pop-
up menu in the lower left corner of the editor window and select “Add”.
Enter a name for the preset in the dialog that appears and click OK.

• To apply a stored preset, select it from the pop-up menu.
This immediately brings up the controller lanes and event types in the preset.

• To remove or rename presets, select “Organize” from the pop-up.

Editing velocity values

When “Velocity” is selected for viewing, the lane shows the velocity of 
each note as a vertical bar.

Velocity values are edited with the Pencil or the Line tool. The different 
tools and Line tool modes offer several possibilities, as listed below.

• If the option “Controller Lane Editing: Select Tool defaults to Pen” is ac-
tivated in the Preferences dialog (Editing page), the Arrow tool automat-
ically switches to the Pencil tool when you move the pointer into the 
controller display.
If you need to use the Arrow tool to select events in the controller display, press [Ctrl]/
[Command].
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• If the Speaker icon (Acoustic Feedback) is activated on the toolbar, the 
notes will be played back when you adjust the velocity, allowing you to 
audition your changes.

• You can use the Pencil tool to change the velocity of a single note: click on its 
velocity bar and drag the bar up or down.
While you drag, the current velocity value is shown in the display to the left.

• You can use the Pencil tool or the Line tool’s Paint mode to change the veloc-
ity values of several notes by painting a “freehand curve”.
When editing velocity, these two methods have the same functionality.

• Use the Line tool’s Line mode for creating linear velocity ramps.
Click where you want the ramp to start and drag the cursor to where you want the 
ramp to end. When you release the mouse button, the velocity values are aligned with 
the line between the two points.
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• Parabola mode works in the same way, but aligns the velocity values with a 
Parabola curve instead.
Use this for smooth, “natural” velocity fades, etc.

• The remaining three Line tool modes (Sine, Triangle and Square) align the ve-
locity values with continuous curve shapes (see below).

Note:

• If there is more than one note on the same position (e.g. a chord), their 
velocity bars will overlap in the controller lane. 
If none of the notes are selected, all notes at the same position will be set to the same 
velocity value when you draw. To edit the velocity of only one of the notes at the same 
position, first select the note in the note display. Now, editing will only affect the veloc-
ity of the selected note.

You can also adjust the velocity of a single note by selecting it and 
changing its velocity value on the info line.
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Adding and editing events in the controller display

When any option other than “Velocity” is selected for viewing in a 
controller lane, you can create new events or edit the values of exist-
ing events using the Pencil tool or the Line tool in its various modes:

• Clicking with the Pencil tool or the Line tool in Paint mode creates a new event.
Note the “Select Tool defaults to Pen” option - see page 418. 

• To modify the value of an event (without creating a new one), press [Alt]/[Op-
tion] and use the Pencil tool or the Line tool’s Paint mode.
Note that you can click and drag to change or add multiple events, draw controller 
curves, etc. You can press or release [Alt]/[Option] while drawing, switching dynami-
cally between “edit mode” and “create mode”.

• With the Pencil tool and the Line tool in Paint mode, the quantize value de-
termines the “density” of created controller curves (if Snap is activated).
For very smooth curves, you should use a small quantize value or turn off Snap. How-
ever, please note that this creates a very large number of MIDI events, which can cause 
MIDI playback to “stutter” in some situations. A medium-low density is often sufficient.

If you want to enter or adjust a single event, click once with the Pencil tool or the 
Line tool in Paint mode:

If you want to “paint a curve”, drag the tool (with the mouse button pressed):

When you move the pointer in the controller lane, the 
corresponding value is displayed in this field.
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• Clicking and dragging with the Line tool in Line mode shows a line in the con-
troller lane, and creates events with values aligned with this line.
This is the best way to draw linear controller ramps. If you press [Alt]/[Option], no new 
events are created – use this mode for modifying existing controller curves.

• The Parabola mode works in the same way, but aligns the values with a para-
bola curve instead, giving more “natural” curves and fades.
Note that the result depends on from which direction you draw the parabola:

Converting a controller curve to a ramp using 
the Line tool:
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• In Parabola mode you can use modifier keys to determine the shape of the 
parabola curve.
If you press [Ctrl]/[Command] the parabola curve will be reversed, if you press [Alt]/
[Option]+[Ctrl]/[Command] while snap is activated you can change the position of the 
whole curve (in both cases the snap value for the positioning will be a quarter of the 
quantize value). If you press [Shift], the exponent will be increased or decreased.

• In Line and Parabola modes, the length quantize value determines the 
“density” of created controller curves (if Snap is activated).
For very smooth curves, you should use a small length quantize value or turn off Snap. 
To avoid over-dense controller curves (which may cause MIDI playback to “stutter”), 
use a medium-low density.

• The Sine, Triangle and Square modes create events with values aligned to 
continuous curves.
In these modes, the quantize value determines the period of the curve (the length of 
one curve “cycle”) and the length quantize value determines the density of the events 
(the lower the length quantize note value, the smoother the curve).

• In Sine, Triangle and Square mode you can also use modifier keys to determine 
the shape of the curve.
If you press [Ctrl]/[Command] you can change the phase of the beginning of the curve, 
if you press [Alt]/[Option]+[Ctrl]/[Command] while snap is activated you can change 
the position of the whole curve (in both cases the snap value for the positioning will be 
a quarter of the quantize value).

• You can also set the curve period freely by holding down [Shift] when 
you insert events in Sine, Triangle or Square mode.
Activate Snap, [Shift]-click and drag to set the length of one period. The period length 
will be a multiple of the quantize value.
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• In Triangle and Square mode you can press [Shift]+[Ctrl]/[Command] to 
change the maximum position of the triangle curve (to create sawtooth curves) 
or the pulse of the square curve. As in other modes, you can press [Alt]/[Op-
tion] if you want to change the existing events rather than creating new ones. 
Again, the snap value for the positioning will be a quarter of the quantize value.

Moving and copying events

You can move or duplicate events in a controller lane, much like you 
can with notes:

1. Click with the Arrow tool to select the events you want to cut or copy.
If the option “Controller Lane Editing: Select Tool defaults to Pen” is activated in the 
Preferences dialog (Editing page), you need to press [Ctrl]/[Command] to get the 
Arrow tool.

2. Click and drag the events to move them.
If Snap is activated, this determines to which positions you can move the events (see 
page 468).

• If you hold down [Alt]/[Option] and drag, the events will be copied 
rather than moved.

If there already is an event of the same type at the exact same position, 
this will be replaced by the moved event.

Remember that a non-note event doesn’t have a length – it’s “valid” until 
the next event (see page 403).
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Using cut, copy and paste

You can use the standard Cut, Copy and Paste options on the Edit 
menu to move or copy events in the controller display:

1. Select the events you want to cut or copy.

2. Select Cut or Copy from the Edit menu.

3. If you want to paste the events into another MIDI part, open that part 
in another Key Editor window.

4. Position the project cursor where you want to paste the events.

5. Select Paste from the Edit menu.
The events on the clipboard are added, starting at the project cursor position, main-
taining their relative positions. If a pasted event ends up at the same position as an 
existing event of the same type, the old event is replaced. 

Deleting events in the controller display

You delete events by clicking with the Eraser tool or by selecting them 
and pressing [Backspace]. Please note:

• Deleting a controller event makes the last event before this valid up 
until the next event. It does not “zero” any controller changes. See 
page 403.

• You can delete notes by deleting their velocity bars in the controller 
display.
Please be aware that if there is more than one note on the same position, there may 
still only be one velocity bar visible – make sure you delete only the desired notes!



CUBASE SE
21 – 426 The MIDI editors

Adding and editing Poly Pressure events

Poly Pressure events are special, in that they “belong to” a specific 
note number (key). That is, each Poly Pressure event has two editable 
values: the note number and the amount of pressure. Therefore, when 
Poly Pressure is selected on the event type pop-up menu, there are 
two value fields to the left of the controller display, one for the note 
number and one for the amount:

To add a new Poly Pressure event, proceed as follows:

1. Select Poly Pressure on the event type pop-up menu.

2. Set the note number by clicking on the keyboard display.
Note that this only works for the topmost lane. If you have selected “Poly Pressure” for 
several controller lanes, you have to type in the desired note number directly in the 
lower value field to the left of each lane. The selected note number is displayed in the 
lower value field to the left of the controller display.

3. Use the Pencil tool to add a new event, just as when adding regular 
controller events.

To view and edit existing Poly Pressure events, proceed as follows:

1. Select Poly Pressure on the event type pop-up menu.

2. Click on the arrow button next to the note number field to the left of 
the controller lane.
A pop-up menu appears, listing all note numbers for which there already are Poly Pres-
sure events.

3. Select a note number from the pop-up menu.
The Poly Pressure events for the selected note number are shown in the controller lane.

4. Use the Pencil tool to edit the events as usual.
Press [Alt]/[Option] to edit existing events without adding any new ones.

• Poly Pressure events can also be added and edited in the List Editor.
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The Drum Editor – Overview

The toolbar and info line

These are much the same as the toolbar and info line in the Key Editor, 
with the following differences:

• The Drum Editor has no Pencil tool – instead there is a Drumstick tool (for in-
putting and removing notes) and a Line tool with various line and curve modes 
(for drawing several notes in one go or editing controller events).

• There are no Scissors and Glue Tube tools in the Drum Editor.
• As in the Key Editor, the mouse pointer display in the toolbar shows the pitch 

and position of the pointer, but the pitch is shown as a drum sound name 
rather than a note number.

• The Use Global Quantize button allows you to select which value should be 
used when Snap is on – the global quantize value on the toolbar or the indi-
vidual quantize values for the drum sounds.

• Instead of a Length Quantize pop-up, there is an Insert Length pop-up menu.
It is used in much the same way, as described on the following pages.
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The drum sound list

The purpose of the Drum Editor is to edit MIDI tracks where each note 
(pitch) plays a separate sound, as is typically the case with a MIDI 
drum kit. The drum sound list to the left lists all drum sounds by name 
(according to the selected drum map or name list – see below), and 
lets you adjust and manipulate the drum sound setup in various ways.

Note:

• The number of columns in the list depends on whether there’s a drum map 
selected for the track or not.
See page 433.

• You can reorder the columns by dragging the column headings, and resize 
the columns by dragging the dividers between the column headings.
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The note display

The Drum Editor’s note display displays notes as diamond symbols. The 
vertical position of the notes corresponds to the drum sound list to the 
left, while the horizontal position corresponds to the note’s position in 
time, just as in the Key Editor. Note however, that the diamond symbols 
don’t indicate the length of the notes. This makes sense, since drum 
sounds most often are “one-shot” samples that play to their end regard-
less of the note lengths.

Drum map and name pop-up menus

Below the drum sound list you will find two pop-up menus, used for se-
lecting a drum map for the edited track or (if no drum map is selected) 
a list of drum sound names. For an explanation of drum maps, see page 
433.

Controller display

The controller display in the Drum Editor is exactly the same as in the 
Key Editor. You can add or remove controller lanes from the Quick 
menu, and create and edit events as described on page 416.
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Drum Editor operations

The basic handling (zooming, playback, auditioning, etc.) is the same 
as in the Key Editor (see page 404). The following sections describe 
the procedures and features that are specific to the Drum Editor.

Creating and editing notes

The standard way of entering notes in the Drum Editor is to click with 
the Drumstick tool.

When you move the pointer in the note display, its bar position and drum sound is 
indicated in the toolbar, making it easy to find the right sound and position.

The position of the created note depends on the following factors:

• If Snap is deactivated on the toolbar, the note will appear exactly where you 
clicked.
In this mode, notes can be positioned freely.

• If Snap is activated and Use Global Quantize is deactivated on the toolbar, 
the note will snap to positions according to the quantize value set for the 
sound in the drum sound list.
You can set up different quantize values for different drum sounds. You may for exam-
ple want hi-hat notes snap to sixteenth notes, but snare and bass drum snap to eighth 
notes.

• If both Snap and Use Global Quantize are activated, the note will snap to po-
sitions according to the Quantize setting on the toolbar (next to the Use Glo-
bal Quantize button).

The length of the inserted note is determined by the Insert Length set-
ting on the toolbar. However, if this is set to “Drum-Map Link”, the 
note will get the length of the quantize value for the drum sound.
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• You can quickly audition the drum sounds by clicking in the leftmost 
column in the drum sound list.
This plays the corresponding note.

• Clicking with the Drumstick tool on an existing note will remove it.
This makes drum pattern editing very quick and intuitive.

Setting velocity values

The notes you enter will get the insert velocity value set in the insert 
velocity field on the toolbar – to speed up things you may want to as-
sign key commands to the insert velocity options. See page 407.

Selecting notes

Selecting notes is done by any of the following methods:

• Use the Arrow tool.
The standard selection techniques apply.

• Use the Select submenu on the Quick menu (see page 408).

• Use the left and right arrow keys on the computer keyboard to step 
from one note to the next or previous note.
If you press [Shift] and use the arrow keys, the current selection will be kept, allowing 
you to select several notes.

• You can also press [Shift] and double click on a note to select all the 
following notes for the same drum sound.

• If the option “Auto Select Events under Cursor” is activated in the 
Preferences dialog (Editing page), all notes currently “touched” by the 
project cursor are automatically selected.

Moving, duplicating or repeating notes

To move or copy notes in the editor (to other positions or other drum 
sounds), you use the same methods as in the Key Editor: click and 
drag, use the arrow keys or Edit menu functions, etc. – see page 409. 
There is one thing to note:
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When you are moving or copying several selected notes by dragging 
them and Snap is activated but Use Global Quantize turned off, the 
notes will snap to positions according to the quantize values for the 
drum sounds. If the moved/copied notes have different quantize val-
ues, the largest value will determine snapping. For example, if you are 
moving two notes, with the quantize values 1/16 and 1/4 respectively, 
the notes will snap to quarter notes (1/4).

• You can also adjust the position of notes by quantizing (see page 373).
Again, which quantize value is used depends on whether Global Quantize is used.

Muting notes and drum sounds

You can mute individual notes by clicking or enclosing them with the 
Mute tool or by using the Mute function on the Edit menu (see page 
412).

Furthermore, if a drum map is selected (see page 438), the drum 
sound list will have a Mute column. Click in the Mute column for a 
drum sound to mute that sound. Finally, clicking the Drum Solo button 
will mute all drum sounds other than the selected one.

Muted drum sounds

Please note that the mute state for drum sounds is part of the drum 
map, so any other tracks using the same map will also be affected. 

Deleting notes

To delete notes, click on them with the Drumstick tool or Eraser tool or 
select them and press [Backspace].
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Other editing methods

As in the Key Editor, you can edit notes on the info line or via MIDI, 
and enter notes using step input. Please refer to page 412.

Working with drum maps

Background

As discussed earlier, a drum kit in a MIDI instrument is most often a 
set of different drum sounds with each sound placed on a separate 
key (i.e. the different sounds are assigned to different MIDI note num-
bers). One key plays a bass drum sound, another a snare and so on.

Unfortunately, different MIDI instruments often use different key as-
signments. This can be troublesome if you have made a drum pattern 
using one MIDI device, and then want to try it on another. When you 
switch device, it is very likely that your snare drum becomes a ride 
cymbal, or your hi-hat becomes a tom, etc. – just because the drum 
sounds are distributed differently in the two instruments.

To solve this problem, and simplify several aspects of MIDI drum kits 
(like using drum sounds from different instruments in the same “drum 
kit”), Cubase SE features so-called drum maps. A drum map is basi-
cally a list of drum sounds, with a number of settings for each sound. 
When you play back a MIDI track for which you have selected a drum 
map, the MIDI notes are “filtered” through the drum map before being 
sent to the MIDI instrument. Among other things, the map determines 
which MIDI note number is sent out for each drum sound, and so 
which sound is played in the receiving MIDI device.

A solution to the problem above would therefore be to make up drum 
maps for all your instruments. When you want to try your drum pattern 
on another instrument, you simply switch to the corresponding drum 
map and your snare drum sound will remain a snare drum sound.
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Drum map settings

A drum map consists of settings for 128 drum sounds (one for each 
MIDI note number). To get an overview of these settings, open the 
Drum Editor and use the Map pop-up menu below the drum sound list 
to select the “GM Map” drum map.

This drum map is set up according to the General MIDI standard. For information on 
how to load, create and select other drum maps, see page 438.

Now, take a look at the drum sound list (you may have to drag the di-
vider between the list and the note display to the right to see all col-
umns). The columns show the settings of the drum map for each sound.
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Here’s a brief description (details follow below):

• All settings in a drum map (except the Pitch setting) can be changed 
directly in the drum sound list, or in the Drum Map Setup dialog (see 
page 439).
Note that the changes you make will affect all tracks that use the drum map.

About Pitch, I-note and O-note

This can be a somewhat confusing area, but once you’ve grasped 
how it all works it’s not very complicated. Going through the following 
“theory” will help you make the most out of the drum map concept – 
especially if you want to create your own drum maps.

As we said earlier, a drum map is a kind of “filter”, transforming notes 
according to the settings in the map. It does this transformation twice; 
once when it receives an incoming note (i.e. when you play a note on 
your MIDI controller) and once when a note is sent from the program 
to the MIDI sound device.

Column Description

Pitch The actual note number of the drum sound. This is what links notes on a 
MIDI track to drum sounds. For example, with the above drum map, all 
MIDI notes with the pitch C1 would be mapped to the Bass Drum sound. 
More on this below.

Instrument The name of the drum sound.

Quantize This value is used when entering and editing notes as described on 
page 430 and page 431.

Mute Allows you to mute a drum sound, excluding it from playback. 
See page 432.

I-note This is the “input note” for the drum sound. When this MIDI note is sent 
into Cubase SE, (i.e. played by you), the note will be mapped to the cor-
responding drum sound (and automatically transposed according to the 
Pitch setting for the sound). See below.

O-note This is the “output note”, i.e. the MIDI note number that is sent out every 
time the drum sound is played back. See below.

Channel The drum sound will be played back on this MIDI channel.

Output The drum sound will be played back on this MIDI output. If you set this to 
“Default”, the MIDI output selected for the track will be used.
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In the following example, we have modified the drum map, so that the 
Bass Drum sound has different Pitch, I-note and O-note values.

I-notes

Let’s look at what happens on input: When you play a note on your 
MIDI instrument, the program will look for this note number among the 
I-notes in the drum map. In our case, if you play the note A1, the pro-
gram will find that this is the I-note of the Bass Drum sound.

This is where the first transformation happens: the note will get a new 
note number according to the Pitch setting for the drum sound. In our 
case, the note will be transformed to a C1 note, because that is the 
pitch of the Bass Drum sound. If you record the note, it will be recorded 
as a C1 note.

O-notes

The next step is the output. This is what happens when you play back 
the recorded note, or when the note you play is sent back out to a 
MIDI instrument in real time (MIDI Thru):

The program checks the drum map and finds the drum sound with the 
pitch of the note. In our case, this is a C1 note and the drum sound is 
the Bass Drum. Before the note is sent to the MIDI output, the second 
transformation takes place: the note number is changed to that of the 
O-note for the sound. In our example, the note sent to the MIDI instru-
ment will be a B0 note.
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Usage

So, what’s the point of all this? Again, the purposes are different for 
I-notes and O-notes:

• Changing the I-note settings allows you to choose which keys will play 
which drum sounds, when playing or recording from a MIDI instrument.
For example, you may want to place some drum sounds near each other on the key-
board so that they can be easily played together, move sounds so that the most impor-
tant sounds can be played from a short keyboard, play a sound from a black key 
instead of a white, and so on.
If you never play your drum parts from a MIDI controller (but draw them in the editor) 
you don’t need to care about the I-note setting.

• The O-note settings let you set things up so that the “Bass Drum” sound 
really plays a bass drum.
If you’re using a MIDI instrument in which the bass drum sound is on the C2 key, you 
set the O-note for the Bass Drum sound to C2. When you switch to another instru-
ment (in which the bass drum is on C1) you want the Bass Drum O-note set to C1. 
Once you have set up drum maps for all your MIDI instruments, you don’t have to care 
about this anymore – you just select another drum map when you want to use another 
MIDI instrument for drum sounds.

The channel and output settings

You can set separate MIDI channels and/or MIDI outputs for each 
sound in a drum map. The following rules apply:

• When a drum map is selected for a track, the MIDI channel settings in the 
drum map override the MIDI channel setting for the track.
In other words, the MIDI channel setting you make in the Track list or Inspector for the 
track is normally disregarded. If you want a drum sound to use the channel of the track, 
set it to channel “Any” in the drum map.

• If the MIDI output is set to “default” for a sound in a drum map, the sound will 
use the MIDI output selected for the track.
Selecting any other option allows you to direct the sound to a specific MIDI output.

By making specific MIDI channel and output settings for all sounds in 
a drum map, you can direct your drum tracks directly to another MIDI 
instrument simply by selecting another drum map – you don’t need to 
make any channel or output changes for the actual track.
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• To select the same MIDI channel for all sounds in a drum map, click the 
Channel column, press [Ctrl]/[Command] and select the desired channel.
All drum sounds will be set to this MIDI channel. The same procedure can be used for 
selecting the same MIDI output for all sounds as well.

It can also be useful to select different channels and/or outputs for dif-
ferent sounds. This allows you to construct drum kits with sounds 
from several different MIDI devices, etc.

Managing drum maps

Selecting a drum map for a track

To select a drum map for a MIDI track, use the Map pop-up menu in 
the Inspector or in the Drum Editor:

Selecting “No Drum Map” turns off the drum map functionality in the 
Drum Editor. Even if you don’t use a drum map, you can still separate 
sounds by name using a name list (see page 441).

Initially, the Map pop-up menu will only contain one map: “GM Map”. 
However, you will find a number of drum maps included on the program 
DVD – how to load these is described below.
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The Drum Map Setup dialog

To set up and manage your drum maps, select Drum Map Setup from 
the Map pop-up menus or the MIDI menu. This opens the following 
dialog:

This is where you load, create, modify and save drum maps. The list to 
the left shows the currently loaded drum maps; selecting a drum map 
in the list displays its sounds and settings to the right.

• The settings for the drum sounds are exactly the same as in the Drum 
Editor (see page 434).
As in the Drum Editor, you can click the leftmost column to audition a drum sound. 
Note: if you audition a sound in the Drummap Setup dialog, and the sound is set to 
MIDI output “Default”, the output selected on the Default pop-up menu in the lower left 
corner will be used. When auditioning a Default output sound in the Drum Editor, the 
MIDI output selected for the track will be used, as described on page 437.

Below the drum sound list you will find a number of buttons, with the 
following functionality:

Button Description

New Map Click this to add a new drum map to the project. The drum sounds will 
be named “Sound 1, Sound 2” and so on, and have all parameters set 
to default values. The map will be named “Empty Map”, but you can re-
name it by clicking and typing in the list.
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• Drum maps are saved with the project files. If you have created or mod-
ified a drum map, you should use the Save function to store it as a sep-
arate file, available for loading into other projects.
If you always want to have the same drum map(s) included in your projects, you may 
want to load these into the default project – see page 540.

O-Note Conversion

This function on the MIDI menu goes through the selected MIDI part(s) 
and sets the actual pitch of each note according to its O-note setting. 
This is useful if you want to convert the track to a “regular” MIDI track 
(with no drum map) and still have the notes play back the correct drum 
sound. A typical application is if you want to export your MIDI recording 
as a standard MIDI file (see page 544) – by first performing an O-Note 
Conversion you make sure that your drum tracks play back as they 
should when they are exported.

New Copy Adds a copy of the currently selected drum map. This is probably the 
quickest way to create a new drum map: select the map that is similar 
to what you want, create a copy, change the desired drum sound set-
tings and rename the map in the list.

Remove Removes the selected drum map from the project.

Load Opens a file dialog, allowing you to load drum maps from disk. On the 
Cubase SE DVD you will find a number of drum maps for different 
MIDI instruments – use this function to load the desired maps into your 
project.

Save Opens a file dialog for saving the drum map selected in the list. If you 
have created or modified a drum map, you should use this function to 
save it as a file on disk – this allows you to load it into other projects. 
Drum map files have the extension “.drm”.

Assign Click this button to assign the selected drum map to the current MIDI 
track (only available if a MIDI track was selected when you opened the 
Drum Map Setup dialog). This is the same as selecting the drum map 
from the Map pop-up menu.

OK Closes the dialog.

Button Description
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Using drum name lists

Even if no drum map is selected for the edited MIDI track, you can still 
use the Drum Editor if needed. As previously mentioned, the drum 
sound list will then only have four columns: Audition, Pitch, Instrument 
(drum sound names) and Quantize. There will be no I-note and O-note 
functionality.

In this mode, the names shown in the Instrument column depend on 
the selection on the Names pop-up menu, just below the Map pop-up 
in the Drum Editor.

The options on this pop-up menu are the currently loaded drum maps 
plus a “GM Default” item which is always available. This means you 
can use the drum sound names in any loaded drum map without using 
I-notes and O-notes, should you so like.
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The List Editor – Overview

The toolbar

The toolbar contains several items that are the same as in the Key 
Editor (edit solo, snap, quantize settings, etc.). These are described 
earlier in this chapter. The following toolbar items are unique to the 
List Editor:

• The Insert pop-up menu is used when creating new events.
This is where you determine what type of event to add (see page 444).

• The Mask pop-up menu and Filter view (Show Filter View button) allow you to 
hide events from view, based on their type and other properties.
See page 447.

• The Value View button can be used for hiding and showing the Value 
display (see below).

The List Editor has no info line (numerical editing is available in the list 
instead).

The list

This lists all events in the currently selected MIDI part(s), in the order 
(from top to bottom) they are played back. You can edit the event 
properties by using regular value editing, as described on page 444.
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The event display

This shows the events graphically. The vertical position of an event in 
the display corresponds to its entry in the list (i.e. to the playback or-
der), while the horizontal position corresponds to its actual position in 
the project. This is where you add new parts or events, drag to move 
them, etc.

The value display

This display shows the “value” of each event, allowing for easy view-
ing and graphical editing. Typically, the value shown is the “Data 2” or 
“Value 2” property (amounts for MIDI controller events, velocity for 
notes, etc.). You can show or hide this display by clicking the “Show 
List Value View” button on the toolbar.

List Editor operations

Customizing the view

You can click and drag the divider between the list and the event dis-
play to make one area wider and the other narrower. Furthermore, the 
list can be customized in the following ways:

• You can change the order of the columns by dragging the column headings.
• You can resize columns by dragging the dividers between the column headings.

Setting the display format

Just like in the Project window, you set the display format (bars+beats, 
seconds, etc.) by right-clicking (Win) or [Ctrl]-clicking (Mac) in the ruler 
and selecting an option from the pop-up menu. This setting affects 
both the ruler and all start, end and length values shown in the list.

Zooming

You can change the horizontal magnification in the event display by us-
ing the zoom slider below the display or the Magnification Glass tool.
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Adding events

To add a new event to the edited part, proceed as follows:

1. Use the Insert pop-up menu on the toolbar to select the event type.

2. Select the Pencil tool and click in the event display, at the desired 
position (relative to the ruler).
If you are creating note events, you can click and drag to set the length of the note.

The new event appears in the list and in the display. Its properties will 
be set to default values, but can easily be adjusted in the list.

• Notes you enter will get the insert velocity value set in the insert velocity 
field on the toolbar. See page 407.

Editing in the list

The list allows you to perform detailed numerical editing of the events’ 
properties. The columns have the following functionality:

Column Description

L Locate column. An arrow in this column indicates the event that starts 
closest before the project cursor position. If you click in this column for an 
event, the project cursor is moved to the start of that event. Double click-
ing moves the cursor position and starts/stops playback – useful for au-
ditioning when editing in the list.

Type The event type. This cannot be changed.

Start The start position of the event, shown in the format selected for the ruler. 
Changing this is the same as moving the event. Note that moving the 
event past any other event in the list will re-sort the list (the list always 
shows the events in the order they are played back).
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• You can edit several events at once. If several events are selected and 
you edit a value for one event, the other selected events’ values will be 
changed as well.
Normally, any initial value differences between the events will be maintained – i.e. the 
values will change by the same amount. If you press [Ctrl]/[Command] when you edit, 
however, all events will get the same value.

• For SysEx (system exclusive) events, you can only edit the position 
(Start) in the list.
However, clicking the Comment column opens the MIDI SysEx Editor, in which you 
can perform detailed editing of system exclusive events – this is described in the sep-
arate “MIDI Devices and Features” pdf.

End This is only used for note events, allowing you to view and edit the end 
position of a note (thereby resizing it).

Length This is only used for note events. It shows the length of the note – chang-
ing this resizes the note and automatically changes the End value as well.

Data 1 This is the “data 1” or “value 1” property of the event. The content of this 
depends on the event type – for notes, this is the pitch, for example. 
Where applicable, the values are shown in the most relevant form. For in-
stance, the Data 1 value for notes is shown as a note number in the for-
mat selected in the Preferences dialog (Event Display–MIDI page). See 
also the table on page 449.

Data 2 This is the “data 2” or “value 2” property of the event. The content of this 
depends on the event type – for notes, this is the velocity value, for exam-
ple. See the table on page 449.

Channel The MIDI channel of the event. Note that this setting is normally overrid-
den by the channel setting for the track. To make a MIDI event play back 
on “its own” channel, set its track to channel “Any” in the Project window.

Comment This column is used for some event types only, providing an additional 
comment about the event.

Column Description
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Editing in the event display

The event display allows you to edit the events graphically using the 
tools on the toolbar. You can edit single events as well as several se-
lected events simultaneously.

• To move an event, click and drag it to a new position.
Note that moving the event past any other event in the display will re-sort the list (the 
list always shows the events in the order they are played back). As a result, the vertical 
position of the event in the display will change as well.

• To make a copy of an event, press [Alt]/[Option] and drag it to a new 
position.

• To resize a note, select it and drag its end point with the Arrow tool as 
in the Project window.
This only works with notes.

• To mute or unmute an event, click on it with the Mute tool.
You can mute or unmute several events in one go by enclosing them in a selection 
rectangle with the Mute tool.

• You can select a color scheme for the events with the Colors pop-up 
menu on the toolbar.
This affects how all MIDI events are shown in the List, Key and Drum editors – see 
page 469.

• To delete an event, select it and press [Backspace] or [Delete], or 
click on it with the Eraser tool in the event display.
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Filtering

Clicking the “Show Filter View” button on the toolbar opens an addi-
tional filter bar that allows you to hide specific event types from view. 
For example, it may be hard to find note events if the part contains a 
lot of controllers. By hiding these the list becomes more manageable.

To hide an event type, tick its checkbox on the filter view. To see one 
event type only (hide all other event types), press [Ctrl]/[Command] 
and click its checkbox. If you [Ctrl]/[Command]-click again, all check-
boxes are cleared (all events will be visible).

• The event types remain hidden even if you close the filter view.
To make sure you see all events, open the filter view and check that all checkboxes are 
deactivated.

• The filter view does not remove, mute or in any other way change the 
events.

Masking

The Mask function is similar to the filter view but allows you to hide 
events based on other criteria as well. Proceed as follows:

1. Select an event (or several events) of the type you want to view.

2. Pull down the Mask pop-up menu on the toolbar and select one of the 
options.
The results are as follows:

Option Description

Event Types Only events with the type of the selected event will be shown. This 
does the same as the filter view but is quicker if you only want to 
view a single event type.

Event Types and 
Data 1

Only events of the same type and with the same “Data 1” value will 
be shown. For example, if a note event is selected, only notes with 
the same pitch will be shown. If a controller event is selected, only 
controllers of the same type will be shown.
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In addition to the above options, the menu also gives you access to 
the Logical Editor presets (see the separate “MIDI Devices and Fea-
tures” pdf for details).

When you apply any of the presets from the Logical Editor, only the 
events that meet the criteria specified will be visible.

• To deactivate the Mask function, select “Nothing” from the Mask pop-
up menu.

The most typical usage of the Mask function is to view a certain type 
of controller only (e.g. Modulation, Breath Control, etc.). Since these 
are all the same event types (controller), this would not be possible 
using the filter view. With the “Event Types and Data 1” option on the 
Mask pop-up menu, it is!

Event Channels Only events with the same MIDI channel value as the selected 
event will be shown.

Option Description
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Editing in the value display

The value display to the right of the event display is a tool for quick 
viewing and editing of multiple values, e.g. velocities or controller 
amounts. The values are shown as horizontal bars, with the bar length 
corresponding to the value.

A velocity ramp in the value display.

You edit the values by clicking and dragging. Note that the pointer au-
tomatically takes on the shape of the Pencil tool when you move it into 
the value display – you don’t have to select the Pencil tool for this.

Exactly which value is shown for an event depends on the event type. 
The following table shows what is displayed and edited in the Data 
columns and the value display:

Event type Data 1 Data 2 Value display

Note Pitch (note number) Velocity Velocity

Controller Controller type Controller amount Controller amount

Program Change Program number Not used Program number

Aftertouch Aftertouch amount Not used Aftertouch amount

Pitch Bend Bend amount Not used Bend amount

SysEx Not used Not used Not used
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• The value display can be hidden from view by clicking the “Show List 
Value View” button on the toolbar, so that it is not lit.

The Score Editor – Overview

The Score Editor shows the MIDI notes as a musical score. The win-
dow contains the following sections and items:

The toolbar

The Score Editor toolbar is similar to the toolbar in the Key Editor, with 
the following differences:

• The Score Editor toolbar has a button for showing or hiding the extended 
toolbar (see below).

• There are no active part settings – in the Score Editor, parts on different 
tracks are shown on different staves.

• There is no chord recognition function.
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The info line

The info line shows information about selected MIDI notes, just like in 
the Key and Drum Editors. You can edit all values on the info line us-
ing regular value editing (see page 412 for details).

• To hide or show the info line, click the “Show Info” button in the toolbar.

The extended toolbar

The extended toolbar (shown or hidden by clicking the “Show Tool 
Strip” button on the main toolbar) contains the following items:

Note value buttons

Click one of these to select a note value for input. The “T” and “.” op-
tions are for triplet and dotted note values. You can also press [Ctrl]/
[Command] and click one of the note value buttons – this will resize all 
selected notes to the note value you choose.

Enharmonic shift

Allows you to manually select whether a note should be shown with 
flat or sharp accidentals. See page 465.
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The score display

The main area of the Score Editor window shows the notes in the 
edited parts on one or several staves. 

• If you are editing one or several parts on the same track, as much of them as 
possible is shown on several staves – one above the other – just as with a 
score on paper.

• If you are editing parts on several tracks, they are put on a grand staff (multiple 
staves, tied together by bar lines).

• The number of measures across the screen depends on the size of the window 
and the number of notes in each measure.
The maximum number of bars across the page is four.

• The end of the last part is indicated by a double bar line.

• Unlike the other MIDI editors, the Score Editor does not have a ruler.
A conventional ruler would not make sense, since there is no exact relationship between 
a note’s horizontal position in the score and its musical position in the Project.
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Score Editor operations

Opening the Score Editor

To open one or several parts in the Score editor you proceed much as 
with the other editors: select one or several tracks or any number of 
parts (on the same or different tracks), and select “Open Score Editor” 
from the Scores submenu on the MIDI menu. The default key command 
for this is [Ctrl]/[Command]-[R].

• You can also select the Score editor as your default editor, allowing 
you to open it by double clicking parts.
This is done with the Default Edit Action pop-up menu in the Preferences dialog (event 
Display – MIDI page).

About editing parts on different tracks

If you have selected parts on two or more tracks and open the Score 
editor, you will get one staff for each track (although you can split a 
staff in two, e.g. when scoring for piano). The staves are tied together 
by bar lines and placed in the order of the tracks in the Project window.

• If you need to rearrange the staves: close the editor, go back into the 
Project window, drag the tracks to the order you want them, and open 
the Score Editor again.

The Active Staff

Just as in the other editors, all MIDI input (as when recording from 
your instrument) is directed to one of the tracks, here called the Active 
staff. The Active staff is indicated by a black rectangle in the left part 
of the first visible bar.

To change Active staff, click in the staff you want to activate.

The Active staff
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Getting the score displayed correctly

When you open the Score Editor for a part recorded in real time, the 
score may not look as legible as you would first expect. The Score Ed-
itor can ignore the minor time variances in performance and make a 
neater score almost instantly. To achieve this, there are a number of 
Staff Settings that determine how the program displays the music.

• Note that the time signature follows the time signature(s) on the Tempo 
track and are common to all tracks/staves in the score.

There are two ways to open the Staff Settings dialog:

• Double click in the white area to the left of the staff.

• Activate a staff by clicking in it, and select “Staff Settings” from the 
Scores submenu on the MIDI menu.
The Staff Settings dialog appears.

The settings you make in this dialog are independent for each staff (track), 
but common for a piano staff which you have created by choosing the 
“Split” Staff Mode option (see below).
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Staff Mode

This pop-up determines how the staff should be shown: 

• When set to “Single”, all notes in the part are shown in the same staff.

• When set to “Split”, the part is split on the screen into a bass and tre-
ble clef, as in a piano score. 
You use the Splitpoint value field to set the note where you want the split to occur. 
Notes above and including the split note will appear on the upper staff, and notes 
below the split note will appear on the lower staff.

Before and after setting a split at C3.

Display Quantize

Notes are not an absolute language, and you must give the program a 
few hints on how the score should be displayed. This is done using 
the Display Quantize section of the Staff Settings dialog.
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These are only display values used for the graphics in the Score Editor. 
They do not affect the actual playback in any way.

Here is a description of the functions:

Parameter Description

Notes Determines the smallest note value to be displayed and the “small-
est position” to be recognized and properly displayed. Set this to the 
smallest significant note position used in your music. 
For example, if you have notes on odd sixteenth note positions, you 
should set this value to 16.
The “T” values are for triplet note values.
This setting is partly overridden by Auto Quantize (see below).

Rests This value is used as a “recommendation” – the program will not dis-
play rests smaller than this value, except where necessary. In effect, 
this setting also determines how the length of notes should be dis-
played. Set this value according to the smallest note value (length) 
you want to be displayed for a single note, positioned on a beat.

Auto Quantize Generally, if your music contains mixed triplets and straight notes, try 
activating this checkbox. Otherwise, make sure it is deactivated.
Auto Quantize uses involved methods to make your score look as 
legible as possible. Auto Quantize allows you to mix straight notes 
with tuplets (triplets) in a part. But, Auto Quantize also uses the (dis-
play) Quantize value. If it can't find an appropriate note value for a 
certain note or group of notes, it will use the set Quantize value to 
display it.
If the part is imprecisely played and/or complex, Auto Quantize may 
have a problem “figuring out” exactly what you “mean”.

Dev This option is only available if Auto Quantize is on. When Dev (Devi-
ation) is activated, triplets/straight notes will be detected even if they 
are not exactly “on the beat”. However, if you know your triplets/
straight notes are perfectly recorded (quantized or entered by hand), 
turn this off.

Adapt This option is only available if Auto Quantize is on. When Adapt is 
activated, the program “guesses” that when one triplet is found, 
there are probably more triplets surrounding it. Turn this on if not all 
of your triplets are detected.
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Key and Clef

The correct Key and Clef are set using the two scroll bars in the Key & 
Clef section.

If you activate the “Auto Clef” checkbox, the program attempts to guess the correct 
clef, judging from the pitch of the music.

• To set the clef and key for the lower staff, activate the “Lower Staff” 
checkbox in the Key/Clef section.

Display Transpose

Some instruments, for example a lot of brass instruments, are scored 
transposed. For this purpose, the Staff Settings dialog allows you to 
specify a separate Display Transpose setting for each staff (track). This 
transposes the notes in the score (i.e. how they are displayed) without 
affecting how the notes play back. This allows you to record and play 
back a multi staff arrangement, and still score each instrument accord-
ing to its own transposition.

• Use the pop-up menu to select the instrument for which you are 
scoring.
You can also manually set a display transpose value with the Semitones box above.
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Flags

These provide additional options for how the score should be dis-
played:

Parameter Description

Clean Lengths When this is activated, notes that are considered to be chords will 
be shown with identical lengths. This is done by showing the longer 
notes as shorter than they are. When Clean Lengths is turned on, 
notes with very short overlaps are also cut off; a bit as with No Over-
lap (see below), but with a more subtle effect. 

No Overlap When this is activated one note will never be shown as overlapping 
another, lengthwise. This allows long and short notes starting at the 
same point to be displayed without ties; the long notes are cut off in 
the display. This will make the music more legible.

An example measure with No Overlap deactivated...

...and with No Overlap activated.

Syncopation When this function is activated, syncopated notes are shown in a 
more legible way.

This is a dotted quarter at the end of a bar when Syncopation is Off...

...and when it is On.

Shuffle Activate this function when you have played a shuffle beat and want 
it displayed as straight notes (not triplets). This is very common in 
jazz notation.
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Applying your settings

After you’ve made your settings, click Apply to apply them to the active 
staff. You can select another staff in the score and make settings for 
that, without having to close the Staff Settings dialog first – just remem-
ber to click Apply before you change staff, otherwise your changes will 
be lost.

• As in many other dialogs and property windows in Cubase SE, you 
can store your settings as presets.
This is done according to the usual procedures: click Store to store the current set-
tings as a preset, select a preset from the pop-up menu to load it into the dialog or use 
the Remove button to remove the currently selected preset.

Entering notes with the mouse

To enter notes into a part in the Score Editor, you use the Note tool. 
However, first you need to set the note value (length) and spacing:

Selecting a note value for input

This can be done in two ways:

• By clicking the note symbols on the extended toolbar.
You can select any note value from 1/1 to 1/64th and turn on and off the dotted and 
triplet options by clicking the two buttons to the right. The selected note value is dis-
played in the Length value field on the toolbar and in the Note tool cursor shape.

• By selecting an option from the Length Q pop-up on the toolbar.



CUBASE SE
21 – 460 The MIDI editors

Selecting a Quantize Value

When you move the mouse pointer over the score, you will see that 
the position box on the toolbar tracks your movement and shows the 
current position in bars, beats, sixteenth notes and ticks.

Positioning on screen is controlled by the current Quantize value. If 
you for example set this to “1/8 Note” you can only insert and move 
notes to eighth note positions, at quarter notes, at half bars or at bar 
positions. It is a good strategy to set the Quantize value to the small-
est note value in the piece. This doesn’t stop you from inputting notes 
at “coarser” positions. However, if you set the Quantize value to too 
small a note value, it is easier to make mistakes.

The Quantize value is set with the Quantize pop-up on the toolbar.

• You can also assign key commands to the different Quantize values.
This is done in the Key Commands dialog on the File menu, under the heading “MIDI 
Quantize”.

• Just like in the other MIDI editors, you can use the Quantize Setup 
dialog to create other quantize values, irregular grids, etc.
However, this is not often used when entering score notes.

Entering a note

To add a note to the score, proceed as follows:

1. Make the staff active.
Notes are always put in on the active staff.

2. Select the type of note by selecting a note value.
This is described in detail above.

3. If you selected the note value by clicking on a symbol on the extended 
toolbar, the Note tool was automatically selected – otherwise select 
the Note tool from the toolbar or Quick menu.

With the Quantize value set to “1/8 Note”, you 
can only input notes at eighth note positions.
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4. Select a Quantize value.
As described above, the Quantize value will determine the spacing between notes. If 
you have Quantize set to “1/1 Note” you will only be able to add notes at downbeats. 
If you set Quantize to “1/8 Note” you will be able to add notes at all eighth note posi-
tions etc.

5. Click in the staff and keep the mouse button pressed.
A note appears under the mouse pointer.

6. Move the mouse horizontally to find the correct position.
Check the lower mouse position box on the toolbar – the position is “magnetically” at-
tracted to the grid defined by the current Quantize value. This allows you to easily find 
the correct position.

7. Move the mouse vertically to find the correct pitch.
The upper mouse position box shows the pitch at the pointer position, making it easy 
to find the right pitch.

8. Release the mouse button.
The note appears in the score.

The notes you enter will get the insert velocity value set in the insert 
velocity field on the toolbar. See page 407.

Selecting notes

There are several ways to select notes in the Score Editor:

By clicking

To select a note, click on its note head with the Arrow tool. The note 
head gets inverted to indicate that it is selected.

• To select more notes, hold down [Shift] and click on them.

• To deselect notes, hold [Shift] down and click on them again.

• If you hold down [Shift] and double click on a note, this note and all 
the following notes in the same staff are selected.
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Using a selection rectangle

1. Press the mouse button with the Arrow tool in some free (white) 
space in the score.

2. Drag the mouse pointer.
A rectangle appears. You can drag to select voices on several voices or staves if you 
wish.

3. Release the mouse button.
All notes with their note heads inside the rectangle get selected.

If you want to deselect one or more of the notes, hold down [Shift] and 
click as described above.

Using the keyboard

By default, you can step through the notes in the staff using the left 
and right arrow keys. If you press [Shift], you will select the notes as 
you step through them.

• If you want to use other keys for selecting notes, you can customize 
the settings in the Key Commands dialog on the File menu (in the 
Navigate category).

Deselecting everything

To deselect everything, simply click with the Arrow tool in some “free” 
(white) space in the score.

Deleting notes

Notes can be deleted in two ways:

Using the Eraser tool

1. Select the Eraser tool from the toolbar or Quick menu.

2. Click on the Note(s) you want to erase, one at a time or drag over 
them with the mouse button pressed.
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Using the keyboard or delete menu item

1. Select the notes you want to delete.

2. Select Delete from the Edit menu, or press [Delete] or [Backspace] on 
the computer keyboard.

Moving notes

To move or transpose notes, proceed as follows:

1. Set the Quantize value.
The Quantize value will restrict your movement in time. You can not place the notes on 
positions smaller than the Quantize value. If Quantize for example is set to “1/8 Note”, 
you will not be able to move the notes to a sixteenth note position. However, you will 
be able to put them on any eighth note, quarter note, half note or whole note position.

2. If you want to hear the pitch of the note while moving, activate the 
speaker icon on the toolbar. 
When it is on, you will hear the current pitch of the “dragged” note.

3. Select the note(s) you plan to move.

4. Click one of the selected notes and drag it to a new position and/or 
pitch.
The horizontal movement of the note is “magnetically attracted” to the current Quantize 
value. The position boxes on the toolbar show what the new position and pitch for the 
dragged note will be.

5. Release the mouse.
The notes appear at their new position.

• If you press [Ctrl]/[Command] and drag, movement is restricted to 
vertical or horizontal only (depending on in which direction you drag).

• You can also move selected notes by using key commands, as as-
signed in the Nudge category in the Key Commands dialog.
When moving notes to the left or right using key commands, the notes will be moved in 
steps according to the current Quantize value. The keys assigned for up/down nudg-
ing will transpose notes in semitones steps.



CUBASE SE
21 – 464 The MIDI editors

Duplicating notes

1. Set the Quantize value and select the notes, as for moving.

2. Press [Alt]/[Option] and drag the notes to their new position.

• If you want to restrict movements to one direction only, press [Ctrl]/
[Command].
This works just as for moving, as described above.

• [Alt]/[Option] is the default modifier key for copying/duplicating. If you 
like, you can change this in the Preferences dialog (Editing–Tool Modi-
fiers page).
The entry for this is found in the Drag & Drop category (“Copy”).

Changing the length of notes

As described earlier in this section (see page 454), the displayed 
length of a note isn’t necessarily the actual note length, but also de-
pends on the Note and Rest Display Quantize settings in the Staff 
Settings dialog. This is important to remember when you change the 
length of a note, since it can give rise to confusing results.

There are several ways to change the length of a note in the Score 
Editor:

By using the Note tool

1. Select a Note value that you wish to apply to the Note.
This can be done by clicking a note value icon in the extended toolbar or by selecting 
a new Length value.

2. Select the Note tool if it isn’t already selected.

3. Hold down [Alt]/[Option] and click on the notes you wish to set to this 
length.
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By using the note value icons on the extended toolbar

Using the extended toolbar is another quick way to set a number of 
notes to the same length:

1. Select the notes you want to change.

2. Hold down [Ctrl]/[Command] and click on one of the note icons on 
the extended toolbar.
All the selected notes are now given the length of the clicked note.

By using the info line

You can also edit length values numerically on the info line, just like in 
the Key and Drum Editors (see page 412).

Splitting and Gluing notes

• If you have two notes strung together by a tie, and click on the “tied” 
note head with the Scissors tool, the note will be divided into two, 
with the respective length of the “main” and the tied note.

• Conversely, if you click on a note with the Glue Tube tool it will be 
joined to the next note with the same pitch.

Enharmonic Shift

The buttons to the right on the extended toolbar allow you to shift the 
display of selected notes so that for example an F# (F sharp) is instead 
shown as a Gb (G flat) and vice versa:

1. Select the note(s) you want to affect.

2. Click on one of the buttons to display the selected note(s) a certain 
way.

The “off” button resets the notes to original display. The other five options are 
double flats, flats, No (no accidentals shown, regardless of pitch), sharps and 
double sharps.
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Flip Stems

Normally the direction of the note stems is automatically selected ac-
cording to the note pitches, but you can change this manually if you like:

1. Select the notes for which you want to change (flip) the stem direction.

2. Pull down the MIDI menu and select Flip Stems from the Scores sub-
menu.

Working with text

You can use the Text tool to add comments, articulation or instrumen-
tation advice and other text strings anywhere in the score:

Adding a text string

1. Select the Text tool from the toolbar or Quick menu.

2. Click anywhere in the score.
A text input line dialog box appears.

3. Enter the text and press [Return].

Editing text

To edit an already added text string, double click it with the Arrow tool. 
This opens the text for editing, and you can use the arrow keys to 
move the cursor, delete characters with the [Delete] or [Backspace] 
keys and type new text as usual. Finish by pressing [Return].

• To delete a text block, select it with the Arrow tool and press [Back-
space] or [Delete].

• You can move or duplicate text blocks by dragging (or [Alt]/[Option]-
dragging) them, just as with notes.
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Changing the text font, size and style

To change the font settings for the text you have added, proceed as 
follows:

1. Select the text block by clicking it with the Arrow tool.

2. Pull down the MIDI menu and select “Set Font” from the Scores sub-
menu.
A Font Settings dialog appears, containing the following settings:

3. When you’ve made your settings, click Apply.
If you like, you can leave the Font Settings dialog open, select another text block and 
adjust the settings for that – just remember to click Apply before you select a new text 
block.

• If you make settings in the Font Settings dialog with no text block se-
lected, the settings will be used as default for all new text.
In other words, all text you enter from then on will get the settings you have specified 
(although you can of course change this manually for each text block as usual).

Item Description

Font This is where you specify the font for the text. Which fonts are 
available on the pop-up menu depends on which fonts you have 
installed on you computer. You probably don’t want to use the 
“Steinberg” fonts – these are special fonts used by the program 
(e.g. for score symbols) and not suited for common text.

Size Sets the size of the text.

Frame Allows you to encase the text in a rectangular (box) or oval frame.

Text style options These checkboxes determine whether the text should be bold, 
italic, and/or underlined.
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Printing

To print your score, proceed as follows:

1. Open the parts you want to print in the Score Editor.
Printing is only available from within the Score Editor.

2. Select Page Setup from the File menu and make sure all your Printer 
settings are correct.

3. This includes paper size and margins.

4. Close the Page Setup dialog and select Print from the File menu.

5. The standard Print dialog appears. Fill out the options as desired.

6. Click Print.

Common MIDI editor options and settings

Snap

Snap activated on the toolbar.

The Snap function helps you find exact positions when editing in a MIDI 
editor. It does this by restricting horizontal movement and positioning to 
certain positions. Operations affected by snap include moving, dupli-
cating, drawing, sizing, etc.

• How Snap works depends on the Snap mode pop-up menu next to the Snap 
button.
See page 113.

• When the “Bars+Beats” display format is selected in the ruler, the snap grid 
is set by the quantize value on the toolbar.
This makes it possible to snap not only to straight note values but also to swing grids 
set up in the Quantize Setup dialog (see page 373).

• When any of the other display formats is selected in the ruler, positioning is 
restricted to the displayed grid, i.e. you can snap in finer increments by zoom-
ing in and in coarser increments by zooming out the display.
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Coloring notes and events

By using the Colors pop-up menu on the toolbar, you can select a 
color scheme for the events in the editor. The following options are 
available:

When any of the options (apart from “Part”) is selected, you can se-
lect “Setup” from the Colors pop-up menu. This opens a dialog in 
which you can specify which colors should be associated with which 
velocities, pitches or channels, respectively.

Option Description

Velocity The notes get different colors depending on their velocity values.

Pitch The notes get different colors depending on their pitch.

Channel The notes get different colors depending on their individual MIDI channel 
values.

Part The notes get the same color as their respective part in the Project win-
dow. Use this option when you are working with two or more tracks in an 
editor, to make it easier to see which notes belong to which track.

GridMatch The notes get different colors depending on their time position. This 
mode makes it easy to see e.g. if the notes in a chord start at the exact 
same beat.
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Background

For each audio or MIDI track in Cubase SE, the tempo can either be 
fixed through the whole project (this is called “Fixed tempo mode”) or 
follow the Tempo track (this is called “Tempo track mode”), which may 
contain tempo changes.

• To switch between Fixed tempo mode and Tempo track mode, use 
the Tempo button on the Transport panel:

When the Tempo button is lit (and the text “Track” is shown), the tempo follows the 
Tempo track, when it is deactivated (and the text “Fixed” is shown), the Fixed tempo 
is used (see page 479). You can also switch tempo mode in the Tempo Track 
Editor (see below).

The Tempo track also contains time signature events. These are always 
active, regardless of whether Fixed tempo mode or Tempo track mode 
is selected.

A note about audio tracks

For audio tracks, the start time position of audio events depends on 
the current tempo setting. However, it is important to realize that the 
actual audio (“within” the events) will play back as recorded, regard-
less of any tempo changes you make. Therefore, it’s good practice to 
make the proper tempo and time signature settings before you start 
recording tempo based audio.

• To make an already recorded audio track follow the tempo changes, you 
can use the Hitpoints and Slicing features, as described on “Background”.
How well this works depends on the character of the audio recordings, since the Hit-
point detection feature works best with fairly rhythmical material.
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The Tempo Track Editor – overview

To make changes to the actual Tempo track you need to open the 
Tempo Track Editor, by selecting “Tempo Track” on the Project menu.

The toolbar

The toolbar contains various tools and settings. The tempo and time 
signature displays to the right allow you to view and edit the value of 
the selected tempo curve point or time signature event, much like the 
info line in other editors.

Tools

Tempo track on/off Autoscroll

Snap on/off

Curve type selector

Curve type for new tempo events

Time signature

The selected tempo

Snap pop-up
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The ruler

The ruler in the Tempo Track Editor shows the timeline. As in other 
windows, you can select a display format by clicking on the arrow but-
ton to the right of the ruler, and selecting an option from the pop-up 
menu that appears.

The two additional items at the bottom of the menu have the following 
functionality:

• If “Time Linear” is selected, the ruler, time signature area and tempo 
curve display will be linear in relation to the timeline.
This means that if the ruler shows bars and beats, the distance between the bar lines 
will vary depending on the tempo.
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• If “Bars+Beats Linear” is selected, the ruler, time signature area and 
tempo curve display will be linear in relation to beats.
If the ruler shows bars and beats, the distance between beats will be constant.

The time signature area

The area below the ruler contains time signature events. 

The tempo curve display

The main display shows the tempo curve (or, if Fixed tempo mode is 
selected, the Fixed tempo – see page 479). To the left of the display 
is a tempo scale to help you quickly locate the desired tempo.

• Note that the vertical “grid lines” correspond to the display format 
selected for the ruler.
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Operations

Zooming

Changing the magnification is done using any of the following methods:

• By using the zoom sliders in the lower right corner of the window.

• By using the Magnifying Glass tool.
This works according to the standard procedures.

• By using the Zoom submenu on the Edit menu.
The options on the menu work as in other windows.

Editing the tempo curve

This section assumes that you are working in Tempo track mode, i.e. the 
Tempo button is lit on the Transport panel.

Adding tempo curve points

1. Use the “insert curve” pop-up menu in the toolbar to select whether you 
want the tempo to change gradually from the previous curve point to 
the new one (“Ramp”) or change instantly to the new value (“Jump”).

2. Select the Pencil tool.

3. Click at the desired time position in the tempo curve display, and keep 
the mouse button pressed.
If Snap is activated on the toolbar, this determines at which time positions you can 
insert tempo curve points, see page 481.

When you click, the tempo display in the toolbar shows the tempo value.
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4. Drag the curve point to the desired tempo value (indicated in the 
tempo display), and release the mouse button.
The tempo curve point is inserted. The result depends on whether you selected 
“Ramp” or “Jump” in step 1 above:

• You can also just click and draw a tempo curve with the Pencil tool, 
having curve points automatically inserted as you draw.
You would probably want to select the “Ramp” Insert Curve mode when doing this.

• Instead of using the Pencil tool, you can press [Alt]/[Option] and use 
the Arrow tool. 
This will only insert a single point (i.e. you cannot draw a curve with the Arrow tool).

You can also have tempo values automatically inserted by the Beat Cal-
culator, see page 482.

Selecting tempo curve points

Selecting curve points is done using any of the following methods:

• Use the Arrow tool.
The standard selection techniques apply.

• Use the Select submenu on the Edit menu.
The options are:

Option Description

All Selects all curve points on the Tempo track.

None Deselects all curve points.

In Loop Selects all curve points between the left and right locator.

Insert curve set to “Ramp”: Insert curve set to “Jump”:
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• You can also use the left and right arrow keys on the computer key-
board, to go from one curve point to the next.
If you press [Shift] and use the arrow keys, the current selection will be kept, allowing 
you to select several points.

Editing tempo curve points

Curve points can be edited in the following ways:

• By clicking and dragging horizontally and/or vertically.
If several points are selected, all of them are moved. If Snap is activated on the toolbar, 
this determines to which time positions you can move curve points, see page 481.

• By adjusting the tempo value in the tempo display on the toolbar.
For this to work, a single tempo curve point must be selected.

Dragging tempo curve points with a time based display format (any other 
format than “Bars+Beats”) may give confusing results. This is because 
moving a point will change the relationship between tempo and time. 
Specifically, let’s say you move a tempo point to the right and drop it on a 
certain time position. When you release the mouse button, the mapping 
between tempo and time will be adjusted (since you have changed the 
tempo curve). As a result, the moved point will appear at another position. 
For this reason, we recommend that you use the Bars+Beats display for-
mat when editing tempo curves.

From Start to Cursor Selects all points to the left of the project cursor.

From Cursor to End Selects all points to the right of the project cursor.

Option Description



CUBASE SE
Working with the Tempo track 22 – 479

Adjusting the curve type

You can change the curve type of a tempo curve segment at any time, 
using the following method:

1. Select all curve points within the segment you want to edit.

2. Pull down the Curve pop-up menu on the toolbar and select “Jump” or 
“Ramp”.
The curve sections between the selected points are adjusted.

Removing tempo curve points

To remove a curve point, either click on it with the Eraser tool or select 
it and press [Backspace]. The first tempo curve point cannot be re-
moved.

Setting the Fixed tempo

When the Tempo track button is deactivated, the Tempo track curve is 
greyed out (but still visible). Since the Fixed tempo is constant through-
out the whole project, there are no tempo curve points. Instead, the 
Fixed tempo is displayed as a horizontal black line in the tempo curve 
display.
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There are two ways to set the tempo in Fixed mode:

• Drag the tempo line up or down with the Arrow tool.

• Adjust the value numerically in the tempo display on the toolbar.

Adding and editing time signature events

• To add a time signature event, click in the time signature area with the 
Pencil tool. 
This adds a default 4/4 time signature event at the closest bar position. You can also 
do this by pressing [Alt]/[Option] and clicking with the Arrow tool.

• To edit the value of a time signature event, select it and adjust the 
value in the signature display on the toolbar.
Note that there are two thumbwheel controls for the signature display; the left adjusts 
the numerator and the right adjusts the denominator.

• You can move a time signature event by clicking and dragging it with 
the Arrow tool.
Again, note that time signature events can only be positioned at the start of bars.

• To remove a time signature, either click on it with the Eraser tool or 
select it and press [Backspace].
The first time signature event cannot be removed.
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Options and settings

Snap

You activate or deactivate Snap by clicking the Snap icon on the tool-
bar. The behavior of the function depends on the display format se-
lected for the ruler:

• If “Bars+Beats” is selected, tempo curve points will snap to the set 
resolution on the Snap pop-up.
If this is set to 1/1 curve points will snap to the start of bars.

• If any other display format is selected, tempo curve points will snap to 
the vertical grid lines in the tempo curve display.
The spacing of the grid lines depends on the horizontal magnification.

• Time signature events can only be positioned at the start of bars, re-
gardless of whether Snap is activated or not.

Autoscroll

When this option is activated, the tempo curve display will scroll dur-
ing playback, keeping the project cursor visible.
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The Beat Calculator

The Beat Calculator is a tool for calculating the tempo of freely re-
corded audio or MIDI material. It also allows you to set the tempo by 
tapping.

Calculating the tempo of a recording

1. In the Project window, make a selection that covers an exact number 
of beats of the recording.

2. Select “Beat Calculator…” from the Project menu.
The Beat Calculator window appears.

3. Enter the number of beats that the selection encompasses in the 
Beats field.
The corresponding tempo is calculated and displayed in the BPM field.

• If you need to adjust the selection, you can just go back to the Project 
window, leaving the Beat Calculator open.
To re-calculate the tempo after adjusting the selection, click Refresh.

4. If you like, you can insert the calculated tempo into the Tempo track, 
by clicking one of the buttons in the lower left corner of the Beat Cal-
culator window.
Clicking “At Tempo Track Start” will adjust the first tempo curve point, while “At Selec-
tion Start” will add a new tempo curve point at the selection’s start position, using the 
“Jump” curve type (see page 476).

If Fixed tempo mode is selected when you insert the calculated tempo, 
the Fixed tempo will be adjusted, regardless of which button you click.
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Using Tap Tempo

The Tap Tempo function allows you to specify a tempo by tapping:

1. Open the Beat Calculator.

2. If you want to tap the tempo to some recorded material, activate play-
back.

3. Click the Tap Tempo button.
The Tap Tempo window appears.

4. Tap the tempo on the computer keyboard’s space bar or with the 
mouse button.
The tempo display will update the calculated tempo between each tap.

5. When you stop tapping, the program calculates the average timing of 
the taps and displays it.

6. Click OK to close the Tap Tempo window.
The tapped tempo is now shown in the Beat Calculator’s BPM display. If you like, you 
can insert it into the Tempo track as described on the previous page.
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Merge Tempo From Tapping

This function allows you to create a complete tempo track based on 
your tapping. Typically, you would use this if you have an audio file 
with no tempo mapping, and want to be able to add sequenced mate-
rial afterwards, etc.

1. Create an empty time-based MIDI track and, while playing back your 
audio material, tap the new tempo on your MIDI keyboard and record 
the created notes onto the new MIDI track.
Note that you must create note events – pedal events cannot be used for this function.

2. Play back the audio and check that the timing of the MIDI notes corre-
sponds to that of the audio. 
If necessary edit the MIDI notes in an editor.

3. Select the part (or the individual notes, in an editor) that you want to 
use for the calculation.

4. Select “Merge Tempo From Tapping” from the Functions submenu on 
the MIDI menu.
A dialog opens.

5. In the dialog, specify what type of note (1/2, 1/4 etc.) you tapped dur-
ing the recording.
If you activate the “Begin at Bar Start” option, the first note will automatically start at 
the beginning of a bar when calculating the new tempo curve.

6. Click OK.
The project’s tempo is adjusted to the tapped notes.

7. Open the Project menu and select “Tempo Track” to check that the 
new tempo information is reflected in the tempo curve.
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Introduction

The Export Audio Mixdown function in Cubase SE allows you to mix 
down audio from the program to a file on your hard disk, in a number 
of formats. The following rules apply:

• When you mix down, you get what you hear – mutes, mixer settings 
and insert effects are taken into account.
Note though that you will only include the sound of the bus or channel you select for 
mixdown.

• MIDI tracks are not included in the mixdown!
To make a complete mixdown containing both MIDI and audio, you first need to record 
all your MIDI music to audio tracks (by connecting the outputs of your MIDI instruments 
to your audio inputs and recording, as with any other sound source).
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Mixing down to an audio file

1. Set up the left and right locator to encompass the area that you want 
to mix down.

2. Set up your tracks, so that they play back the way you want.
This includes muting unwanted tracks or parts, making manual mixer settings and/or 
activating the R (Read) automation buttons for some or all mixer channels.

3. Pull down the File menu and select “Audio Mixdown…” from the 
Export submenu.
The Export Audio Mixdown dialog appears.

The upper half of this dialog is a standard file dialog, while the lower 
half contains file format options and settings for the mixdown function. 
Note that the available settings and options differ depending on the 
selected file format (see page 489).

4. Select the bus you want to mix down with the Outputs pop-up menu.
This lists all output busses in the active project.
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5. Select the channel configuration for the mixdown file with the 
Channels pop-up menu.
Typically you would select the same channel configuration as the bus or channel you’re 
mixing down, but it’s also possible to e.g. mix down a stereo bus to a mono file. In this 
case a warning will appear, asking if that’s what you want to do.

6. Select a file format with the File type pop-up menu.

7. Make additional settings for the file to be created.
This includes selecting sample rate, resolution, quality, etc. The available options de-
pend on the selected file format – see page 489.

8. If you want to automatically import the resulting audio file back into 
Cubase SE, activate the “Import to” checkboxes.
If you activate the “Pool” checkbox, a clip referring to the file will appear in the Pool. 
Activating the “Audio Track” checkbox as well will create an audio event that plays the 
clip, and place it on a new audio track, starting at the left locator.

• The Import options are only available if you have selected an uncom-
pressed file format.

9. If you activate Update Display, the meters will be updated during the 
export process.
This allows you to check for clipping, for example.

10.Select a folder and a name for the audio file to be created.

• With some file formats you can create split stereo files (see page 489). 
This will create two files (one for each side) with the same name, but 
with the letter “L” appended for the left channel file and “R” for the right 
channel file.

11.Click Save.

• Depending on the file format, an additional dialog may appear.
For example, when exporting to MP3 format a dialog appears where you can add info 
about the song title, artist, etc. Make the desired settings and click OK to proceed.

A dialog with a progress bar is displayed while the audio file is created. 
If you change your mind during the file creation, you can click the Abort 
button to abort the operation.

• If you have activated any of the “Import to” options, the file will be im-
ported back into the project.
When playing back the re-imported file in Cubase SE, remember to mute the original 
tracks so that you really hear the true result.
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File format specifics

The following pages describe the different export file formats, and 
their options and settings.

• AIFF files (see page 489).
• Sound Designer II files (Mac OS X only, see page 491).
• Wave files (see page 491).
• MP3 files (upgrade needed, see page 492).
• Ogg Vorbis files (see page 494).
• Real Audio G2 files (Windows only, see page 495).
• Windows Media Audio files (Windows only, see page 496).

AIFF files

AIFF stands for Audio Interchange File Format, a standard defined by 
Apple Computer Inc. AIFF files have the extension “.aif” and are used 
on most computer platforms. The following settings are available for 
the AIFF export file format:

Channels

Option Description

Mono The audio is mixed down to mono.

Stereo Split Two mono files are created, one for each side of the stereo mix. 
The files will have the name you specify in the dialog, but with “L” 
and “R” added, respectively. Select this format if you plan to use 
the resulting file in another application that doesn’t support stereo 
interleaved files.
If you plan to re-import the file into Cubase SE, we recommend 
that you use the Stereo Interleaved option instead, since Cubase 
SE doesn’t automatically handle stereo split files as one entity.

Stereo Interleaved A stereo audio file is created. This is the recommended stereo 
option if you want to re-import the file into Cubase SE.
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Resolution

Allows you to select 8, 16 or 24 bit files.

• If you are making a mixdown for CD burning, you should use the 16 bit option, 
as CD audio is always 16 bit.

• 8 bit resolution should only be used if required, since it will result in limited au-
dio quality.
8 bit audio may be suitable in some multimedia applications, etc.

Sample Rate

This is the sample rate of the exported file. In most cases, you should 
select the sample rate set for the project, since a lower sample rate 
will degrade the audio quality (mainly reducing the high frequency 
content) and a higher sample rate will only increase the file size, with-
out adding to audio quality. Also consider the future usage of the file – 
if you e.g. plan to import the file into another application, you should 
select a sample rate supported by that application.

• If you are making a mixdown for CD burning, you should select 
44.100kHz, since this is the sample rate used on audio CDs.
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Sound Designer II files (Mac OS X only)

The SD II format was developed by Digidesign. It is one of the most 
popular audio file formats on the Macintosh, especially for professional 
audio work. The following export settings are available:

Channels

Allows you to select mono or stereo files, with the same options as for 
AIFF files (see page 489).

Resolution

The bit resolution of the file, with the same options as for AIFF files 
(see page 490).

Sample Rate

The options are the same as for AIFF files (see page 490).

Wave files

Wave files have the extension “.wav” and are the most common file 
format on the PC platform. Wave files can be uncompressed or com-
pressed, as described below. For uncompressed Wave files (the 
most common choice), the following settings are available:

Channels

Allows you to select mono, stereo or multi-channel files with the same 
options as for AIFF files (see page 489).

Resolution

The bit resolution of the file, with the same options as for AIFF files 
(see page 490).

Sample Rate

The options are the same as for AIFF files (see page 490).
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Coding (Windows only)

The Coding pop-up menu allows you to select a compression scheme 
for the Wave file, creating smaller files (with a loss of audio quality).

• Which options are available depends on the installed and activated codecs in 
the ACM (Audio Compression Manager) under Windows.
See the operating system documentation for details.

• When a compression option is selected, not all Channels, Resolution and 
Sample Rate options may be available (depending on the selected compres-
sion scheme).
The Attributes pop-up menu displays the currently selected properties for the file.

• For regular, uncompressed Wave files, select “PCM / uncompressed Waves”.

Wave files exported by Cubase SE for Mac OS X are always uncom-
pressed.

MPEG Layer 3 file

• You can export to MP3 20 times as a “trial” feature (fully functional), af-
ter which the function is disabled. 
When the MP3 format is selected, a text at the bottom of the Export Audio Mixdown di-
alog shows you how many remaining encodings you have left. 
You can upgrade your Cubase SE copy to include unlimited MP3 encoding by clicking 
the “Order now” link in the lower right corner of the dialog (this takes you to Steinberg’s 
online store on the web – a working internet connection is required).

MPEG Layer 3 files have the extension “.mp3”. By use of advanced 
audio compression algorithms, mp3 files can be made very small, 
maintaining good audio quality.

The following options are available for MPEG Layer 3 files:

Channels

Use the radio buttons to select mono or stereo files. This setting affects 
which options are available on the Attributes pop-up menu (see below).
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Sample Rate

Determines the frequency range of the audio – the lower the sample 
rate, the lower the highest audible frequency in the audio. This setting 
will also affect which options are available on the Attributes pop-up 
menu, as described below.

Attributes

This pop-up menu allows you to select a bit rate for the mp3 file. As a 
rule, the higher the bit rate, the better the audio quality and the larger 
the file. For stereo audio, 128 kBit/s is often considered to result in 
“good” audio quality.

• Note that the available options on this pop-up menu depend on the 
Channels and Sample Rate settings.
This is because for mono audio and/or low sample rates, there is no point in using the 
highest bit rates – they would simply create larger files without adding to audio quality.

Quality

These options determine the “depth” of the encoding algorithm and 
thus the quality of the resulting file. In the “Highest” mode, the encod-
ing will take the longest time, while in the “Fast” mode, the audio qual-
ity may be lower. The file size is not affected by these options.

Options

When you click the Save button, an Options dialog opens in which 
you can enter information about the file. This additional information 
(called the ID3 tag) will be embedded as text strings in the file, and 
can be displayed by some mp3 playback applications.

• For the information to be included in the file, you need to activate the 
“Insert Options” checkbox in the dialog.
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Ogg Vorbis files

Ogg Vorbis is an open, patent-free audio encoding and streaming 
technology, offering compressed audio files (extension “.ogg”) of 
small size but with comparatively high audio quality.

The following options are available for Ogg Vorbis files:

Channels

Use the radio buttons to select mono or stereo files.

Sample Rate

Determines the frequency range of the audio – the lower the sample 
rate, the lower the highest audible frequency in the audio.

Quality

The Ogg Vorbis encoder uses variable bit rate encoding, and the 
Quality setting determines between which limits the bit rate will vary. 
Generally speaking the higher the Quality setting, the higher the 
sound quality but also the larger the files.

Options

When you click the Save button, an Options dialog opens in which you 
can enter information about the file, as when creating mp3 files.

• For the information to be included in the file, you need to activate the 
“Insert Options” checkbox in the dialog.
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Real Audio G2 files

Real Audio files (extension “.rm”) allow very high compression rates and 
can therefore be made very small. This makes the format especially use-
ful for downloading and streaming multimedia from the internet.

The following options are available for Real Audio files:

Coding and Content

This is where you specify the desired audio quality for the file. In the 
Real Audio G2 format, this information is divided in two pop-up menus: 
Coding (determining the bit rate) and Content (specifying the typical 
audio content – voice, music, etc.).

When you select a Coding/Content, a descriptive text appears in the 
field below the pop-up menu, describing the suitable use of the se-
lected format.

• Note that the choice of mono or stereo is included in the Coding/Content 
options.

Options

When you click the Save button, an Options dialog opens in which you 
can select one or more modes (each explained in the dialog) for the 
file. You can also enter information about the file. These text strings 
will be embedded in the file and can be displayed by some Real Audio 
playback applications.
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Windows Media Audio files (Windows only)

Windows Media Audio is an audio format developed by Microsoft Inc. 
Due to advanced audio compression algorithms, Windows Media Au-
dio files can be made very small, maintaining good audio quality. The 
files have the extension “.wma”.

The following options are available for Windows Media Audio files:

Attributes

This pop-up menu allows you to select a bit rate for the WMA file. As 
a rule, the higher the bit rate, the better the audio quality and the larger 
the file. For stereo audio, 96 kBit/s is often considered to give “good” 
audio quality.

Options

When you click the Save button, an Options dialog opens in which 
you can enter information about the title and author of the file, as well 
as copyright information and a description. These text strings will be 
embedded in the file and can be displayed by some Windows Media 
Audio playback applications.



24
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Background

What is synchronization?

Synchronization is said to exist when you make two pieces of equipment 
agree on time or tempo. You can establish synchronization between 
Cubase SE and a number of other types of devices, including tape re-
corders and video decks, but also MIDI devices that “play back”, such 
as other sequencers, drum machines, “workstation sequencers” etc.

When you set up a synchronization system, Cubase SE is always the 
master. All other devices are then slaved to this unit, which means 
they will adjust their playback speed to Cubase SE.

The VST System Link feature (with which you can synchronize separate 
computers running Cubase SE or Nuendo for example) is described in a 
separate chapter. See page 504.

MIDI Clock

MIDI Clock is a tempo based type of synchronization signal, that is it is 
related to the number of “beats per minute”. MIDI Clock signals are 
suitable for synchronizing two devices that agree on tempo, such as 
for example Cubase SE and a drum machine.

MIDI Clock is not suitable as a master sync source for an application 
like Cubase SE. Therefore Cubase SE will transmit MIDI Clock signals to 
other devices, but it will not receive MIDI Clock.

Any digital playback system has an internal clock that ultimately affects 
the playback speed and stability, and PC audio hardware is no excep-
tion. This clock is extremely stable.

Since Cubase SE is playing back with no external synchronization, all 
playback is internally synchronized to the internal digital audio clock, 
to ensure synchronization between digital audio and MIDI.
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About the ASIO Positioning Protocol (APP)

ASIO Positioning Protocol requires audio hardware with specific ASIO 
drivers. As of this writing, APP is not available for audio hardware with 
non-ASIO drivers under Mac OS X.

The ASIO Positioning Protocol is a technology that expands on the 
type of sync described above and makes sample accurate positioning 
possible.

When transferring audio digitally between devices, it is important that 
synchronization using word clock and timecode is completely corre-
lated. If not, the audio will not be recorded at the exact intended (sam-
ple accurate) position, which can cause various types of problems, 
such as inaccurately positioned audio material, clicks and pops etc.

A typical situation is when transferring material from a digital multi-
track tape recorder to Cubase SE (for editing) and then back again. If 
you do not have sample accurate synchronization set up, you cannot 
be sure that the material will appear in its exact original position, when 
transferred back to the tape recorder.

In order to take advantage of the ASIO Positioning Protocol, your au-
dio hardware must be suitably equipped and the functionality must be 
included in the ASIO driver for the hardware.

Hardware and software requirements for APP

• Your computer audio hardware must support all the functionality required for 
the ASIO Positioning Protocol. That is, it must be able to read the digital audio 
and the corresponding positional information from the external device.

• There must be an ASIO 2.0 driver for the audio hardware.
• For resolving to external timecode, the audio hardware must have a timecode 

reader/writer on-board.
• For information about which audio hardware models currently support APP, 

see the Steinberg web site (www.steinberg.net).

The ASIO Positioning Protocol exploits the specific advantage of having 
an audio card that has a built-in timecode reader. With such a card and 
the ASIO Positioning Protocol, you can achieve constant sample accu-
rate synchronization between the audio source and Cubase SE.
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Window Overview

The Synchronization Setup dialog

This dialog is used for setting up everything that has to do with the 
synchronization of Cubase SE to other units. You reach it from the 
Transport menu.

Synchronizing other Equipment to Cubase SE

You may have other MIDI devices that you want to synchronize to 
Cubase SE. This can be done by transmitting MIDI Clock.

Transmitting MIDI Clock

If you transmit MIDI Clock to a device supporting this type of synchro-
nization signal, the other device will follow Cubase SE’s tempo. The 
tempo setting in the other device is of no relevance. Instead it plays at 
the same tempo as Cubase SE. If the device also reacts to Song Po-
sition Pointers (which Cubase SE transmits) it will follow when you 
wind, rewind and locate using the Cubase SE Transport panel.

• MIDI Clock transport commands include “Start”, “Stop” and “Continue”. 
However, some MIDI equipment (e.g. some drum machines) do not 
recognize the “Continue” command. If this is the case with your equip-
ment, activate the option “Always Send Start Message” in the Synchroni-
zation Setup dialog (MIDI Clock Destinations section).
When this is activated, only the Start command is used.

Timecode 
Source 
settings. 
The default 
setting is 
“Internal 
Timecode”.

Outputs for 
MIDI Clock.
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Setting Up

1. Connect the desired MIDI Outputs from Cubase SE to the device(s) 
that you plan to synchronize.

2. Open the Synchronization Setup dialog from the Transport menu.

3. Activate the sync outputs by using the corresponding checkboxes.

Some MIDI Interfaces will automatically send MIDI Clock to all MIDI out-
puts, regardless of the MIDI Clock Port selection you make in Cubase 
SE. If this is the case, you should only select one MIDI Clock Port (con-
sult the documentation of the MIDI Interface if in doubt).

4. Set the other device(s) to their “external synchronization” mode (or 
some other mode with a similar name) and activate playback on them 
if necessary.

5. Activate playback in Cubase SE, and the other device(s) will follow.

MIDI Clock transmitted 
to Output 3.
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Options

Making Project Settings

About Frame Rates

The frame rate is the number of frames per second in a film or on a 
video tape. Just as there is always sixty seconds to a minute, there is 
always a certain number of frames to each second. However, the frame 
rate used varies with the type of media (film or video), which country 
the video tape has been produced in, and other circumstances.

In the Project Setup dialog are two settings for frame rates:

• The Frame Rate pop-up determines the frame rate of the sent sync 
signal.

The Project Setup dialog contains six frame rates to choose from:

• The Display Format pop-up contains a number of formats that when 
selected work as the “master” setting for the display format used in 
the various windows’ rulers and position displays.
To make editing with frame accuracy correspond to the actual frame rate in an external 
sync source, you need to set this frame rate to the same value as the Frame Rate pop-up.

Frame Rate Description

24 fps The traditional frame rate of 35mm film.

25 fps The frame rate used for all video and audio in Europe (EBU).

29.97 fps Straight 29.97 frames per second.

30 fps Straight 30 frames per second. This is often used in the United States 
for audio only work.

29.97 dfps “Drop frame” code running at 29.97 frames per second, most often 
used in the United States of America for work with color video.

30 dfps Very rarely used.
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Introduction

VST System Link is a network system for digital audio that allows you 
to have several computers working together in one large system. Un-
like conventional networks it does not require Ethernet cards, hubs, or 
CAT-5 cables; instead it uses the kind of digital audio hardware and 
cables you probably already possess in your studio.

VST System Link has been designed to be simple to set up and oper-
ate, yet give enormous flexibility and performance gains in use. It is ca-
pable of linking computers in a “ring” network (the System Link signal 
is passed from one machine to the next, and eventually returns to the 
first machine). VST System Link can send its networking signal over 
any type of digital audio cable, including S/PDIF, ADAT, TDIF, or AES, 
as long as each computer in the system is equipped with a suitable 
ASIO compatible audio interface.

So, why would you want to link up two or more computers? Well, the 
added computer power gives you vast possibilities:

• Dedicate one computer to running VST instruments while recording audio 
tracks on another.

• If you need lots of audio tracks, you may simply add tracks on another com-
puter.

• You could have one computer serve as a “virtual effect rack”, running CPU-
intensive send effect plug-ins only.

• Since you can use VST System Link to connect different VST System Link ap-
plications on different platforms, you can take advantage of effect plug-ins 
and VST instruments that are specific to certain programs or platforms.

This chapter describes how to set up and use VST System Link in 
Cubase SE.
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Preparations

Requirements

The following equipment is required for VST System Link operation:

• Two or more computers.
These can be of the same type or use different operating systems – it doesn’t matter. 
For example, you can link an Intel-based PC to an Apple Macintosh without problems.

• Each computer must have audio hardware with specific ASIO drivers, 
installed and working.

• The audio hardware must have digital inputs and outputs.
Of course, to be able to connect the computers the digital connections must be com-
patible (i.e. the same digital formats and connection types must be available).

• At least one digital audio cable for each computer in the network.

• A VST System Link host application installed on each computer.
As of this writing, VST System Link is implemented for Cubase SX/SL, Cubase SE, 
Nuendo and Cubase 5.2s (System Link version). Any VST System Link applications 
can connect to each other.

Additionally, we recommend that you use a KVM switchbox:

Using a KVM switchbox

If you want to set up a multi-computer network, or even a small net-
work in a limited space, it's a good idea to invest in a KVM (Keyboard, 
Video, Mouse) switchbox. With one of these switchers you can use 
the same keyboard, monitor, and mouse to control each computer in 
the system, and switch between computers very rapidly. KVM switch-
ers are not too expensive, and very easy to setup and operate. It you 
decide not to go this route, the network will function just the same, but 
you may end up doing a lot of jumping from one machine to the other 
while setting up!
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Making connections

Below, we will assume that you are connecting two computers. 
Should you have more than two computers, it’s still best to start with 
two and add the others one by one once the system is working – this 
makes troubleshooting easier if you run into problems. For two com-
puters, you will need two digital audio cables, one in each direction:

1. Connect a digital audio cable from the digital output of Computer 1 to 
the digital input of Computer 2.

2. Connect the other cable from the digital output of Computer 2 into 
the digital input of Computer 1.

• If a card has more than one set of inputs and outputs, choose which-
ever one that suits you – for simplicity usually the first set is best.

Setting up clock sync

Before you proceed you need to make sure that the clock signals on 
your ASIO cards are synchronized correctly. This is essential when 
cabling any kind of digital audio system, not just VST System Link.

All digital audio cables by definition always carry a clock signal as well as 
audio signals, so you don't need to use a special Word Clock input and 
output for this (although you may find that you get a slightly more stable 
audio system if you do, especially when using multiple computers).

The Clock Mode or Sync Mode is set up in the audio hardware’s 
ASIO control panel. In Cubase SE, you proceed as follows:

1. Pull down the Devices menu and open the Device Setup dialog.

2. Select your audio interface from the VST Audiobay subpage.

3. Click the Control Panel button.
The ASIO control panel appears.

4. Open the ASIO control panel on the other computer as well.
If you are using another VST System Link host application on that computer, check its 
documentation for details on how to open the ASIO control panel.
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5. Now, you need to make sure that one audio card (and only one!) is set 
to be the Clock Master, and all the other cards must be set to listen 
for the clock signal coming from the Clock Master i.e. they must be 
Clock Slaves.
The naming and procedure for this differs depending on the audio hardware – consult 
its documentation if required. If you are using Steinberg Nuendo ASIO hardware, all 
cards default to the “AutoSync” setting – in this case you must set one of the cards 
(and only one) to “Master” in the Clock Mode section of the control panel.

• Typically, the ASIO control panel for an audio card contains some in-
dication of whether the card receives a proper sync signal or not, and 
the sample rate of that signal.
This is a good indication that you have connected the cards and set up clock sync 
properly. Check your audio hardware’s documentation for details.

It’s very important that one and only one card is the clock master, other-
wise the network cannot function correctly. Once you have set this up, 
all the other cards in the network will take their clock signal from this 
card automatically.

The only exception to this procedure is if you are using an external 
clock – which could be from a digital mixing desk or special Word 
Clock synchronizer for example. If so, you must then leave all your 
ASIO cards in Clock Slave or AutoSync mode, and make sure that 
each of them is listening for the signal coming from the synchronizer, 
usually passed through your ADAT cables or Word Clock connectors 
in a daisy chain fashion.



CUBASE SE
25 – 508 VST System Link

Minimizing the latency

The general definition of latency is the amount of time it takes any sys-
tem to respond to whatever messages are sent to it. For example, if 
your system’s latency is high and you play VST instruments in real 
time, you will get a noticeable delay between when you press a key 
and when you hear the sound of the VST instrument. Nowadays, most 
ASIO-compatible audio cards are capable of operating with very low 
latencies. Also, all VST applications are designed to compensate for 
latency during playback, making the playback timing tight.

However, the latency time of a VST System Link network is the total 
latency of all the ASIO cards in the system added together. Therefore 
it’s extra important to minimize the latency times for each computer in 
the network.

• The latency does not affect the synchronization – it's always perfectly in 
time. But, it can affect the time it takes to send and receive MIDI and au-
dio signals, or make the system seem sluggish.

To adjust the latency of a system, you typically adjust the size of the 
buffers in the ASIO control panel – the lower the buffer size, the lower 
the latency. Generally speaking it's best to keep to fairly low latencies 
(buffer sizes) if your system can handle it – about 12 ms or less is 
usually a good idea.
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Setting up your software

Now it’s time to set up your programs. The procedures below de-
scribe how to set things up in Cubase SE; if you are using another 
program on the other computer, please refer to its documentation.

Setting the sample rate

The projects in both programs must be set to use the same sample 
rate. Select “Project Setup…” from the Project menu and make sure 
the sample rate is the same in both systems.

Streaming digital audio between applications

1. Create input and output busses in both applications and route these 
to the digital inputs and outputs.
The number and configuration of the busses depends on your audio hardware and on 
your needs. The important thing is that you should have the same configuration in both 
applications – if you have four stereo output busses on Computer 1, you want four ste-
reo input busses on Computer 2, etc.

2. Set things up so that Computer 1 plays back some audio.
You could for example import an audio file and play this back in Cycle mode.

3. In the Inspector, make sure the playing audio channel is routed to one 
of the digital output busses you set up.

4. In Computer 2, select the corresponding digital input bus for an audio 
channel and activate monitoring for the channel.
The audio being played back should now “appear” in the program running on Computer 
2. You should see the input level meters moving.

5. Reverse this procedure so that Computer 2 plays back and Computer 1 
“listens”.

Now you have verified that the digital connection works as it should.

• From this point on in this chapter, we refer to the busses connected to 
the digital inputs and outputs as “VST System Link busses”.
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Settings for the audio hardware

When you send VST System Link data between computers, it is im-
portant that the digital information isn’t changed in any way between 
the programs. Therefore, you should open the control panel (or addi-
tional application) for your audio hardware and make sure that the fol-
lowing conditions are met:

• If there are additional “format settings” for the digital ports that you 
use for VST System Link data, make sure these are turned off.
For example, if you are using an S/P DIF connection for VST System Link, make sure 
that “Professional format”, Emphasis and Dithering are turned off.

• If your audio hardware has a mixer application allowing you to adjust 
the levels of digital inputs and outputs, make sure that this mixer is 
disabled or that the levels for the VST System Link channels are set to 
(± 0dB).

• Similarly, make sure no other forms of DSP (pan, effects, etc.) are ap-
plied to the VST System Link signal.

Notes for Hammerfall DSP users

If you are using RME Audio Hammerfall DSP audio hardware, the 
Totalmix function allows for extremely complex signal routing and mix-
ing in the audio hardware. This can in some situations lead to “signal 
loops” in which case the VST System Link won’t work. If you want to 
make absolutely sure this won’t cause any problems, make sure the 
default or “plain” preset is selected for the Totalmix function.



CUBASE SE
VST System Link 25 – 511

Activating VST System Link

After setting up the inputs and outputs, you now need to define which 
input/output should carry the actual VST System Link information.

The System Link networking signal is carried on only one bit of one 
channel. This means that if you have an ADAT based system which 
normally carries eight channels of 24-bit audio, once you activate VST 
System Link you will have seven channels of 24-bit audio and one 
channel of 23-bit audio (the least significant bit of this last channel is 
what we will use for networking). In practice this makes no discernible 
difference to the audio quality, since you will still have around 138dB 
headroom on this channel.

To set things up we need to open the VST System Link panel:

1. Open the Device Setup dialog on the Devices menu.

2. Select the VST System Link device from the VST Audiobay subpage.

3. Use the ASIO Input and ASIO Output pop-up menus to define which 
channel should be the networking channel (and thus become a 23-bit 
audio channel, in our example).
Quite often you will be able to just leave these pop-ups the way they are. 
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4. Click the Active checkbox at the top of the panel.

5. Repeat the steps above for every computer on the network. 

As the computers are made active, you should see the small T (Trans-
mit) and R (Receive) lights flashing on each active computer, and the 
name of each computer should appear in the list at the bottom of the 
pane. Each computer is assigned a random number – don't worry 
about this, it's just so the network knows internally which one is which.

• You can double click on the name in bold (which is the name of the 
computer you’re currently working on) and set it to whatever other 
name you wish.
This name will appear in the System Link window of every computer on the network.

• If you don't see the name of each computer appearing once you have 
made it active, you may have to check your settings. 
Go through the procedure above again and make sure that all ASIO cards are listening 
to the digital clock signals correctly, and that each computer has the correct inputs 
and outputs assigned to the System Link network.

Putting the network online

After each computer's name you will see whether it is online or not. 
When a computer is online, it will receive transport and timecode 
signals, and its sequencer application can be started and stopped by 
remote control. If it is off-line it can only be started from its own key-
board – it is effectively an independent machine, although it is still on 
the network.

• Note that any computer can control any and all of the others – VST Sys-
tem Link is a peer to peer network and there is no absolute “master” 
computer.
However, most users do like to think of one machine as the master (in a one person/
two computer network, this would be the machine you actually sit behind most of the 
time). 
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For now, let's put all computers online:

1. Activate the Online checkbox in the VST System Link panel for all 
computers. 

2. Check that the system is working by pressing Play on one computer – 
all computers should start almost instantly and play perfectly in time, 
with sample accurate precision.

• The Offset setting to the right allows you to adjust whether one ma-
chine will play back slightly ahead or behind the rest.
This is normally not needed, but occasionally with some hardware you may find that the 
lock is a few samples out. In that case you can adjust the lock with the Offset value. For 
now, leave it set to 0 – it will most likely be what you want.

VST System Link sends and understands all transport commands, so 
you can play, stop, fast forward, rewind etc. the entire network from 
one computer without a problem – try it! If you jump to a locator point 
on one machine, all other machines will also instantly jump to that lo-
cator point.

Don't forget to make sure that all computers have their tempos set to the 
same value, otherwise your synchronization will be seriously skewed.
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Using MIDI

As well as supplying transport and sync control, VST System Link also 
supplies up to 16 MIDI ports, each with 16 channels. You set this up 
as follows:

1. Use the MIDI Ins and Outs value boxes to specify the number of MIDI 
ports you need.
The default value is 0 MIDI In and 0 MIDI Out ports.

2. Create a MIDI track in the Project window and open the Inspector 
(top section).

3. If you now pull down the “in” or “out” pop-ups, you will find the spec-
ified System Link ports added to the list of MIDI Inputs and Outputs.

This allows you to route MIDI tracks to VST instruments running on 
another computer, as described in the application examples (see 
page 518).
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The “Active ASIO Ports for Data only” setting

If you are sending huge amounts of MIDI data at once, there is a small 
possibility that you might run out of bandwidth on your VST System 
Link network. This will manifest itself by notes “choking” or timing be-
coming erratic.

If this happens, you can devote more bandwidth to MIDI by selecting 
Active ASIO Ports for Data only in the VST System Link Setup panel. 
When this is active, the VST System Link information will be sent on 
the entire channel instead of just one bit, more than enough for all the 
MIDI you could ever hope to use. The downside is that you can no 
longer use this ASIO channel for audio transfer (do not connect it to a 
speaker!), thus leaving you only 7 channels of audio in our ADAT ca-
ble example. Depending on how you work this might be a reasonable 
compromise.

Hearing the network audio

If you are using an external mixing desk, hearing your audio really isn't 
an issue – just plug the outputs of each computer into the desired 
channels on the external mixing desk, press Play on one of the com-
puters, and you're good to go.

However, many people prefer to mix internally inside the computer and 
just use a desk for monitoring (or maybe not use any external mixer at 
all). In this case you'll need to select one computer to be your “main mix 
computer” and send the audio from your other computers into this.

In the following example, we assume you are using two computers, 
with Computer 1 as your main mix computer and Computer 2 running 
two additional stereo audio tracks, an FX channel track with a reverb 
plug-in and a VST instrument plug-in with stereo outputs.

1. First you want to set things up so that you can listen to the audio play-
back from Computer 1.
In other words, you need an unused set of outputs, e.g. an analog stereo output, con-
nected to your monitoring equipment.

2. Go to Computer 2 and route each of the two audio tracks to a sepa-
rate output bus.
These should be busses connected to the digital outputs – let’s call them Bus 1 and 2.

3. Route the FX channel track to another VST System Link bus (Bus 3).
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4. Route the VST instrument channel to yet another bus (Bus 4).

5. Go back to Computer 1 and add four new stereo audio tracks and 
route these to the output bus you use for listening, e.g. to the analog 
stereo outputs.

6. For each of the audio tracks, select one of the four input busses.
Now, each Computer 2 bus is routed to a separate audio channel on Computer 1.

7. Activate monitoring for the four tracks.

If you now start playback, the audio from Computer 2 will be sent 
“live” to the new tracks on Computer 1, allowing you to hear them to-
gether with any tracks you play back on Computer 1.

Adding more tracks

OK, but if you have more audio tracks than you have VST System Link 
busses (physical outputs)? Then you just use the Computer 2 mixer 
as a submixer: Route several audio channels to the same output bus 
and adjust the output bus level if needed.

Note also that if your audio cards have multiple sets of input and out-
put connections you can link up e.g. multiple ADAT cables and send 
audio via any of the busses on any of the cables.

Internal mixing and latency

One problem with mixing inside the computer is the latency issue we 
mentioned earlier. The VST engine always compensates for record la-
tencies, but if you are monitoring through Computer 1 you will hear a 
processing delay while you listen to signals coming from your other 
computers (not on your recording!). If your audio card in Computer 1 
supports ASIO Direct Monitoring you should definitely turn this on – 
you'll find the setting in the VST Audiobay Device Setup panel (see 
page 45). Most modern ASIO cards support this function. If yours 
doesn't you may want to change the Offset value in the VST System 
Link Setup panel to compensate for any latency issues.
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Setting up a larger network

This is not much more difficult than a two computer network. The main 
thing to remember is that VST System Link is a daisy chain system. In 
other words, the output of Computer 1 goes to the input of Computer 
2, the output of Computer 2 goes to the input of Computer 3, and so 
on around the chain. The output of the last computer in the chain must 
always go back into the input of Computer 1, to complete the ring.

Once you've done this, the transmission of all the transport, sync, and 
MIDI information to the whole network is handled pretty much automat-
ically. However, where you may run into confusion in a large network is 
in the transmission of audio signals back to a central mix computer.

If you have lots of hardware inputs and outputs on your ASIO cards you 
don't need to send audio via the chain at all, but can transmit it directly 
to the master mix computer via one or more of its other hardware Inputs. 
For example, if you have a Nuendo Digiset interface or 9652 card on 
Computer 1 you could use ADAT cable 1 for networking, ADAT cable 2 
as a direct audio input from Computer 2, and ADAT cable 3 as a direct 
audio input from Computer 3.

You can also transmit audio via the ring system if you don't have enough 
hardware I/Os for direct audio transmission. For example, in a four com-
puter scenario you could send audio from Computer 2 into a channel in 
the mixer in Computer 3, and from there to a channel in the mixer in 
Computer 4, and from there back to the master mixer in Computer 1. 
This can certainly be tricky to set up, so generally it is recommended 
that if you want to set up a complex network, you should make sure to 
use ASIO cards with at least three separate digital I/Os. 
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Application examples

Using one computer for VST instruments

In this example, you are using one computer as your main record and 
playback machine, and want to use another computer as a virtual 
synth rack.

1. Record a MIDI track into Computer 1.

2. Once you have finished recording, route the MIDI output of that track 
to System Link MIDI port 1.

3. Now go to Computer 2, open up the VST Instrument rack and assign 
an instrument to the first slot in the rack.

4. Route the VST Instrument channel to the desired output bus.
If you are using Computer 1 as your main mixing computer, this would be one of the 
VST System Link output busses, connected to Computer 1.

5. Create a new MIDI track in the Project window of Computer 2, and 
assign the MIDI output of the track to the VST Instrument you created. 

6. Assign the MIDI input of the track to be VST System Link port 1.
Now, the MIDI track on Computer 1 is routed to the MIDI track on Computer 2, which 
in turn is routed to the VST Instrument.

7. Now activate monitoring for the MIDI track on Computer 2, so that it 
will listen and respond to any MIDI commands coming in.
In Cubase SE, you would click the monitor button in the Track list or Inspector.

8. Press play on Computer 1.
It will now send the MIDI information on the track to the VST Instrument loaded on 
Computer 2.

Even with a slow computer you should be able to stack a whole bunch 
of extra VST Instruments this way, expanding your sound palette con-
siderably. Don't forget that VST System Link MIDI is also sample ac-
curate, and thus has much tighter timing than any hardware MIDI 
interface ever invented!
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Creating a virtual effect rack

The effect sends for an audio channel in Cubase SE can either be 
routed to an FX channel track or to any activated Group or output bus. 
This allows you to use a separate computer as a “virtual effect rack”, 
by setting things up in the following way:

1. Go to Computer 2 (the machine you will use as effect rack) and add a 
new stereo audio track.
You cannot use an FX channel track in this case, since the track must have an audio in-
put.

2. Add the desired effect as an insert effect for the track.
Let’s say you add a high-quality reverb plug-in.

3. In the Inspector, select one of the VST System Link busses as input 
for the audio track.
You want to use a separate System Link bus, which will only be used for this purpose.

4. Route the channel to the desired output bus.
If you are using Computer 1 as your main mixing computer, this would be one of the 
VST System Link output busses, connected to Computer 1.

5. Activate monitoring for the track.

6. Now, go back to Computer 1 and select a track to which you want to 
add some reverb.

7. Bring up the effect sends for the track, in the Inspector or the mixer.

8. Pull down the send routing pop-up menu for one of the sends, and 
select the VST System Link bus assigned to the reverb in step 3.

9. Use the send slider to adjust the amount of effect as usual.

The signal will be sent to the track on Computer 2 and processed 
through its insert effect, without using any processor power on Com-
puter 1.

You can repeat the steps above to add more effects to the “virtual ef-
fect rack”. The number of effects available this way is only limited by 
the number of ports used in the VST System Link connection (and of 
course by the performance of Computer 2, but given that it won’t have 
to handle any recording or playback, you should be able to use quite a 
lot of effects).
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Getting extra audio tracks

All computers on a VST System Link network are locked with sample 
accuracy. Therefore, if you find that the hard drive on one computer 
isn’t fast enough to run as many audio tracks as you need, you could 
record new tracks on one of the other computers instead. This would 
create a “virtual RAID system”, with several disks all operating to-
gether. All tracks will remain locked together just as tightly as if they 
were all running on the same machine. This means that you effectively 
have an unlimited track count! Need another 100 tracks? Just add an-
other computer.
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Background

Video support in Cubase SE

Cubase SE plays back video films in a number of formats. 

Under Windows, video playback can be done using one of three play-
back engines: Video for Windows, DirectShow or Quicktime. This en-
sures compatibility with as wide a range of video files as possible. 
The following file formats are supported: AVI, Windows Media Video, 
Quicktime or MPEG formats.

Under Mac OS X, Quicktime is always used as playback engine. 
QuickTime supports the following video file formats: AVI, MPEG, 
QuickTime and DV.

Generally there are two ways to play back video:

• Without any special hardware at all.
While this will be fine in many situations it does put a limit on the size of the video win-
dow as well as the quality of the image.

• Using video hardware that for example connects to an external monitor.
Mac OS X: Using a FireWire port, you can play back video on an external monitor us-
ing a DV-to-analog converter or a DV camera.
This is valid for DV video and QuickTime is used for playback.

Windows: Multi-head graphics cards which support overlay functionality can be used 
to display the video picture on an external monitor. As of this writing, the following 
manufacturers have working solutions available: nVIDIA and Matrox.
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Operations

About the video playback engine

In Cubase SE for Windows, you select a playback engine in the De-
vice Setup - Video Player page:

What playback engine to select depends largely on which type of video 
system you are using, as well as on the file format and codec of the 
video files you want to work with.

• Make sure to read the section “Before you start” on page 527.

• Generally, you can expect most Windows hardware to work with Direct-
Show.
On a Windows system, the DirectShow and Video for Windows players are provided 
by the operating system, you don’t have to install any additional software.
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• For the Quicktime playback method to be available, you must have 
QuickTime installed on your computer (Windows).
There is a freeware version (a QuickTime installer is included on the Cubase SE DVD if 
required, or you can download it from www.quicktime.com) and a “pro” version, which 
offers additional video cutting options. The player engine is the same in both versions, 
so for mere playback in Cubase SE there is no need to purchase the “pro” version.

Under Mac OS X, there is only one standard player option. The Quick-
time playback engine is always used, supporting the formats AVI, MPEG, 
QuickTime and DV. If your system has a FireWire port, there is also a 
FireWire option – see below.

Importing a video file

Video files are imported in the same manner as audio files.

• By using the File menu (Import Video File).

• By using drag and drop.

• By importing to the Pool first and then dragging to the Project window 
(see the Pool chapter for details).

Note:

• To be able to play back the video, you must add a video track (by using the 
Add Track submenu on the Project menu or Quick menu). You can only have 
one video track in each project.

• All video files on the track must be of the same size and compression format.
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Playing back a video file

Video files are displayed as events/clips on the video track, with 
thumbnails representing the frames in the film (if the option Show 
Video Thumbnails is activated in the Preferences dialog).

A video event on a video track.

To view the video on the computer screen (as opposed to on an exter-
nal monitor, see below), proceed as follows:

• If you’re running MacOS X, first open the Device Setup dialog from the 
Devices menu, click Video Player in the list and make sure “Onscreen 
Window” is selected in the Video Output section of the dialog. 

• Pull down the Devices menu and select Video (or use a key command 
– by default [F8]).
A video window appears. In Stop mode, this displays the video frame at the project 
cursor position.

Playback is done together with all other material, using the Transport 
panel.

Setting the Window size

If you are playing back video in a window on your computer screen, 
you may want to adjust the size:

• Open the Device Setup dialog from the Devices menu, click Video 
Player in the list and use the Video Window buttons to select a size.

Playing back video in full screen mode

When viewing video on the computer screen you can choose to let 
the video occupy the whole screen, during playback or in Stop mode:

• Right-click (Win) or [Ctrl]-click (Mac) in the video window to switch to 
full screen. Click again to exit full screen.



CUBASE SE
26 – 526 Video

Playing back video file using grahics cards (Windows only) 

Multi-head graphics cards which support overlay functionality can be 
used to display the video picture on an external TV or computer mon-
itor in full screen mode. As of this writing, the manufacturers nVIDIA 
and Matrox have working solutions available. Check the card’s docu-
mentation for information on how it handles video output and how to 
set it up for multi-monitor display.

Playing back a video via FireWire (Mac OS X only)

For Apple computers equipped with a FireWire port, you can easily 
connect external video hardware via this, as OS X has built-in video 
support for the most common formats (NTSC/PAL/DVCPRO). 
FireWire is capable of high data-transfer speed and is the most com-
mon standard for communicating with video-related peripheral equip-
ment.

• To play back a video file via hardware connected to the FireWire port, 
select “FireWire” in the Outputs pop-up of the Device Setup–Video 
Player dialog.
When FireWire is selected as output, a number of format options appear on the For-
mat pop-up, allowing you to select between various video formats and resolutions.

Project window editing operations

Video clips are played back by events just as audio clips are. You can 
use all the basic editing operation on video events, just as with audio 
events. The following operations are not possible on the video track:

• Drawing, Gluing, Muting and Scrubbing.

• The video track has no editor and does not make use of parts.

Pool operations

For more about operations on video clips in the Pool, see page 350.
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Before you start (Windows only)

When working on a project involving a video file, there are several 
points to bear in mind:

Have you selected the right player?

The player is used not only for playback of the video file, but also to 
provide file information in the Pool. Therefore, to make sure that you 
have chosen the right player for a particular type of video file, check 
the file information displayed in the Pool prior to trying to import or 
playing back the file.

When this information reads “0x0 pixel”, “0.000 s” and “0 Frames”, 
the video file is either corrupt, or the format is not supported by the 
codecs available to the selected video player. You will either have to 
change the video player, or install the required codec.

Trying to import or play back a file not supported by the selected video 
player leads to unpredictable results – if no information on the number 
of frames, the length and the pixel resolution is available in the Pool, you 
cannot import/play this file properly with this particular video player.

You can change the video player in the Device Setup dialog. After having 
done so, make sure to remove any previously imported video file from the 
Pool first, and re-import it.

Editing a video file

Cubase SE allows you to cut, copy, paste and trim video events, i.e. 
your video track may contain more than one video event. However, 
when using the DirectShow video player on a Windows system, you 
may find that only the first event on the video track is played back cor-
rectly. In such a case make sure that the video track contains no more 
than one video event.

When working with a Windows operating system, you may find that 
you are unable to edit a video file copied from a CD. This is because 
files copied from CD are write protected by default. Right-click the file, 
and uncheck the “Read-Only” option in the File Properties dialog.
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When you have a video file in a format not supported by Cubase SE, 
use an external application to convert the file to a format that Cubase 
SE can import.

Options

In the Preferences dialog (Event Display–Video page), there are two 
options for video playback:

• Show Video Thumbnails.
When this is activated, thumbnail frames of the video contents are shown in the track.

• Video Cache Size.
This determines how much memory is available for video thumbnails. If you have long 
video clips and/or work with a large zoom factor (so that a lot of frames are shown in 
the thumbnails), you may have to raise this value.
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Introduction

ReWire and ReWire2 are special protocols for streaming audio bet-
ween two computer applications. Developed by Propellerhead Soft-
ware and Steinberg, ReWire provides the following possibilities and 
features:

• Real-time streaming of up to 64 separate audio channels, at full band-
width, from the “synthesizer application” into the “mixer application”.
In this case, the “mixer application” is of course Cubase SE. An example of a “synthe-
sizer application” is Propellerhead Software’s Reason.

• Automatic, sample accurate synchronization between the audio in the 
two programs.

• The possibility to have the two programs share one sound card and 
take advantage of multiple outputs on that card.

• Linked transport controls that allow you to play, rewind etc, either from 
Cubase SE or from the synthesizer application (provided it has some 
kind of transport functionality).

• Automatic audio mixing functions of separate channels as required.
In the case of Reason for example, this allows you to have separate mixer channels for 
the different devices.

• Additionally, ReWire2 offers the possibility to route MIDI tracks in 
Cubase SE to the other application, for full MIDI control.
For each ReWire2 compatible device, a number of extra MIDI outputs will be made 
available in Cubase SE. In the case of Reason, this allows you to route different MIDI 
tracks in Cubase SE to different devices in Reason, having Cubase SE serve as main 
MIDI sequencer.

• Less total system requirements than when using the programs together 
in the conventional way.
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Launching and quitting

When using ReWire, the order in which you launch and quit the two 
programs is very important:

Launching for normal use with ReWire

1. First launch Cubase SE.

2. Enable one or several ReWire channels in the ReWire Device dialog 
for the other application.
This is described in detail on page 532.

3. Launch the other application.
It may take slightly longer for the application to start when you are using ReWire.

Quitting a ReWire session

When you are finished, you also need to quit the applications in a 
special order:

1. First quit the synthesizer application.

2. Then quit Cubase SE.

Launching both programs without using ReWire

We don’t know exactly why you would want to run Cubase SE and the 
synthesizer application at the same time on the same computer, with-
out using ReWire, but you can:

1. First launch the synthesizer application.

2. Then launch Cubase SE.

Please also note that the two programs now compete for system re-
sources such as audio cards, just as when running either with other, 
non-ReWire audio applications.
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Activating ReWire channels

ReWire supports streaming of up to 64 separate audio channels, 
while ReWire2 supports 256 channels. The exact number of available 
ReWire channels depends on the synthesizer application. Using the 
ReWire Device panels in Cubase SE, you can specify which of the 
available channels you want to use:

1. Pull down the Devices menu and select the menu item with the name 
of the ReWire application. All recognized ReWire compatible applica-
tions will be available on the menu.
The ReWire panel appears. This consists of a number of rows, one for each available 
ReWire channel.

The ReWire panel for Reason.

2. Click on the power buttons to the left to activate/deactivate the de-
sired channels.
The buttons light up to indicate activated channels. Please note that the more ReWire 
channels you activate, the more processing power is required.

• For information about exactly what signal is carried on each channel, 
see the documentation of the synthesizer application.

3. If desired, double click on the labels in the right column, and type in 
another name.
These labels will be used in the Cubase SE mixer to identify the ReWire channels.
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Using the transport and tempo controls

This is only relevant if the synthesizer application has some sort of built-
in sequencer or similar.

Basic transport controls

When you run ReWire, the transports in the two programs are com-
pletely linked. It doesn’t matter in which program you Play, Stop, Fast 
Forward or Rewind. However, recording (if applicable) is still com-
pletely separate in the two applications.

Loop settings

If there is a loop or cycle facility in the synthesizer application, that 
loop will be completely linked to the Cycle in Cubase SE. This means 
that you can move the start and end point for the loop or turn the loop 
on or off in either program, and this will be reflected in the other.

Tempo settings

As far as tempo goes, Cubase SE is always the Master. This means 
that both programs will run in the tempo set in Cubase SE.

However, if you are not using the Tempo track in Cubase SE, you can 
adjust the tempo in either program, and this will immediately be re-
flected in the other.

If you are using the Tempo track in Cubase SE (if the Tempo button is 
activated on the Transport panel), you should not adjust the tempo in 
the synthesizer application, since a tempo request from ReWire will au-
tomatically deactivate the Tempo switch in Cubase SE!
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How the ReWire channels are handled in 
Cubase SE

When you activate ReWire channels in the ReWire Device panels, 
they will become available as channel strips in the mixer. The ReWire 
channel strips have the following properties:

• ReWire channels appear to the right of the other audio and MIDI 
channel strips in the mixer.
ReWire channel strips are denoted by a yellow label in the mixer.

• ReWire channels may be any combination of mono and stereo, de-
pending on the synthesizer application.

• ReWire channels have the same functionality as regular audio channels.
This means you can set volume and pan, add EQ, insert effects and sends and route 
the channel outputs to groups or busses. However, ReWire channels have no monitor 
buttons.

• All ReWire channel settings can be automated using the Read/Write 
buttons.
When you write automation, channel automation tracks will automatically appear in the 
Project Window. This allows you to view and edit the automation graphically, just as 
with VST Instrument channels, etc.

• You can mix down the audio from ReWire channels to a file on your 
hard disk with the Export Audio Mixdown function (see page 487).
You can export the output bus to which you have routed the ReWire channels.



CUBASE SE
ReWire 27 – 535

Routing MIDI via ReWire2

This feature is only available with ReWire2-compatible applications.

When using Cubase SE with a ReWire2-compatible application, ad-
ditional MIDI outputs will automatically appear on the MIDI Output 
pop-up menus for MIDI tracks. This allows you to play the synthesizer 
application via MIDI from Cubase SE, using it as one or several sepa-
rate MIDI sound sources.

The MIDI outputs for a Reason song. Here, each output goes directly to a device in 
the Reason rack.

• The number and configuration of MIDI Outputs depends on the syn-
thesizer application.
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Considerations and limitations

Sample rates

Synthesizer applications may be limited to audio playback in certain 
sample rates. If Cubase SE is set to a sample rate other than those, 
the synthesizer application will play back at the wrong pitch. Consult 
the documentation of the synthesizer application for details.

ASIO drivers

ReWire works well with ASIO drivers. By using the Cubase SE bussing 
system you can route sounds from the synthesizer application to various 
outputs on an ASIO compatible audio card.
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File Operations

New Project

The New Project command on the File menu allows you to create a 
new project, either empty or based on a template:

1. Select New Project from the File menu.
A list of templates is displayed. When you install Cubase SE, templates for various 
purposes are included, but you can also create your own (see page 541).

2. Select a template from the list, or select “Empty”.
A file dialog appears, allowing you to specify a folder for the new project.

3. Select an existing project folder or create a new one by typing its 
name in the dialog.
A new, untitled project is created.

Open

The Open command on the File menu is used for opening saved 
project files.

• Several projects can be open at the same time.
The active project is indicated by the blue Activate button in the upper left corner of 
the Project window. To make another project active, click its Activate button.

An active project.

• You can also open project files by selecting a shortcut from the “Recent 
Projects” submenu on the File menu.
This submenu lists the projects you have recently worked with, with the most recent 
one at the top of the list.

• Projects can automatically be opened when you launch Cubase SE 
(see page 555).
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About the “Pending Connections” dialogs

If you open a Cubase SE project created on another setup (other audio 
hardware), the program tries to find matching audio inputs and outputs 
for the i/o busses (this is one of the reasons why you should use de-
scriptive, generic names for your input and output ports – see page 16).

If the program cannot resolve all audio inputs and outputs used in the 
project, a Pending Connections dialog will appear. This will allow you 
to manually re-route any ports specified in the project to ports available 
in your system.

Similarly, a Pending Connections dialog will appear if you open a 
project with MIDI ports that don’t match the current MIDI setup. Again, 
use the dialog to re-route ports.

Close

The Close command on the File menu closes the active window. If a 
Project window is active, selecting Close will close the corresponding 
project.

• If the project contains unsaved changes, you will be asked whether 
you want to save the project before closing it.
If you select “Don’t Save”, and have recorded or created new audio files since saving, 
you get the choice to delete or keep these.

Save and Save As

The commands Save and Save As allow you to save the active project 
as a project file (file extension “.cpr”). The Save command stores the 
project under its current name and location, while Save As allows you 
to rename and/or relocate the file. If you haven’t yet saved the project, 
or if it hasn’t been changed since it was last saved, only Save As will 
be available.

Generally, we recommend that you save project files in their project 
folders, to keep the projects as manageable as possible.
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A word about file extensions

Under Windows, file types are indicated by three letter file name ex-
tensions (such as *.cpr for Cubase SE project files). Under Mac OS X, 
it is not necessary to use file name extensions, since the file types are 
stored internally in the files. However, if you want your Cubase SE 
projects to be compatible with both platforms, you should make sure 
the option “Use File Extension in File Dialog” is activated in the Prefer-
ences dialog – this is the default setting. When this is activated, the 
proper file name extension is automatically added when you save a file.

Saving a Default project

If you always want the same default project to open when you launch 
Cubase SE, you can save a default project:

1. Set up a project the way you want it.

2. Select “Save As” from the File menu and save the project with the 
name “default.cpr”. The location depends on the operating system:
Mac OS X: the folder “Library/Preferences/Cubase SE 3/” in your “home” directory. 
The full path would be: Users/<user name>/library/preferences/Cubase SE 3. 
Windows: Among the User Settings for Cubase SE. The full path is:
\Documents and Settings\<user name>\Application Data\Steinberg\Cubase SE 3\

This is the one case when the file name extension is crucial under Mac 
OS X as well!

3. Open the Preferences dialog and select the General page.

4. Open the “On Startup” pop-up and select “Open Default Project”.
The next time you launch Cubase SE, the default project is automatically opened. For 
details on the other Startup options, see page 555.
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Save New Version

This function is only available as a key command, by default 
[Ctrl]+[Alt]+S (Windows) or [Command]+[Option]+S (Mac). When 
you use this function, a new version of the project is saved (or in other 
words, the project is saved under a new name). The new file will have 
the same name as the original project but with an incremental number 
attached. For example, if your project is called “My Project” you will 
get new versions called “My Project-01”, “My Project-02”, and so on.

Save New Version is useful if you are experimenting with edits and ar-
rangements and want to be able to go back to a previous version at 
any time. The most recent new versions you have created will be listed 
on the Recent Projects submenu on the File menu, for instant access.

Save as Template

This function allows you to save the current project as a template. Tem-
plates are always stored in the Templates folder, which on a Windows 
system is created under \Documents and Settings\<username>\Appli-
cation data\Steinberg\Cubase SE 3\templates. On the Mac they are 
stored inside Users/<username>/Library/Preferences/Cubase SE 3. 
When you create a new project, the available templates will be listed, 
allowing you to base the new project on a template.

• Templates can contain clips and events, just like regular projects.
If this is not what you want, make sure to remove all clips from the Pool before you save 
the project as a template.
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Save Project to New Folder

This function is very useful if you want to move or archive your project. 
If you select this item, you will first be asked where to store the saved 
project. Then a dialog will appear, with the following options:

When you’ve made your settings, click OK to save the project in the 
new folder. The original project isn’t removed or affected.

Revert

If you select Revert from the File menu, you will be asked whether you 
really want to revert to the last saved version of the project. If you click 
“Revert”, all changes you have made since saving will be discarded.

• If you have recorded or created new audio files since saving, you will 
be asked whether you want to delete or keep these.

Item Description

Project Name By default, this will be the current name of the project you’re sav-
ing, but you can change it if you like.

Minimize Audiofiles If this is activated, only the audio file portions that are actually used 
in the project will be included. This can significantly reduce the size 
of the project folder (if you are using small sections of large files), 
but it will also mean you cannot make use of the remaining audio file 
portions if you continue working with the project in its new folder.

Freeze Edits This will perform a Freeze Edits operation, making all processing 
and applied effects permanent to each clip in the Pool. See page 
274.

Remove Unused 
Files

When this is activated, only files in the Pool that are actually used 
in the project will be stored in the new folder.
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The Cleanup function

The Cleanup function on the File menu helps you to save hard disk 
space by locating, and if you like, deleting unused audio files in the 
project folders on your disk.

1. Select “Cleanup…” from the File menu.
If there are any open projects, an alert will appear, allowing you to close these. Clicking 
“Close” closes all open projects and brings up the Cleanup dialog.

2. If you want to restrict the Cleanup function to a certain folder only, 
click the “Search Folder” button and select the folder.
You should only select a specific folder if you are certain it doesn’t contain audio files 
used in other projects (outside the folder)! See the note below.
If you want the Cleanup function to be applied to all folders on all hard disks, you don’t 
need to make any special settings, as this is the default mode. After selecting a folder 
you can reset the function to search all folders by opening the “Search Folder” dialog 
again and clicking “Cancel”.

3. Click the Start button.
Cubase SE will now scan the selected folder (or all hard disks) for Cubase SE project 
folders and check for audio and image files (in the Audio, Edits and Images subfolders) 
that are not used by any project. The found files are listed in the dialog.

4. When the scan is complete, you can select files by clicking in the list.
Use [Ctrl]/[Command]-click to select several files, and [Shift]-click to select a range of 
files. You can also click the Select All button to select all files in the list.

• There are situations when the Cleanup function will list files that are not 
unused! 
- If you have moved or renamed files or folders (without updating the project files to 
use the new paths), there is no way for Cubase SE to know that these files are used in 
a project. 
- If you perform the Cleanup function on a folder in which there are audio files belong-
ing to other projects (outside the folder), these files will be considered “unused”. 
- Also, make sure you don’t delete any files used in other applications, or files that you 
generally want to keep!

However, you can safely delete Image files since these can be recon-
structed by the program if necessary.

5. Delete any files you don’t want to keep, by selecting them and clicking 
Delete.

6. Close the dialog by clicking its close button.
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Exporting and importing MIDI files

Cubase SE can import and export Standard MIDI Files, which makes 
it possible to transfer MIDI material to and from virtually any MIDI ap-
plication, on any platform. When you import and export MIDI files, you 
can also specify whether certain settings associated with the tracks 
should be included in the files (automation subtracks, volume and pan 
settings etc.).

Exporting MIDI Files

To export your MIDI tracks as a Standard MIDI File, pull down the File 
menu and select “MIDI File…” from the Export submenu. A regular file 
dialog appears, allowing you to specify a location and name for the file.

When you have specified a location and a name for the file, click “Save”. 
At this point, the Export Options dialog appears, allowing you to specify 
a number of options for the file – what should be included in the file, its 
type and its resolution (see below for descriptions of the options).

The Export Options dialog.
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You will also find these settings in the Preferences dialog (MIDI-MIDI 
File page). If you set these up once and for all in the Preferences, you 
only need to click OK in the Export Options dialog to proceed.
The dialog contains the following options:

Option Description

Export Inspector 
Patch

If this is checked, the MIDI patch settings in the Inspector – Bank 
Select and Program Select (used for selecting sounds in the con-
nected MIDI instrument) are included as MIDI Bank Select and 
Program Change events in the MIDI file.

Export Inspector 
Volume/Pan

If this is checked, Volume and Pan settings made in the Inspector 
are included as MIDI Volume and Pan events in the MIDI file.

Export Automation If this is checked, recorded automation (see page 222) is con-
verted to MIDI controller events and included in the MIDI file. This 
also includes automation recorded with the MIDIControl plug-in. 
This is described in the “MIDI Effects” chapter in the separate 
MIDI Devices and Features pdf.

Export Inserts If this is checked and you are using any MIDI plug-ins as insert ef-
fects, the modifications to the original MIDI notes that occur as a 
result of the effect(s) will be included in the MIDI file. A MIDI delay, 
for example, will produce a number of repeats to a MIDI note by 
actually adding additional, “echoing” notes at rhythmic intervals – 
these notes will be included in the MIDI file if the option is activated.

Export Sends If this is checked and you are using any MIDI plug-ins as send ef-
fects, the modifications to the original MIDI notes that occur as a 
result of the effect(s) will be included in the MIDI file.

Export as Type 0 If this is checked, the MIDI file will be of Type 0 (all data on a single 
track, but on different MIDI channels). If you don’t check this op-
tion, the MIDI file will be of Type 1 (data on separate tracks). 
Which type to choose depends on what you want to do with the 
MIDI file (in which application or sequencer it should be used, etc.).

Export Resolution You can specify a MIDI resolution between 24 – 960 for the MIDI 
file. The resolution is the number of pulses, or ticks, per quarter 
note (PPQ) and determines the precision with which you will be 
able to view and edit the MIDI data. The higher the resolution, the 
higher the precision. The resolution should be chosen depending 
on the application or sequencer with which the MIDI file should be 
used though, since certain applications and sequencers may not 
be able to handle certain resolutions.

Export Locator 
Range

If this is checked, only the portion of the MIDI file wihin the locators 
will be exported.
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• The MIDI File will include the Tempo track.

• Inspector settings (other than patch, volume, pan and effects – see 
above) are not included in the MIDI file!
To include these, you need to convert the settings to “real” MIDI events and properties 
by using the Merge MIDI in Loop function for each track, see page 368.

Importing MIDI Files

To import a MIDI file from disk, proceed as follows:

1. Select “MIDI File…” from the Import submenu on the File menu.

2. In the dialog that appears, select whether a new project should be 
created for the file or not.
If you select “No”, the MIDI file will be imported into the current project.

3. Locate and select the MIDI file in the file dialog that appears, and click 
Open.

4. If you chose to have a new project created, you are asked to specify a 
project folder for the new project.
Select an existing project folder or create a new one by selecting a location for it and 
typing its name in the dialog.

The MIDI file is imported. The result depends on the contents of the 
MIDI file and the Import Options settings in the Preferences dialog – 
MIDI-MIDI File page. The Import Options are as follows:

Option Description

Extract First Patch If this is checked, the first Program Change and Bank Select 
events for each track are converted to Inspector settings for the 
track.

Extract First Volume/
Pan

If this is checked, the first MIDI Volume and Pan events for each 
track are converted to Inspector settings for the track.

Import Controller as 
Automation track

If this is checked, MIDI controller events in the MIDI file will be 
converted to automation data for the MIDI tracks.

Import to Left Locator If this is checked, the imported MIDI file will be placed so that it 
starts at the position of the left locator – otherwise it will start at 
the beginning of the project. Note that if you choose to have a 
new project created automatically, the MIDI file will always start 
at the beginning of the project.
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As mentioned on page 545, the result also depends on what type of 
MIDI file it is – Type 0 or Type 1:

• If the MIDI file is of Type 0 (all data on a single track), only one MIDI track will 
be created.
This track will be set to MIDI Channel “Any”, allowing all MIDI events to play back on 
their original channels. You can use the Dissolve Part function on the MIDI menu to dis-
tribute the events onto different tracks with different MIDI Channels (see page 390).

• If the MIDI file is of Type 1 (data on several tracks) a number of new MIDI 
tracks and parts will be created.

In both cases, the Tempo track is adjusted according to the Tempo 
track in the MIDI file.

It is also possible to import a MIDI file from disk by dragging and dropping 
it from the Windows Explorer or the Mac OS Finder into the Cubase SE 
Project window. The Import Options apply if you use this method as well.

Importing Cubase VST files

It is possible to import files created in older versions of Cubase. There 
are three options for this on the File – Import submenu:

Import Cubase Song

This will open a Song file (Windows file extension “.all”) created in Cu-
base 5.0 or later and convert it to a Cubase SE project. When import-
ing a Song, you will be asked to specify a folder for the new project, as 
usual.

• Cubase Songs can contain more than one Arrangement (containing in-
dependent part and event data). If this is the case, you will be asked 
which one of these Arrangements to import.
To import all Arrangements in a Cubase Song, simply repeat this for all Arrangements, 
and save each as a separate project.

Ignore Mastertrack 
Events on Merge

If this is activated and you import a MIDI file into the current 
project, tempo track data in the MIDI file is ignored. The im-
ported MIDI file will play according to the current Tempo track 
in the project.

Option Description
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The conversion has the following limitations:

Data Conversion result

MIDI output setting 
for MIDI tracks

If the output information stored in the original Song doesn’t 
match the current outputs, a “Pending Connections” dia-
log will appear, allowing you to remap each MIDI output in 
the Song to a new output.

MIDI track play parameters 
(Inspector settings)

Only the volume and transpose settings are included; the 
other parameters (velocity, compression, length and pan) 
are ignored.

MIDI part play parameters 
(Inspector settings)

All settings are included, except transpose.

Group tracks Removed.

Style tracks Removed.

Chord tracks Removed.

Drum tracks Converted to MIDI tracks with drum maps. MIDI output 
settings for individual drum sounds will be ignored.

Solo/Mute status of tracks Ignored.

MIDI “effect” devices, such 
as the arpeggiator and IPS

Removed.

Window layouts Ignored.

Key command settings Ignored.

Grooves Ignored.

MIDI Mixermaps Removed.

Dynamic events in audio 
parts (including M-points)

Ignored.

Automation The VST channel automation is included, but limited to 
volume, pan and EQ data. Plug-in automation settings are 
ignored.

Left/right locator positions 
and cycle status

Ignored.

Sync settings and status Ignored.

Master track hitpoints Removed.

VST Group channels Removed.
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• It’s also possible to import Songs created in version 3.7x of Cubase for 
Windows.
However, this will only include the basic audio and MIDI data, ignoring most of the set-
tings.

Import Cubase Arrangement

As mentioned above, a Song in previous versions of Cubase could 
contain one or several Arrangements. These contained all the part and 
event data along with file references, but without mixer settings and 
similar, which were global to all Arrangements in the Song. Arrange-
ments could be saved as separate files, with the extension “.arr”.

When you import a Cubase Arrangement into Cubase SE, it will be 
converted to a project, just as when importing a Song. The same limi-
tations apply.

Import Cubase Part

Just as in Cubase SE, previous Cubase versions used parts as con-
tainers for MIDI or audio events. These could be saved as separate 
files with the extension “.prt”. When you import a part file, the follow-
ing happens:

• A new track is created, with the name of the part.
That is, the name of the part when it was saved in Cubase, not (necessarily) the file name.

• The part appears as a Cubase SE part, at the left locator position.
• If the imported part was an audio part, the necessary clips and file references 

are added to the Pool.

Note that none of these file formats contain any actual audio data. Just 
as with Cubase SE projects, the files only contain references to audio 
files. This means that you need access to the referenced audio files as 
well, to properly import Songs, Arrangements or Parts with audio.

Multiple audio tracks routed 
to the same audio channel

Will be replaced by separate audio tracks (with separate 
channels in the mixer). This is because in Cubase SE 
there is always one channel per track.

Solo/Mute status of VST 
channels

Ignored.

Data Conversion result
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Importing audio CD tracks

You can import audio from audio CDs, for use in Cubase SE projects. 
This is done by selecting “Import Audio CD” from the Pool menu (or 
by selecting the “Audio CD…” option from the Import submenu on the 
File menu).

• If the project window is active, the imported audio CD track(s) will be 
inserted on the selected audio track, at the project cursor position.
It is also possible to import audio CD tracks into the Pool, which may be the preferred 
method if you want to import several CD tracks in one go.

Selecting one of the Import Audio CD menu items brings up the follow-
ing dialog:

• If you have more than one CD drive, you use the Drives pop-up menu 
to select the one holding the audio CD.
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• The Speeds pop-up menu (Windows version only) lists all possible 
data transfer speeds for the selected CD drive.
While you normally want to use the fastest possible speed, you may have to select a 
slower speed for flawless audio extraction.

• The main display in the dialog lists all audio tracks on the CD.
The columns have the following functionality:

• You can audition the selected audio CD track by clicking the Play 
button.
The track will be played back from the grab selection start (see below) to the track end 
(or until you click the button again). During playback, the button is labeled “Stop”.

• The arrow buttons next to the Play button allow you to audition the 
start and end of the grab selection only.
The left button will play a short snippet beginning at the start of the grab selection (see 
below), while the right button will play a snippet starting just before the end of the grab 
selection.

Column Description

Grab Activate the checkbox in this column for the track you want to grab (im-
port). To activate more than one checkbox (import more than one track), 
click and drag over the checkboxes (or press [Ctrl]/[Command] or [Shift] 
and click).

Track When you import an audio CD track, the file will be named according to 
the name in this column. You can rename a track by clicking in the Track 
column and typing a new name. You can also apply a name to all audio 
CD tracks (e.g. the name of the album, see below).

Length The length of the whole audio CD track, in minutes and seconds.

Size The file size of the whole audio CD track, in MegaBytes.

Grab Start You can grab a section of a track if you like. This indicates the start of the 
section to be grabbed in the track. By default, this is set to the start of the 
track (0.000) but you can adjust this on the grab selection ruler (see below).

Grab End Indicates the end of the section to be grabbed in the track. By default, this 
is set to the end of the track but you can adjust this on the grab selection 
ruler (see below).
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• If you want to import a section of an audio CD track only, you select 
the track in the list and specify the start and end of the grab selection 
by dragging the handles in the grab selection ruler.
Use the start and end audition buttons to fine tune the selection boundaries.

Note that you can import sections of several audio CD tracks by selecting them in turn 
and adjusting the grab selection. The grab start and end settings for each track will ap-
pear in the list.

• If you wish, you can change the generic audio file name in the File 
Name field.
By default, the imported audio files will get this name with a track number added (typ-
ically Track 01, Track 02, and so on). However, if you have adjusted the track name for 
a specific audio CD track in the list, the corresponding audio file will use that name in-
stead.

• By default, imported audio CD tracks will be stored as Wave files 
(Win) or AIFF files (Mac) in the Audio folder of the current project.
You can select another folder by clicking the Change Folder button.

• Clicking the Grab button will convert the selected audio CD tracks 
(the tracks for which the Grab checkbox is ticked) to audio files.
The grabbed files will be listed at the bottom of the dialog – click OK to actually import 
the files into the project and close the dialog, or click Cancel to discard the grabbed files.
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Importing ReCycle files

ReCycle, developed by Propellerhead Software, is a program designed 
especially for working with sampled loops. By “slicing” a loop and mak-
ing separate samples of each beat, ReCycle makes it possible to match 
the tempo of a loop and edit the loop as if it was built up of individual 
sounds. Cubase SE can import two file types created by ReCycle: 

• REX files (export file format of the first versions of ReCycle, extension “.rex”).
• REX 2 files (file format of ReCycle 2.0 and later, extension “.rx2”).

Proceed as follows:

1. Select an audio track and move the project cursor to where you want 
the imported file to start.
You probably want to import REX files to tempo based audio tracks, since this will allow 
you to change the tempo later on (having the imported REX file automatically adjust).

2. Select “Audio File…” from the Import submenu on the File menu.

3. Select REX files or REX 2 files with the file type pop-up menu in the 
file dialog.

4. Locate and select the file and click Open.
The file is imported, and automatically adjusted to the current Cubase SE tempo. 

Unlike a regular audio file, the imported REX file will consist of several 
events, one for each “slice” in the loop. The events will automatically 
be placed in an audio part on the selected track, and positioned so 
that the original internal timing of the loop is preserved.

5. If you now open the part in the Audio Part Editor, you can edit each 
slice separately by muting, moving and resizing events, adding effects 
and processing, etc.
You can also adjust the tempo and have the REX file automatically follow.

• You can also achieve similar results by using Cubase SE’s own loop 
slicing features.
See page 306.
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Importing compressed audio files

During the last years, various audio compression formats have be-
come very common. The major advantage of using such file formats is 
that the file size is significantly reduced, with very little degradation of 
sound quality. This allows for quick download, mass storage and easy 
transportation.

Cubase SE can import (and export, see page 487) several common au-
dio compression formats. The procedure is the same as when import-
ing any non-compressed audio file, with one important thing to note:

If you import a compressed audio file, Cubase SE will create a copy of 
the file and convert this to Wave format (Windows) or AIFF format (Mac 
OS X) before importing it (the original compressed file will not be used 
in the project). The Wave/AIFF file will be placed in the designated 
project Audio folder. Please be aware that the converted Wave/AIFF file 
will be several times larger than the original compressed file!

The following file types are supported:

MPEG audio files

MPEG, which stands for Moving Picture Experts Group, is the name 
of family of standards used for coding audio-visual information (e.g. 
movies, video, music) in a digital compressed format. 

Cubase SE can read mp3 only.

• Note that the file extension “.mpeg” can also be used by MPEG video files.

Ogg Vorbis files

Ogg Vorbis is a relatively new format that is open and patent-free and 
offers very small audio files maintaining comparatively high audio qual-
ity. Ogg Vorbis files have the extension “.ogg”.

Windows Media Audio files (Windows only)

Windows Media Audio is an audio format developed by Microsoft Inc. 
Due to advanced audio compression algorithms, Windows Media Au-
dio files can be made very small, maintaining good audio quality. The 
files have the extension “.wma”.
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Options and Settings

Auto Save

If you activate the Auto Save checkbox in the Preferences dialog 
(General page), Cubase SE will automatically save backup copies of 
all open projects with unsaved changes.

• You specify how often a backup copy should be created with the Auto 
Save Interval setting.

• Backup copies are named “Name.bak”, where “Name” is the name of 
the project. The files are saved in the project folder.

• Unsaved projects are also backed up in the same way.
Backup copies of unsaved projects will be named “#UntitledX.bak” where “X” is an in-
cremental number, to allow multiple backup copies in the same project folder.

Startup Options

The “On Startup” pop-up menu in the Preferences dialog (General 
page) allows you to specify what should happen each time you launch 
Cubase SE. The following options are available:

Option Description

Do Nothing Cubase SE launches without opening a project.

Open Last Project The last saved project is opened on launch.

Open Default Project The default project is opened (see page 540).

Show Open Dialog The Open dialog appears on launch, allowing you to manu-
ally locate and open the desired project.
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Cubase SE Open Document Options Dialog

The Cubase SE projects you have used recently are displayed in the 
list. To open one of them, select it and click the “Open Selection” but-
ton. To open another project not listed there, click the “Open Other…” 
button. A file dialog appears that allows you to look for the desired file 
on your disk. Click the “New Project” button to create a new project 
using a template or not.

If you hold down [Ctrl]/[Command] while launching Cubase SE this 
dialog will always be displayed, regardless of the startup option se-
lected in the Preferences dialog (General page).

Show Template Dialog The Template dialog appears on launch, allowing you to cre-
ate a new project from one of the templates.

Show Open Options 
Dialog

The Open Document Options dialog appears on launch, see 
below. It allows you to make a different choice each time you 
launch Cubase SE.

Option Description
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Background

The user can customize the appearance and functionality of Cubase 
SE in various ways.

User configurable items described in this chapter are:

• Transport panel
The user can configure which Transport panel items are to be shown or hidden, and 
where they should be located – see page 559.

• Toolbars
In the project window and all editor windows, the user can configure which toolbar 
items are to be shown or hidden, and where they should be located – see page 561.

• Appearance
The general look of the program can be adjusted – see page 563.

This chapter also contains a section describing where your preferences 
and settings are stored (see page 566), to help you transfer your cus-
tomized settings to another computer.
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Customizing the Transport panel

You can customize the appearance of the Transport panel by deci-
ding which parts of it you wish to be visible, and where the parts 
should be located on the panel.

Setting which items are shown/hidden

If you right-click (Win) or [Ctrl]-click (Mac) anywhere within the Trans-
port panel area, a pop-up menu will appear. On this menu, you can di-
rectly check or uncheck elements of the Transport panel as desired.

You can also select different preset configurations from the lower half 
of the menu. To make all hidden items visible again, select “Show All”.

The Transport Setup dialog

If you right-click (Win) or [Ctrl]-click (Mac) anywhere within the Trans-
port panel area and select “Setup…” from the pop-up menu, a dialog 
appears. In this dialog you can also configure where the separate parts 
should be placed on the panel as well as saving/recalling different con-
figurations of the Transport panel.
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The dialog is divided into two columns. The left column displays the 
currently visible items on the Transport panel, and the right column 
displays the currently hidden items.

• You can change the current show/hide status by selecting items in 
one column and then use the arrow buttons in the middle of the dialog 
to move them to the opposite column.
Changes are applied directly.

• By selecting items in the “Visible Items” column and using the Move 
Up and Move Down buttons you can change the position of the se-
lected item(s) on the Transport panel.
Changes are applied directly. To undo all changes and revert back to the standard 
Transport panel layout, you can select “Default” from the pop-up menu accessed by 
right-clicking/[Ctrl]-clicking the Transport panel.

A “customized” Transport panel

• If you click the Save button (disk icon) in the Presets section, you can 
name the current configuration and to save it as a preset.
The saved setting appears in the Presets field.

• To remove a preset, select it and click the trash icon.

• Saved configurations are available for selection from the Presets pop-
up in the dialog, or directly from the pop-up menu brought up by right-
clicking or [Ctrl]-clicking the Transport panel.
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Customizing the toolbars

You can customize the appearance of the toolbars in the Project win-
dow and editor windows by deciding which sections should be visi-
ble, and where the sections should be located on the panel. The 
screenshots below illustrate customizing the Project window toolbar 
but you can use the same procedures for the toolbars in the Sample 
Editor, the MIDI editors and the Tempo Track Editor.

Setting which items are shown/hidden

If you right-click (Win) or [Ctrl]-click (Mac) anywhere within the tool-
bar area, a pop-up menu will appear. On this menu, you can directly 
check or uncheck elements of the toolbar as desired.

You can also select “Show All” (makes all hidden items visible) or 
“Default” (makes all hidden items visible – except those that are hid-
den by default – and moves them back to their standard locations).
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The Toolbar Setup dialog

If you select “Setup...” from the pop-up menu, a dialog appears. In this 
dialog you can decide which items should be visible, where the sepa-
rate items should be placed on the toolbar and save/recall different 
configurations of the toolbar.

The dialog is divided into two columns. The left column displays the 
currently visible items on the toolbar, and the right column displays the 
currently hidden items.

• You can change the current show/hide status by selecting items in 
one column and then use the arrow buttons in the middle of the dialog 
to move them to the opposite column.
Changes are applied directly.

• By selecting items in the “Visible Items” column and using the Move 
Up and Move Down buttons you can change the position of the se-
lected item(s) on the toolbar.
Changes are applied directly.

A “customized” toolbar
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• If you click the Save button (disk icon) in the Presets section, a text 
field appears, allowing you to name the current configuration and to 
save it as a preset.
The saved setting appears in the Presets field.

• To remove a preset, select it and click the trash icon.

• Saved configurations are available for selection from the Presets pop-
up in the dialog, or directly from the pop-up menu brought up by right-
clicking or [Ctrl]-clicking the toolbar.

Appearance

In the Preferences dialog you will find a page called Appearance. Here 
you can adjust the look of the program, with the following settings:

• Basic Appearance Scheme.
By selecting an option from this pop-up menu you can adjust the general look of the 
program. After selecting an Appearance Scheme and clicking Apply or OK, you need 
to restart the program for the changes to take effect.

• Brightness/Intensity sliders.
These sliders allow you to fine-tune the brightness and contrast in various areas in the 
program. Changes take effect when you click Apply or OK.

Applying track and event colors

You can use color scheming for easier overview of certain tracks and 
events in the Project window. Applying colors is divided into two ar-
eas; track and event colors.

• A track color is reflected and can be edited in the Inspector, Track list, 
and in the corresponding channel in the Mixer. It is furthermore dis-
played in all parts and events for the track in the Event display.
Track colors can be switched on or off globally.

• Event colors are reflected in parts and events in the Event display and 
are independent from the track colors.
An applied event color “overrides” the track color, if both are used.
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Track colors

• You activate track colors by clicking the color strip at the top of the 
Track list.

A small arrow appears to the right in the Track Name title bar.

• Clicking the arrow brings up the color palette where you can select a 
color and apply it to the selected track.
This palette or color set can be edited in the Event Color dialog.

The chosen track color is now reflected in the Inspector title bar, the 
field by the output activity meter in the Track list, in the Mixer and any 
parts or events on the selected track.

Click here to bring up the color palette.
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Colorizing parts and events

There is a Color tool (the paint bucket icon) on the Project window 
toolbar that can be used to colorize parts and events.

The Color tool.

Just below the Color tool there is a small strip. Click this to bring up 
the standard color palette. If you double-click this strip the Event 
Color dialog opens, where you can define new colors for the standard 
palette, add more colors etc.

• To colorize one or several selected events, select the Color tool, 
chose a color from the palette, and click on an event.
The color is applied to all selected events and overrides the track color (if used). 

• If you press [Ctrl]/[Command] and click on an event with the Color 
tool, the color palette is displayed and you can chose the desired 
color for an event.

• If you press [Alt]/[Option], the Color tool cursor becomes a pipette, 
which can be used to select a color by clicking on a part/event.

• An alternative way to colorize parts and events is by selecting them, 
and then picking a color from the Color selector on the toolbar.
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Where are the settings stored?

As you have seen, there are a large number of ways in which you can 
customize Cubase SE. While some of the settings you make are 
stored in each project, others are stored in separate preference files.

If you need to transfer your projects to another computer (e.g. in an-
other studio), you can bring all your settings along by copying the de-
sired preference files and installing them on the other computer.

• It’s a good idea to make a backup copy of your preference files once 
you have set things up the way you want!
This way, if another Cubase SE user wants to use his or her personal settings when 
working on your computer, you can restore your own preferences afterwards.

• Under Windows, the preference files are stored in the folder “\Docu-
ments and Settings\<user name>\Application Data\Steinberg\Cu-
base SE 3\”.
On the Start menu you will find a shortcut to this folder, for easy access.

• Under Mac OS X, the preference files are stored in the folder “Library/
Preferences/Cubase SE 3/” under your “home” directory.
The full path would be: “/Users/<user name>/Library/Preferences/Cubase SE 3/”.

The table below shows the location and name of each preference file:

Setting Stored in

Current edit modifier keys Edit Modifiers.xml

Current key commands Key Commands.xml

Current preferences Defaults.xml

Color setup saved in project

Crossfade presets Presets\RAMPresets.xml

Drum maps saved in Project/Export as *.drm file

EQ presets Presets\RAMPresets.xml

Installed MIDI devices Midi Devices.bin

Key commands presets Presets\KeyCommands\<Preset Name>.xml

Logical Editor presets Presets\Logical Edit\<Preset Name>.xml
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MIDI FX presets Presets\<Plugin Name>\<Plugin Name>.xml

Mixer view preset saved in project

Quantize presets Presets\RAMPresets.xml

User templates templates\<Template Name>.cpr

Toolbar presets Presets\RAMPresets.xml

Transport panel presets Presets\RAMPresets.xml

Usage profile log Usage Profile.xml

VST connections presets Presets\RAMPresets.xml

Zoom presets Presets\RAMPresets.xml

Setting Stored in
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Background

Introduction

Most of the main menus in Cubase SE have key command shortcuts 
for certain items on the menus. In addition, there are numerous other 
Cubase SE functions that can be performed via key commands. These 
are all default settings. If you want, you can customize existing key 
commands to your liking, and also add commands for menu items and 
functions currently not assigned any.

You can also assign tool modifier keys, i.e. keys that change the behav-
ior of various tools when pressed. This is done in the Preferences dialog 
– see page 579.

How are key commands settings saved?

Every time you edit or add any key command assignment, this is stored 
as a global Cubase SE preference – not as part of a project. Hence, if 
you edit or add a key command assignment, any subsequent projects 
that you create or open will use these modified settings. However, the 
default settings can at any time be restored by selecting “Reset All” in 
the Key Commands dialog.

In addition, you can save key commands settings as a “key commands 
file”, which is stored separately and can be imported into any project. 
This way you can quickly and easily recall customized settings, when 
moving projects between different computers, for example. The set-
tings are saved in a file on disk with the windows extension ”.xml”.

See later in this chapter for details on how to save key commands 
settings.
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Setting up Key Commands

The following is a description of how you set up key commands and 
save them as presets for easy access.

Key commands settings are accessed and edited mainly in the Key 
Commands dialog, but there are also some settings that can be made 
in the Preferences dialog, and these are also addressed in this chapter.

Adding or modifying a key command

In the Key Commands dialog you will find all main menu items and a 
large number of other functions, arranged in a hierarchical way similar 
to that of the Windows Explorer and Mac OS Finder. The categories 
are represented by a number of folders, each containing various menu 
items and functions. When you open a category folder by clicking the 
plus-sign beside it, the items and functions it contains are displayed 
with the currently assigned key commands.
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To add a key command, proceed as follows:

1. Pull down the File menu and select “Key Commands…”.
The Key Commands dialog appears.

2. Use the list in the Commands column to navigate to the desired cate-
gory.

3. Click the plus-sign to open the category folder and display the items 
contained in it.
Note that you can also click the “global” plus-signs and minus-signs in the top left cor-
ner to open and close all category folders at once.

4. In the list, select the item to which you wish to assign a key command.
Already assigned key commands are shown in the Keys column as well as in the Keys 
section in the top right corner.

5. Alternatively, you can use the search function in the dialog to find the 
desired item.
For a description of how to use the search function, see page 574.

6. When you have found and selected the desired item, click in the 
“Type in Key” field and enter a new key command.
You can choose between any single key or a combination of one or several keys (Com-
mand, Option (Mac), Ctrl, Alt (Win), Shift) plus any key. Just press the keys you want to 
use.

If a selected item or function has a key com-
mand assigned already, it is displayed here...

...and here.
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7. If the key command you entered is already assigned to another item or 
function, this is displayed below the “Type in Key” field. 

In case a key command is already assigned to another function, you can either ignore 
this and proceed to assign the key command to the new function instead, or you can 
select another key command.

8. Click the Assign button above the field.
The new key command appears in the Keys List.

If the key command you enter is already assigned to another function, 
you will get a prompt asking if you want to reassign the command to the 
new function instead, or cancel the operation.

Note that you can have several different key commands for the same 
function. So adding a key command to a function that already has an-
other key command will not replace the key command previously de-
fined for the function. If you wish to remove an assigned key command, 
please see page 574.

9. Click OK to exit the dialog.
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Searching for key commands

If you want to know which key command is assigned to a certain func-
tion in the program, you can use the Search function in the Key Com-
mands dialog:

1. Click in the search text field at the top left of the dialog and type in the 
function for which you want to know the key command.
This is a standard word search function, so you should type the command as it is 
spelled in the program. Partial words are OK; to search for e.g. all quantize related 
commands you could type “Quantize”, “Quant”, etc.

2. Click the Search button (the magnifying glass icon).
The search is conducted and the first matching command is selected and displayed in 
the commands list below. The keys column and the keys list show the assigned key 
commands, if any.

3. To search for more commands containing the word(s) you entered, 
just press the Search button again.

4. When you’re done, click OK to close the dialog.

Removing a key command

To remove a key command, proceed as follows:

1. If the key commands dialog isn’t already open, pull down the File 
menu and select “Key Commands…”.

2. Use the list of categories and commands to select the item or function 
for which you wish to remove a key command.
The key command for the item is shown in the Keys list and the Keys column.

3. Select the key command in the Keys list and click the Remove button 
(the trash icon).
You will get a prompt asking if you want to remove the key command or cancel the 
operation.

4. Click OK to close the dialog.
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Setting up macros

A macro is a combination of several functions or commands, to be 
performed in one go. For example, you could select all events on the 
selected audio track, remove DC offset, normalize the events and du-
plicate them, all with a single command.

Macros are set up in the Key Commands dialog as follows:

1. Click the Show Macros button.
The macro settings are shown in the lower part of the dialog. To hide these from view, 
click the button (now renamed to Hide Macros) again.

2. Click New Macro.
A new, unnamed macro appears in the Macros list. Name it by typing the desired name. 
You can rename a macro at any time by clicking it in the list and typing a new name.

3. Make sure the macro is selected, and then use the Categories and 
Commands in the upper half of the dialog to select the first command 
you want to include in the macro.

4. Click Add Command.
The selected command appears in the list of Commands in the Macros section.

5. Repeat the procedure to add more commands to the macro.
Note that commands are added after the currently selected command in the list. This 
allows you to insert commands “in the middle” of an existing macro.

A macro with three commands.

• To remove a command from the macro, select it in the Macros list and 
click Delete.
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• Similarly, to remove an entire macro, select it in the Macros list and 
click Delete.

After you’ve closed the Key Commands dialog, all macros you have 
created appear at the bottom of the Edit menu, available for instant 
selection.

You can also assign key commands to macros. All macros you have 
created appear in the upper section of the Key Commands dialog un-
der the Macros category – just select a macro and assign a key com-
mand as with any other function.

Saving key commands settings

As previously mentioned, any changes made to the key commands 
(and macros) are automatically stored as a Cubase SE preference. It 
is however also possible to store key commands settings separately. 
In this way, you can store any number of different key command set-
tings as presets for instant recall.

Proceed as follows:

1. Set up the key commands and macros to your liking.
When setting up key commands, remember to click “Assign” to make the changes.

2. Click the Save button (the disk icon) by the Presets pop-up menu.
A dialog appears, allowing you to type in a name for the preset. 

3. Click OK to save the preset.
Your saved key commands settings will now be available in the Preset pop-up menu 
for your future projects.
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Loading saved key command settings

To load saved key command settings, proceed as follows:

• Note that this operation may replace existing key commands!
The key command settings you load will replace the current key command settings for 
the same functions (if any). If you have macros of the same name as those stored in the 
preset you load, these will be replaced too.
If you want to be able to revert to your current settings again, make sure to save them 
first, as described above!

1. Open the Key Commands dialog from the File menu.

2. Select the saved key commands preset you wish to open from the 
Presets pop-up.

3. Click OK to exit the Key Commands dialog and apply the saved pre-
set settings.
The loaded key commands settings now replace the current key command settings.

Loading saved key commands settings from earlier versions of Cubase SE

If you have used a previous version of Cubase SE, you may have 
saved key commands settings from it that you’d like to use in the cur-
rent version. This is possible by using the Import function, which lets 
you load and apply either saved key commands or macros:

1. Open the Key Commands dialog from the File menu.

2. Click the “Import” button (the folder icon) to the right of the Presets 
pop-up menu.
A standard browser dialog opens.

The Import button



CUBASE SE
30 – 578 Key commands

3. In the browser dialog, use the “Files of type:” pop-up to specify if you 
want to import a Key Commands File (Windows file extension “.key”) 
or a Macro Commands File (extension “.mac”).
In the current version, Key Commands files include any macro settings and use the 
Windows extension “.xml”. So after you have imported an older file, you might want to 
save it as a preset (as described on page 576) to be able to access it from the Presets 
pop-up menu in the future.

4. Navigate to the file you want to import and click “Open”.
The file is imported.

5. Click OK to exit the Key Commands dialog and apply the imported 
settings.
The settings in the loaded key commands- or macros file now replace the current 
settings.

About the “Reset” and “Reset All” functions

These two buttons in the Key Commands dialog will both restore the 
default settings. The following rules apply:

• “Reset” restores the default key command setting for the function se-
lected in the Commands list.

• “Reset All” will restore the default key commands for all commands.

Note that the “Reset All” operation will cause any changes made to the 
default key commands to be lost! If you want to be able to revert to 
these settings again, make sure to save them first!

About the default key commands

As mentioned before, there are numerous default key commands. For 
an overview of these, please refer to the Getting Started book where 
they are listed for your convenience.
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Setting up tool modifier keys

A tool modifier key is a key you can press to get an alternate function 
when using a tool. For example, clicking and dragging and event with 
the Arrow tool normally moves it – holding down a modifier key (by 
default [Alt]/[Option]) will copy it instead.

The default tool modifier keys are listed in the Getting Started book, 
but you can customize them if needed. This is done in the Preferences 
dialog:

1. Open the Preferences dialog from the File menu (on the Mac, this is 
located on the Cubase SE menu) and select the Editing – Tool Modi-
fiers page.

2. Select an option in the Categories list, and then locate the action for 
which you want to edit the modifier key.
For example, the “Copy” action mentioned above resides in the category “Drag & Drop”.

3. Select the action in the Action list.

4. Hold down the desired modifier key(s) and click the Assign button.
The current modifier key(s) for the action is replaced. If the modifier key(s) you pressed 
are already assigned to another tool, you will be asked whether you want to overwrite 
them. If you do, this will leave the other tool without any modifier key(s) assigned.

5. When you’re done, click OK to apply the changes and close the dialog.
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A
Activate Next/Previous Part 397
Activate project button 538
Active ASIO Ports for

Data only 515
Active Part 396
Active Staff 453
Add Bus 17
Add Track 90
Adjust Fades to Range 139
Aftertouch

Deleting 425
Editing 421
Recording 57

AIFF files 489
Always Send Start Message 500
Any (MIDI channel setting) 53
APP

Introduction to 499
Appearance 563
Archiving 347
ASIO 2.0 45
ASIO Direct Monitoring 45
ASIO Positioning Protocol

Introduction to 499
Audio channels

Copying settings 175
Linking 181
Making settings for 168
Mixing down to file 486
Saving settings 183

Audio clips
About 256
Creating new versions 333
Deleting 335
Locating events 336
Managing in Pool 333
Opening in the Sample 

Editor 341

Audio effects
About 188
Automating 233
Editing 204
For output busses 

(Master inserts) 193
Inserts 190
Loading 206
Naming 205
Organizing in subfolders 207
Post-fader inserts 190
Pre/Post fader sends 200
Presets 204
Saving 205
Sends 198
Tempo sync 189
Using VST System Link 519

Audio events
Blue handles 138
Editing in Sample Editor 276
Fade handles 138
Making selections in 286
Slicing 322
Volume handles 140

Audio files
Converting 348
Deleting permanently 335
Exporting 486
Format for recording 40
Formats 342
Import options 93
Importing into Pool 341
Importing into Project 

window 92
Locating missing 339
Reconstructing missing 339
Removing missing 340
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Audio parts
About 69
Creating by gluing events 101
Creating from events 94
Drawing 94
Editing in Audio Part 

Editor 294
Sliding contents 105

Audio pre-record 38
Audio Tempo Definition tool 318
Auditioning

Audio Part Editor 298
MIDI editors 405
Project window 95
Sample Editor 283

Auto Fades 150
Auto Monitoring modes 43
Auto Quantize 55
Auto Quantize (Score Editor) 456
Auto Save 555
Auto Select Events under Cursor

MIDI editors 408
Project window 97

Automation
About 222
Opening automation 

subtracks 225
Reduction Preference 241
Showing and hiding 225
Write/Read buttons 231

Automation events
About 235
Editing 236
Removing 239
Selecting 238

Automation follows Events 230
Automation Reduction Level 241

Automation subtracks
Assigning parameters to 226
Hiding and showing 229
Muting 230

Autoscroll 117, 404

B
Backup (.bak) files 555
Bars+Beats Linear

MIDI editors 400
Tempo Track Editor 475

Basic Appearance Scheme 563
Beat Calculator 482
Bounce (Export Audio) 486
Bounce Selection

Project window 108
Sample Editor 289

Brightness 563
Busses

About 14
Adding 17
Mixing down to file 486
Routing to and from 18
Viewing in the mixer 19

Bypass
Effect sends 201
Insert effects 192

C
Calculate (Hitpoints) 311
Channel (MIDI) 50
Channel Overview

Insert effects 193
Channel Settings

Audio tracks 168
Copying 175
MIDI tracks 180

Channel view sets 159
Chase 30
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Chn setting 53
Chord Recognition 401
Clean Lengths 458
Cleanup 543
Clef 457
Click 63
Clips, see “Audio clips”
Close 539
Close Gaps 325
Color pop-up menu

MIDI editors 469
Project window 91

Color tool 91
Colorize Event Background 87
Conform Files 349
Constrain Delay 

Compensation 217
Controller display

About 402
Adding and removing 

lanes 416
Controller lane presets 418
Editing events 421
Editing velocity 418
Selecting event type 417

Controller Lane Editing - Select
Tool defaults to Pen 418, 424

Controllers
Deleting 425
Editing 421
Recording 57

Convert Files 348
Convert to Real Copy 99
Count-in 63
Cpr files 538
Create Audio Images During

Record 46
Create new controller lane 416
Create slices 322
Crop 113

Crossfades
Creating 145
Editing in dialog 147
Presets 149
Removing 146

Csh files 347
Cubase VST files 547
Cursor, see “Project cursor”
Cut Time 112
Cycle

About 28
About recording 38
Recording audio 48
Recording MIDI 56

Cycle markers
About 128
Adding in Marker window 129
Drawing 133
Editing 135
Making selections with 135
Navigating to 134
On Marker track 132

Cycle Record modes 56

D
DC Offset 270
Deactivate Punch In on Stop 62
Default Edit Action 395
Default project 540
Delay compensation

About 189
Constraining 217

Delete
Audio files from disk 335
Events in Project window 108
MIDI controllers 385, 425
MIDI drum notes 432
MIDI notes 412

Delete Continuous Controllers 385
Delete Controllers function 385
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Delete Doubles function 385
Delete Notes function 386
Delete Overlaps

Mono (MIDI) 387
Poly (MIDI) 388

Delete Time 112
Device Ports

Selecting for busses 17
DirectShow 523
DirectX plug-ins 208
Disable Hitpoints 314
Disable inserts 192
Disable sends 201
Disable Track 29
Display format 79
Display Quantize 455
Display Transpose 457
Dissolve Part

Audio 94
MIDI 390

Divide audio events 323
Drag Delay 97
Draw

Automation events 236
Hitpoints 315
In Sample Editor 289
Markers 133
MIDI controllers 421
MIDI notes 405
Parts 94

Drum Editor
Creating and editing notes 430
Muting drum sounds 432
Selecting drum maps 438

Drum maps
About 433
Making settings 434
MIDI channel and output 437
O-Note Conversion 440
Selecting 438
Setup dialog 439

Drum mode (Time Stretch) 273
Drum name lists 441
Drum Sound Solo 432
Drumstick tool 430
Duplicate

Events and parts 99
MIDI notes 409

Duplicate track 91

E
Edit Active Part Only 396
Edit as Drums when Drum Map is

assigned 395
Edit button

Audio channel strips 168
Audio track Inspector 73
MIDI channel strips 180
MIDI track Inspector 354

Editing via MIDI 413
Edits folder 256
Effect Return channels 202
Effects, see “Audio effects” or 

“MIDI effects”
Elements (Sample Editor) 277
Enable Record on Selected

Track 35
Enable Solo on Selected

Track 107
Enable Track 29
Enharmonic Shift 465
Envelope

Process 259
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EQ
Bypassing 173
Presets 173
Setting 170

Eraser tool 108
Events

Color 91
Duplicating 99
Locking 106
Moving 97
Muting 107
Overlapping in audio part 297
Overlapping in Project

window 98
Removing 108
Renaming 101
Renaming all on track 90
Resizing 102
Resizing with time stretch 104
Selecting 96
Sliding contents 105
Splitting 101

Events (Snap mode) 115
Events to Part 94
Events, see also “Audio events”
Exclusive Solo 166
Export Audio Mixdown 486
Export MIDI files 544
Export Options (MIDI files) 544

F
Fade handles 138
Fade In/Out functions 140
Faders 164
Fades

Auto Fades 150
Creating 138
Editing in dialog 142
Presets 143

Processing 140
Removing 140

Fill Loop 100
Filter (MIDI) 61
Filter bar 447
Find missing files 339
Find Selected in Pool 337
FireWire 526
Fixed Lengths 385
Fixed tempo 472
Fixed Velocity 389
Flip Stems 466
Folder parts 123
Folder tracks

About 120
Moving tracks into 121
Muting and soloing 122

Frame rates 502
Freeze Edits 274
Freeze Quantize 382
FX channel tracks

About 195
Adding effects for 197
Mixing down to file 486
Routing sends to 198
Setting up 196
Soloing 203

G
Gain 260
Generic Remote Device 250
Glue Tube tool

MIDI editors 411
Project window 101
Score Editor 465

Grid (Snap mode) 114
Grid Relative (Snap mode) 115
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Group channel tracks
About 68
Routing audio to 177
Using effects 194

H
Hitpoint Edit tool 314
Hitpoint Sensitivity 312
Hitpoints

Auditioning 311
Background 306
Calculating 311
Disabling 314
Editing manually 315
Locking 314

Horizontal Zooming Only 83

I
Import

Audio CD Tracks 550
Audio files 92
Cubase Arrangement 549
Cubase Part 549
Cubase Song 547
Medium in Pool 341
MIDI files 544
MPEG files 554
Ogg Vorbis files 554
REX 553
Video files 92
WMA files 554

Import Audio CD 343
Info line

Drum Editor 427
Key Editor 399
Pool 331
Project window 78
Sample Editor 281
Score Editor 451

Initialize Channel 176
I-Note 435
Input (MIDI) 50
Input busses

About 14
Adding 17
Routing to channels 18

Input levels 42
Insert effects (Audio) 190
Insert into Project 337
Insert pop-up menu 444
Insert Silence

Project window 113
Sample Editor 288

Insert velocity (MIDI Editors) 407
Inspector

Audio tracks 74
Folder tracks 75
General controls 73
Handling 71
MIDI tracks 353

Intensity (Appearance) 563
Interpolate Audio Images 283
Iterative Quantize 380

J
Jump tempo curve mode 477

K
Keep Last

Audio cycle recording 48
MIDI cycle recording 56

Key (Score Editor) 457
Key commands

About 570
Default 578
Importing 577
Loading 577
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Modifying 571
Removing 574
Resetting to default 578
Saving 576
Searching for 574

L
Lanes

Audio Part Editor 296
Latency

Monitoring 43
VST System Link 508

Left locator 28
Legato 384
Length Adjustment 60
Length Compression 359
Length Quantize 406
Level faders 164
Level meters

Settings 176
Line mode

Automation 237
MIDI controllers 422
MIDI velocity 419

Linear Record Mode
Audio 46
MIDI 55

List Editor
Adding events 444
Editing in the list 444
Editing in the value display 449
Filtering events 447
Masking events 447

Locate when clicked in empty
space 26

Locators 28
Lock 106
Lock Event Attributes 106
Lock Hitpoints 314

Loop icon
Audio Part Editor 298
Pool 340
Sample Editor 283

M
M button 107
Macros 575
Magnetic Cursor (Snap mode) 116
Magnifying Glass tool 83
Markers

About 128
Adding in Marker window 129
Drawing on Marker track 133
Editing on Marker track 133
ID-numbers 130
Key commands for 136
Marker track 132
Marker window 128
Moving 130
Removing 129
Snapping to 115

Mask function 447
Merge Clipboard 261
Merge MIDI in Loop 368
Merge Record Mode

Audio 46
MIDI 55

Merge Tempo From Tapping 484
Meter characteristics 176
Meters

Settings 176
Metric Bias 313
Metronome

Activating 63
Precount 63
Settings 64
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MIDI channel
"Any" 53
In drum maps 437
Selecting for tracks 53
Send effects 364

MIDI Channel Settings 180
MIDI Clock

About 498
Always Send “Start” 500
Transmitting 500

MIDI connector button 413
MIDI effects

About 362
Deactivating 367
Inserts 363
Presets 365
Sends 364

MIDI files 544
MIDI Filter 61
MIDI input (Editing via) 413
MIDI inputs

Renaming 51
Selecting for tracks 51

MIDI notes
Deleting 412
Drawing 405
Editing velocity 418
Moving 409
Muting 412
Muting in Drum Editor 432
Quantizing 373
Resizing 411
Selecting 408
Splitting and gluing 411
Transposing (Function) 383
Transposing (in editor) 409

MIDI outputs
In drum maps 437
Renaming 51
Selecting for tracks 53
Send effects 364

MIDI parts
About 69
Drawing 94
Editing 395
Sliding contents 105

MIDI Record Catch Range 60
MIDI reset 58
MIDI Thru 50
MIDI tracks

Channel Settings window 180
Settings 354
Track Parameters 357

Minimize Files 346
Mix (Cycle Record mode) 56
Mixer

Common panel 162
Group channels 177
Hiding channel types 158
Link/Unlink channels 181
Loading settings 184
Pan 167
Saving settings 183
Solo and Mute 166
Volume 164

Mixer Selection Follows 
Project 169

Mixing down to an audio file 486
Modifier keys 579
Monitor button

Audio tracks 44
MIDI tracks 50

Monitoring modes 43
Move Controller 

(Quantize setting) 378
Move Hitpoints 315
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Move to Back/Front 98
Move to Cursor 98
Move to Origin 98
MP3 files

Exporting 492
Importing 554

MPEG files
Audio 554
Video 523

Multiple audio tracks 90
Mute

Events in Project window 107
MIDI notes 412
Mixer 166
Tracks 107

Mute Pre-Send when Mute 200
Mute tool 107

N
New Project 81
No Overlap 458
Noise Gate 262
Non Quantize setting 378
Normal Record Mode

Audio 46
MIDI 55

Normal Sizing 102
Normalize

Audio process 263
Notes, see “MIDI notes”
Npl files

Pool files 348
Nudge buttons

MIDI editor toolbar 409
Project window toolbar 98

Numeric keypad 25

O
Ogg Vorbis files

Exporting 494
Importing 554

On Import Audio Files 93
On Processing Shared Clips 257
On Startup setting 555
Online (VST System Link) 512
O-Note 435
O-Note Conversion 440
Open 538
Open Document Options 

dialog 556
Output (MIDI) 50
Output busses

About 14
Adding 17
Mixing down to file 486
Routing channels to 18
Viewing in the mixer 19

Over Quantize 379
Overlapping events

Audio Part Editor 297
Project window 98

Overwrite (Cycle Record mode) 56

P
Padlock symbol 106
Pan Law 167
Parabola mode

Automation 238
MIDI controllers 422
MIDI velocity 420

Part Data mode 89
Parts, see “Audio parts” or

“MIDI parts”
Paste at Origin 100
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Paste Time
MIDI editing 410
Selection ranges 112

Pedals to Note Length 387
Pencil tool 94
Pending Connections 539
Performance meter 185
Phase Reverse 264
Pitch Bend

Deleting 425
Editing 421
Recording 57

Pitch Shift 264
Play icon

Audio Part Editor 298
Pool 340
Sample Editor 283

Play tool
Audio Part Editor 298
Project window 95

Plug-in delay compensation 189
Plug-in Information window

MIDI plug-ins 367
VST plug-ins 208

Plug-ins
Automating 233
Getting info 208
Installing 206
Organizing 207

Poly Pressure events 426
Polyphony (Restricting) 387
Pool

About 328
Auditioning 340
Convert Files 348
Finding clips in 336
Handling audio clips 333
Import Medium 341
Importing Pool files 348

Locate missing files 339
Record folder 344
Status column icons 332

Postroll 62
Pre fader sends 200
Pre/Post crossfade 259
Precount 63
Preferences

Transferring 566
Prepare Archive 347
Preroll 62
Printing Scores 468
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Show Extra Info 79
Selecting
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